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Installing and/or Upgrading Information
Here is some important information to be aware of when installing your new Diamond Cut version 10 software (sometimes referred to as DC-Art, version 10). This applies to both the DCArt10 and the Forensics10 software programs. If you are upgrading from an earlier version of a Diamond Cut Audio Restoration product such as DC7 or DC8, (or an earlier version of DC Forensics) there are some things to be particularly aware of.
1. If you’ve purchased a hard copy version of the product, you will find your serial number located behind the install disc which is contained in a pouch located at the back of the printed user’s manual. Otherwise, it will have been emailed to you after an electronic purchase online. It is a 16 figure code.
2. If you have purchased a new installation (not at upgrade), you will need to enter a user name* (up to 256 characters maximum), a serial number and your email address. After that, the software will fetch your registration code via your internet connection or via email. If you do not have an internet connection, you can call us or write to us to obtain a registration code. We will need the exact user name that you used when you installed the software and your product serial number. If either of these are not provided exactly as entered into the software, the system will not register and, will not work after the time trial period has expired. The registration code is a 12 figure code.
*Note: Do not use the ampersand symbol (&) in your User Name as it will not be properly recognized by the registration system. Instead, consider using the word “and”. Besides “&”, other invalid characters are “\” or “/” and “?”
3. If you purchased an upgrade, the Diamond Cut system will look for a previous registration in terms of your User Name, Serial Number and/or email address. The system looks for existing DC6, DC7 or DC8 registrations. Earlier versions will not be recognized. Forensics10 upgrades will look for earlier DC Forensics versions on your system. If it finds one, it will extract the required information and use it for the electronic registration of your upgraded product which should occur within 24 hours.
4. After product installation has been completed, please check for software updates at www.diamondcut.com because we are in the continual process of creating product improvements and bug fixes. These updates are free to registered Diamond Cut customers.
5. Every so often, it is a good idea to check for additional free product updates to keep your software current in terms of bug fixes and feature enhancements.
6. You do not need to un-install DC7 or DC8 before installing DCArt10. The same applies to an upgrade from an earlier version of DC Forensics to DC Forensics Audio Laboratory, v.10.x. As a matter of fact, it may be of advantage to leave your earlier version of DC-Art (Diamond Cut Audio Restoration Tools) installed if they contain important presets that you have created over time or if you want to maintain your existing DC Tune Database and playlists.
7. You do need to un-install previous versions within a product family before updating. For example, if you are updating your software from DCArt10, version 10.x to version 10.y, we recommend un-installing 10.x first.
8. If you have personal favorite presets that you had created using an earlier version of DC-Art (like DC8.5), you can use the Preset Manager (found under the Edit Menu) in DCArt10 to import them into the new preset directory created by DCArt10 as long as the earlier version is still installed.
9. The first time that you open your new DCArt10 DC Tune Library, the system will ask you if you want to import your old DC Tune Library Database from an earlier directory into your DCArt10 directory. If you choose to do this, it will also transfer your old playlists into the DCArt10 Directory.
10. It is a good idea to record your User Name, Serial Number and Registration code for safe keeping in case your hard drive fails. A good place to record this is in the “Notes” section located at the back of the printed users guide. You will need that information to restore your system in the event of a system failure. To locate that information, go to your Diamond Cut Help\About DCArt --- menu. All of the salient Diamond Cut Software registration information can be found there including your software revision number. The most common support call that we receive occurs after a hard drive crash. That question is “what was my User Name, Serial Number and Registration Code”. Due to security concerns, we have to research the request and then go into our archive to find that information. This process delays the user’s restoration of their computer system. Thus, the delay can be avoided by recording that information immediately after your initial Diamond Cut Software installation. With that information at hand, you can re-install your Diamond Cut software without contacting the company. Of course, if that information has been lost, feel free to contact us, but give us 24 hours to do the necessary research and to get back to you with your Diamond Cut license information. The product serial number, user name, registration code and e-mail address are not kept on the Diamond Cut Productions servers indefinitely. It is the customer’s responsibility to preserve that information in their own archive.
Section 1 - Welcome & the Product Basics
Thank you for purchasing another fine product from Diamond Cut Productions, Inc. We strive to provide you with audio DSP software that pushes the envelope in terms of features, but leave enough money in your wallet to afford the envelope. We will do our best to not only provide you with the most effective DSP audio software available anywhere, but also complement it with excellent support materials. This manual is your window into the product. Please use it. A great supplemental source of information can be found at the Diamond Cut Productions forum located at:
http://www.diamondcut.com/vforum/
It is a free service and has a large body of information (roughly 27,000 posts coupled with a search engine) built up over a long period of time by users of the various Diamond Cut products. Though we will support this product to the best of our ability via telephone, email, the forum and our web site, chances are, everything that you need to navigate DCArt10 and Forensics10 are right here. We’ve done our best to make this manual and the other supporting documents as user friendly and intuitive as possible…give it a try… “reading is fundamental”.
History of the Product
Diamond Cut Audio Restoration Software was originally written by two engineers in their spare time to facilitate the very specific needs that arose in their restoration of the Edison Lateral Collection of Test Pressing Recordings, which is located at the Edison National Historic Site in West Orange, New Jersey. Rick Carlson and Craig Maier developed and improved this program over a 23 year period of time. When they made it available to the general public many years ago, it was with the idea in mind that if it solved some audio restoration problems for them in dealing with the Edison archive, it might also be of use to others confronted with similar audio signal processing problems. Since then, it has grown into the most used audio restoration, enhancement and forensics audio authentication product on the planet, and beyond.
How to Get Started
This manual is nice and thick but it’s not a novel and we don’t expect you to read it cover to cover. However, we’d like you to get started by carefully reading Section 1. It covers how to install the software, hook up your external sound system, and test your installation. Section 1 also gives you some great hands-on tutorials that will take you step-by-step through some real restorations. If you go through that section of the manual, you’ll be fully oriented and ready to use the program! The remaining sections are great reference materials should you run into any questions for which you need more detailed answers. Additional tutorials can be found in Section 3.
Important Note: This manual supports two different products. As many of the features for both DCArt10 and Forensics Audio Laboratory v.10.x are similar, we have streamlined this manual to support both products. As you browse the Table of Contents, you’ll notice numerous entries marked with the sub-title of “Forensics Only”. These features are only supported in the DC Forensics Audio Laboratory v. 10.x.
About the Product
DCArt10 and DC Forensics Audio Laboratory v.10.x contain a comprehensive set of tools designed for audio restoration, enhancement audio archiving and audio surveillance. This extensive toolkit will allow the user to remove extraneous noise and also enhance the sound from any audio source without degrading the content contained on the original. Recognizing that there is a tradeoff between the degree of noise removed from a source and the fidelity, transient and frequency response maintained, we have sought to provide the highest level of user control while maintaining ease of use over the variables that affect the audio restoration and enhancement process.
Professional Audio Engineers, Radio and Television Engineers, Forensic Scientists, Audio Archivists, Ham Radio operators, Recording Studios and Audiophile hobbyists use our products for re-mastering, editing, noise removal, signal enhancement and audio signal analysis and/or synthesis. It is also used by many local, state, and federal government agencies including both military intelligence operations and forensics law enforcement applications, particularly in surveillance situations. Private sector forensics audio engineers use it for post processing and authentication of forensic recordings of phone calls and surveillance tapes. Radio and television networks have found the LIVE (real-time signal processing) feature of particular value in their real-time applications. Additionally, a number of Engineering Colleges and Universities use this software as part of the laboratory portion of some coursework pertaining to applied DSP techniques and Audio Forensics Science.
Important Note: Most of the algorithms used in DCArt10 and DC Forensics Audio Laboratory v10.x use double precision floating point math as opposed to fixed precision integer math in order to minimize the possibility of introducing digital noise or distortion into your .wav files. The tradeoff associated with using this method is the time required to process a file being slightly longer than the fixed precision integer method.
About the Version
DCArt10 (v.10.x) and DC Forensics Audio Laboratory (v.10.x) have been in the works for over a year. We’ve added a ton of novel new features. If you’ve been using our products and are only new to DCArt10 or DC Forensics Audio Laboratory v.10.x, use the list below as your table of contents. It includes every new feature to the product so that you can quickly access all of the newest info without rehashing the stuff you’ve already read. Here is a list of the features making their debut in Version 10:
DCArt10 & DC Forensics V. 10.x New Features:
About the Manual
With roughly 650 pages of information passed on to us by our scientists and engineers, we tried to format a manual that was basic enough for a first time, non-experienced user, but filled with the kind of detail that any “propeller head” would love. We’ve also condensed a good deal of the material…all that means to you is that if you have an interest in a specific item such as the Punch and Crunch Filter, you simply look it up in the Table of Contents or Index. You’ll not only find all the information describing the tool, but also any tutorial information on that specific tool all in the same location. Our Tutorial section now contains only multiple tool procedures. As mentioned earlier, this manual supports both DCArt10 and DC Forensics10, so be aware that features native only to the Forensics version will be marked accordingly. Information contained in the product’s help file will sometimes supersede information contained in the printed User’s Guide (or the user printable .pdf), because the software (and thus its help file) is updated more frequently than the printed material.
Getting Started
Note: Everything you need to know to install the software, hook up your hardware and begin to use the program will be found in this “getting started” chapter. This is must reading. You’ll find it easy and fun!
So, that’s enough of our bloviating. Let’s install this software and have some fun.
In this section, we’ll tell you everything you need to know in order to install, configure, check out and start using the software. Read through this section carefully and perform the steps indicated and you’ll have a perfectly working real time audio restoration workstation!
Step One – Make Sure System Meets Our Requirements
Most machines today are more than capable of handling extensive audio signal processing techniques. Hard drives have also grown to a point, where you really have no limits on what you can do…except perhaps time. As we’ve not yet developed time manipulation outside of the computer, let’s just deal with what you’ll need in the way of a PC. Here are the minimum System Requirements:
* You now possess the state-of-the-art in technology for audio restoration, enhancement, audio measurement and forensics file surveillance and authentication. If you haven’t yet replaced the sound card that came with your computer (which is probably the lowest quality audio component you own), consider purchasing a high-performance unit. Your audio restoration results will only be as good as the weakest link in your audio chain allows. Maybe that’s a good item to add to your “wish list”.
** If your computer has more than the minimum required to run your OS adequately, further increases in the quantity of RAM will not appreciably speed up the DCArt10 / DC Forensics10 algorithms since they are almost totally limited by the processor. Upgrading to a faster processor will allow the filters to run faster.
Most DCArt10/DC Forensics10 algorithms use a single thread and will not be appreciably speed up by multi-core or multiprocessor CPUs.
***This product uses DirectX and requires DirectX 9.0 or higher.
Some older computers may require additional component installations.
Note: Most DCArt10/DC Forensics10 algorithms use a single thread and will not be appreciably speed up by multi-core or multiprocessor CPUs.
Step Two - Installation of the Product
Most users find this extremely easy.
The software will be installed in a folder called Diamond Cut Productions. Several demo .wav files are also supplied as part of the demonstration tutorials found in both the Help file and PDF version of the manual.
During the installation process, you will be asked to approve the license agreement, and select an install location. After a few seconds of installation time, you’re ready to launch the program by clicking on the DCArt10 or Forensics10 Icons, depending on which program you have purchased.
When DCArt10 or Forensics10 is first run you must choose your User Name and enter it into the software. You also will need to enter the Serial Number that was supplied to you when you purchased the product. Enter the serial number exactly as shown using only the numbers 0-9 and letters A-Z.
The combination of your name and serial number is your unique key to DCArt10 or DC Forensics10; no other personal information is used.
After you have entered your name and Serial Number, you must then register the program with Diamond Cut Productions. The registration process can be done automatically over the internet or via phone or email.
If you choose automatic registration, DCArt10/DC Forensics10 will attempt to contact the servers at Diamond Cut Productions and automatically register your product. The registration process installs a registration code into your computer and activates the product. After registration you will receive an email with a duplication registration code for your records, should you ever need to re-install the product.
If you register by phone or email, you will receive a registration code from Diamond Cut Productions that you must enter into the program to complete the registration. We strongly encourage either automatic or email registration. .
Note 1: Diamond Cut Productions is the ONLY authorized source of registration codes, regardless of where you purchased your product.
Note2: DCArt10 and DC Forensics10 require a User Name, Serial Number and Registration Code from Diamond Cut Productions, Inc. After you receive your Serial Number and have assigned yourself a User Name, you will receive a registration code via email. Record those data somewhere for future reference. The most common support question is “my hard-drive crashed and I just replaced it. I have my serial number but I do not remember my user name. Can you retrieve my user name from your server database for me?” Of course, we can usually do that, but it will cause you an unnecessary delay. Once you have a successful installation, you can print out these data from the Help/About Diamond Cut Audio Restoration Tools, XX.YY menu.
Step Three - Configure Your DCArt10/DC Forensics10 Program
DCArt10/Forensics10 does not require much configuration, but it does require that your sound card be installed and working properly. If you have more than one sound card in your system, make sure the one you wish to use has been selected in the Sound Card Selection screen (in the Edit/Preferences/Soundcard Menu).
Next, check the Temp File Path under the Edit/Preferences/General
Menu. DCArt10/DC Forensics10 automatically assigns temporary file names for files that are being processed. You should set this temporary drive path to the disk drive that you wish to use for audio editing. This is usually the drive with the most free disk space. Keep in mind that high quality (44.1 kHz – 16 bit) Stereo recording consumes 10.5 Mbyte of disk space per minute.
Generally, this is where we get calls from customers who experience one form of problem or another. This is usually because most people don’t record onto their computer’s hard drive very often and they may not have their system set up for this type of application. We’re happy to help, but before you call us… please read the next few paragraphs:
Important Note – also make sure your “Line” input is selected in this mixer – not your “Mic” input (unless you are attempting microphone based recording).
We’ll cover more in the Troubleshooting section of the manual, but these are the highlights.
Step Four – Connect Your Computer to Your Audio System
Your sound card has both an input and an output. The output is used when you play an audio file and the input is used when you record audio into the computer. Refer to your sound card manual or the little icons on your soundcard to identify which jack is for output (playing back audio) and which is for input (recording audio). Often, a small speaker or headphone icon represents the output jack.
We first want to connect speakers to the output of your sound card so we can hear audio. You probably already have speakers connected. If you do, then fine. Just leave them alone. If not, you’ll need to connect the output of your sound card to either an amplifier or amplified speakers having line level inputs (-10 dBv).
Note: Your sound card records and plays audio at a certain established Voltage level. This standard level is referred to as “Line Level”. Just about all devices play or record at this exact audio level so they’re all compatible with each other. CD players, Tape Recorders, Amplifiers, Receivers, VCRs, DAT machines, Mini discs and most other devices all play or record this standard “Line Level” signal amplitude. This means you can plug your tape player output or other line level device directly into the input of your sound card since they both use the same signal level (amplitude).
Wiring Things Up!
Next, we need to connect a signal into the input of your sound card so that we can record this audio onto your computer’s hard drive. If you are using a line level device, just plug it into the sound card “Line” level input using whatever adapter cable mates your player device (i.e., tape recorder) to the input jack on your sound card.
Critical Note on Turntables - There are two common playback devices that are not line level and which can’t be plugged directly into your sound card line level input. The first is a turntable with a magnetic phono cartridge. A magnetic phono cartridge produces a signal that is much lower in amplitude than line level sensitivity. Your sound card cannot use this signal as it is; it must be amplified up to the standard line level before it is applied to the line input of your sound card.
If your turntable has a magnetic phono cartridge, you must use what is called a magnetic phono preamplifier as the first element of the signal path. If you have a stereo system with an input jack on the back-labeled “Phono”, you probably already have a magnetic phono preamp. It’s in your stereo system. Just leave your turntable connected to the “Phono-Input” of your stereo and connect a Line Level output of your stereo to the sound card input. Many times, this line level output is marked as “Tape Out”. Now, any audio (including your turntable) you can hear from your stereo system will be available to your computer for recording. Another option to consider is the use of a “Flat Phono Preamplifier”. Flat preamplifier front ends, when used in conjunction with the Diamond Cut Virtual Phono Preamplifier (VPP™) provides a high level of EQ curve flexibility as well improved sonic performance of your transfers. For more information on this technique, you can download an Application Note from our website located at:
http://www.diamondcut.com
Navigate to the Application Note section of the site and look for AN 8 titled “The New Way of Recording LPs”.
Note: A more direct link to this Application Note is:
http://www.diamondcut.com/AppNotes/TheNewWay.html
If you don’t have a stereo system to connect your turntable to, or it’s in another room, you’ll need a stand-alone preamplifier. These are not expensive and you can purchase one at:
http://www.diamondcut.com/st3/
Again, this device takes the tiny signal from your turntable and amplifies it so that it’s now a standard Line Level signal that can be plugged directly into your sound card.
Note 1: Low cost turntables utilizing Ceramic Phono Cartridges do not require a special pre-amplifier because their signal levels are already at approximately line level.
Note 2: Be sure to connect the turntable-grounding wire (strap) to the chassis ground of your Phono Preamplifier or to the computer chassis itself to minimize ground loop induced hum.
Another device that does not develop a standard Line Level signal is a microphone. If you want to record from a “mic”, just plug it into the jack on your sound card that is labeled “Microphone”. If you need to use this mic jack, again, refer to your sound card manual for specifics.
Note 3: Some laptops have only two analog audio jacks. One is always an earphone / audio output jack while the other is often labeled “mic”. Many laptop computers allow you to convert the functionality of this “mic” input over to that of a “line” input via the sound system chipsets driver routine control panel. Please refer to the manufacturer of the laptop for details on this mic/line level switchover functionality.
In most cases, you’ll simply be taking the output of your source to the input of your sound card. This is pretty easy to visualize since the computer is really acting like a familiar tape recorder with an input and an output. Many audiophiles have very sophisticated and complicated audio systems that allow many different types of hookups. Therefore, there are many alternative methods for connecting your computer to a sound system in order to be able to use DCArt10/DC Forensics10. Here are several methods:
(NOTE: Typical users will not have to use these or other complicated hookups – just supply an audio signal to the input of the sound card and listen to it on the output.)
Method #1: Using a home stereo tape-monitoring loop
Method #2: Using a DAT with digital (S/PDIF) inputs and outputs
Method #3: Using a mixing board and Analog Sound card
Warning: Method #3 is the most versatile method for setting up a small sound restoration lab. However, because it is so versatile, feedback loops are easily created which can produce very annoying and potentially dangerous signal levels (to your ears, power amplifier and loudspeakers). So you must be careful not to allow the output of a device to feedback into the same device when operating the mixing board. Always check twice before raising a slider control on your mixing board utilizing this method.
Step Five – Turn Screen Saver and Background Tasks Off
In some cases when recording, if your screen saver or other background computer tasks automatically comes on, it may interrupt your recording or add glitches that you didn’t want. It is always better to turn these functions off before recording. Though this is less of a problem with faster computers, most users will feel more secure if they turn off automatic backups, screen savers, etc. This allows the computer resources to fully dedicate themselves to recording clean audio.
Step Six - Choose your Operating Mode
The software can be operated in either of two basic operational modes. Choose your operating mode based on your personal preferences. Beginners will likely find that the Fast-Edit mode is easier to get oriented with since it works more like traditional audio editing programs. More advanced users will likely switch to the Classic mode since this offers a fully optimized restoration environment. You can quickly switch between these two modes of operation via the “One Click Edit Mode Switch” icon. Just click on the icon and it will change between the two alternative editing modes.
“One Click Edit Mode Switch” Icon
Fast-Edit Mode
The Fast-Edit (single file editing mode) mode operates much like a word processor where all editing is done on one file. The original file is not modified until a “Save” is performed. Fast-Edit mode maintains a separate history file representing the editing sequence and offers almost unlimited Undo capability. The advantage of the Fast Edit’s Single file editing mode is its “greased lightning” speed, leaving you with more time for your domestic chores. Where editing examples are used in this manual in order to highlight the use of an editing or filtering sequence, the Classic Edit (Source and Destination) mode is utilized.
In this Fast-Edit mode, you preview the processing results, and if not satisfactory, you can use the “Undo” feature found in the Edit menu. Also, you can highlight a particular step in the Fast-Edit history in order to quickly jump back to a previous editing state. The editing processes will be temporarily undone back to the selected point in the Edit History Monitor. If you want to permanently go back to a previous editing state you can simply double click on the last edit you want to delete in the Fast-Edit Window (display). All editing done after that point will be removed and you can continue your editing session. The Delete function can also be found by clicking with the right mouse button. Fast Edit temp files are maintained in the same directory as the source file and include elements of the original file name for ease of identification. The Fast-Edit history file uses the extension of .ses. Temporary files created by your Diamond Cut Software precede the extension with dctmpxx. They are stored in the TempFiles directory and can have various file extensions such as .wav, .pkf, or .ses.
Classic (Edit) Mode
DCArt10/DC Forensics10 Classic (Edit) mode usually operates on files in a non-destructive manner. The Source and Destination mode (the Classic technique) involves the use of a “Source and Destination” set of files. When a file is processed with a DCArt10/DC Forensics10 filter or effect, the software reads the Source file, modifies it with the selected filter or effect, which then writes it to the Destination file. The main workspace of DCArt10/DC Forensics10 always has a Source and a Destination file in the Classic (Edit) mode. This mode of operation has a few important benefits:
The Source and Destination Workspace
When you open a .wav file in DCArt10/DC Forensics Classic-Edit Mode, two workspaces will appear. The top one, called the Source Workspace will display an envelope consisting of the program peaks of the .wav file just opened. If you are using Peak files (a user preference), the entire waveform should be visible in the window. If you have peak files turned off, then the amount of the .wav file that will be displayed is determined by your preferences "display limit" settings. Both settings can be found in the Edit/ Preferences/General section of the Edit Menu. The display will consist of a black signal on a yellow background (depending on the user’s preference settings).
The Destination Workspace just below the Source workspace will contain no waveform information initially, and will contain a gray background color. Both of these two workspaces display amplitude on the Y-Axis (vertical) and time on the X-Axis (horizontal). When you initially open a file, the entire file is displayed, and is periodically represented by a sample of the peak of the waveform envelope. When you Zoom-in on a portion of the waveform, at some value of magnification, you will begin to see continuous waveforms, rather than impulse representations of your .wav file signal. For more information regarding Zooming-In on a .wav file or Zooming-Out on a .wav file, please refer to the sections entitled "Zooming-In & Zooming-Out on portions of a .wav file". Please note that the active workspace is always shown in yellow (the software default setting).
If you are working with stereo .wav files, the workspace will display a pair of waveforms. The top waveform in either of the workspaces represents the left channel while the bottom waveform represents the right channel. If the signal is monophonic, only one waveform will be seen in the workspace(s).
At the top of the DCArt10/Forensics10 screen is a Title bar, which contains the name of the opened Source .wav file. At the bottom of the DCArt10/Forensics10 screen and on the right side, you will see five little boxes. The first shows the Mode in which the file was recorded or processed (“Stereo” or “Mono”) followed by the Sample Rate that was used to create the file and then the Bit Depth. The fourth box give the total running time of the Source .wav file and the final box shows the space remaining on the hard drive being used.
After a .wav file has been processed by one of the functions under the Filter command, the output of that file will be sampled just like the Source file and displayed in the Destination workspace just below the Source workspace. It will become highlighted in yellow just following the completion of a processing session.
At the bottom of each of the two workspaces, you will see several time displays. Each display is indicated in Minutes: Seconds: Milliseconds. The time display on the left side of the workspaces indicates the starting time of the portion of the .wav file being displayed in the particular workspace. The time display on the right side of the two workspaces indicates the ending time of the displayed portion of the highlighted .wav file. When a file is initially opened, the display on the left will indicate 00: 00: 00. The right display will indicate the total time duration of the opened .wav file. If you use the Zoom function, the left display will now display the start time of the highlighted
Zoom-In portion of the .wav file. The right time display will indicate the end-time of the highlighted Zoomed-In portion of the .wav file. The total time duration of the Zoomed-In highlighted portion of the .wav file will be displayed on the status bar located below the workspaces.
At the right hand side of each of the two workspaces, you will see two vertically oriented slider controls next to one another. These are useful for viewing details in a selected portion of a waveform which has been Zoomed-In on. For example, there may be a small transient that you want to see in more detail that is riding on top of a much larger waveform. The control on the farthest right is the “Display Gain” control. Using your mouse, you can move this control up and down in order to change the display gain. Moving it downwards will increase the gain of the time display. This will cause the waveform to appear larger on your screen (you can also adjust the Display Gain using your mouse scroll wheel). However, it may get so large as to move the portion of the waveform in which you are interested off of the top or the bottom of the display screen. The control just to the left of the gain control is the “Offset” control; this is used to move the entire portion of the waveform in which you are interested back into view. You should experiment with these controls a few times to get a feel for how they behave, and then you will begin to understand their usefulness.
At the bottom of each workspace, you will see the “Time Axis Scroll-bar”. This control is also operated by the left mouse button, and is used to move the “Play Pointer” to various locations within the display workspace. Sometimes, there can be a few seconds of delay when using this slider, so be patient as it performs the calculations to keep up with your commands. When you are Zoomed-In on a portion of a file, the slider control can be used to move the display start-point within the highlighted field using either the slider with your mouse, or by using the arrow controls which are located at each end of the slider. The Time Axis Scroll-bar position is always relative to the entire file length, no matter how zoomed-in on a particular waveform you may be. Clicking on the right arrow button will move the waveform to the left of the workspace 1/10th of the overall display length and clicking on the left-hand arrow button will do the same thing, only moving the file in the opposite direction. If you click on the Scroll-bar (not the slider control itself), the waveform will move one full frame to the left each time you click.
Note 1: The Time Axis Scroll-bar is inactive when you are fully zoomed-out.
Note 2: If you are not using Peak Files, then the software only reads the first few Megabytes of a .wav file for the initial display. No .wav file processing operations are adversely affected by this action. Portions of your .wav file not shown on the display can still be played, filtered and operated on just as if they were displayed. To set the size of the waveform that will be displayed, use the Preferences dialog box (found under the edit menu) and increase the "Display Length Limit" to the size of the file you wish to be displayed. Keep in mind that the larger the display size, the longer it will take to initially open a .wav file. We recommend the use of Peak Files for faster future displays of the .wav file data.
Note 3: The Destination Workspace can be converted into an Audio Spectrogram time synced to the Source Workspace. Please refer to the appropriate section of the manual for details on the operation of the Audio Spectrograph/Spectrogram.
Note 4: How to Choose Your Mode – To switch between Classic-Editing and Fast-Editing mode is fairly simple. If you start with one and decide you want to try the other one, you can simply go to the Edit Menu and click on Preferences and the General Tab. There you will see a check box that enables Fast Edit Mode. You then need to exit the program and re-run it for the changes to take place or you need to close any open file and then re-open it for the new mode to be invoked. Alternatively, you can simply click on the “One Click Switch” icon which toggles back and forth between the two editing modes.
Step Seven – Testing Your System
By now you should have installed the software and connected your speakers to the sound card output and some audio playback device (such as a tape player) to the sound card input. It’s time to make sure your efforts have borne fruit.
The first thing we’re going to do is run the DCArt10/DC Forensics10 program. Do this by double clicking the new DCArt10 or the DC Forensics10 icon on your desktop. Put away the tips screen and click on File/Open Source. You’ll now see a familiar Windows file selector box. Navigate to C:/program files/Diamond Cut Productions/DCArt10/Wavefiles (or wherever else you chose to install the program). If you are using Forensics10, the demo files are located as shortcuts in the Start menu. Open the file called Demo1 (Getting Started Demo can be found under the Open Demo Wavefiles). This is a standard .wav file and was included with the program. We’ll actually clean up this file in the next section, but for now we just want to play it.
Once the file is selected, it will open in the program and you’ll see the graphic drawing of the audio waveform on your display. It will look something like this:
A Monophonic File is opened
The small band of waveforms above the main waveform is your waveform overview display. It will show you where you are zoomed-in (on the main file) with respect to the overall file via a highlight. Note the zoom-in and zoom-out icons near the left-hand side of the waveform overview display. You can drag the highlighted area left and right and that action will be reflected in the primary waveform display below.
Notice all the nice icons at the top of the display. If you move your mouse over any one of them and leave it there for a second, a little box will open telling you what that icon does. To play our file, we need to find the little icon that looks like a right pointing triangle. This is the standard symbol for “play” that you’ll find on any tape deck. Click on this icon and you should hear audio and see the cursor move.
The Diamond Cut Play Toolbar
Note: If you aren’t getting audio at this point, check out our Troubleshooting steps found later in the user’s manual.
Let the audio play to the end of the file and it will stop automatically and reset itself so you can play it again. Let’s play it again using a keyboard shortcut. Shortcuts are simply keys on your keyboard that perform a function without having to use the mouse. Power users love shortcuts and the Play shortcut is the easiest of all. Just hit the spacebar now and the audio starts playing. Hit the spacebar again to stop the audio from playing. Easy, isn’t it? Many beginners like to spend hours doing this, but let’s move on to test the recording capability of your system.
For our recording test, we’re going to assume you have a tape recorder connected to the input of your sound card. A CD player or even a turntable with a preamp uses exactly the same process, so just make sure you’re hooked up correctly.
To record, start your tape recorder playing a pre-recorded tape (or start playing an LP, etc.). You should hear the audio coming from your speakers. Now click the red Record button on the toolbar in DCArt10 / DC Forensics. A nice record screen comes up which looks like this:
The DC Forensics10 Record Window
This screen will allow you to set the recording parameters and make sure the recording is happening correctly. Let’s start by making sure we are set to record a stereo file at 44.1 kHz, 16 bit. Just use the drop down boxes to select these parameters. Note the Recording Device box. Your sound card should be listed here. If not, drop the box down and choose the sound card that has the audio being fed to it. If you click on the “Set Levels” button, something like the following drop-down will appear which will allow you access to the Windows Mixer controls.
Windows Sound Card Mixer Control
Now click the Pause button in the Record Window. This puts the program into what is called Record/Pause mode. The VU meters on the left should now start dancing as the program is actually seeing the audio from your tape recorder.
If those meters are dancing, adjust the input level until they are reasonable (not too high or clipping and not too low) and you are now done with testing your installation. Click “Stop”, and then click “Close”. Answer “yes” when the program asks if you want to discard this recording. You now have a perfectly working audio restoration workstation and you can go on to the next section where we’ll teach you to use this powerful tool.
If you found that your meters didn’t jump when you hit the Pause button, the problem is very likely caused by your sound card being set to the Mic input and not the Line Level input. Full troubleshooting help is included later in this manual, but this common problem is easily and permanently solved by double clicking the little yellow speaker icon in your Window tray – just to the left of the clock on the bottom of your screen. Now choose Options and then Properties. Click the record button and then click OK. Now click the check box under Line Input and your meters will start to jump in DCArt10/DC Forensics10 indicating that all is now well. You just turned on the Line Level input – which is where our audio is, after all.
Now that your system has been installed and checked, it’s time to get to the software and perform an actual restoration project.
Step By Step Guides
In this section, we’re going to take you by the hand and lead you through some complete examples of typical restoration projects. You’ll remove noise and “sweeten” the audio. When you are done, you’ll be licensed to drive the product yourself without training wheels.
This entire training process will take you about 15 minutes and will give you all the basics you need to know to use the program. Please follow along step by step thru the first three examples – Super Easy, Easy and Advanced Record Restoration. If you are a Forensics audio user, please go thru all three Step By Step Guides. In these Guides, we’ll tell you exactly what to do and even explain why it is you are doing these things. It’s important that you follow along exactly as one step builds upon the next.
Note: The actions in this section of the user’s guide that you are expected to take are highlighted in Bold Italics. Let’s get started!
Super Easy Record Restoration - - - Step By Step Guide
If you are new to audio restoration and feel a bit intimidated with the large number of filters and tools in DCArt10, then EZ Clean™ is for you. Our first guide is designed to get you going almost instantly. The EZ-Clean™ filter will remove clicks, pops, hiss and other surface noise from music recording almost instantly. Here we go.
First, we need to run the program. If it’s not already up, just double click the icon on your desktop to start it. DCArt10/DC Forensics10 starts with a tip screen, which offers quick suggestions as to how to use the program. You can disable this by clicking on the check box in this screen.
In this guide, we’re going to use the Classic Source/Destination mode to run you thru the software. You can choose this mode by clicking on Edit/Preferences in the program. Make sure the check box that is labeled Enable Fast Edit is unchecked. If you just unchecked it, close and restart the program to get going in Classic mode.
Next, open the Demo1 .wav file the way we did in the testing section above.
Listen to this file by either clicking the Play button or hitting the spacebar – it’s full of clicks, hiss, low frequency noise, etc. It’s a mess. Stop the playback when you’re done listening.
And, now let’s get to the fun part. Click the Filter Menu and choose EZ-Clean. The filter looks like this:
EZ Clean™ Is Almost Too Easy
Notice that there are only three sliders, one for scratches or clicks, one for crackle (or small clicks) and another for hiss or other continuous type noises. We are simply going to listen to the audio and move these three sliders as we listen.
Move each slider to approximately the settings shown above. We don’t need to be perfectly accurate, just set them similar to what you see. When you move these sliders to the left, the filtering becomes more aggressive. Now click the Preview button. You’ll start to hear the audio.
Listen for a second or two. Now click the checkbox labeled Bypass. This “bypasses” the filter and stops the filtering. You are now hearing the original music without the filters in place. Note the large amount of clicks and hiss.
Uncheck the bypass box to start filtering again. What a relief! That’s much better isn’t it? But, you can do better yet. Move the Hiss slider a bit farther to the left until you remove more of the random noise. Remember, moving the sliders to the left, makes them filter more, so just slide them until you are happy with the result. If you move the controls too far to the left, you may introduce digital artifacts and/or distortion into the signal. You must strike a balance between noise reduction and artifact/distortion creation with these tools.
Now note the Hum filter on the EZ-Clean screen. If you live in the US, you’ll check the 60 Hz box to remove power line hum. If you live in Europe, you’ll check the 50 Hz box. There are many other tools to remove larger amounts of hum in DCArt10, but this one is quick and easy.
Now, stop the preview by clicking on the Cancel Button in the Progress- box. Click on “Run Filter” and you now have a destination file that is fully cleaned! Could this possibly be any easier?
Please continue on with the Easy Record Restoration guide below. It starts your education on how to use individual tools and goes into more depth on the overall concept of the Diamond Cut software.
Easy Record Restoration Step By Step Guide
Since EZ-Clean™ is so easy to use, you don’t really get a feel for the overall software program and its depth of capability. This guide assumes you will use individual tools and will perform a restoration in a series of steps.
You will be working with DCArt10/DC Forensics10 by choosing filters to apply to your audio .wav file. Some of the filters remove noise and others enhance the audio though they are all referred to in this guide as filters. You choose a filter by identifying the type of noise you want to remove and then selecting the filter that removes that type of noise. Make sense so far, right? In just about every case, when clicks and pops are present, we want to remove them first. Trust us, this is the right first step whenever you get ticks, clicks and pops on records or other recordings (called impulse noise).
To remove the clicks, we’ll choose the EZ-Impulse™ filter. Clicks are short noise impulses so it makes sense to use this filter. To choose the filter, click on the Filter menu item and choose EZ-Impulse Noise. You’ll see the filter open like this:
The EZ-Impulse Noise™ Filter Appears
Note that the filter takes up only a portion of the screen. You can still see part of the waveform and all the menus and icons. You can move this filter window around on your screen and position it wherever you want. Just grab the title bar at the top of the filter window and drag it around. Try it now.
Now let’s focus on the filter itself. Just about EVERY filter in DCArt10/DC Forensics10 will work the way this one does. Once you learn this particular filter, you’ll be able to use all of them! Because of this, we’re going to cover this filter in great detail. Be sure and follow along.
The EZ-Impulse Noise™ Filter
In the filter window, you will see several features. First, you’ll notice sliders that control various filter parameters. These sliders can be adjusted while you listen to the audio so you will instantly hear the result of any changes you make. Our sliders in this example are labeled Scratch, Crackle and Narrow Crackle in this filter.
Next, you’ll have Radio buttons that control other aspects of the filters. Again, you can usually change them while listening, so you’ll hear the results instantly. The Radio buttons in the EZ-Impulse filter are Bypass, Big Clicks and Solo/Brass. The EZ-Impulse filter allows you to change the Bypass and Solo/Brass buttons while previewing, but not the “Big Clicks” button. You can only change that one prior to Previewing.
In every filter or effect, you will have a Preview button. This is the most important button here. This button will start the audio playing while the filter is processing it. You will hear the results of the filter instantly. This makes for easy adjustment of the filters. The Preview button allows you to adjust any/all filters before actually running the filter on the file (the “Run Filter” button).
Also in every filter, you will have a “Bypass” checkbox. This takes the filter in and out of the audio stream instantly. When you listen to a filter being applied by the Preview button, you may want to be able to compare the processed audio to the original audio. Clicking this checkbox will bypass the filter and you’ll be hearing the original audio. Un-checking it will instantly put the filter back into the signal path. This way, you can “fine tune” even subtle nuances in the audio signal with DCArt10/DC Forensics10.
Lastly, every filter will have controls for Presets. A preset is a saved group of settings for this filter. Go ahead and drop down the Preset box now – it’s the white box at the bottom of the filter. Click on some of the presets and watch the sliders as they move to good starting points for common tasks. You can tell a lot by looking at the name of the presets. Now select the preset labeled Default. This one is already set up with good settings for our Demo1.wav file. Every filter will also have a Save and Delete button that allows you to save your own presets under any name you want – and delete them too!
You’re probably ready to try this filter by now, but there is one more thing that is common to each filter that you should know. Hit F1 now on your keyboard. Notice that our online Help comes up with information on this specific filter. This context sensitive help is available for each and every filter.
Put the Help screen away and let’s clean some audio. If you’ve already been listening to this filter, then shame on you for jumping ahead. Simon has not said click the Preview button yet. As punishment, please go back to page one of this manual and start reading again. We’ll wait for you here.
Welcome back. Now let’s get started by clicking the button labeled Preview. You will hear the audio as it is being filtered. You will still hear the low frequency rumble and the hiss, but the clicks should be gone. Let it preview all the way to the end of the file. Notice that once it reaches the end, it will automatically start over at the beginning. This is called Looping and is automatic when you are previewing with a filter (though it can be turned off in the Edit/Preferences screen).
Let’s just confirm that the clicks are gone. To do this, check the Bypass box in the filter while it is still previewing. Now the filter is bypassed and the clicks will once again be audible. Listen for a while and then uncheck the Bypass box. Now the filter is again doing its job and the clicks are no longer heard.
It’s time to learn how to adjust a filter. While you are previewing, move the three sliders to the bottom. This makes the filter less aggressive and it will filter less. Notice that the clicks return as the sliders are moved down. Moving the sliders upwards results in more of the clicks being removed from the file. All of the filters work this way – you just adjust them while you listen. As you might expect, if you move them too far up you’ll make the filter(s) too aggressive and you’ll get distorted, stuttering or otherwise bad audio – just move them up enough to get the desired result. Set them all to 50. The “Scratch” control is adjusted by the user to attenuate large impulses. The “Crackle” control is for medium sized crackle and the “Narrow Crackle” control is used to attenuate smaller impulses. “Solo/Brass” should be turned on when dealing with up-front vocals or brass instruments like trumpets or trombones.
Now click on Cancel in the Progress window seen here:
Monitor your Progress
This stops the preview from playing. By Previewing, we have adjusted the filter and confirmed that it is doing its job. The next step is to click on the “Run Filter” button. This takes the filter just as you have set it and applies it to the demo1.wav file and creates a new file in the lower window. This new file has been run through the filter and has the clicks removed. At this point, click on Close in the EZ-Impulse filter window since we’re now done with it.
Look at the two waveforms. The top one is called the Source. This is where we normally work on a file, preview filters, etc. The bottom is called the Destination and is the result of our filtering efforts. You can play either one by clicking in the respective window which will highlight that window. Then, click the “Play” button (or the spacebar) to hear either the source file or the destination file. You have not changed your original (source) file at all – rather we’ve created a new cleaned up version (the one found in the destination window).
Now it’s time to remove that rumble sound, but how can we do that if we work on the Source window and we really want to remove the rumble from the semi-clean file in the Destination window? The answer is a little command under the File menu called Make Destination the Source. This moves the file in the bottom window up to the top where we can work on it. Click on File/Make Destination the Source now.
A “Save As” box will pop up and suggest a new name for this file; just click on Save to accept it.
Note: DCArt10 & DCForensics10 will automatically assign sequential names to new files. While you’re new to the program, always just accept its recommendation as to file names.
Now we are ready to remove that low frequency rumble. To do that, we’ll choose the High Pass filter (an IIR type). Click on Filter/High Pass now. (To get there, go to the Filter Menu\LP BP HP Filters and then select the “High Pass” filter.) A high pass filter will remove all frequencies below a certain value and allow all higher frequencies to pass. Drop the Preset box and select the preset called “Demo audio Wave file de-rumble”. It will look something like this:
The Highpass Filter
We’ll start to go a bit quicker now since you already know what most of the buttons and controls do on this filter. To find out specific info on this filter, don’t forget you can call for help by pressing the F1 key. We are going to free you now to preview and play with this filter on your own, but when you’re done, return it to these settings by once again clicking on the demo Wave file preset. Run the filter when you are ready.
You now have removed two of the annoying noise types in this file. First, we rid ourselves of the clicks and pops, and then we removed the rumble. Now it’s time to get rid of that loud hiss sound. First, remember to move our Destination file up to the Source window.
Now click on the Filter menu and select the Continuous Noise Filter. This filter is perfect for reducing hiss and other types of continuous noise. Also, click on the View menu and make sure you have the Time Display checked at this time. The Time Display box shows you various timing calculations with the program and will come in handy, as you will see. Your screen should look something like this:
The Continuous Noise Filter is Awake
The Continuous Noise filter is one of the coolest filters in the whole program so follow along carefully here. This filter will remove just about any continuous noise in a program, but it needs you to give it a sample of this noise. Once it is able to examine the noise, it will be able to seek it out and attenuate it. Play the file now using the Play button at the top and listen carefully to the first couple of seconds. You will hear an area right at the beginning which contains only the noise and without any of the good audio. That’s a great spot from which to grab a sample of the noise. To do this, we need to click and drag with our mouse to select this area of the file. The narrow area near the left-hand margin in the illustration above is the area we want to select. Just left click about ½ inch from the left edge and, while holding down the left mouse button, drag all the way left. Let the mouse button go and you will see that area highlighted in bright yellow. This is the area you have selected. Move the mouse pointer over either edge of the selected area and the pointer will turn into a Left/Right indicator. Click and drag as necessary to select an area from the beginning of the file that is about .5 seconds long. Use the “Span=” display in the timer window to confirm that your selection is around ½ second long.
Now hit the spacebar. You’ll play only the selected area. It’ll be quick. This allows you to audition a selected area to make sure you are really working on the correct area (does not contain silence or desired signal). You should only hear the hissing noise. Again, your selected area should only include noise and no music.
Now, it’s time for the fun part. You will like this. Hit the Sample Noise button in the Filter window. The filter will analyze the noise sample and then display the frequency characteristics of the noise in red. The blue line is the filter that has been designed to attenuate this noise. Notice how they track with each other. Yours should look something like this:
The Continuous Noise Filter Does its Job
If you have jumped ahead again and clicked on Preview, there will be no lunch for you today. First, we’ve got to explain those little blue dots on the filter line. Notice how the blue line is above the red noise sample? The higher the blue filter line, the more filtering occurs at that frequency. The blue dots are called Control Points and allow you to adjust the amount of filtering for frequency components in the vicinity of the control point manually. We’re going to do that in a second, but realize that the Help file contains the complete information on this filter.
Before we click on Preview, we need to again select the whole file so we’ll hear the whole thing and not just our ½ second noise sample that is now selected. To select the entire file, just double click anywhere in the waveform display area. Notice how the entire thing gets highlighted in yellow. Now, go ahead and click on Preview.
Listen to the audio. The clicks are gone. The rumble is gone and now the hiss is gone too! Well, not quite. You can still hear a bit of hiss can’t you? While Previewing, click the bypass button a few times to take the filter in an out of the signal path. Yes, the hiss is reduced, but there is still some of it there. Let’s adjust this filter to get rid of all of the hiss.
Make sure your bypass button is NOT checked and make sure you are previewing the audio. Now grab the 2nd control point from the right side and move it up a bit as shown below.
Tackling the remaining Hiss
It’s like magic, isn’t it? The hiss almost completely goes away because you told the filter to be a bit more aggressive on the high frequencies. Remember, moving the blue line upwards makes it filter more. Now stop the preview, click on Run filter, and close the Continuous Noise filter. If you like that filter setting, you can click on the “Save” button and then name it as a preset so that it can be recalled later.
You now have a Destination file that is completely restored. To finish, click on File/Make Destination the Source, accept the file name and you’re done. This file is the completed version and all others can be deleted or saved if you want each processing step before and after the saved file. You can now exit the program or close the files using the commands under the File Menu.
What you’ve learned in this section
In this quick Step by Step guide, you’ve learned how to launch the program, how to select filters, how to preview them, how to bypass them, how to load and save presets, what are Source and Destination files, how to apply multiple filters to a single file, how various filters work and much more. Not bad for a few minutes! Next, we’ll give you a more advanced Step by Step procedure in which you get to use the most powerful feature of DCArt10/DC Forensics10, the Multi-Filter.
Advanced Record Restoration Step-By-Step Guide
You learned a lot in the last Step-by-Step Guide, so let’s continue by restoring this same file using a completely different approach. This will show you the flexibility and power of DCArt10/DC Forensics10 and will introduce you to our powerful Multi-Filter. Also, we will perform this advanced restoration in a Step-by-Step fashion using our new Fast Edit Single Screen mode. We’ll assume you’ve done the Basic Guide above and are therefore comfortable with the basic functions of the program so we will take this at a little faster pace. As before, the actions you are expected to perform will be in Bold type. Let’s get started!
First, we want to make sure that you are in Fast Edit mode. To do this, click on Edit/Preferences and make sure the box labeled Enable Fast Edit is checked (under the “General” tab). If it’s not already checked, put a check mark in the box by clicking it. Now close the program and then restart it. The operational mode change will take effect when you start the program.
Remember, Fast Edit mode is a single screen mode of operation with no Source or Destination file window. This mode of operation has the advantage of allowing almost instant cuts, pastes and copies on even very large files. It also may be more familiar to users of traditional audio editing programs. You can change from Fast Edit to Classic Mode anytime you want.
Next, we want to enable the Fast Edit History box by clicking on View and then checking “Fast Edit History”. This will open your History box. This box will show you everything that you do with this file and in the order that you do it. It also allows you to return to an earlier state of the file quickly and easily.
Now open the Demo1.wav file in the same way we did before. Select an area near the center of the file using a mouse click and drag. Your screen should now look similar to this:
A Highlighted Section in Fast-Edit Mode
Let’s cut out the highlighted area. Just click on Edit and then Cut. Boom! It’s gone! Fast Edit mode is called that because it’s FAST. You will now have two entries in your History window – the top one is for the original file as opened, and the second one is for the version you now see in front of you which is somewhat shorter.
Click on the first entry in the Fast-Edit History window now. The original file instantly comes back! Did we say this thing was fast? Everything you do will show up in the history window and you can bounce around your various versions of a file at will. Click on the first and then second entries a few times to confirm this and then right click on the second entry and choose “Delete”. You just deleted the cut-up version and we’re back to the original file.
Now click on the Filter Menu and choose Multi-Filter. In order to select the entire file for processing, double-click anywhere in the waveform display or left-click and drag to select a segment of the file. Notice how DCArt10/DC Forensics10 allows you to select an area or the entire file while the filter windows are open. This is a very handy feature.
The Multi-Filter is one of the most powerful features contained within the DCArt10/DC Forensics10 software products. It allows you to string together many filters and then to preview or apply them sequentially or all at once to your file. This saves a lot of time and makes it possible for users to create some incredibly sophisticated filter setups.
Notice that the Multi-Filter has an input on the left side and an output on the right side. Between the input and output is a signal path. You can drag any filter (or multiple instances of the same filter) that you want into this signal path. At this time, remove any filters that are in the signal path by clicking on them and dragging them out of the signal path.
Remember when we went through the Basic Step by Step guide (above), we used three filters: the EZ-Impulse™ Noise filter for clicks, the High Pass filter for rumble and the Continuous Noise filter for the hiss. Drag these three filters into the signal path with the EZ Impulse filter on the left side followed by the High Pass filter in the middle and then the Continuous Noise filter on the rightmost side. Now double click on the EZ-Impulse filter icon in the signal path of the Multi-Filter. Your screen should look something like this:
Working with the Multi-Filter
To open the individual settings for any filter in the Multi-Filter signal path, just double click on that filter and create your settings. For the Expert Impulse filter, drop the preset box and choose “Demo Audio Wave file De-click”. You could preview and adjust while listening here, of course, but we’ve already got some good settings available as a preset. Close the Expert Impulse filter window.
Now Double click on the High pass filter and select the “Demo Audio Wave file De-Rumble” preset. Close the High Pass filter window when done.
Lastly, open the Continuous Noise filter and choose the “Demo Audio Wave file DeNoise” preset. Close the window. We used these presets only because they are available. You can always choose any preset or you can set the filters yourself by just previewing as we did in the Basic Step by Step guide.
Note: Each individual filter can be previewed even in the Multi-Filter.
Now we have three filters strung together. Click the Preview button in the Multi-Filter window. You will hear the audio being filtered by all three of these filters. Click the Bypass button a few times to marvel at what is happening here. Feel free to giggle and then cancel the preview.
Now we’re going to add a fourth filter. Drag the Paragraphic EQ icon into the signal path and put it last in line (on the rightmost side). Double click the Paragraphic EQ icon to open its adjustment window. Now again click on the Multi-Filter Preview button. You may have to move the Paragraphic filter window out of the way to access this button. You are now hearing the audio filtered thru 4 filters. Make sure the Bypass button is not checked. While the preview is happening, find the blue control point in the Paragraphic EQ that is close to 110 Hz. You can see this on the horizontal scale on the bottom of the EQ adjustment area. Move this up to increase the bass frequencies in our old recording. The more you move it up, the more low frequencies you get. It should look something like this:
Using the Paragraphic EQ
You should notice that you are applying all four filters at once and you are adjusting one of them. The results of your adjustments are instantly heard while all the filters are being applied. Cancel the preview, run the filter, and “Save Source As” the file. Fast Edit mode requires that you save files when you are done.
What you’ve learned in this Advanced Step-by-Step Guide - - -
You now know how to choose and use Fast Edit Mode, how to bring up and use the Multi-Filter, and how to Preview and adjust filters (or effects) while using the Multi-Filter.
Forensic Audio Step-by-Step Guide (DC Forensics10 Only)
If you are a new user of DC Forensics10, please go through the Basic and Advanced record restoration guides first. We know you won’t be restoring records with DC Forensics10, but these guides provide an excellent introduction to the overall flow of the Diamond Cut software programs. We’ll assume you have that basic knowledge in preparation for this Forensic Guide tutorial. As before, the specific steps for you to perform are in Bold.
To get started, run DC Forensics10 and put it in Classic (Source/Destination) mode. Now open the file called Forensicdemo.wav. Forensics version demo files can be found on the Start Menu.
Play this file. Like a lot of Forensic audio files, the signal to noise ratio is very poor (a low ratio). The noise is much louder than the voice and this makes it difficult to understand what is being said. The speech is masked by a loud buzz and has a high frequency and a low frequency noise throughout the piece. As always we start by listening so that we can identify the noise components that make up our problem.
It’s easy to hear in this file that we will need multiple filters to clean this thing up. Therefore, let’s use the Multi-Filter. Click on Filter/Multi-Filter and bring it up and clear out any filters that are in the signal path. The file contains a loud Buzz that almost overwhelms the good audio. To remove the hum and buzz, we will use the Harmonic Reject Filter. It’s called this since hum and buzz are rich in harmonics and this filter can remove them. We’ll need one of these filters for sure but don’t put it in the Multi-Filter yet.
Next, listen again. There are other noises in this piece that you probably can’t easily identify by listening. However, we don’t only have to listen to the audio, we can also see it. Click on View and then choose the Spectrum Analyzer. Set the Spectrum Analyzer to a resolution of 5.38 Hz and 8192 FFT size. Now click on Play on the toolbar and you’ll see the audio as well as hear it. After listening for a few seconds, hit the spacebar to stop the playback. The Spectrum Analyzer continues to show you the frequency spectrum of the audio. Notice that there are some “spikes” of audio in here. One, for example, is at around 950 Hz. You can click on any spot in the display and the Spectrum Analyzer will show you the frequency and amplitude at that spot in the upper left corner of the display. It should look a lot like this:
Using the Spectrum Analyzer
If you look closely, you can see that there are actually four spikes and some random noise above 12,000 Hz. We can remove specific frequency ranges with a Notch filter and we can remove that high frequency noise with our Continuous Noise filter or a Low Pass Filter. So now we know all the basics to attack this problem – we’ll need a Harmonic Reject filter, 4 Notch filters and a Continuous Noise filter. You can see how we used the tools to come up with a general plan of attack. Now, close the Spectrum Analyzer.
We have already created a Multi-Filter preset designed to clean this file. Select the Multi-Filter preset called “Forensic Demo Clean Up Filter”. Notice that our basic filter is not quite the same as we had set-up in the earlier analysis. We know you want to hear this, so we will explain each component of this Multi-Filter preset after we listen to it in action.
Note: This is a computationally challenging filter. Even a pretty fast computer might stutter or pause while trying to do all these calculations in real time. If this happens just stop the preview. Hit the Multi-Filter Preview button and listen. Click bypass in and out a few times to get the full effect. Cancel the Preview when you’re ready.
Now click on Run Filter and listen to the resultant file in the Destination window. This is almost as impressive; check out the before display in the Source window and compare it to the after waveform display in the Destination window. It should look like this:
The Power of the Multi-Filter is Obvious
Notice how the total jumble of noise in the source window has changed to a nice speech pattern in the destination window. You could even make this a bit more “Hi-Fi” if you wanted, but the goal of most Forensic restoration and enhancement projects is to make speech understandable so that it can be transcribed.
Now we will explain the filters we used in this preset. Double click each filter as we explain it and examine the settings (each of these filters has its own tutorial in Section 2 of this Manual). Close each filter when you finish looking at the settings.
Brick Wall Filter – this is set to reject all low frequency sound below 135 Hz and all sound above 11 kHz. Remember the noise in the Spectrum Analyzer at 12 kHz and above? We took it out with this filter.
Harmonic Reject Filters – both are set to 60 Hz, which is a common power line induced noise frequency (50 Hz in many countries outside the US). Why do we use two of them? Because multiple filters of this type will deepen the attenuation of hum and buzz noise. It’s like one worker digging a hole two feet deep and then another also digging a hole two feet deep, but the second worker starts in the hole created by the first. You end up with approximately a four foot deep hole.
Spectral Filter – Remember we thought we might need 4 notch filters? We could have done that, but our Spectral Filter allows us to set up as many as 32,000 notch filters at once! Additionally, this filter allows us to either boost or cut any frequency range we want including ones like these that are not related to each other harmonically. This is just a more efficient way to handle several unrelated noises.
Continuous Noise Filter – This filter is set up to aggressively filter just about all noise frequencies within the speech range. Remember, this doesn’t take out all sound, but targets noise while leaving behind good audio. It’s a good filter to add to the mix.
Median Filter – This was chosen to add intelligibility to the voice. It is good for enhancing muffled speech.
Virtual Valve Amplifier - This will add harmonics to the voice, increasing intelligibility.
Paragraphic EQ – This is set to raise the volume of the speech frequencies.
So you see, we really did follow our initial path by using Harmonic filters, Notch filters and Continuous Noise filters. We ended up adding some additional tools that further enhanced our audio. You will likely do the same thing as you perform your own restorations. This process of first planning a course of action and then making it better is a common one that you will use often.
Close all filters, Make Destination the Source (saving it under a new name), and exit the program.
This guide will introduce you to another major feature of the program. As before, follow along with the included demo file and perform the actions printed in Bold type. We assume you have mastered the other concepts we introduced in the Basic and Advanced record restoration Step by Step guides. Please make sure you have completed those earlier guides before attempting this one even if you are a Forensics User. It teaches the basic flow of the software program.
Live-mode is a powerful feature of DCArt10 / DCForensics10 that allows you to remove noise and enhance audio as it happens. You do not have to record the audio to the hard disk before applying filters. Live Mode is used by TV and Radio broadcast engineers to clean up noisy live feeds for real-time transmission. Forensics users use it to clean up real-time surveillance audio streams. It is also useful for cleaning up radio reception for Hams, SWLs, DXers, and other Forensic applications. Audiophiles sometimes use Live mode to replace the preamplifier and tone controls in their audio system. If you have your computer connected to your home stereo, you can use Live-mode to actually restore your records while you play them. It can also be used “on site” by Forensic users who may need to listen to (and record) surveillance audio as it happens.
To use Live-mode, make sure you have your speakers connected to the sound card output and an audio signal connected to the line level input. This audio signal source can be from a soundboard, mixer, radio receiver (or tuner), turntable (with preamp) or any other signal. For this Step-by-Step guide, we’re going to assume you are using a radio to provide a signal to the program. In this case, you would connect the headphone or other audio output of your radio or tuner to the Line Input of your sound card.
Turn on the radio and you should hear audio from the speakers connected to your computer. This step depends somewhat on the brand and model of sound card that you have, but the great majority of sound cards will simply take whatever audio appears on its input and sends it directly to the output of the sound card. If you don’t hear anything, just keep going in this Guide, as we’ll check everything out a bit later.
Now turn off your Radio and launch the program if you haven’t already and then open the file called “Radiodemo.wav”. It’s in the same directory as the other demo files. Before we do this live, we’re going to experiment a bit with a recorded bit of audio.
Once the file is loaded, listen to it. You can hear that there is A LOT of noise in this file. It is understandable, but would not be fun to listen to due to all the noise. Once the file has finished playing, open the Multi-Filter (under the Filter Menu) and choose the preset called “Live Mode Demo Cleanup – SW Radio”. This preset provides some useful tools for this demonstration file. This preset will also be a good starting point for your own efforts as you use the program in Live mode.
Double click the Continuous Noise Filter to open its adjustment window. You can look at the settings for all the tools in the Multi-Filter preset and you should be able to understand what they are doing based on your learning so far. Remember, you can always open a specific filter and then hit F1 to find out about it. Your screen should look something like this:
Multiple Screens Shown Working Together
We want to bring your attention specifically to the Continuous Noise filter here because we are dealing with a concept that you might not have considered – How do I use this filter in Live mode when I can’t take a sample of the noise? Remember, the audio is happening in real time and is typically not recorded to the disk at all in Live-mode. It’ll therefore be impossible under these conditions to actually take a noise sample. Our preset setting here shows how you can deal with this. Notice that the filter is set to provide a fairly large amount of attenuation to the low frequencies and the higher frequencies (remember, the higher the blue square controls are set, the more noise is removed at that frequency). With radio signals, we will seldom care about very low or very high frequencies anyway, so this setting gets rid of a lot of noise without unduly bothering our good signal. The controls between 300 Hz and 3,000 Hz (which are speech frequencies) were then simply adjusted for good results. Go ahead and hit the Multi-Filter Preview button now. Click Bypass in and out to hear the improvement. (Alternatively, change the CNF mode of the Continuous Noise Filter to Auto Spectrum CNF or AFDF and the filter will find its own noise fingerprint on-the-fly.)
Notice the slider labeled Attenuation. This control determines the overall amount of filtering that is going on for the entire filter. If you move this control upwards, it will filter more overall noise. While Previewing, adjust the attenuation slider to find the point you like best. You’ll find that this very weak signal is now quite understandable – if you speak German. The other filters are also adjustable, of course. You’ll quickly find that there is a tradeoff here. The more aggressive you make the Continuous Noise filter, the more digital artifacts you will induce. Just adjust it to please your ears.
Now stop the Preview and let’s go into Live-mode. Turn on your radio so that you can hear the signal in your computer speakers.
Note: If you don’t hear anything, continue on anyway as some sound cards don’t monitor incoming audio by default. Double click the leftmost icon in the Multi-Filter so that you can adjust your audio settings. Do that and then click on the button labeled “Live Preview” and the program will immediately start providing filtered audio to your speakers. You should certainly be hearing audio now.
In the Live-mode, your screen should look something like this figure:
Live-Mode is Engaged
Important -- Do you hear two versions of the audio – one a bit later in time than the other - like an echo effect? If so, you need to turn down the input of your sound card. If you have a standard sound card, just double click the speaker icon in your tray and choose “Options” then “Properties”. Now click on “Recording” and then click “OK”. Now move the slider labeled Line Input or Line down to the bottom. The echo should go away! If you have a more sophisticated sound card, refer to its documentation to find out how to turn off monitoring or turn down the Line Input control.
If you have the DC Forensics10 version of the program, you cannot only process audio in real time, but you can record it as well. Just click the Log to Disk button. Additionally, you can also select VOX recording (the program starts and stops recording automatically with the signal that comes in) and have the program mark the segments with the date and time of their occurrence.
Here’s a tip. You can now add or change the filters as you please. A good one for radio work is the Dynamic Processor using the ALC mode. This can help a lot with atmospheric fading in a SW (Short Wave) signal as it will even out the audio level in real time.
What you have learned:
In this Step-by-Step Guide, you’ve learned how to use the Multi-Filter in Live mode to process audio as it happens. You’ve learned how to adjust your sound card for Live-mode – remember, however, that some low quality sound cards cannot record and play at the same time and therefore can’t be used in Live Mode. You’ve also learned how some filters can be used to make radio reception much better.
Which Tool Do I Use?
Probably the most frequently asked question we get each day is “How do I get rid of a certain type of noise?” Certainly, the more you use this product, the more proficient you’ll become at picking the right tool to match the noise you’re trying to remove. But for now, if you’re new to the game, we’ve included this handy chart that may help you get a jump on finding the tools that match your problem areas.
Filter Finder
Section 2 – The System and Its Operation
In this section we’ll discuss everything you’ll see when you open DCArt10/DC Forensics10 for the first time. These items are arranged in their Menu order…meaning that we start at the left, open the first menu and proceed from there. We’ll also discuss the various ways to access these menu items. In DCArt10/DC Forensics10, many items in the Menu bar can be accessed via Hot Keys and icons on the various Tool Bars.
DCArt10/DC Forensics10 before the Source File is opened
Important Note: If you see a Tool or a Menu item listed here but don’t see it in the program, keep in mind that many items are grayed out or not available until an audio file has either been recorded or opened within the program (.wav, .mp3, .wma, etc).
Audio file is opened in Classic Edit Mode
Data in the following file formats can be opened:
† The following compressed Wave File formats are also supported:
Open Dialog Box
This command opens the desired audio file on which you will perform the DCArt10/DC Forensics10 processes. The file will be displayed as a periodic sampling of the file’s peak amplitude envelope vs. time in the Source graphical workspace. Please note that the software allows you to load .wav, MP3, .wma, .aif and .aiff files as well as A-Law and Mu-Law compressed files and automatically converts them to .wav files upon opening. If you click once on a prospective file, the Wave File details will be displayed (File Size, Channels, Sample Rate, Bits per Sample, Time Length of File). This function can also be activated by using the file folder icon in the File Tool bar in the upper left hand corner of the workspace or by using the Ctrl + O hot key.
Variable Bit Rate (VBR) MP3 File Support
MP3 files of Constant Bit Rate (CBR) and Variable Bit Rate (VBR) are supported automatically within DCArt10/DC Forensics10. They simply open with no additional input from the user.
Convert Various Formats to .wav (Tutorial)
DCArt10/DC Forensics10 provides you with a means for converting various file formats into .wav extension files for editing. You can perform your signal processing after the conversion to .wav and then re-convert back to your favorite format with an appropriate encoder if necessary. The MP3 decoder supports Blade, Lame, Fraunhofer, and many other formats. Also, it can handle formats with or without an ID3 tag and with either fixed or variable bit rates. The process of converting from an MP3 (*.mp3), AIFF or A-Law and Mu-Law to wave (*.wav) is extremely simple:
Note 1: No actual editing takes place on the original compressed file…only the subsequent .wav file conversion.
Note 2: Drag and Drop is supported for this feature.
Files in the Diamond Cut native format (.wav) are limited in size to 2.14 Gbytes which is a Windows operating system constraint. At a 44.1 kHz sample rate with 2 channels (stereo) and 16 bit resolution, this represents a time limit of roughly 3 Hours and 22 Minutes. If you are attempting to open a lossy (compressed) file (such as an .mp3*) that requires more than the 2.14 GByte .wav file size limit, your Diamond Cut software will deal with the situation automatically by creating multiple files. When this occurs, the first file created will be in the standard .wav format. Subsequent files will be of the Broadcast Wave Format (BWF) which is an extension of the .wav format. These expanded files are deposited in the same folder that held the original source file and they will have a sample rate of 44.1 kHz with a resolution of 16 bits. They will be named the same as the original file but having a _partXX added to the file name, where XX starts at 2 and continues up from that number. The Broadcast Wave format contains a field in its header which includes a starting time. When opening these files, they will have a start time that is correct with respect to the original lossy file; the subsequent Broadcast Wave files will not start at a time value of 00:00:00. If you want to edit time values that you have already created, you can view the time offset value in the Broadcast Wave header. To see that menu, it can be found at:
View->File Info
Next, choose the “Broadcast Wave Detail” button. You can change the header to adjust the offset time value of these files as needed. Note that this value is given (within the Broadcast Wave Dialog Box) in samples wherein the value is essentially the sample rate (44,100 samples per second) times the number of channels (1 for mono or 2 for stereo) times 2 bytes per word (for 16 bit files). If you change the header start time value, you must then press the “Update File” button for it to stick. To write the wave header information back onto the file, you will have to close and then re-open the file to get the software to recognize the new time values.
The File Information Dialog Box
*Note: Only the .mp3 lossy format is supported by the Diamond Cut Expanded File Conversion feature at this time.
Drag and Drop File Support
DCArt10/DC Forensics10 fully supports drag and drop file opening. You can drag a file onto the open program window or you can drag a sound file icon right on top of the DCArt10/DC Forensics10 Icon on your desktop.
View AVI Video and Edit Audio with AVI Audio Support
DCArt10/DC Forensics10 provides the ability to extract the audio portion of a video from the following file formats:
*.avi *.asf *.mpg *.mpeg
It converts the audio on these video formats into the .wav format. The Video/Audio Extraction System is found under the File Menu. To use it, just click on File/Open Source and in the “Files of type” box select “Video Files” and then navigate to your video file of interest. A video display box will appear similar to the one shown in the next figure:
The Video Extraction Window
To view the video and hear the audio, click the Play button found on the Diamond Cut software toolbar (just like you would to play any audio file). You will see the video presented in the Video/Audio Extraction System display window and hear the audio via your soundcard and audio system. To stop or play the video, use the same buttons that you would use on audio files. The scrollbar at the bottom of the Video window indicates where you are in the process of the playing of the video relative to its total length. If you select the drop down “Time Display” found under the View Menu, you can get more specific timing information regarding your Video file. There are several important controls below the scroll-bar, which are as follows:
To operate the Video/Audio Extraction system, simply browse to the video file of interest and click on it. Set the desired start and end points with the play pointer. Click on the “Extract Audio” button. The progress bar will start to increase its value. When completed, the converted .wav file will be displayed in the Source Display window.
Note 1: The following keyboard keys perform some special functions when operating the Video/Audio Extraction system:
Note 2: The Maximize button on the Video/Audio Extraction system is useful for increasing the size of the video frame so that it can be viewed in better detail. This is the square button in the upper right hand corner of the features display.
This function saves the file to its current directory with its current name, etc. This menu item is only active in Fast Edit mode. In Classic Edit mode, files are automatically saved as you work on them.
“Save Source As” saves your Source file as it is, or assigns it a new name, sample rate, dithering technique, create .mp3s, .wma (or other audio file formats). It can also be used to assign your file to a new directory location.
Your data can be saved in any of the following file formats:
Note: A dialog box will appear when you attempt to save your file in a compressed audio format such as .mp3 or .wma. From there, you can choose from a variety of compressed audio parameters.
†Note: For more information pertaining to Ogg Vorbis Lossy Compression support, please refer to the Ogg Vorbis Tutorial Section of this Users Manual.
Quick access to your factory supplied demo files is available through this feature.
Data Disc Burner
Overview
The Diamond Cut Data Disc Burner facilitates optical media storage using formats other than just Red Book CD Audio†. You can archive data on optical media such as CD-Rs, CD-RW, DVD+/-R, and DVD+/-RW provided that your optical drive supports burning onto those formats. CD-Rs are capable of storing around 700 Mbytes of data while DVDs are capable of storing roughly 4,400 Mbytes (your mileage may vary). It works with most PC format data extensions including .wav, .mp3, .wma, .jpg, .bmp and so forth. The Diamond Cut data disc burner has three points of user access. You can access it via the Data Disc icon on the toolbar, or you can access it from either the File or the CD Prep menu under the rubric of “Burn a Data Disc”. The Data Disc Burner supports complex hierarchical file tree structures having multiple directories and sub-directories. Disc layouts can be created either by browsing and adding or removing files directly from the Data Disc Burner dialog box or by dragging and dropping them into the Data Disc structure field directly from Windows Explorer. The file systems created by the Diamond Cut Disc Burner are ISO 9660 level 2 compliant. This system, however limits the number of characters assigned to a given file to 180 and the file extension limited to 3 with up to 8 directory levels. The Burner provides you with the option to choose the Joliet file system which provides for file names having up to 64 unicode characters (128 bytes) in length and directory hierarchies greater than 8 levels. Both Disc at Once (DAO) and Track at Once (TAO) modes of burning are supported, providing that your disc drive hardware supports them. Track at once mode provides the optional ability to keep sessions open after creating a CD session so that the disc can be added to at a later time.
The Data Disc Burner
The Data Disc Burner Controls
The following is a description of the various Data Disc Burner controls:
1. Add Files – Click on this button to add a file or multiple files to your disc layout from the Windows file system. First click on the location in the tree under which you desire the new files to appear. Then click on the Add Files button, browse to the file(s) of interest and then highlight them. Next, either double click on the file or click on “open”. The file or files will then appear in your disc layout field.
2. Add Folder – Click on this button to add an entire folder to your disc layout from the Windows file system. First click on the location in the tree under which you desire the new folder to appear. Then, click on the Add Folder button, browse to the folder of interest and then highlight it. To move the file into your layout, click on the “OK” button. The folder will then appear in your disc layout field.
3. New Folder – This allows you to insert a folder into your new file structure. To do so, first click on the location in the tree under which you desire this new folder to appear. Then, click on the New Folder button. A dialog box will appear and you can then “Enter a Name for the New Folder”. When you are satisfied with the name, click on “OK” and the new file will appear in the designated location in your disc layout. Files and other folders can then be added beneath that level in your disc layout.
4. Remove – This will allow you to remove a file or directory. Highlight the item in your layout that you wish to remove and then click on the Remove button. A dialog box will appear and query you to determine if you are really sure that you want the item removed. Click on “Yes” or “No”.
5. Remove All – This allows you to remove the entire disc layout from your file tree except for the optical drive root directory. A dialog box will appear and query you to determine if you are really sure that you want to remove the entire disc layout. Click on “Yes” or “No”.
6. Disc Burners Selector – Scroll to the Disc Burner that you want to use for your project.
7. Data Burners Options – Choose the setup that fits your needs:
A. File System Type
I. ISO 9660 (level 2)
II. Joliet File System (Long File Names)
B. Writing Mode
I. Track at Once (TAO)
a. Keep Session Open checkbox*
II. Disc At Once (DAO)**
C. Other Optional Attributes
I. Sort Disc Layout - When this is checked, the disc
layout is placed in alpha-numeric order.
II. Enable Optimal Power Calibration - When this is
checked, an extra step is added to the process to
optimize the burning power of the laser diode. This
creates a more consistent burn at the cost of longer
disc burn time.
*Note: “Keep Session Open” is only available in TAO Mode and for CD Burning.
**Note: “Disk At Once” is typically only supported for blank CD-R discs and rarely supported on DVD media. TAO mode is the preferred mode for creating DVD Video backups or data backups.
8. Drag and Drop – You can also drag and drop files, folders and directories directly from Windows Explorer into the Data Disc Burner.
Data Disc Burner Sample Procedure
Here is a fairly typical example of a procedure that you can use to burn a data disc:
1. Launch the Data Disc Burner.
2. Browse the “Disc Burners” feature to the Optical Drive of your choice.
3. Insert a media disc into that optical drive.
4. The top portion of the Data Disc Burner display should show the type of media inserted into the drive and also the number of Mbytes that are available for use (after a short time delay).
5. Click on the “Options” button and check Joliet File System under the File System Type and then click on “Track at Once” under the writing mode option.
6. Use the Add Files, Add Folder(s) and New Folder features in order to create your disc layout in the workspace area found below the controls section of the Data Disc Burner.
7. When you have completed your layout, click on the Burn Disc button in the top right had corner of the application.
8. A progress bar will show you how things are progressing as the disc burns.
9. At the end of the burn process, the hourglass will remain showing while the system closes the disc. The progress bar will show an increasing percentage as this process proceeds.
10. The disc closing process could take as long as 15 minutes, so please be patient.
11. When the project has completed, the system will show a message which reads “Disc has been burned successfully” and a “gong” will sound via your sound system. Please remove the disc from the drive.”
12. Done.
†Note: Red Book Audio CDs can also be created with your Diamond Cut Software. This feature is accessed via the CD Button on the toolbar or via the CD menu item titled “Burn a CD”.
DC Tune Library
An Alternative Way to Focus the View of Your Audio Restoration Work
You have seen that the most typical way to view your work is via the Classic-Edit Source and Destination Workspace(s) as well as the Fast-Edit time domain display. Alternatively, the DC Tune Library can be made the primary focus of your Diamond Cut system by ticking off the “DC Tune Library” feature in the View Menu. Then, the DC Tune Library provides you with an alternative way to view all of your audio restoration projects and the subsequent archive that you will be creating. The DC Tune Library includes a full-featured audio file archive within the context of your DCArt10 or your DC Forensics10 software. It supports files in the .wav, BWF (Broadcast Wave), .mp3, .wma, .ogg and .flac formats. It can search your hard drive and find all of your audio files and store their path, name, genre and other pertinent data within its file structure. After your DC Tune database has been constructed, it will provide you with lightning fast access to any of your audio files, provided that they are in any of the supported formats mentioned above. You can search your database, sort it by various parameters and create and recall playlists. The DC Tune Library completely replaces the old Playlist feature in DC6 and prior versions.
You can play any file directly through the normal play features of DCArt10 or DC Forensics10, or you can listen to a file or series of files by using the Preview feature found in the Diamond Cut filters and/or effects. You can even listen to the database by way of a complex series of filters and effects by previewing a file or playlist via the DCArt10 Multifilter. You can have the DC Tune Library start automatically by checking the “Start DC Tune Library” in the Preferences dialog (found under the Edit\Preferences Menu). You can also open this feature by going to the File menu, and then clicking on “Open DC Tune Library” and the spreadsheet view will appear. The system supports files having the .wav, broadcast wave, mp3, .ogg, .flac and .wma extensions. The system does not support files having the .wma format that incorporate Digital Rights Management (DRM) schemes.
To create a library from the files that exist on a particular hard drive or sub-directory, simply click on “File” and then on “Add Folder to Library”. The preferences menu provides you with a number of options for obtaining information on a file, but .mp3 and .wma tag information will take precedence for those types of files. For files without tag information, such as Wave files, the Title, Artist, Album, and Genre information can be obtained from the directory structure of your hard drive. You can customize the way this information is used within the DC Tune Library’s by using the preferences dialog. By default it looks something like:
<Genre>\<Artist>\<Album>\<Title>
Use this system in conjunction with the highlighting and the “Move Up” feature to align the file sorting to most closely resemble your database organization scheme. When adding a new folder containing multiple .wav files to the DC Tune Library, individual track numbers for files contained therein will be set to the order in which they were originally created based on their time-stamps. If individual audio files are added to the library (one at a time), they will appear in the DC Tune database in the order in which they were added.
You have the option to customize the names applied to the various DC Tune Library columns by using the “Customize Column Header Titles” feature found under the Tune Library Preferences menu (or by clicking on a column title with the right mouse button and scrolling to the bottom item). Just click on the Edit button in the preferences and the following dialog box will appear:
Customize DC Tune Library Columns Dialog Box
After you edit the User Names, just click on Save, and the columns will become customized. Please note that this column customization feature can also be accessed via the right mouse clicking on any of the column headers.
The system will take some time (anywhere from 30 seconds to 20 minutes, depending on your system and the number of files to be found) to build your library, but once it is constructed, the system will no longer need to search your hard drive each time you want to access a particular file. If you have files on multiple hard drives, you will need to perform the creation step independently on each drive. Ultimately, all of the file(s) information will be integrated into one DC Tune Library. Note that the DC Tune Library does not copy or change any of your original files; it simply saves their location and other information into the DC Tunes database.
This database is stored in the following path(s):
- - - \My Documents\My Music\DCArt10\DcTuneDb
And a backup copy is saved as:
- - - \My Documents\My Music\DCArt10\DcTuneDb.bak
The extension used for these files within the DC Tunes Library Database is .xml.
The first path is the primary database, while the second one (.bak) is its backup. A Backup copy of the database is created each time you exit the program. The paths to the various files are stored in the DcTuneDb directory, but not the files themselves, which are all left in their original directories. Editing a file (like removing it from the DC Tune Library) will not delete the actual sound file from your hard drive.
After a period of time, you may want to update the database by re-doing the search process. Files that already exist will not be duplicated (if the appropriate “Tune Library” preference is selected); only the new ones will be added to the library.
If you have deleted files on your hard drive but not in the DC Tune Library, you can update it by using the “Check Tracks” function under the “Tracks” menu. It will search for database entries that no longer have real audio files associated with them and highlight them for you.
If you ever decide to re-create a database from scratch, you can delete the DcTuneDb and the DcTuneDb.bak folders and the system will re-create these when you attempt to rebuild your DC Tune Library. When you build a DC Tune Database, you have the option to use file tags to place items into certain categories based on file tag information. You can enable the tags feature in the DC Tune preference tab under the Edit Menu and are given several choices as follows:
The desired tag extraction mode should be established before building your DC Tune database. If neither box is checked, no tag information will be used from any of your audio files.
The Library includes the following fields as viewed from left to right that can contain data concerning your audio files:
Song, Artist, Album, Genre, Filename, Path, Track #, Length, Type, Modification Date
The DC Tune Library Spreadsheet Display
A number of actions can be performed after your DC Tune Library has been built, including the following that are all available on the menu that appears when you click your right mouse button on a file/track:
1. Display the Properties of a File
2. Play the Track(s)
3. Delete the Track(s)
4. Open the Folder for the track in question
5. Edit a Track using the Standard Diamond Cut features
6. Burn a CD from Selected Tracks
7. Create a Playlist from Selected Tracks
Additionally, you can search the database across all fields by using the “Search” field found in the upper left corner of the DC Tune Library. You can also perform a secondary sort by “Album” and then “Track” number when sorting on “Artist”. If a track number is not found in the sort, the system will resort to the use of the file modification dates to establish the order of the items in the display.
After your DC Tune Library has been built, individual file access will become virtually instantaneous simply by double clicking on the desired item. The highlighted file will play and the system will continue to play the entire database thereafter until you click on the “Stop” button on the toolbar. The DC Tune Library also includes a search engine. It will find any string of characters that you type into the search box by looking at the entire directory pathway for all matches. If a certain column is hidden, items contained therein will not be used in your search. You can see the relative play location of a particular file via the play progress bar (the horizontal green display). You can advance or retard the location of play by pointing and clicking to a different location on the play progress bar and the system will jump and then play from the new file location. As play progresses through the library, the playing item will become highlighted.
If you only want to add a single file to your DC Tune Library, click on “Add File to Library” and browse to the desired item. Further functionality can be found by right clicking on a file and then on properties which brings up the following screen:
DC Tune Library Right Mouse Track Properties Dialog Box
Playlists and Tunes from the library can be played via the Diamond Cut “Play” button, or via any of the Diamond Cut Filters and/or Effects via the Multifilter “Preview” mode button. The Multifilter “Preview” function is an especially interesting way to listen to these files, since it allows you to string together a series of filters and effects that you can apply to the playback in real time. To commence a preview after bringing up a particular playlist, make sure that the first line in the playlist is highlighted and then click on the “Preview” button associated with the filter or effect of interest.
The standard Windows mouse selection commands can be used on the DC Tune Database. If you want to delete a particular item from the database, right click on it and then right mouse to “remove”. If you want to remove a sequence of items, left click on the first item in the sequence, hold down the “Shift” key on your keyboard and then click on the last item in the sequence. Those items and all of the ones in-between will become highlighted. Then, right click on “remove” and they will be removed from your DC Tune Library. If you have a highlighted listing of files, and you want to un-highlight one item somewhere in the listing, depress the Ctrl key on the keyboard, and left click your mouse on the item of interest. To select all songs in the list, use the menu item, Edit/Select All.
Playlists are initially displayed in the order in which they are created. You can change the order by clicking on the desired column header of the DC Tune Library spreadsheet. Clicking on it once will put it in alphabetical order and clicking on it a second time will reverse that order, so you can have it ordered in either direction. Playlists can be re-ordered by dragging and dropping the songs from one position in the playlist to another. Note that only a Playlist can be re-ordered; if you have selected “All Songs” the order is determined by the sorted column.
Shuffle Play
Shuffle Play is a form of random access to the selections presented to you in the DC Tune Library spreadsheet display area. Instead of playing the files in order, the system randomly advances through the listing. After a file (tune) has been played, it will be omitted from the selection process for the next round of random selection. Thus, no tune will be played more than once during a “Shuffle Play” session. This feature is located just to the right of the play progress bar and its icon looks something like the letter “X” but with arrows pointing towards its right hand side. To activate this mode, click your mouse on the icon. When it is in its active state, it will present itself in two shades of green. When it is inactive, it will present itself in two shades of grey. Each time this feature is enabled on a listing (even if the listing is the same as a previous listing) the files will be played in a different (pseudo) random sequence.
Playlists
Playlists are used to further organize your tune library. A Playlist is a subset of the tune library based on your criteria such as Album or Artist or just picked at random. Playlists are not only used to play tunes but also to Burn CDs and Create Batches for the Batch File Editor. It allows a sequence of files to be played or transferred to an audio medium without having to manually cue up each audio file in real time. This is also useful and particularly advantageous in a forensics legal situation wherein an expert may be required to play certain groups of files in real time as an element of their testimony.
Multifilter Play Mode
Sometimes, it is desirable to apply filters, tone controls or effects to the list of files that you are playing through the DC Tune Library. The Multifilter checkbox in the DC Tune Library facilitates this functionality. Every filter and/or effect in the Multifilter becomes accessible via this feature and is applied to the file being played and does so in real time.
You can either use a selected preset, or use the currently selected preset when using the Multifilter for playback in the tune library. If you look at the track properties for any wave file, you can set the Multifilter preset that you want to use for that file. However, you also need to set the preference in the DC Tunes preferences page to “use the preset from the tune library”. The default mode is to not change the preset. Please note that placing too many filters into the Multifilter in conjunction with the DC Tune Library could lead to a situation in which the system “stutters” or “skips”. The reason for this is your CPU’s inability to keep up with the math required to process the data in real time. If this occurs, remove filters until the situation is resolved or use a more powerful computer. Please note that the DC Tune Library
progress bar is not mouse - scrollable when using the Multifilter mode.
A special mode will facilitate the repeated playing of a selected file or a list of files. The system can be placed into “Continuous Playback” mode by ticking off the checkbox having the same name found under the “Preferences Menu” under the “Tune Library” tab.
The DC Tune Library Operating in Multifilter Mode
After checking the Multilter checkbox, the Multifilter will appear. When you click on the “Play” button, what you hear is what is being processed by the lineup of filters and/or effects set up in the Multifilter. A typical setup might include a 10 Band Graphic EQ, a Sub-harmonic Synthesizer and a Virtual Valve Amplifier. You can also use de-noising filters such as the EZ Impulse or EZ Clean filter. Actually, any of the filters or effects that are available in the Multifilter become available when using this DC Tune Library feature. Presets can be saved and affiliated with audio files. You have two preferences to choose from with respect to Presets for the DC Tune Library Multifilter function. They are found under Edit/Preferences/DCTune Library/Playback with the Multifilter. Select either “Use Preset from the Tune Library” or “Do Not Change the Preset”. When in “Use Preset from the Tune Library” mode, the system affiliates a preset with an audio file via the right mouse button file properties dialog box. Go to the “Preset to Use for Multifilter Preset” listing and then scroll to the desired Multifilter preset (and settings) and it will be recalled in the future when that particular file is played. If a specific preset is not chosen, the DC Tune Library uses the “TuneLibDefault” preset. To de-activate the Multifilter feature, click on the “X” symbol in the top right corner of the Multifilter. For more information, please refer to the Multifilter section of this Users Guide.
Creating a Playlist from your DC Tune Database
Use the general techniques described earlier to select a group of tracks that you wish to constitute a specific playlist. After you have completed the selection process, and while still pointing your mouse at one of the selections, right click and select “Create Playlist from Selected Tracks”. The system will choose the Album Name of the first item in the listing to use as the default the name for this playlist. If you do not want to use that name, you can simply edit it in the dialog box presented, as shown here:
The Playlist Title Box
The playlist will be stored in .xml format in the following directory:
- - - \My Documents\My Music\DCArt10\DCplaylists
The new playlist will now show up in the left hand margin of the DC Tune Database under “Playlists”. To play a desired playlist, click on the desired item, and then click on the “Play” button on the Diamond Cut toolbar. But, there are also a number of other options available to you on the menu which appears when you click the right mouse button on a particular playlist item:
1. Create New Playlist (using the existing one as the base)
2. Rename This Playlist
3. Delete This Playlist
4. Export This Playlist (dialog box provides export format alternatives)
5. Burn a CD from this Playlist
6. Run Batch Processing on this Playlist
You can also import pre-existing playlists having the following extensions:
.m3u,.wls (the older Diamond Cut Playlist Format), .cue and .pls. (These formats are sometimes referred to as M3U, WLS, CUE and PLS.)
To access this feature, go to the File Menu (of the spreadsheet display) and then go to “Import Playlist”. The system will convert the imported format into the required .xml format.
The system allows you to view and modify some of the properties of a particular file. To do so, right click on the file of interest in the DC Tune Library and then on “Properties”, and a dialog box will appear as shown below:
The DC Tune Library Track Properties Dialog Box
You can modify information directly in the dialog box. When you are satisfied with your changes, click on the “Update” button. Additionally, you can use the “Browse” button to find a file that has been moved or renamed.
You can use this feature to update the DC Tune database and the MP3 or WMA tag information for the selected files. If multiple files are selected, some fields are disabled such as the Title and Track Number. You can enter information for the group of files such as the Album Title and update all of the selected files at once.
CD Creation / CD ROM Creation / CD ROM Burning / CD Burn
In much the same way that you can construct a playlist, you can also set up a listing to create a Red Book CD. This feature is accessed via the right mouse button or the CD icon, and details can be found pertaining to its operation in the CD Burner section of this User’s Manual found under the CD Prep section. It is worth noting that you can drag and drop items from the DC Tune Database directly into the CD Burner Dialog box.
Your Playlist can be exported into other programs that permit importing data such as disc label makers and CD-ROM printing programs. The feature will export the following parameters:
Clicking on the Export button found on the right mouse button activates this feature which allows you to save it in a number of formats. When you click the Export List button, you can specify a file name. The default will be saved in the *.txt format which can be opened by many other programs. It can also be saved in your choice of other formats including .m3u, cue and .pls (sometimes referred to as M3U, CUE, and PLS).
.wma File Encoding
You can encode a file in compressed .wma format if you so choose. To do so, click on “Save As” .wma and you will be presented with the following dialog box with a list of compression options from which to choose. In general, higher bit rates (kbps) produce better sounding files at the expense of greater memory space requirements. You decide which options best meet your needs.
The WMA Dialog Box with Compression Options
To view the other compressed formats that are available, click on Compressed Formats in the “Save as type” field and highlight “Compressed Formats”. Then, click on the “Available Audio Codecs: Please Select One” field. A listing of available formats will be displayed. The contents of this listing will be dependent on your operating system and/or which Codecs you have installed.
Save As Dialog Box
DCArt10/DC Forensics10 has the ability to use an external Encoder to help you turn any .wav file into an MP3. This process simply allows you to download one of the popular encoders. To do so, go to your Edit/Preferences/Mp3 Encoder and define a path to that particular .EXE file. From that point on, if you choose to SAVE AS or Batch File Processing and want the end result to be MP3 files, DCArt10/DC Forensics10 will use that encoder to make the conversion. We recommend the LAME encoder as the most popular and highly regarded and it is the default encoder included with the software.
Playing CDs using the DC Tune Library
You can play CDs (Red Book Audio) using the DC Tune Library. Simply place your CD into your optical drive. After the drive “spins-up” (which will take a few seconds) double click on the words “Audio CD” which is in the “tree” listing within the left-hand column of the DC Tune Library display. You should then see the following appear as part of the tree:
“Audio CD: xx:yy”
where xx:yy is the length of the CD in minutes and seconds. Single clicking on “Audio CD: xx:yy” will then construct a listing of the tracks which will appear in the right-hand display of the DC Tune Library. To play these CD tracks, just click on the play button located on the tool bar. Most of the various controls previously described and associated with the DC Tune Library also apply to the CD Player (including Shuffle Play). However, the Multifilter does not work in conjunction with the CD player.
Import Playlists
This feature allows you to search your hard drive and import playlists into your DCArt10 software. It will search your hard drive for playlists in the .wls, .m3u and .cue formats and convert them into the .xml format for compatibility with the DCArt10 or the DC Forensics10 system.
Close Source
This command closes a previously opened Source and/or Destination .wav file.
Rip CD Tracks to .wav, or .mp3 or .ogg
This feature allows you to “Rip” (convert) CD Red Book Audio CDs to Wave files (.wav) or MP3s (.mp3) or Ogg (.ogg). To operate this feature, first place the CD into the CD ROM drive in your computer and then launch the “Rip CD Tracks” feature found under the File Menu. A dialog box will appear with the following selections and features from which to choose:
Destination Path for Ripped Files: Browse to the desired Directory
An MP3 Setup button is provided to quickly bring up the MP3 encoder(s) preferences box should you desire to make some changes in its settings, precluding the necessity of having to go to the Edit/Preferences menu item.
Note 1: ID3V2 mp3 tags are automatically added by the ripper to MP3 files. These include the Title, Artist, Album, Track #, Maximum tracks and Genre.
Note 2: Ripping directly to an external (USB or Firewire) drive is not recommended. Timing errors in the data pathway can result in the creation of corrupted files. If you want to maintain your ripped files on an external drive, rip them to a directory on your “C” drive first and then transfer these files to your external drive(s) thereafter.
MP3Encoder Setup
CD Ripper Preferences
If you click on the “Rip Options” button, the CD Ripper Preferences Menu will appear.
File Options
This controls your file overwriting and file opening options.
The file format extension that is created by the “Create Playlist after Ripping” feature is .xml.
CD Control Options
One feature involves the limiting of the ripping speed of the system. This is useful sometimes when a CD ROM has become warped due to its paper label (or due to other variables). Disc “warpage” can create a situation in which the CD ROM will not rip, but slowing the disc down can sometimes overcome this difficulty. Also, it is generally good practice to leave the “Jitter Correction” on, but it substantially slows down the ripping process due to the extensive calculations required to perform this task. But sometimes better CD ROM ripping success may be had with this feature turned off when encountering extremely problematic discs. Experimentation is the only way to know for sure what will work when ripping warped (or out-of-balance) CDs.
The CD Ripper Preferences Menu
Track Naming
You control how the resulting ripped tracks are named via the Track Naming feature. Typically track names are simply the track # and song title, but many folks prefer to include more information in the title.
The system derives its information from the CDDB or via manual data entry in the Ripper and constructs the file name accordingly. Select the fields you want included in the name and arrange them by using the “Move Up” button. Four choices are provided along with 3 possible data separators including a Dash, Space or a Comma. To change the order, click on one of the attributes and then click on the “Move Up” button. That will cause that item to be moved one position to the left in the hierarchy. Repeat the process until you obtain your desired final result.
Open Destination
This command allows you to define the name and desired storage location of the processed version of the .wav file that you are about to create through the use of the various signal-processing tools of the DCArt10/DC Forensics10. The use of this command is optional since the software creates temporary files automatically.
Save Destination As
Since DCArt10/DC Forensics10 does not require the Destination workspace file name to be defined before your audio processing session, this command is used to define a Filename and directory location for your Destination file following the completion of an audio processing session, should you desire to save it. This function can also be activated by using the file folder icon in the File Tool bar of the workspace or by using the Ctrl + S hot key. Note: It is almost never necessary to manually save a file in the Classic Edit Mode. The program automatically does this for you.
Close Destination
This command allows you to close a file when operating in Classic Edit mode that has just been processed from the Source file. The working Destination file will have been stored on a temporary basis in a dctempxx.wav file. When you attempt to close the Destination file, you will be prompted to indicate whether or not you want to save it. If you do, then you will be prompted to define a path and a name for your processed file to be saved in.
Clone Source
Quickly copy a .wav file from the Source to the Destination Window
This feature takes whatever .wav file exists in the Source Window and replicates it in the Destination Window. It is only applicable in the Classic Edit mode and not the Fast Edit mode. It is particularly useful when operating the system in Selective Filtering Mode. Highlighted areas of the Source file that are selectively filtered will be modified in the corresponding time slot of the cloned file found in the Destination window.
Note: Sync files mode (found under the View Menu or via the Sync Files Icon) must be enabled for Selective Editing to work properly in Classic Edit mode.
This command takes the file that has just been processed in Classic Edit mode, and makes it into the Source file in a new workspace window. This is a useful feature, since most sound jobs require several passes utilizing several different signal-processing techniques to affect a complete audio restoration. When using this command, the program will prompt you to name the file. It is recommended that you accept the suggested name. The original Source file may be deleted when making the Destination the Source by using the appropriate checkbox in the dialog box. This command is grayed out until you actually have a Destination file.
Delete Files
This feature allows DCArt10/DC Forensics10 to delete a file from a hard drive. Since .wav files tend to be large, this command will be used often. The software will prompt you to be sure that you want to delete the selected file before doing so. Remember that every minute of stereo audio sampled at 44.1 kHz consumes 10.584 Mbytes of disc space, which is useful to know when it comes time to clear up some disc space in order to get ready for your next sound restoration job.
Deleting a Wave file (Tutorial)
*Note 1: Multiple files that are sequential in the file listing can be deleted in one operation by clicking on the first item on the list, and then dragging the mouse pointer down to the last file you desire to delete. The files that are about to be deleted will be highlighted.
*Note 2: Multiple files that are not sequential in the file listing can also be deleted in one operation by holding down the CTRL key at the same time that you click on the appropriate item you wish to delete with the left mouse button. The files that are about to be deleted will be highlighted.
This commands prints the screen as defined by your choices identified in “Print Setup.” It prints the present DCArt10/DC Forensics10 screen as “WYSIWYG” (What You See Is What You Get). Note that the screen is a very complex graphic with high-resolution images for Forensics applications. As a consequence, some laser printers will exhibit a problem using the Print command because of their rasterization demands – this just means your printer does not have enough internal memory and would be unable to print any graphic of this complexity. This is not generally the case with inkjet printers. This function can also be activated by using the Printer icon in the File Tool bar of the workspace or by using the Ctrl + P hot key.
Printing Help-File Topics
Sometimes it is useful to be able to read Help file topics from paper rather than from your computer screen. This is accomplished in the following manner:
Printing a Screenshot (Tutorial)
Though DCArt10/DC Forensics10 includes its own Print function, you may still find the need to print a specific multi-layered screen.
Note: If you need to print the entire screen, just hit the “Print Screen” function on your keyboard. Do not use the “Alt” function.
Print Preview
This function simply shows you a snapshot preview of what you’re about to print.
Print Setup
This command opens the Print Setup dialog box in which you can define the following parameters:
Page Setup
This feature allows you to select among the following printing choices:
The Print Setup Dialog Box
Exit
Note: Exiting the program will also clean up all temp files in the Classic Edit Mode. It will ask you if you want to save any unsaved files before you exit.
The Edit Menu
Undo
This feature allows you to return to a previous version of a destructively edited file after using such features as Mute, Fade-In, Fade Out, Cut, and Copy / Paste / Insert. After an “Undo” is performed, it is removed from the “Undo” listing. You can also access the function using the Ctrl + U Hot Key.
All single file operations can be undone by using the Undo menu item. The default number of undo levels is 10. The number of undo levels is selectable in the Preferences dialog box (Edit/Preferences/General Tab). When you close DCArt10/DC Forensics10 (Exit the program) all undo information will be lost. Many Edit Menu functions will not appear in the list if no file has been opened.
Undo Procedure Using Classic editing mode (Tutorial)
Undo Procedure Using Fast-Edit Mode (Tutorial)
Use the Fast-Edit history window to temporarily go back to the last step. This method does not permanently undo the last action. Use the right mouse button to delete the last operation. Double click or use the right mouse button menu in the Fast-Edit history window to delete the last action or series of actions. You will always be prompted by the computer to make sure this is what you want to do. This operation does not display the undo levels in the Edit/Undo Window as the Classic mode does.
This is the key with an icon consisting of two paper documents contained within its perimeter. It is used to Copy a highlighted selection of a .wav file from either the Source or Destination .wav file, and place it onto the program's clipboard. This function can also be accessed by using the Copy Icon in the upper left tool bar or by using the Ctrl + C Hotkey. You can also access Copy and several other functions by selecting an area and using the right mouse button menu.
Copy and Paste Procedure (Tutorial)
Important Note:
The timing rules used by "Copy and Paste Over/Insert" are as follows:
Manual De-Click with "Copy” and “Paste Over” (Tutorial)
Note: This is one of many methods available to you in your Diamond Cut Software for manual interpolation of damaged sections of .wav files.
Important Note:
The replacement algorithm used in the Impulse Noise Filter is much more sophisticated compared to one used in this manual de-clicking procedure. Whenever possible, you should use the Impulse Noise Filter to de-click a record or the interpolator “I” key or the “O” key on your keyboard for manual interpolation of a highlighted area. Manual interpolation can easily be accomplished on tablet computers too by highlighting the event needing interpolation and then touching the manual interpolation icon. Also, worth consideration, is the use of the Pencil Tool. Only in the unusual or extreme case wherein these other tools have been unable to remove a particular artifact, should you use this “Paste Over” process.
Just as the title implies… Cut allows you to highlight an area of your file and then remove it from that file. For example, this feature is useful when it is necessary to reduce the musical portion of a segment for a competitive event in which the total length of the musical program is governed, and you do not want to eliminate either the beginning or the end of the song to achieve that end. Additionally, it is useful for eliminating long sectors of silence from Forensics files. You can also access this function by using the Ctrl + X hotkey.
Splicing out a portion of a Wave file (Tutorial)
Important Note:
Fast Edit Mode can perform multiple cuts on very long files almost instantly. Classic Edit mode takes longer to achieve a “Cut” operation.
Manual De-Clicking with the Cut feature (Tutorial)
Important Note:
Removing clicks by cutting, although very easy to use, is not recommended because it actually shortens the total program length from the original. Instead, consider using the manual interpolator “I” key (or the pencil tool) which preserves the file length and can produce very good file sector substitutions.
Paste
As the name implies and similar to every word processor you’ve ever used, Paste allows you to take whatever element you’ve cut or copied onto your clipboard and put it back into your current file in one form or another. We’ve created many different ways to paste your material (10 alternatives are provided in the Paste menu structure). When navigating this feature with its icon, click on the down-arrow to expand out the menu of choices. It will only come to life if there is something already on the copy clipboard to be pasted in some manner. We’ve thought of everything but “Paste Eat”, which we’ve reserved for the Elementary School edition of the product.
Append to End
Paste Clipboard Contents Directly To End of a File
The "Append to End" feature takes whatever file or portion thereof you have copied onto the clipboard and attaches it to the end of the displayed .wav file. The resulting file will become larger so you may have to zoom-out to see it in its entirety.
Insert at Start
Paste Clipboard Contents Directly to the Beginning of a File
The "Insert at Start" feature is the complimentary function to the "Append to End" feature. Simply stated, it takes whichever file has been copied to your clipboard and attaches itself to the beginning of the displayed .wav file. As a result, the total newly formed file length will become larger so you will have to zoom-out to see it in its entirety.*
Time Domain Manual Interpolation Technique)
The Diamond Cut Time Domain Interpolator allows you to manually correct a recording impulse noise defect such as a tick, pop, click or thud. Some folks fondly refer to this technique as the Diamond Cut “Oterpolator” named after the “O” hot-key that is used to activate it. This system employs time domain interpolation techniques to calculate an accurate replacement signal and is primarily optimized for short time interval situations.
To use the time domain paste “oterpolator”, simply highlight the area in the Source file in which you are observing a noise event. Next, strike the “O” Hotkey on your keyboard. The noise event will be replaced with a new waveform. The new waveform is calculated by a high-order modeling algorithm utilizing up to a maximum of around 2,200 samples of data per channel (up to approximately 0.05 seconds on a 44.1 kHz sampled file {50 mSec}). If you try to exceed the algorithm’s limit, you will be prompted as such. If that happens, consider using the Diamond Cut Bi-Modal Interpolator (the “I” key) which is capable of longer interpolation time intervals.
Manual De-Clicking with the Time Domain Interpolator (Tutorial)
Note 1: If you are interested in interpolating only the Left or Right channel with the Time Domain “Oterpolator” routine (rather than both channels together), just use the L or R channel selector buttons on the toolbar first. You must be using WDM drivers, however, for this method to work; it will not work with MME drivers.
Note 2: Other methods of manual interpolation include Paste Interpolate (Bi-Modal Technique) and Pencil Editing. Please refer to those sections of this users guide for details.
Paste Interpolate (Bi-Modal Technique)
DCArt10/DC Forensics10 provides you with an automatic switchover method for inserting manual interpolations onto a waveform called “Paste Interpolate” via the “I” key. It is used in the same manner as the standard Time Domain Paste Manual Interpolator. This bi-modal interpolation technique uses a combination of time and frequency domain algorithms to determine the best replacement signal and is better optimized for longer time interval interpolations of up to around 19,800 samples (up to 0.45 seconds on a stereo 44.1 kHz sampled file {450 mSec}). It automatically converts to a frequency domain system when the selected area of the waveform is greater than a few milliseconds in length. Along with the capability of fixing very large impulse noise events (events which are very long and tall) with improved accuracy, it can also be used to remove other recording anomalies such as coughing, chair movement or short duration PA system feedback bursts from a recorded concert performance. Additionally, it can be used to correct things like “fret” noise from a studio recording of a guitar and other similar studio recording related problems.
Its interpolation capability has been lengthened and its accuracy improved on long events compared to the original Diamond Cut time domain only counterpart. Previous versions of the Paste Interpolate function utilized only time domain curve fitting techniques. This version now uses time domain as well as frequency domain interpolation techniques. This combination of two techniques results in more accurate results, especially on longer time interval events. From a user’s perspective, it works in the same manner as the time domain Paste Interpolator, but uses the original Diamond Cut “I” Hotkey. If you want to interpolate the Left Channel only, use either the “J” or the “SHIFT + I” Hotkeys. Conversely, if you want to interpolate the Right Channel only, then use either the “K” or the “CONTROL + I” Hotkeys. It automatically switches from a time domain interpolator to a frequency domain interpolator on highlighted signals which exceed several milliseconds.
Note 1: Generally speaking, the best interpolations for short impulsive events (250 samples and below) are achieved via the Time Domain Interpolator routine (the “O” key
Note 2: Generally speaking, the best interpolations for long impulsive events (250 samples and above) are achieved via the Bi-Modal Interpolator (the “I” key).
Note 3: Notes 1 and 2 are not hard and fast rules and the best interpolation results are due to a combination of the method and the nature of the audio material that you are working with. Experimentation is the best way to make the determination. When all else fails to provide a satisfactory result, try the “Direct Spectral Editor” (found under the Edit Menu) which uses only frequency domain techniques. Compare its result with the result produced by the “I” key and its affiliates.
Note 4: Other methods of manual interpolation include Paste “Oterpolate: (Time Domain Technique – the “O” Hotkey), Pencil Editing and Direct Spectral Editing. Please refer to those sections of this users guide for details on their operation.
Note 5: When using a tablet, you may find it more convenient to touch the manual interpolation icon button after highlighting the area in need of repair.
Paste Over
Paste Over allows you to insert the portion of the .wav file located on the clipboard over the top of a different location in your .wav file or to other .wav files. (This operation will delete the portion of the .wav file that previously had been in the particular location, installing the temporary file in that position instead.) The “Copy” and “Paste Over” feature in DCArt10/DC Forensics10 can also be used to manually “de-click” or “de-pop” a sound source (see tutorials under “Copy”). This function can also be accessed using the Ctrl + V Hotkey or by right clicking the mouse after you’ve copied or cut a portion of the .wav file. For various tutorials of Copy and Paste Over, you can refer to the Copy section of this manual.
Paste Insert
Unlike Paste Over, Paste Insert does not wipe out the sector of the .wav file where you desire to place the contents of the “Copy” temporary file. Instead, “Paste Insert” adds the contents (from your clipboard) to the area of interest. In other words, you are pasting into the targeted area and the Diamond Cut system just shifts the existing material over in time. This process lengthens the time duration of a .wav file.
Paste Mix
Paste Mix allows you to add or “mix” one file (or a portion thereof) to a second file. This feature is useful for creating “voice-overs,” or inserting special effects on top of a previously created sound track. This feature works in conjunction with the Copy function. In many cases it will require that two files be opened, one in the Source Workspace, and a second in the Destination Workspace. But this is not mandatory in that you can “paste mix” a portion of a file back onto itself if desired. The file that you open in the Source Workspace can be the file onto which you will be mixing. The File which you will be establishing as the “voice over” or special-effect, might be the one opened in your Destination Workspace. In other words, you can mix the Destination file into the Source File, in this example. The process can also be performed in reverse, wherein you can mix a portion of the Source file into the Destination File. These processes are undo-able, so that you can experiment until you are satisfied with the result. To use this feature, you will be highlighting the portion of the Destination File that you want to mix into the Source file. You will then use the Copy command to place it on a clipboard. Then you will highlight the Source file location in which you want the voice-over mixed in. When you run Paste Mix, you will be able to adjust the Source and Destination gain settings over a range of from +12 dB to – 100 dB.
Paste Crossfade
Paste Crossfade is the cousin of the Paste Mix feature. It operates in a similar manner, with the difference that there is a time varying function applied to the gain settings, so that a “cross-fade” effect can be produced. This feature is useful when you want to fade one song (or file) into another, with no “dead-air” in between. When you run Paste Crossfade, you will be able to adjust the File-1 (clipboard) Start and Stop Gain settings as well as those for the target file (File-2). You have available four gain controls in total. You will also be able to control the dynamics of the cross-fade by selecting Linear In, Log In, or Log Out. This feature is undo-able when executed under the Edit Menu. The “Crossfade” feature is also available under the Filter Menu.
Using the Paste Cross-Fader Tutorial (Classic Edit Mode Only)
This method of cross fading is undo-able.
Paste Crossfade Dialog Box
Paste As A New File
This feature provides a convenient means to chop a large file into smaller pieces, and assign new .wav file names to these subset files. It is useful for creating a number of .wav files that could be listed and quantized for CD-R indexing from a single large file such as that which you might have from transferring a Vinyl LP, or a concert tape recording to DCArt10/DC Forensics10. In Forensics applications, this feature is useful to isolate shorter conversations from a large file and then to create a file listing of those conversational snippets. A popup window will appear in which you can redefine a file name for each “chopped” file subset when using this command.
Paste Silence
This command simply inserts a predetermined amount of silence somewhere (your choice) in your .wav file. You can select from the Beginning of the file, End of the File or the Beginning of a selected area. This command will increase the total length of your .wav file.
Insert A Tone To Cover Objectionable Material
The Paste bleep tone feature interjects a 440 Hz Sine wave (A above middle C) at a –10 dB level over the highlighted area of a .wav file. It is intended to be used to “bleep out” unwanted verbiage or other sounds. It is commonly used in the Forensics audio field to redact portions of an audio file. To use this feature, merely highlight the area of the .wav file in the Source Window that you want to “bleep out.” Then, navigate to the Edit/Paste/Bleep (tone) feature. The highlighted area of the .wav file will be replaced with the bleep tone. This is an undoable function (it can be reversed).
This command selects the entire .wav file. It can also be activated by using the Ctrl + A Hotkey or a double left click within the file area. If you have markers present in the file, double clicking will highlight the area between the two closest markers.
This device is provided for sample-to-sample level editing of your waveform. Though not as useful for general waveform drawing, it can be very useful for eliminating tiny clicks and pops that will show up if you are zoomed in closely on the waveform. It will not become active until you’ve zoomed into this level. You can access this feature by using the Pencil icon located in the toolbar or using the Ctrl + E Hotkey.
Remember, you must be zoomed in before this feature this will activate. Watch your pencil icon; when you’ve reached the correct zoom in resolution, it changes from grayed-out to active.
Manually De-clicking With the Pencil Icon (Tutorial)
Mute
This feature uses direct hard disk editing to allow you to mute a selected portion of your .wav file. With Mute, the audio file sound level is reduced to nothing in the selected area, but the area remains as part of your file. The Mute feature is also useful for getting rid of noise at the beginning or the end of a recording. You can access this feature via the Ctrl + M Hotkey or by depressing the right mouse button and using that menu. The Mute function does not alter the length of your file.
Important Note:
Do not mute the beginning or the ending of a .wav file before operating any of the Impulse Noise filter(s). Doing so will cause them to function at an extremely slow rate of speed during the muted section, because it will have a very difficult time calculating a signal to noise ratio on a signal containing all zero’s. Perform the .wav file muting function after all other filter operations have been completed.
Muting Procedure (Tutorial)
Manual De-Clicking with Mute or Interpolate (Tutorial)
Though you are sometimes actually muting a segment of the audio file, if you use this method carefully, you may not hear it in the final playback if the event is short-lived. The Interpolate method (“I” or “O” hotkeys) will generally yield a more transparent result compared to “Mute”.
Fade-In
Fade-In does what the name implies when applied to the beginning of a .wav file. You can choose between linear or logarithmic envelopes, and you can also choose the time period for the Fade-In by selecting the portion of the .wav file over which you desire the Fade-In to occur. Lastly, you can choose the "start level" for Fade-In as well as the "stop level." ("Level" is the start and stop loudness for the Fade-In.) Fade-In operates on the selected file (which can be the Source or Destination file).
Fade-In Procedure (Tutorial)
Note: After a Fade-In has been performed; there may be a sector of your .wav file containing some noise at the very beginning just prior to the start of the Fade-In. This can be eliminated with the Mute function.
Fade-Out
Fade-out also does what the name implies. It contains all of the features outlined in the "Fade-In" description except that it normally works near the end of the file. Fade-Out runs under the Edit menu, and unlike the various Filter functions, operates directly on the selected file (which can be the Source or Destination file).
Fade-Out Procedure (Tutorial)
Note: After a "Fade-Out" has been performed, there may be a sector of noise after the "fade-out" and the end of your .wav file. This can be eliminated with the Mute function.
Single file Operations
Because of the nature of several Diamond Cut operations, the Cut, Copy, Paste, and Fade menu items operate on the file that is currently selected. This means that a Cut will delete a section of the Source or Destination file if it is the currently selected file in the workspace. Likewise, a Fade operation will modify the highlighted section of the selected file (Source or Destination).
Snap Selection to Zero Crossing
Prevent Editing Glitches with Snap To Zero Crossing
The Snap Selection to Zero Crossing editing feature takes the beginning and ending of a highlighted section of a .wav file and moves both of them to the closest zero crossing point. This is used to minimize the introduction of transients, which could be produced at editing points. This feature is only completely effective on monophonic files since stereo files rarely share zero crossing points on both channels on a highlighted section of a file. Thus, on stereo .wav files, the “Snap” feature moves the highlighted area to the closest average zero crossing value between the two channels. The “Snap Selection to Zero Crossing” feature can be invoked from the Edit menu, via the right mouse button or via the “Q” hotkey on your keyboard. To operate this feature, simply zoom in and highlight the desired section of the file and invoke one of the three options just mentioned above.
Delete All Temp Files
Delete All Temp and Fast Edit Files With One Click Of The Mouse
This command does exactly what the name implies to the temp files in your Temp file (dctmp) directory. Think twice before invoking this command to assure yourself that you are not deleting something important! It does not delete all .pkf (peak) files and .ses (Fast Edit History) files.
DCArt10/DC Forensics10 provides a Gain Change feature that is useful for correcting loudness deficiencies on recordings, or to provide the additional headroom required before running the graphic equalizer filter (or any other filter or effect that increases signal loudness). Gain Change can be very creatively applied using the contour graphical interface. It can also be utilized globally on a file, or selectively to bring out a weak vocal, etc.
The following is a summary of the control parameters and the range of adjustment provided for the Gain Change algorithm:
The Gain Change graph shows you how you have programmed the gain to change as a function of the selected .wav file time axis. You can use the mouse to drag the two (or four) green control points to establish the time relationship that you desire. Often, a flat line is appropriate; however, sometimes the loudness of old 78s decreased toward the end of the recording by a few dB. This can be corrected by a gain correction starting at 0 dB and ending with perhaps 3 dB (depending on the severity of the problem). The reason this occurred is that the early cutting lathes did not provide automatic gain (or frequency response) compensation controls. When the curve shape is selected, two additional green cursors appear. The two additional green cursors can be moved both vertically and horizontally allowing you to create numerous curvilinear gain vs. time relationships.
Important Warning:
Digital systems, like analog systems, can be overdriven to the point of "clipping" the signal. This will produce non-desirous distortion (except on rock n' roll). Before applying a gain increase to a .wav file, study the amplitude of the signal and be sure that you are not adding so much gain as to exceed the dynamic range of the system which is most often set to 2^16 LSB's (or whatever the resolution of the recording that you have digitized). If you do, signals will appear to flatten out horizontally at their peaks on the Source or Destination Workplace displays. If you do indeed notice clipping after a gain change, you can “Undo” this function.
File Properties
The File Properties feature shows you information concerning the file that is opened in your Diamond Cut software. The Figure below shows an example of the sort of file header data presented and/or editable.
The File Properties / File Information Dialog Box
Noteworthy is the fact that this information is also available under the View Menu. However, it can only be edited here via File Properties as found under the Edit Menu. If you want to Edit the .wav header, click on the “Wave Header Details” button and a screen similar to this one will appear:
The Wave Header Editor Dialog Box
From this dialog box, you can edit/change some of the parameters associated with the opened .wav file. In general, it is not desirable to do so unless you are thoroughly familiar with .wav file structures and desire to accomplish some very specific task that could not otherwise be accomplished. After you have changed the desired parameters, click on “Write Wave Header” and the changes will take effect. You can use this feature to repair corrupted .wav file headers.
Your Diamond Cut Software also supports the Broadcast Wave (BWF) .wav file format. BWF facilitates metafiles in conjunction with .wav files. More information on BWF can be found in the Glossary of Terms section of this users guide. You can use the “Save As” command found in the File Menu to create this sort of a file. If you want to View or Edit a BWF, click on the “Broadcast Wave Details” button and the following Dialog box will appear:
The Wave Header Editor Dialog Box
As you can see, there are a number of data that you can add to the .wav file header not associated with normal .wav files. After you edit your BWF, click on “Update File” and the file header will be modified.
Playback Controls
If you are new to audio processing on a PC, fear not. The playback controls will be a few familiar friends that you’ll recognize instantly on your tool bar. These tools closely match their “real world” counterparts on every cassette or tape deck that you’ve ever seen. They simply help you quickly and easily navigate through your .wav file in any direction and speed you choose. Because the laws of hardware do not bind us, we’ve been able to improve these controls and make them more accurate and useful than their hardware brethren.
Play
Click here to play your file. If the display is enabled, the highlighted portion shall be played. If the entire file is highlighted, the entire file will play. A shortcut alternative to access this command is via the spacebar. There is also a Play+n key (located to the right of the loop-play button) which will play the highlighted portion of your file including approximately 1 second on each side of the highlighted sector. So, play will commence 1 second before the highlighted sector and end one second after the highlighted sector.
Loop Play
The Loop Play key is located just to the right of the Play button. Clicking on it will cause the system enter into an infinite loop-play of the highlighted area of the file. Use the stop key to terminate this function or click on the loop play key again to force it to stop.
The “Scrub Audio” (scrubber) feature (when enabled) allows you to use your mouse to play a portion of a .wav file with its playback speed being proportional to the left or right position of your mouse. It provides you with a method to find a cue point more easily than via the standard “Play” and “Pause” controls. It is also very useful in file transcription work and also can be used to correct the speed of a file having a variable speed error “on the fly”. To use this feature, just point the mouse where you want to commence play and then click down on the left mouse button. Move the mouse left or right to change the speed of playback. Moving your mouse towards the right advances playback in the forward direction while moving it to the left reverses the direction of playback. Please note that this feature only works with WDM soundcard drivers. It will not work with MME drivers.
You can click here to move the cursor backwards to the beginning of the highlighted area of a file. This function does not operate when previewing a filter or effect. It works in conjunction with the play and pause buttons. To use it, first pause play with the pause button on a highlighted file portion. Then, click on the rewind button. Next, when you click on the play button, play shall commence at the beginning of the highlighted area of your file.
Pause
This is the key with two vertical lines contained within its perimeter. When activated, the playback of the .wav file will pause at that location. Play can be resumed by activating the play button, depressing the spacebar on your keyboard or by simply hitting the Pause button again. Essentially, the spacebar “toggles” your system between “Play” and “Pause”.
Fast Forward
You can click here to move the cursor forward within the highlighted area of a file. This function does not operate when previewing a filter or effect.
Stop
This is the key with the black square with a green dot contained within its perimeter. It is used to stop either a record or a playback session. Unlike the Pause feature, hitting the play button will commence play from the beginning of the highlighted area of the file thereafter.
Record
This is the button with the red square. It is used to place the DCArt10/DC Forensics10 program into Record mode. You can also access this function by hitting the Ctrl + R Hotkey. Pressing either the hot keys, menu item or clicking on the Record button will activate the Recording Window. From there, you see the following dialog box:
The Recording Window
Trip Level - Threshold Range is from +1 dB to –100
dB. This “trips” the system into recording when the
desired level is reached.
Minimum Duration - Time Range is from 0 to 360
seconds. After the system begins to record, it will stop
automatically when the desired signal stops occurring for
the amount of time you’ve dictated in this field.
As indicated above in the Record window, VOX (Voice Operated Xmit {transmit} – an old military communications term), or signal activated recording, is possible with DCArt10/DC Forensics10. This feature allows the Diamond Cut recorder to start and stop itself based on the presence or lack of presence on an audio input signal. The recording activation process is triggered by signal level sensing as determined by your setting of the Trip Level control. The record de-activation process is triggered by a combination of the signal level sensing system in conjunction with the Minimum Duration control setting. For example, you will want to set the Minimum Duration to a value long enough so that the recorder does not stop between songs on an LP. In that example, you would probably want to set the control for about 10 seconds. To use the VOX feature, bring up the Recording dialog box and check VOX recording and set the Trip Level and Minimum Duration appropriately for your specific application.
In the DC Forensics10 Version, you can also perform automatic time stamping of VOX events when you have the Log to Disk function selected (see the Live Mode section for more information). This function adds a time stamp for each recording event and is accurate to less than 1 second. It is very useful for Forensics surveillance recording situations.
Extended Recording
Record Material of any Length- No More 2 Gbyte Wave file Limit
Wave files are limited in length to 2 Gbytes. In some situations, it is desirable to record for a period of that exceeds this 2 Gbyte limit. The
Extended Recording Feature accommodates this situation. It works by automatically opening a new file when a particular file approaches the 2 Gbyte limit. When you save the Extended file(s), you will see that the file(s) will be named in the following format in your directory of choice:
xxx_part1.wav
xxx_part2.wav
xxx_part3.wav
xxx_partn.wav
Each file will have to be played or processed independently thereafter.
Recording Signals onto your Hard Drive (Tutorial)
Important Note:
DCArt10/DC Forensics10 is compatible with .wav files that were originally created by other programs. It is not necessary to record your .wav files using the Diamond Cut recording routine in order to use the programs processing features.
This is the key on your toolbar with a black and green arrow, which is pointing towards the right. This key is used to play your file. The playback will begin at the leftmost portion of the yellow highlighted area of your .wav file. You can also access this function by pressing your keyboard spacebar.
Playing a Wave file (Tutorial)
Pausing and Resuming Playback
Note 1: Toggling with the “Loop Play” button behaves like toggling with the spacebar including the rewind to the beginning of the selection operation.
Note 2: If “Play from Cursor” is selected (in Preferences), playback will resume from the stopped position.
Playing and Pausing using the Right Mouse Button
This button allows you to play either the entire file or a highlighted area over and over again, back to back. Playback will continue until the button is depressed again or the space bar is pressed. You can also access this feature by using the “L” Hotkey.
Note: This feature will not work if the “Play from cursor” method of playback is selected in the Preferences menu.
This feature allows you to play a range of time around a selected area. It is useful when you need to listen for small anomalies on a sound recording in order to find their exact location(s). You can choose between the following, which can be activated from the keyboard using the following keystrokes (shown in brackets): To use this function, select an area by clicking and dragging. You can play this selected area by using the spacebar or the Play button. You can also play the selected area PLUS a specific amount of time in front and behind the selected area by simply hitting the 1 thru 4 keys on your keyboard. For example, if you select an area 10 seconds in length, hitting the 2 key will play starting at a point 2 seconds before the selected area and continue for an area representing 2 seconds after the selected area.
Play Range +/- 0.5 seconds: (Keyboard Key # 1)
Play Range +/- 1 second: (Keyboard Key # 2)
Play Range +/- 2 seconds: (Keyboard Key # 3)
Play Range +/- 4 seconds: (Keyboard Key # 4)
Timer Recording
The Timer Recorder feature found under the Edit Menu is useful for such applications as recording your favorite radio broadcast (sometimes referred to as “time-shifting”) at a defined time, or to commence a surveillance recording based on a particular time of day. It is a single event 24-hour timer, which clears itself after the event has passed, or can repeat its action the following day by checking the “Re-Occurring Event” box. To set a “Start Time”, click on the number to be changed in the “Start Time” field, and use the up and down arrows until the readout agrees with the desired start time. The same process is used for setting up the timer’s “End Time.” The Re-Occurring Event checkbox will cause the recorder to record the same time span every day. Use the “File Name for Recording” in conjunction with the “Browse” feature to define the file location and name into which the recording shall be placed. You must leave the software running for the Timer Recorder feature to work and you must close the Timer Recording window. You can minimize it, but do not exit the program. If you want to disable the Timer, click on the “Cancel Timer” checkbox.
The Timer Recording Window
Click on the red record button found on the tool bar in order to set your recording parameters such as sample rate, resolution (bit depth), channels (stereo or mono), and sound card location. The record dialog box will appear on your screen. Then, select the parameters that you desire and close the recorder. Those values will be saved and used by the Timer Recording feature.
Make Waves Signal Generator
The Make Waves Signal Generator
The “Make Waves” signal generator feature provides you with the comprehensive capabilities associated with a fully programmable audio signal generator (sometimes referred to as a function generator by engineers). It can produce Sine Waves, Square Waves, and Triangle Waves of adjustable frequency and amplitude. The frequency of these waveforms can also be swept from one value of to another. The Make Waves generator is also capable of producing random waveforms of the White Noise variety. (Pink Noise, Brown Noise or Seismic Noise can also be produced when random noise is used as a signal source in conjunction with the appropriate Multifilter or Paragraphic EQ conversion preset.) Make Waves is useful for calibrating and verifying the performance of the audio equipment used in your sound restoration laboratory, especially when used in conjunction with the onboard Spectrum analyzer or Spectrogram. These tools will also be useful to help you better understand the functionality of some of the filters provided in the Diamond Cut software program. The Sweep and Random generator are especially useful for characterizing the frequency response (and/or transfer function) of electrical and acoustical systems when used in conjunction with Diamond Cut measurement tools like the VU Meter, X-Y plotter, Spectrum Analyzer or Spectrogram. The Triangle Wave generator is useful for characterizing the time-domain linearity of an audio system or component. Included with the Make Waves Generator presets are all of the musical notes running from C0 to D9# (referenced to a 440 A4 of the equal-tempered scale) as well as a number of useful test signals from which to choose. The following controls with their adjustment range are provided with the Make Waves Generator:
*Note 1: The frequency programming precision of the Make Waves Generator in the DC Forensics10 version is greater than the standard DCArt10 product. Keyboard entry of the desired frequency must be used to attain this higher level of resolution. The actual frequency resolution in the DC Forensics10 Make Waves Generator is 0.01 Hz (10 mHz or millihertz). Thus, values like 59.99 Hz or 60.01 Hz are permissible.
**Note 2: To create a Make Waves file having a custom sample rate value, simply highlight the sample rate field and use your keyboard to enter the desired sample rate value. Note that only very high-end soundcards are capable of handling sample rates above 192 kHz (such as 210 kHz). Less capable soundcards may hang your system when presented with sample rate signals greater than their maximum design capability.
The following chart summarizes the Harmonic Distortion components produced by the various waveforms provided by the “Make Waves” generator at a 44.1 kHz sample rate and 16 bit resolution:
Wave-form | THD% | 3rd Harm. | 5th Harm. | 7Th Harm. | 9th Harm. |
Sine | 0 | 0 | 0 | 0 | 0 |
Square | 44 | 33.3 | 20 | 13.8 | 10.8 |
Triangle | 12 | 11 | 4.1 | 2.0 | 1.3 |
*Note:
Using the Making Waves Signal Generator (Tutorial)
Important Note 1:
If the sweep generator function is desired, click on "linear sweep" and then adjust the "stop frequency" control to the desired value. The generator will then produce a linear sweep of frequencies ranging from the start frequency value to the stop frequency value over the interval of time defined by the "length" control.
Note: The Sweep and Random Generator is useful for characterizing the frequency response or Transfer Function of electrical and acoustical systems when used with other Diamond Cut Measurement tools (VU Meter, Spectrum Analyzer, Spectrogram, and/or the X-Y Plotter).
Important Note 2:
Pink noise can be created from the random white noise generator by applying the “White to Pink Noise Converter, 20 kHz” to the white noise file. This feature is found in the preset list under the Multifilter. First, create a sample of random (white) noise using the Make Waves Generator. Use a sampling rate of 44.1 kHz for this procedure. Next process the resulting file through the indicated Multifilter preset and the resulting file will be Pink Noise.
Important Note 3:
Brown and/or Seismic Noise can be created in a similar manner as described in Important Note 2. However, the converters are found as presets under the appropriate names in the Multifilter.
Important Note 4:
A number of factory presets are provided for the Make Waves Generator consisting of commonly used audio signals. You can add to that list as desired.
Change Sample Rate / Resolution
The Change Sample Rate feature allows you to convert a .wav file from any common sample rate to any other common sample rate. It also allows you to convert from any common resolution (or file depth) to any other common value. These features are provided with a user selectable interpolation quality since improved interpolation takes more CPU horsepower and therefore more time to make the conversions. This way, the user can make this tradeoff. The following controls are provided with the associated ranges of the Change Sample Rate / Change Resolution Feature:
New Sample Rate: 11,025, 22,050, 32,100, 44,100, 48,000, 88,200, 96,000, 192,000 Samples/sec.
Resolution: 8 Bits, 16 Bits, 20 Bits, 24 Bits, 32 Bits FP
Conversion Quality: Choose between –
Note 1: The tradeoff between these conversion quality choices is the time that it takes to make the conversion; higher quality levels of interpolation requires longer processing time.
Note 2: The Conversion Quality used by the Batch Processor is non- selectable and is set to “Master Quality”.
Note 1: In general, choose Triangular or Noise Shape 2 with your ears helping you to make the decision as to what is best.
Note 2: Usually dithering is used when lowering the bit depth…like going from 24 to 16 bits.
To perform a conversion, bring up the file to be converted in the Source window. Select the desired conversion parameters from the outlined choices. Run the filter and the results will be displayed in the Source window after a period of processing time. The file will automatically be re-named by incrementing its name by a value of one, so long as there are no other files with that same incremented name in existence in the chosen file directory.
Preferences
The Diamond Cut “Preferences” menu allows you to customize the system to your own liking.
Configure the System Your Way!
Preferences are broken down into eight sub-categories that can be accessed by clicking on the desired Tab at the top of the Preferences window.
General:
Note: The Edit History (or Session File) is stored in the same directory as the .wav file. It contains the file extension .ses and should not be deleted manually because it will leave the associated temporary files on your hard drive.
14. Scroll Waveform View On Playback: Normally, the play
cursor moves across the time domain display as a .wav file is being played and stops at the end of the highlighted area. “Scroll Waveform View On Playback” is an option wherein the display will keep pace with the playback position. As the cursor reaches the end of the display area, the display will page one frame to the right and the cursor will start again at the left hand side. The Zoom level is maintained and can be changed with the Zoom X2 feature while playing. You will need to use the “Play from Here” function found on your right mouse button to use this feature or use the Zoom X2 functions to display an area that is different than the highlighted area.
15. On Startup, Open DC Tune Library: When checked, and the
software is launched, the DC Tune Library will automatically
be launched too.
16. Use Source Directory for Temp Files: This mode is
particularly useful to Forensics users. It allows all of your
work to be put into a single directory for easy archiving.
When this mode is not used, it may be difficult to identify all
of the files used in a fast edit session because they will be in
the temp directory. This is only available in the Forensics
version of the software.
17. Use Alternate FFT: This feature is a diagnostic tool used by
the Diamond Cut Company for troubleshooting purposes.
Important Note: Most tech support calls that describe “no playback” or “no record” symptoms relate to sound card issues. DCArt10/DC Forensics10 uses all standard Windows calls to playback and record audio. The Diamond Cut software does not communicate with your specific sound card directly. Therefore, any sound card that works under Windows will automatically work with DCArt10/DC Forensics10. If you are having problem playing or recording audio, make sure your sound card is working with other applications and make sure you have the correct inputs and outputs selected under Edit/Preference/Soundcard.
*Note: These user selectable parameters are reflected both in terms of the displays but also exportable values where applicable.
Spectrogram:
Note 1: Please refer to the Spectrogram section of this manual for details.
Note 2: Left mouse double clicking in the Spectrogram window can also access the Spectrogram preferences.
mp3 Encoder Preferences Setup
Setup is provided for an externally provided MP3 Encoder. At this time, we accept popular 3rd party encoders that are available from the Internet. To allow the program to Save or Batch Process files into MP3 format, you must download an encoder and choose it in this screen. The Browse button allows you to show DCArt10/DC Forensics10 where the encoder is located on your hard drive. In general, higher bit rates produce better sonic results at the expense of greater memory consumption. Note that the system supports both CBR (Constant Bit Rate) and VBR (Variable Bit Rate) encoding techniques.
Tune Library:
Please refer to the DC Tune Library section of this documentation for detail on these preferences.
Your software has the capability to “Rip” Red Book CD Audio to .wav files. For details regarding the operation of this feature, please refer to the section of the manual called “Rip CD Tracks” which is found under the Filter Menu of the program. The CDDB Setup allows you to establish the parameters so that your system can fetch Track Titles off of the Internet and use them as Track Names rather than the Track Numbers assigned by your Diamond Cut software. Here is a screen shot of the CDDB Setup Tab:
CD Database Setup
You will need to be on the Internet for the CDDB feature to function. Generally, the default settings provided will work for you. However, it is a good idea to click on the “Get Server List” and select the server closest to your locale. If you are running a firewall on your system, you will have to check the “Use Proxy Server” box and enter the proxy server address and proxy port number.
File Split and Recombine
Sometimes it may be desirable to split a stereo .wav file into its left and right components, establishing individual .wav files for separate channel processing. For example, if one of the stereo channels needs some equalization but not the other, using this splitting and re-combining tool can facilitate that function. This easy to use tool allows you to either Split a Stereo file into two Mono files or combine two Mono files into one Stereo file. You can select whether or not to open these files after the process is complete. Note that the L/R buttons on the toolbar allow instant selection of either or both channels for playing and processing.
Easily Split and Recombine files with this feature
Manage Presets
The Presets Archive stores all presets, either factory produced or user produced in folders according to their filter (or effect or other) and have the file extension of .pst. A nice feature of DCArt10/DC Forensics10 is the ability to share presets you have created with other users via email, or web pages like the Diamond Cut Users Forum. You can export any or all of your presets to share them with other users by sending them via a single (.zip) file to the Presets sharing portion of the Diamond Cut Users Forum. Go to www.diamondcut.com and then click on the Users Forum link. Once there, you will see the preset exchange area. This exchange provides both uploading and downloading capability with an area for you to describe the preset(s) that you are posting. You will find approximately 200 presets that you can download from that site that have been created and uploaded by Diamond Cut Users over the years.
Your current presets are stored in a Presets folder in the Diamond Cut directory on your hard disk as a single small file for each preset. Since DCArt10/DC Forensics10 comes with over 1000 presets, it would be cumbersome to find and share them by sending or receiving one file for each preset. The Manage Presets window makes this easy. You simply create an Archive by clicking on the button and giving the new archive a name. Now you can copy any individual or group of presets into this archive. Double clicking a preset folder will open it and reveal its individual presets. This archive file will exist as a single filename .zip file on your hard disk and will contain all the presets you copied into it. Copying presets does not delete them from your own preset list. This single .zip file can then be sent to another user and opened using the Open Archive function. The user can then place any or all of the received presets into any of his or her personal preset folders.
Saving a Preset (Tutorial)
Recalling a Preset (Tutorial)
Deleting a Preset (Tutorial)
The Filter Toolbar
A Batch File editor is provided, so that you can assemble a group of audio files with similar problems and apply filters and their associated parameters to this entire list of files. This will allow you to create your setups and then go out and mow the lawn or perform other chores while your computer and DCArt10/DC Forensics10 are performing their chores unattended by you. The Batch File Editor functionality can be greatly enhanced via the use of the Multifilter which is one of its elements. That way, multiple filters and/or effects can be applied to a group of files in one pass. The number of files that the batch processor is capable of handling results from a total path length of 128K characters as the sum total for all file paths that you want to batch process. The maximum number of characters allowed per file name and path is 2048. The system will remember the last path that you used.
The following items are supported by the Batch File Editor (depending on the version of the software that you own):
Note: The DC Forensics10 version supports all of the listed items.
Process Multiple Files Simultaneously!
The Batch File editor includes the following controls:
Auto Leveling
Match Volumes of Numerous Wave Files with Auto Leveling
The Auto Leveling routine is contained only in the Batch Editor which is found under the Filter Menu. It allows you to make .wav files sound very similar in loudness across a number of files. It performs this function by calculating a combination of the RMS and Peak values of each of the files and normalizing them while accounting for both parameters and assuring that none of the .wav files overload. This functionality is quite different compared to the Gain Normalize feature in which a single file is normalized in gain with respect to its own peak value. The Auto Leveling routine has no specific controls unto itself. It uses the generic controls associated with the Batch Editor. To operate the Auto Leveling feature, highlight the Auto Leveling Icon. Then merely use the “Add Files” feature in the Batch Editor to list the files of interest by placing them in the “Files to Run this Filter On” listing box. Lastly, click on the “Run Batch” button. The resultant processed .wav files will be found to be very similar in overall loudness from one file to the next.
Concatenate Files
Concatenate Files Feature Available in the Batch Processor
Another feature, which is only available in the Batch File Editor, is the Concatenate File feature. It takes multiple files and connects them together (the tail of the first file to the head of the next, etc) and defines the resultant file with a unique name. This feature uses the standard controls associated with the Batch File Editor having no ancillary controls of its own.
Note: If multiple filters need to be run, you can use the Multi-Filter to create your desired filter sequence for Batch Processing files with more than one filter at a time.
EZ Clean One Step Scratch, Crackle, Hiss and Hum Removal
Sometimes it is very desirable to be able to clean up a piece of audio quickly without any hassles. The EZ Clean Filter® is designed to do just that by using adaptive filtering techniques. It removes scratches, clicks, crackle, static, hiss and hum with one very simple user interface. It includes four time domain visual Noisegraphs® to help tune it up, coupled with only three slider controls and a few checkboxes making it extremely easy to use. After initial setup, they system will adapt to varying noise environments. The tradeoff associated with the EZ Clean Filter® is that the clean-up process may not be as finely optimized as can be accomplished using the stand alone filters, each having a full array of controls over numerous variables. But, for a lot of routine audio clean-up work, you will find that the EZ Clean Filter® to be very easy to use and adequately effective.
The EZ Clean Operating Table
Scratch Control
The top control on the EZ Clean Filter® is used for attenuating large clicks, pops, and scratches in the audio material. The normalized range for this control is 0 to 100. A good starting point for this control is 50. To “tweak” (or fine tune) this control (or any of the EZ Clean Filter® controls), use the left and/or right arrow keys of your keyboard. The top graph on the EZ Clean Filter® Noisegraph® indicates the number of events being repaired per unit time vs. time. Taller bar graphs indicate that more aggressive filtering is taking place.
Crackle Control
This control sets the threshold for the detection and interpolation of small clicks, crackle, static and impulses. Like the Scratch control, low numbers represent its least aggressive behavior, while large numbers provide a more aggressive response. The normalized range for this control is 0 to 100. A good starting point for this control is 50. The Noisegraph® graph for this control is immediately adjacent to its control. Its Noisegraph® also indicated the number of events being repaired per unit time vs. time. Taller bar graphs on the Noisegraph® indicate more aggressive filtering.
Hiss Control
The hiss control attenuates exactly what the name implies as well some continuous noise content over the entire audio spectrum. This system is relatively automatic in that it determines its noise fingerprint “on the fly” and is dynamic. The Hiss control setting will be very much dependent on the audio presented to it, so there is no universal position from which to start. Very noisy material may require relatively low value settings to be effective while relatively quiet material may need a much more aggressive setting. Its optimum setting will also depend on the bandwidth of the source material that it’s presented with. Like the other EZ Clean Filter® controls, its range runs from 0 to 100. Its Noisegraph® graph is adjacent to the Hiss control indicating the aggressiveness of the filter on the material vs. time. If the Hiss Noisegraph® starts to “clip” (hitting full scale), this is an indication that the filter is set too aggressively and will produce “artifacts” in the resultant sound. There will be some time delay (latency) after the Hiss control is changed before the system properly re-initializes to a new starting point noise fingerprint.
Hum Selector
The bottom portion of the Noisegraph® indicates the presence of Hum. This Noisegraph® is only active when the filter has been activated. Red indicates the presence of Hum in the 50 Hz ranges +/- 2 Hz and Orange indicates 60 Hz +/- 2 Hz depending on which mode is selected. Taller bar graphs indicate louder Hum levels, which are plotted vs. time on the Noisegraph®. You must determine the appropriate checkbox to attenuate the Hum, selecting between either 50 or 60 Hz depending on the indication on the Noisegraph®. (In general, recordings made in Europe will contain 50 Hz Hum while recordings made in North America will contain 60 Hz Hum.) If clicking on one of the two frequencies causes the Noisegraph® to produce a steady stream of Noisegraph® signals, then there is probably Hum present at that frequency. The Hum Filter will remove the fundamental component of the selected value and two harmonics thereof. So if 50 Hz is selected, 50, 100 and 150 Hz components will be attenuated. Similarly if 60 Hz is selected, the system will attenuate the 60, 120 and 180 Hz Hum components.
EZ Clean Ancillary Controls
The EZ Clean Filter® also includes the following ancillary controls:
“Run” the filter.
Note: Since the EZ Clean filter is adaptive in nature and can also be used in real- time, it will take a few seconds for it to measure the signal to noise ratio at the beginning portion of a file. This can produce a slight latency of filter action depending on the source material. If this is an issue, consider copying a few initial seconds of the file onto the clipboard and then pasting that to the beginning of the file to be processed. This will give the filter something to measure for use as its initialization process. That extra beginning of the file can be removed later with the edit cut command.
DCArt10/DC Forensics10 provides the capability of cascading up to 20 filters or effects together and running them as if they were a single filter. It also provides for a “Live” (real time feed-through) mode of operation. The elements of the string of cascaded filters can all be unique, or repetitions of the same filter/effect or a combination thereof. The multi-filter also allows you can even mix Diamond Cut filter and/or effects with VST plugins. This allows you the flexibility to construct your own favorite sequence of filters, along with their presets, and be able to save the cascade along with all of the filter parameters under one user defined single preset name.
The filter/effect combinations thereby created can by previewed or run like any other single filter. In Live Preview mode (real time feed-through) you can also run all of the filters in the chain through a full duplex sound card, using the computer as a digital signal processor. Live Preview mode is particularly useful in surveillance and live broadcast work. For details on this mode of operation, please refer to the section on “Live Preview” mode below.
The best way to envision the Multi-Filter is to merely view it as another DCArt10/DC Forensics10 filter that can be customized and sequenced. To create a customized sequence (cascade) of filters merely click on the Multi-Filter icon or select Filter/Multi-Filter, and the Multi-Filter dialog box will pop up. On the left, you will see the source input (In) to the system. On the right of the screen, you will see the output (Out). The input is that .wav file which is present in the source window, (or in the case of Live mode, it can be the sound card input signal) as is the case with any other filter. The output of the filter can be previewed, bypassed, or run just like any other filter. It can also be run in “Live Preview” mode as well (see below).
To create your filter sequence, merely drag and drop the desired filters from the filter selection grouping into the signal pathway in your prescribed order. If you want to change the order of the filters in the cascaded chain, merely left click on the filter in the pathway, and drag it to a new location along the signal path. To get rid of a filter, simply drag it away from the signal pathway with the left mouse button, releasing the button when the filter is away from the signal stream. To view the parameters of any given filter or effect in the Multi-Filter, double click on the filter icon in the cascaded chain and the particular filter dialog box will pop-up. Adjust the parameters to the values that you desire, and they shall be saved as part of the sequence of filters that you have just constructed. As with all of the filters, the parameters may be previewed while adjusting the parameters. Be aware that when long chains of filters have been created, there will be a delay in time before the controls react to your changes. If you desire to delete a filter, drag the filter out of the chain and release the left mouse button.
After you have developed a Multi-Filter chain that you find to be particularly effective for a certain type of task, you can save its settings under a descriptive name just like any other DCArt10/DC Forensics10 filter for ease of recall later.
It is important to note that improved audio performance will be achieved using the Multi-Filter as opposed to a sequence of .wav file processing, performed one step at a time. The reason is that there will not be the quantization error buildup since the Multi-Filter will maintain the highest possible resolution for the signal throughout the process from the first filter to the last one in the sequence. Sequential one step at a time filtering must always convert back to a .wav file as the intermediate step between filter operations, producing a buildup of quantization errors. This error build-up is avoided with the Multi-Filter.
Run Multiple Filters Simultaneously!
Forensics Starter Setup preset in the Multifilter
The “Forensics Starter Setup” preset found in the Multifilter is a very good place to start a Forensics enhancement project. It includes a plethora of useful filters all having good starting point settings. From those starting point values, you can adjust each filter element for optimal results for a given enhancement project.
Live (real time feed-through) mode allows you to bypass the hard disk recording process, making your computer into a real-time feed-through digital signal processor. Signals are fed into your sound card, processed through the filter or filters chosen, and then fed back out of the output of the sound card for use "live." Live mode is useful for professional applications such as broadcasting, or surveillance work where a signal needs to be processed in real-time without the intervening process of hard drive recording. It is also very handy for use in a Ham Radio, Short Wave listening (DXing) or even as a permanent part of a home audio system as a real time signal processor. This feature is particularly useful for real time audio restoration as may be required by radio stations desiring to play old vinyl or 78s directly on the air. It is also useful for cleaning up live news audio feeds or noisy telephone audio on talk radio shows.
This feature requires a full-duplex sound card and a fast computer. We recommend the fastest computer that you can afford, since the faster that your computer can perform the mathematical functions, the more filters that you can cascade in "Live" mode. System "stuttering" is an indication that you have exceeded your computer's ability to keep up with the data processing in real-time. Also, latency (the time delay for processing) is reduced as the speed of your computer is increased. For professional applications, we recommend a Pentium 4 or higher for "Live Preview" mode when used in conjunction with the Multi-Filter feature. However, slower computers will run with increased latency and a reduced maximum number of allowable cascaded filters.
Live mode is activated by clicking the “Live Preview” button in the Multi-Filter window. To adjust the input parameters for your sound card, double click on the input icon (the turntable) and a dialog box will pop-up. The following input parameters are adjustable:
Adjust the parameters appropriately. Keep in mind that stereo signals will consume about twice the computer resources compared to monophonic signals. So, if you do not need stereo, do not operate the Live mode in stereo, else you will be adding extra latency to the signal and reduce the number of filters that can be run without “stuttering”.
Drag and drop the filters of interest into the signal path. Adjust their parameters by double clicking on each filter, producing its dialog box.
To run the "Live" mode, merely click on the "Live Preview" button, and the signal will be processed through the filters/effects in the signal path. To adjust the output level, double click on the output device (the loudspeaker icon) and a dialog box will appear to facilitate this function. You can also create .wav files in real time while using the Live mode. This feature is also contained in the output device dialog box.
To delete a filter from the line-up, simply drag it out of the pathway or use the right-mouse function called “Delete Filter”. To clear the entire signal pathway, use the right mouse function called “Delete All Filters”.
Note: To minimize Live Preview Mode latency, use the smallest number of preview buffers and the highest possible sampling rate that your system will support. Minimum latency will generally occur at 96 kHz or 192 kHz sampling rates. (Conceptually, this is probably counter-intuitive.)
Important Note: When using "Live" mode, it is not advisable to connect the soundcard I/O in an effects loop on a mixing console. Doing so can produce echo effects due to the latency of the computational process. Instead, connect the soundcard directly in the signal pathway which you desire to process.
Live Log to Disk Mode (DC Forensics Versions Only)
You can now "Log to Disk" (to your hard drive) both the input and/or output content of the signal path being used in Live mode via the Multi-Filter. These features can be useful when it is necessary to create an archival recording of a surveillance or of a broadcast session. It is possible to log both the unprocessed and processed data simultaneously to your hard drive for later retrieval. To perform the Log to Disc functions, merely click on the appropriate Log button(s) that you want to set up. To log the raw source data, click on the “Log Input” button and it will become highlighted. To log the processed data, click on the “Log Output” button and it will become highlighted. You can log the Input and Output signals simultaneously if you desire by clicking and therefore activating both logging functions. Whenever you click on the "Live" button, whatever signals are being presented to the Multi-Filter will be logged to the disk under the Filename(s) indicated next to the “Log Input” and “Log Output” toggle buttons.
Both input and output logging can be stopped and started during a live session, and neither has to be enabled when live mode is first started. Log to disk data will be appended to the files that are shown in the log filename boxes. If the Multi-Filter is closed and re-opened, a new temp filename will be selected in the log filename boxes. The Automatic VOX and Time/Date Stamp feature applies to both the input and output logging function when checked.
Live Mode VOX Time/Date Stamp (Forensics Versions Only)
By checking the box labeled Automatic VOX Time/date Stamp, DC Forensics10 will add a marker each time a recording starts in VOX mode. This is useful for remote location or surveillance recording. By enabling this function, the system will record only when audio is actually present to be recorded and each recording event will be marked with the exact time and date of the individual recording. This function is useful only in Live mode.
Flashback (DC Forensics Versions Only)
Flashback lets you quickly Review and Clean an audio stream Live without interrupting your recording
Flashback is primarily designed to be used in real time intelligence gathering and Forensics surveillance situations. It is a feature that allows you to go back and listen to something that you may have heard during real time operation of the software that may be of immediate interest and needs rapid clarification, especially in covert military situations. This feature is available when you are operating the Multi-Filter in Live mode and is only available in the Forensics version of the software. It uses RAM to store up to 300 seconds (5 minutes) of audio data in stereophonic 16-bit, 44.1 kHz format on a FIFO basis. Therefore, it will require about 53 Mbytes of available RAM in order to properly function. It can be operated with or without the log to disc function(s) activated. Faster sampling rates used in the Multi-Filter recorder will de-rate the available Flashback time availability. Flashback always operates on the output signal of the Multi-Filter. Therefore, signal processed data as set up in the Multi-Filter is fed into the Flashback buffer memory.
The controls for the Flashback feature are as follows:
Available Flashback Time as a Function of Sampling Rate | ||||
Sampling Rate | 44.1 kHz | 48 kHz | 96 kHz | 192 kHz |
Available Flashback Time | 5 Minutes | 4.5 Minutes | 2.3 Minutes | 1.2 Minutes |
DCArt10/DC Forensics10 includes the ability to accept (or host) up to six standard VST plug-ins. There are thousands of compatible plug-ins available which offer many types of audio processing routines. Plug-ins range in price from free to super expensive and are available over the Internet. (DirectX plugins are not supported.)
The VST Toolbar
Before you attempt to apply a VST Plug-in tool, you must first install it onto your computer and then add it to the list of available VST .dll routines inside the Diamond Cut Software Program.
To add an installed VST into your Diamond Cut Software, click on the add/remove function next to the VST slots under the Effects menu. A dialog box will appear as shown here:
Add VST Plugin Dialog Box
Next, click on one of the “Add VST x” slots and then click on “Add VST” and steer to the location of your installed VST plugin .dll using the dialog box, as shown here:
VST .dll location dialog box
That operation will assign that particular VST plugin to the selected slot. You can do this for up to a total of six VST plugins. The installed VST .dll plugins are generally found in one of the program folders under the “C” drive.
You can use the Delete button to remove VST Plugin tools from the “Availability” list.
To use a VST plugin, just go to the Effects menu and then click on one of the populated VST Plug-ins slots. A screen similar to the one shown here will then appear. Like all of the Diamond Cut Software tools, you have the standard “Run Effect”, “Preview”, and “Close” buttons available.
A VST Plugin launched in Diamond Cut Forensics10
A VST Effect in Context
Once you have added tools you can enable them for actual use by double clicking on the desired plug-ins. Clicking on a tool will bring up that specific plug-in’s graphic controls. It can then be dragged and placed anywhere on your workspace. Chaining of VST Plug-ins is possible using the Diamond Cut Multifilter. Since VST Plug-in tools are written by programmers other than the authors of DC Forensics10, we can’t predict what you will ultimately see on the multifilter screen.
Usage from this point forward is like any other built in tool with DC Forensics10; just preview and adjust or run the VST filter or effect to suit your needs.
Using VST Plug-ins in the Multi-Filter
VST Plug-ins Integrate into the Multi-Filter
As can be seen above, the new VST icon(s) are available in the Multi-Filter so that these types of tools can be freely used with all the native DC Forensics10 tools. Please see the section in the users’ manual describing the Multi-Filter topic for specifics on the use of these tools when cascaded with others.
Caution:
Being able to use audio tools designed by dozens of different companies is a powerful feature in your Diamond Cut software. However, it must be remembered that these tools are all independently designed and created by their respective manufacturers and are not created or supported by Diamond Cut Productions, Inc. Correctly written VST Plug-ins should work fine in the program, but it is possible to download a poorly written or buggy plug-in. If you find that a specific plug-in is behaving strangely, we recommend contacting the VST plugin manufacturer or simply deleting or uninstalling it from your hard drive.
Impulse Noise Filters (Attenuates Clicks, Ticks, Crackle, Snaps, Pops, Thuds, Static & Buzz)
Four Impulse Noise filters are provided in the DCArt10/DC Forensics10 suite. They are all found under the Filter sub-group called “Impulse”. The EZ Impulse Noise Filter provides you with a high degree of automation (adaptive techniques) to simplify the impulse noise reduction process, with the tradeoff of reduced user controllability. This is the “goto” filter of choice for most impulse noise reduction work. The Expert Impulse Noise filter provides a very high degree of adjustability for those who want to customize the system to their own personal preferences. Some people like create a custom impulse filter via multiple Expert Impulse Noise Filters in the multifilter with each one set to different modes and parameters. However, this impulse filter is difficult to use, especially for the casual user. The Narrow Crackle filter specializes in handling impulse noise having narrow pulse width. The Big Click Filter specializes in very large clicks and thuds only. All of these filters are non-linear algorithms used to eliminate pops, ticks, clicks, and crackles from audio recordings. It is also useful for the elimination of "static" interference from AM, FM, or Short Wave radio broadcasts. It can also be quite effective for attenuating high frequency line related “buzz” from certain recordings. All of these types of noise signals generally look like impulses (although sometimes referred to as "spikes"), and therefore the name “Impulse Noise Filter”. The algorithm essentially monitors for fast events, and when their value exceeds a threshold value, the algorithm blanks out the portion of the file wherein the fast event occurred, and re-inserts a waveform that is an approximation of the signal that likely would have occurred during the event. The phase of the inserted signal is aligned to match the point in time in the file where it is inserted so that there is no phase discontinuity, and therefore almost no artifact will be injected into the .wav file.
EZ Impulse Noise Filter
The EZ Impulse Noise Filter combines the noise rejection characteristics of the more user controllable performance of the “Expert-Impulse” Filter with some automation and the resultant ease of use. The purpose of this filter is the attenuation of record clicks, ticks, crackle, and pops. It can also used to reduce radio static interference and can be used to remove some high frequency “buzz” related to the power line frequency. It has only three controls that need to be set by the user. One control determines the aggressiveness of the EZ-Impulse Filter’s response to large scratches or impulses. A second control affects its response to “crackle” which is another term for smaller and densely populated impulses. The “Narrow Crackle” control affects its response to smaller impulsive events. Three bar graphs provide the user with visual feedback as to the effect that each of the controls has on the signal. A tally of “Total Clicks Fixed” is also provided for use as a relative reference and an operational aid. The following is a listing of the EZ-Impulse Filters controls:
EZ Impulse- Powerful and Easy To Use!
This control sets the threshold for the detection and interpolation of large clicks, pops and scratches. Low numbers are less aggressive, while large numbers are more aggressive. The normalized range for this control is 0 to 100.00
This control sets the threshold for the detection and interpolation of small clicks, crackle, impulses and high frequency “buzz”. Like the Scratch control, low numbers are least aggressive, while large numbers provide a more aggressive response. The normalized range for this control is also 0 to 100.00
This control sets the sensitivity of the system to narrow pulse width crackle. Like the other controls, increased values represent increased sensitivity to this type of noise. The normalized range for this control is 0 to 100.00 with a good place to start being around 50.
This feature enables a “Big Click Filter” having a fixed ratio setting of 1.4. For details pertaining to the functionality of a “Big Click Filter”, please refer to the section of this User’s Manual having that name.
All three filter controls have their own “Clicks per Second” bar graph having a range of display of 0 to 400. These three graphs are useful for setting their respective controls. Indications that are too low may mean that the system is not sensitive enough to pick up the impulses, while indications that are too high may indicate that the Wave file is being damaged by overreaction of the filter(s). Using these graphs, in conjunction with the “Preview” mode makes the setting of the EZ Impulse Filter very simple and effective.
The Total Fixed accumulator counts the total number of impulsive events repaired by the system. It responds to the Scratches and Crackles, but not to the Narrow Crackle function.
This control allows you to hear the unprocessed signal for comparison purposes.
Choose this setting when brass instrument solos or up-front vocal solos are causing distortion when using the EZ Impulse filter. This feature will suppress distortion produced by those instruments or strong lead vocals. It should not be used on material that does not contain up-front brass or up front vocals as the filters performance will be compromised under those circumstances.
EZ Impulse Noise Procedure (Tutorial)
The EZ Impulse Filter operating procedure is as simple as one, two, three.
Also, an array of presets is provided with the EZ Impulse Filter that may produce reasonable results without the need for adjusting the filters controls. However, the optimum results will usually be obtained by following the above-mentioned four-step procedure since impulse noise removal is source material dependent.
Note 1: Use the Impulse Noise filter(s) first in your audio restoration
sequence. Never pre-filter the signal prior to this restoration step. The filter needs the maximum bandwidth signal to help it to perform its function.
Note2: Improved performance of this filter can be achieved by recording at a 48 kHz or 96 kHz sampling rate. The filter takes advantage of the ultrasonic content of the impulse signal provided by a higher sample rate in order to improve detection and discrimination of impulsive noise. You can down-convert to 44.1 kHz immediately after the de-clicking process has been completed if you so choose, since the remaining filters will not specifically benefit from a higher sampling rate.
Note 3: Up-Sampling a file to 96 kHz that was originally sampled at 44.1 KHz or lower will not provide the same benefits outlined in Note 2. The EZ Impulse filter primarily benefits from a 48 kHz or a 96 kHz sampled file that was originally digitized (transferred) at one of these higher rates from its analog source during the Analog to Digital conversion process.
As your expertise with the product grows, so too will your demands from the various filters. The Expert Impulse Noise Filter approach allows you to control all of the parameters associated with a basic impulse filter and therefore obtain the most flexible results. Since it contains no adaptive elements, it does require a larger degree of experience to use compared to the EZ Impulse Filter. Multiple Expert Impulse Noise filters placed in the multifilter will often provide the best results, with each instance set up with different modes and/or parameters. Generally speaking, the Expert Impulse Noise Filter is designed to remove impulsive noises from a signal such as clicks, ticks, scratches, pops and static. It can also be used to attenuate harmonically rich “buzz” from a recording. The Expert Impulse Noise filter is primarily intended to be used in extremely unusual phonographic situations or (primarily) for Forensics applications in order to filter out buzz or static from a communications link. You will find that the EZ Impulse filter solves almost all impulsive noise problems that you will encounter, but for the rare few situations that occasionally pop up. So, try the EZ Impulse filter first before experimenting around with the Expert Impulse Filter. As with all of the Diamond Cut Impulse Filters, the minimum sample rate used should be 44.1 kHz. Lower sample rates will produce inferior results. The following is a summary of the Expert Impulse Noise Filter control parameter functionality and their adjustment ranges:
Expert Impulse Noise Filter
This is the Voltage derivative signal level above which the program decides that an impulse noise event has occurred. It has a range of adjustment from 1 to 18,000 (in DAC counts normalized to a 16 bit system). A good starting point for the threshold value is 1/3rd of the full-scale value of the envelope of your .wav file. For example, if the .wav file is almost full scale in amplitude (+/- 32,000 counts) set the threshold at around 10,000.
For 78 RPM records, (with the Tracking control set to 0), start with a Threshold value of 1000, and adjust up or down depending on the results obtained. Lower values of Threshold will produce a higher degree of de-clicking. If it is set too low, however, you will produce distortion on your recording. If you do not want to start at 1000, use the 1/3rd of full-scale rule for your initial setting.
Note: Threshold should be set to its lowest value (slider down) for Vinyl LP/45 RPM applications. Adjustments should be made using the Tracking adjustment for these applications.
This is the number of samples during which the "click" or "pop" event must remain to be defined as an impulse noise event. It has a range of adjustment from 2 to 60 samples. Short "clicks" require a smaller setting compared to longer "pops." A good range of values to start with for Vinyl LP applications is in the 10 to 15 area. A good range of values to use for non-Vinyl (like 78-RPM records) is between 3 to 7 samples.
This is the value of rectified output Voltage from a High-pass filter that is used to modulate the threshold Voltage of the filter. When there is a lot of high frequency information present on the recording, like the crashing of cymbals, it is desirable to move the threshold higher in value so that the transients contained in such sounds are not mistaken to be impulse noise events. Tracking has a range of adjustment from 1 to 100 (in relative units). Tracking is most useful on "high fidelity" recordings that contain a lot of "real" high frequency information such as loud dynamic cymbal crashes, or exaggerated sibilant sounds, which may be interpreted by the Impulse Filter as impulse transients.
Most 78s de-click best with the tracking turned all the way down (to a setting of 1). For LPs, start with a setting of around 25 to 30, and adjust the value upwards if distortion is heard on high frequency passages or sibilant sounds, until the distortion disappears. However, if the tracking is set too high, adequate de-clicking may not be obtained.
Note: Tracking should be set to its lowest value (slider down) for non-Vinyl LP applications. Adjustments should be made using the Threshold adjustment in these applications. If the threshold control is set too high, the Impulse filter will not completely de-click your recording. If it is set too low, the filter will create distortion on your recording when high frequency signals are present, especially on the higher registers of the audio scale.
When enabled, this allows you to hear quickly the results of your chosen settings in real time. If your computer is a slower model, the system may "stutter" when this is enabled, however, the feature can still be quite useful for finding the best settings, since the "stutter" will not appear on the final product when the filter is “Run”. The slider controls can be adjusted "live" when the preview mode is enabled. Preview mode is invoked merely by clicking on the "Preview" button on the filter dialog box.
When this is enabled, a different type of detector algorithm is utilized which is more optimized for the wider bandwidth and narrower clicks and pops encountered with Vinyl LPs. Vinyl mode works most effectively on .wav files that are sampled at 44.1 kHz up to 96 kHz. When this mode is turned off, the detector is more optimized for slower and wider impulse noise. Unlike most of the other controls, you cannot switch Vinyl LP mode on or off "live" when preview mode is invoked. Use the following table for determining the correct mode for this selector based on the type of material you are working with:
Sound Source | Vinyl LP Mode |
Vinyl LP (Stereo or Mono) | "On" |
45 RPM | "On" |
FM Impulse Noise | "On" |
FM Stereo Impulse Noise | "On" |
Acoustical 78s | "Off" |
Electrical 78s | "Off" |
Cylinders | "Off" |
Hill and Dales | "Off" |
Movie Soundtrack "Pops" | "Off" |
AM or Short-Wave Static | "Off" |
Forensic Audio | "Off" |
Note 1: When you run the Expert Impulse Filter, a dialog box will appear which indicates the Clicks/Second and the Total Clicks Processed. The Clicks/Second statistic is relative to the timing of your .wav file, and not the time frame in which your computer is processing the data. This feature is provided to help you determine if you are "trashing" (creating distortion) your .wav file due to Thresholds or Tracking values that are set too low. When the algorithm's parameters are set too aggressively, the Clicks / Second number will become extremely high, which could be an indication of impending distortion of your .wav file (although it depends largely on the condition of your Source material).
Note 2: Multiple runs of the impulse filter(s) set un-aggressively will produce better results than running an impulse filter aggressively. Consider setting up multiple Impulse Filters strung together in the Diamond Cut Multi-Filter to facilitate this approach easily.
DCArt10 and DC Forensics10 have included an enhancement to the Impulse filter called Hind Quaternion mode (a name related to the method used in the click detector portion of the Impulse filter). This mode can be used with 78s, vinyl, or any source containing impulsive type noise or clipping distortion. Its operation couples several related variables in this new detector algorithm together in a logical ratio-metric relationship allowing you to vary them with one control. The Size slider controls these new variables. The other controls on the Impulse filter still perform their previously defined functions. In HQ mode, you will find that you have a much larger degree of control of the detector algorithm, especially through the use of the Size control. Small fast rise time clicks will be detected optimally with small values of Size while larger and slower events will be best detected with larger settings. The advantage of this mode is an improvement in the ability of the detector to reject musical transients while still maintaining good click sensitivity.
Universal Mode provides an adaptive element to the detector portion of the Expert Impulse Filter algorithm. It can be used with any type of impulsive noise, whether the source is from records (78s, 45s, 33.3s), radio static, or tape head static discharge. Universal Mode is of particular advantage in some wireless surveillance applications where occasional static needs to be mitigated. The advantage of this mode is its ability to adapt to changing signal environments. The Tracking control is its primary means of adjustment. The Tracking control affects the systems overall centered value of sensitivity while the Threshold control sets the minimum value that the system can apply to the detector. The size control does the same thing as with the all of the other modes associated with the Expert Impulse Filter. The disadvantage of the Universal Mode detector is its diminished transient response. This will cause the system to have some difficulty in dealing with the leading edges of rapidly changing audio material, since it will take some time to re-adjust itself. This could cause some transient leading edge distortion and/or leading edge missed impulse detection.
Important Note: The various Impulse Noise filter modes (LP, 78, HQ, Universal) all take a somewhat different approach toward identifying clicks and pops. Since these types of impulses can come in an almost infinite number of sizes and types, a user may select the mode that provides good results over a very wide range of impulsive noise environments.
DCArt10/DC Forensics10 provides you with a discriminator routine which identifies brass instruments (and certain types of vocal solos) and excludes them as candidates for interpolation. Since brass musical instruments (like solo trumpets) produce waveforms that are quite similar in form to impulsive noise events, this option can be quite useful in preventing distortion from being interjected upon those types of instruments. This mode of operation is also useful on some “close-miked” vocals where the background instrumentation is low in sound level comparatively speaking. The tradeoff with using Solo/Brass mode of operation is reduced de-clicking capability during the actual presence of the brass instrument or vocal in question. This mode should not be used on material that does not contain strong solo brass instruments or up-front lead vocals.
Note 1: Do not mute the beginning or the ending of a .wav file before operating the impulse noise filter. Mute the extraneous noises from the beginning and the ending of your .wav file at the end of all of your audio restoration processes.
Note 2: There will be occasions wherein 78-RPM recordings will benefit from the de-clicking action of the vinyl mode impulse filter in conjunction with the tracking control. If the clicks are small and short, it is worth giving it a try.
Note 3: Multiple passes through the impulse filter, especially in vinyl mode while using the tracking control, can produce ever-improving results, especially when Solo/Brass mode is enabled.
Expert-Impulse Noise Operating Procedure (Tutorial)
Note: This feature is also utilized for 45-RPM records. If you are de-clicking a 78-RPM record or something similar, make sure "Vinyl LP" is turned-off. (It is important to re-emphasize that Vinyl LP mode works best on .wav files that have been sampled at 44.1 kHz or higher.)
Note: Setting the filter too aggressively may cause excessive stuttering during Preview. Even a fast computer will stutter when this filter is finding hundreds of clicks per second. If this is happening, readjust the filter to be less aggressive.
Note: Notes 1, 2 & 3 found at the end of the EZ Impulse Filter Tutorial also apply to the Expert Impulse Noise Filter.
Narrow Crackle Filter
The Diamond Cut Narrow Crackle Filter (NCF) is a special impulse filter designed to identify and interpolate narrow pulse-width crackle type noise. It is especially effective on mint condition LPs having only very small impulsive noise due to vinyl defects or static electricity discharge effects. This filter is also useful on other recording types provided that larger impulsive noises have been removed by one of the other Diamond Cut Impulse Noise filters first. Additionally, it can be used to remove some power-line frequency related high frequency “buzz” (which is high frequency & harmonically rich “hum”). The advantage of the Narrow Crackle filter is that it is the least invasive of all of the impulse noise reduction filters in the Diamond Cut suite. We have found it to be effective in reducing the residual crackle sounds on not only Vinyl LPs, but also transcription acetate recordings and 78s after all of the other impulsive noises have been removed first. It is not effective for removing impulses due to poor record handling; use the EZ Impulse filter for those situations. The Narrow Crackle Impulse Noise Filter is very easy to operate, having only two controls which are as follows:
The Narrow Crackle Impulse Noise Filter
The Narrow Crackle Filter’s “Events” bar graph provides you with a relative indication of how aggressively the filter is operating. It “modulates” vertically in proportion to the number of events that are being interpolated by the system. The “Keep Residue” feature allows you to hear what the Narrow Crackle Filter is removing from your source signal. A good way to “tweak” this filter is to highlight a short sector (around 10 seconds) of the .wav file that has the type of narrow crackle impulse noise that you desire to eliminate or attenuate. Preview that sector and adjust the two controls for the best result on that 10 second sector. After you are satisfied with your settings, it should then do a fine job on the entire file in “Run Filter” mode.
The Big Click Filter (BCF) handles exactly what the name implies which includes the elimination of very large clicks but also loud thuds. Its response intentionally ignores smaller clicks and ticks. Its response covers the long time interval range of events lasting greater than 2 mSec but less than 200 mSec. Its detector is actually sensitive to the time amplitude product of the applied signal. This parameter is user adjustable by way of the “ratio” control which has a range which can be varied between 0.75 and 2.5. 1.4 is a good starting place with higher values decreasing the filters aggressiveness and lower values increasing aggressiveness.
Figure 57 – Big Click Impulse Filter
This filter is very useful for fixing big clicks caused by phonograph records that are cracked or have been glued back together or have major gouges on their surface. It is also very useful for interpolating some of the long lived noises found on 16 inch acetate transcription recordings. Finally, it has a Forensics audio application in that it can attenuate cell phone noise interference from audio recordings. The BCF will not remove nominal clicks, ticks or crackle from a recording; use the EZ Impulse filter to remove those noises after running the BCF. Big clicks should always be removed as the first step of the de-clicking process before attempting to remove smaller impulsive noise using any of the other Impulse filters. The interpolation portion of the algorithm uses a frequency domain technique. Big Click Signals which last up to 200 mSec are able to be handled by this filter. A minimum impulse size of 2 mSec can be handled by the BCF. Very large clicks and thuds sometimes excite the resonance of a tone arm leaving behind a long-lived low frequency “tail” or “thump”. This tone arm resonant “thump” can be dramatically reduced by checking the checkbox labeled “De-Thump” which rejects the de-clicked “tail” for a period of time of 150 mSec past the end of the interpolation portion of the Big Click Filter algorithm. It is important to note that the “De-Thump” function will only remove “Thumps” that are preceded by a large click event; it is not capable of removing stand-alone thumps from recordings.
The Big Click filter has the following controls and indicators with the following ranges of adjustment:
A demo .wav file is provided in the Wavefiles folder within your Diamond Cut Directory called “BigClickCracked78Demo.wav”. Use this file to experiment with the Big Click Filter.
Note: Always use the BCF as the first step in your restoration process (assuming that you have a Big Click Issue). Use the other Impulse Filters as the next step(s).
This filter is useful for reducing background "Hiss" and other constant noise from a recording or from a noisy AM or FM radio transmission. Magnetic tape recordings and phonograph records all contain a residual background “Hiss” type of noise that can be reduced with this filter. It is referred to as a "Continuous" noise filter (or CNF) because unlike impulse noise, hiss is present at all times. When adjusted properly, this filter can almost completely eliminate all residual continuous noise from a recording. However, it is easy to overuse this filter and leave the recording sounding dead and lifeless, and also introduce digital artifacts into the signal (music or speech).
The Continuous Noise Filter has 4 modes of operation to choose from:
To use this filter in Normal CNF or Spectral Subtraction modes, you must first take a sample of a section of noise from your file. This noise template will then be used by the algorithm to discriminate between what constitutes noise and what constitutes music or speech during the filtering process. It is important to sample a section of the .wav file that does not contain any music/speech so that the filter does not remove signals that contain musical or speech information. Of course, it can be used in the opposite sense too. If you sample on a sound that you do not want other than noise, it will attenuate that sound from the final result.
Note: We strongly recommend trying the Artifact Suppression mode when using this filter; its performance is often much better than standard mode and allows for a more aggressive use of the Attenuation Control without the production of digital artifacts.
The Continuous Noise Filter
The CNF graphically shows a frequency spectrum of the sampled noise in red (sometimes referred to as a noise-print or noise fingerprint). This spectrum represents the amount of noise at each frequency band in the recording. The blue line represents the filter design that has been created by the software program. You can use the mouse to move the blue threshold line to tailor the kind of noise reduction that the filter performs to your taste.
This filter should only be used on recordings that have little or no impulse noise, or on recordings that have already been processed through the Impulse Noise Filter(s) in order to minimize the possibility of producing digital artifacts. When operating this filter in the Auto Spectrum CNF Mode, the system will automatically find and modify its own noise fingerprint on-the-fly. Therefore, there is no need to manually take a noise fingerprint when operating in the Auto Spectrum CNF Mode.
This is one of two different types of non-linear filters that can be used to reduce noise from a signal source. Like the Dynamic Noise Filter, it is useful for reducing "Hiss" from a recording or from a noisy FM radio transmission. However, unlike the Dynamic Noise Filter, it will also reduce lower frequency noise. When adjusted carefully, it can almost completely eliminate all residual noise from a recording. However, when compared to the Dynamic Noise Filter, this filter is a bit trickier to adjust so as to avoid the introduction of digital noise artifacts into the Destination .wav file. It also can have some detrimental effects on the "presence" and the musical transient content of a .wav file when not properly adjusted.
This filter takes a sampling of your file and converts it into the frequency domain utilizing a Fast Fourier transform. Next it marches along to the next time interval and performs another Fourier transform. It keeps repeating this process until the entire .wav file is converted into samples which are no longer representing the time domain, but strictly represented in the frequency domain, with the appropriate Voltage, phase and frequency co-efficients for each window contained in memory. The entire audio spectrum is divided into up to 8,192 bands by a 16,384 point fast Fourier transform (FFT) algorithm (the resolution of which is user selectable). When a signal in a particular band exceeds a threshold (when operating in the Normal CNF or the Auto Spectrum CNF Modes) that you can define graphically, then that particular band is allowed to pass its signal from the input of the algorithm to the output of the algorithm. Lastly, the entire file is then re-converted back into the time domain via an inverse fast Fourier Transform. So effectively the only time during which bandwidth is provided at any of the selected number of frequency buckets is when there is a useful signal present in that portion of the audio spectrum. Otherwise, the remaining frequency bands are attenuated to a varying degree (depending on the Attenuation Control setting).
Insert Additional Control Points onto the Continuous Noise Filter
By simply right clicking anywhere on the Frequency Spectrum of the Continuous Noise Filter, you can insert your own additional Control Point(s) onto the graphical display. This can help increase the flexibility and power of the filter. Upon right clicking of your mouse, the menu that appears allows you to add a point, delete a point, or reset the control point count to the factory default setting of 11.
The following is a summary of the control parameters functionality and range of adjustment provided by the Continuous Noise Filter:
This is the time required for any of the filters to "open up" on the leading edge of a signal that exceeds the threshold line on the spectral graph.
This represents the time constant normalized value at 1 kHz. The time constant for filter frequencies operating above 1 kHz will be shorter than the setting, and the time constant for filter frequencies operating below 1 kHz will be longer.
(The Attack time constant value is weighted with a -1 slope across the audio spectrum.) Small values of attack provide excellent transient response, while long values provide a minimization of digital artifacts produced by the system. A good value to start with for the Attack Time parameter is around 100 Milliseconds. The total range of adjustment for Attack time is 1.0 to 300 milliseconds. Smaller settings will improve transient response but allow more digital artifacts to pass through. Larger values will decrease transient response, but will minimize the production of artifacts during the noise reduction process.
This is the time allowed for any of the filters to "close down" or "decay" following a signal that falls below the blue threshold line on the spectral graph. All remaining characteristics of the Release time Constant are the same in nature as the Attack time Constant. A good value to start with for the Release Time parameter is around 200 Milliseconds. If there is too much fast filter "breathing" (a digital artifact that is also sometimes referred to as “pumping”), lengthen this time until you are satisfied with the result. The total range of adjustment for Release time is 1.0 to 1000 milliseconds.
This control sets the degree of attenuation for signals that are present and below the blue threshold line. The greater that one sets the Attenuation control, the greater will be the degree of noise reduction. However, the greater the degree of noise reduction achieved, the greater will be the loss of the sense of "Ambiance" on the resultant recording. So you must make a careful judgment as the correct tradeoff between noise reduction and ambiance for the material you are dealing with. A good value for the Attenuation parameter is around 10 dB to start with. If there is too much loss in signal ambiance, decrease this value. If you desire more noise reduction, increase this value. If you increase the attenuation too much, you will begin to introduce some digital aliasing artifacts into the Destination .wav file. The total range of adjustment for Attenuation is 0 to 100 dB.
This feature controls the threshold value above which a signal at a particular frequency must exceed before it is passed through to the output of the algorithm without attenuation. It works in conjunction with the "sample noise" button. Although the continuous noise filter has up to 8,192 discrete frequency bands, it would be inconvenient to have to set each of them. DCArt10/DC Forensics10 provides up to 256 inflection points (shown as blue dots connected by blue lines on the graph of amplitude vs. frequency) that can be moved along both the frequency and the amplitude axis. The software will place these inflection points automatically at approximately 10 dB above the noise floor after you perform the "sample noise" function. Try these settings first to find out if the results are acceptable. Thereafter, if there seems to be some noise that needs more attenuation at a particular frequency, adjust the threshold upwards utilizing the left mouse button at the frequency of interest until you are satisfied with the results. The graphical threshold line is adjustable "live" when preview mode is enabled. If you want more than the 11 inflection points provided by default, double click using the left mouse button while pointing at the desired position on the graph. To remove inflection points, use the right mouse button in a similar manner.
a) Up & Down "Shift Threshold" Control - This feature allows you to globally shift the entire threshold line up or down independent of frequency. The feature consists of an up and down arrow box. It is operated via the left mouse button. The amplitude resolution of the control is 4 dB / click. After clicking on either of the arrows, you will see the entire threshold line shift in the direction of the chosen arrow.
b) "Reset" Control - This button will restore all of the threshold line inflection points to their original default settings.
When enabled, the "Keep Residue" function will allow you to "preview" (hear) or process to the Destination Workspace the algebraic difference between the Source File and the Filters Output. In essence, you will be listening to the noise which would have been removed from the Source File had this function not been enabled. It is sometimes useful (via this function) to be able to hear just how much of the real audio signal along with the noise components that you are removing from the source signal. However, it is only fair to warn the user not to make final adjustments using this feature, as that technique can be quite deceptive. It is always best to optimize your parametric settings for the best results while listening to the actual processed filter output signal (i.e. "Keep Residue" function off).
This mode of operation reduces the level of digital artifacts (sometimes referred to as “the birdies”) produced by the CNF during its noise reduction process, especially when it is being used aggressively. It can also be used to effectively reduce some forms of inter-modulation distortion (IM Distortion) from a recording (like that “raspy” sound found on some distorted 45 RPM records - - - especially on vocals). When operating the CNF in Artifact Suppression Mode, the Attack and Release functions are eliminated in that the routine operates independently of those parameters. The “Attack” control will become grayed out and the Release control will revert to a new mode of operation simply called “Artifacts”. The artifact suppression mode not available when operating in the Auto Spectrum CNF mode. In artifact suppression mode, use the CNF as you normally would, including the taking of a noise print sample in the other two modes of CNF operation (normal mode and spectral subtraction mode). The Artifact Suppression control affects the degree to which the system attenuates digital artifacts with higher settings providing a more aggressive action. You should note that higher levels of “Attenuation” are achievable in Artifact Suppression Mode compared to non-Artifact Suppression mode. 40 to 50 is a good setting to start with for the Attenuation control with an FFT size set to 4096. Experiment with FFT sizes on each side of the recommended value to find the optimal result on any particular file. 200 is a good setting to start with for the Artifact Suppression Control. Adjust this control upwards for an increased artifact reduction effect and downwards for a reduction in the removal of audio material (ambience and transients, etc). Use this control to find the best balance between those two sonic characteristics of the particular material that you are working with. Note that the optimal settings for the mentioned controls are substantially source material dependent. Using the “Keep Residue” mode will allow you to monitor how much audio material is being removed from the signal by the CNF Artifact Suppression system.
The Artifact Suppression system is not functional in Auto Spectrum mode but does operate in Normal mode, Spectral Subtraction mode and Forensics AFDF mode. Also, it is to be noted that fairly high FFT sizes produce more optimal results with this system. FFT sizes below 1024 are not recommended with the Artifact Suppressor because the system is less effective due to the poor frequency resolution associated with reduced FFT count. It is worth noting that the Artifact Suppression mode requires much higher levels of CPU resources and thus takes around 4 times longer to process a given file compared to the normal (non-Artifact Suppression) mode.
An alternative to Artifact Suppression mode is Smoothing Mode. The smoothing checkbox applies some additional signal processing that reduces the digital artifacts or “Musical Noise” that may be heard when applying the Continuous Noise Filter by averaging adjacent frequency bins within an FFT. This feature is most useful on very noisy recordings with high levels of surface noise such as old 78s or extremely noisy Forensics situations. When using the smoothing function, you should be able to increase the level of noise reduction without introducing digital artifacts by about 3 dB or more. The tradeoff (and there are always tradeoffs), is that the frequency selectivity is reduced in this mode (sometimes resulting in reduced bass response). An example of where the smoothing function would not be useful would be when you are trying to remove pure tones or steady state buzzing sounds where you need to maintain a high degree of frequency selectivity. Please note that this function can’t be used in conjunction with the Artifact Suppression mode. It is an alternative to Artifact Suppression mode.
Choose between 32, 64, 128, 256, 512, 1,024, 2,048, 4,096, 8,192, and 16,384.
The frequency resolution of the Continuous Noise Filter can be adjusted. This parameter determines the number of frequency bins used by the FFT algorithm. The actual number of frequency bins produced is the FFT Size divided by two (since the FFT produces data for both the real and imaginary planes). Large values of resolution produce the largest degree frequency selectivity and thus high degrees of noise reduction, while the best time domain transient response will be realized with smaller FFT values. Put another way, there is a tradeoff between frequency resolution and time resolution and they are inversely related to one another. You will have to experiment with the various binary weighted values to determine the best resolution for the material that you are dealing with. Listen for the best levels of noise reduction attainable while minimizing any digital artifacts and yet maintaining good musical transient response on things like rim shots on drums, and other percussive instruments.
Important Note:
This parameter cannot be adjusted while the filter is previewing or running.
This allows you to choose the percentage of overlap between FFT windows. The range for this adjustment is 30% to 50%. Often, reduced values of % overlap will yield better results in terms of digital artifacts produced, but will take longer to process. Conversely, larger values of overlap will produce more digital artifacts, but take less time to process. Start with 50% and lower it order to achieve faster sonic transients tracking. Note that this feature is only available in the DC Forensics10 Audio Laboratory version of the software. The overlap parameter is fixed at 50% in the DCArt10 version of the software and is not visible to the user.
This changes the mode of the Continuous Noise Filter into a spectral subtraction system making it especially useful for some Forensics noise reduction applications. As with the normal mode of the filter, you will still need to take a fingerprint of the noise when operating in Spectral Subtraction mode. The amplitude signal of the resultant FFT is then subtracted from the entire .wav file signal thereby providing rejection of the highlighted fingerprinted signal. The offending signal could be an air conditioner, city noise, automobile noise, etc. To adjust the depth of effect, use the attenuation control. The attenuation slider sets the maximum amount of attenuation as an absolute number (as in all of the CNF modes) and in Spectral Subtraction mode the threshold shift scales the overall gain of the noise sample. Threshold and attenuation are not equivalent parameters because of the fact that the maximum attenuation value is absolute but it is not a maximum delta value between the signal and the sampled reference.
Important Note:
If the parameters for the Continuous Noise filter are set incorrectly, it has the propensity to produce extremely strange sounds (digital artifacts) - - - some of them quite comical in nature. If you hear these "birdies", back down on the attenuation setting and / or some of the graph inflection points and they should disappear. If not, increase the Attack and Release time values.
Sometimes, it may be desirable to have the Continuous Noise reduction system determine its own noise fingerprint “on the fly.” There are three possible reasons why you might be interested in using this mode:
The Auto Spectrum CNF Mode solves these problems by calculating the noise fingerprint “on the fly” and updating it on a continuous basis. It is capable of performing this function even if you can’t see or hear a totally quiet passage in the target .wav file. The mathematical routine utilized to create this fingerprint is more sensitive than your ears and can always find a noise fingerprint. This system may not be quite as effective for removing noise compared to the other two modes of the CNF operation, but its convenience coupled with its ability to adapt to changing noise environments sometimes outweigh its noise reduction performance limitation. To operate the CNF in this mode, merely preview it and adjust (primarily) the attenuation, attack and release times for the best sounding results. As with all of the Diamond Cut filters, the “Keep Residue” mode can be useful as an adjustment tool. In “Keep Residue” mode, tune for maximum noise and minimum signal while operating in “Preview” mode. The Auto Spectrum CNF Mode has the following controls and displays:
The Auto Spectrum CNF Screen
Forensics Adaptive Frequency Domain Filter (AFDF) Mode
(Forensics Version Only)
The Forensics Adaptive Frequency Domain Filter (AFDF) is a variation on the basic theme of the Auto Spectrum CNF filter mode. The primary difference is that the Forensics AFDF is optimized for Forensics oriented files and not “High Fidelity” files. It is found as one of the modes under the CNF filter or directly via an item called “Adaptive FD Filter” found under the Forensics Menu*. It has a faster response time compared to the Auto Level function and also a narrower effective bandwidth while producing higher levels of noise reduction at the expense of potentially producing higher levels of digital artifacts. The AFDF Filter is “Adaptive”, which means that it will automatically adjust itself to varying noise environments. This filter has a Time Domain twin sister found in the Forensic Menu, which is simply called the “Adaptive Filter”. The AFDF can produce more attenuation of noise compared to the Time Domain Adaptive Filter but can also produce more spurious digital artifacts. The Time Domain Adaptive filter does not produce spurious digital artifacts, but can produce an echo delay sound as an artifact. We provide both types of Adaptive filters since they exhibit somewhat differing sonic characteristics. Experimentation is the best way to determine which filter is the most effective on a given Forensics audio file. Also, a combination of the two used together in cascade in the Multi-Filter has been shown to work some magic that otherwise would not be possible on some extremely noisy forensics files. In general operation, the controls and the display graph for the Forensics AFDF is much the same as that of the Auto Spectrum CNF. Refer to it for details.
*Note: When you need to use the AFDF in the Multifilter, you must access it via the appropriate CNF mode inside in the CNF.
Continuous Noise Filter Procedure (Tutorial for Normal CNF Mode)
The Continuous Noise Filter is one of the most mathematically complex of all of the DCArt10/DC Forensics10 algorithms. It will, therefore, take the longest amount of processing time to complete its calculations. This algorithm will benefit the most from the use of a high clock rate computer. This filter is also the most difficult filter to use correctly. Aliasing artifacts can be produced when the settings are not correct for the particular .wav file you are attempting to "de-noise." The first time you use it, it will be worthwhile to spend about an hour playing around with it in order to become familiar with its behavior.
Note 1: The threshold line inflection points can be adjusted "live" when you are running the filter in "Preview Mode." You will be able to hear the effects of modification that you make to the threshold line almost immediately.
Note 2: Sometimes, record albums that are in excellent condition exhibit only one type of noise which is called “Rumble”. Rumble comes from the record mastering process as well as from the bearings in your turntable. Generally, one uses a High Pass filter to remediate this problem, but that approach also cuts into the low pass portion of the audio signal. There is a special preset in the CNF called “Dynamic Rumble (Only) Filter” which will remove this type of noise without damaging the deep bass on the recording or affecting any other signal above 90 Hz. This filter is more effective on Rumble noise than the standard High Pass Rumble filters found elsewhere in this software program.
Note 3: The most common issue with the use of the CNF is setting it too aggressively. It’s nice to reduce noise, but not to aim to completely eliminate it, as that approach will produce digital artifacts.
Harmonic Reject
The Harmonic Reject filter, which is sometimes referred to as a "comb" or "multiple notch" filter is used to attenuate periodic noises that contain harmonics. It is capable of attenuating either the odd or even harmonics of the selected fundamental frequency. This filter is very effective for attenuating a form of hum (line frequency related) noise that is rich in harmonics. This type of noise is sometimes referred to as "Buzz." Noise, such as this can be introduced into an audio recording from sources such as light dimmers or switching mode computer power supplies. "Buzz" can contain odd harmonics of the power line frequency, all the way through the entire audio spectrum. A 60-Hertz square wave is, by definition, the fundamental component of the waveform plus all the odd harmonics of that frequency up to infinity. If the waveform is perfectly symmetrical, it will include a fundamental component and only its odd harmonic multiples. The various bands (tines) of the Harmonic Reject filter will attenuate the fundamental as well as all of the harmonic by- products within the audio spectrum. Should you encounter wide-band line frequency related noise that is asymmetrical, it can produce some even harmonics.
An example of noise containing even harmonics would be that produced by an unsymmetrical sine, trapezoidal or square waveform (e.g.- a square wave having non-symmetrical duty cycle values). Non-linear devices in a signal pathway can introduce this effect. The Harmonic Reject filter can be placed in a mode in which it will attenuate the "evens" rather than the "odds" if you should encounter such noise. Before using the Harmonic Reject Filter, it is often useful to identify the fundamental frequency of the noise signal by using the Spectrum Analyzer in a high frequency resolution mode of operation (found under the "View" menu).
The Harmonic Reject Filter
The following is a summary of the control parameters and range of adjustment provided for the Harmonic Reject Filter:
This filter also incorporates a "Keep Residue" feature. This allows you to hear or keep only the noise component of the original signal. This feature is useful for "tuning" the filter to the maximum level of noise, so that when you actually run the filter with the "Keep Residue" feature turned off, the noise left behind will be minimized. Lastly, the keep residue function also allows you to produce "slot" filters, provided the slots that you need are harmonically related. See Appendix 1 for more details about slot filters.
Fine Tuning the Harmonic Reject Filter
Let’s assume that you have a .wav file having a buzz which contains roughly a 60 Hz fundamental frequency. This can be determined by applying the spectrum analyzer to the file and making a measurement of the first spike in the series. Set the Range (checkbox) to 60 Hz. Adjust the frequency of the Harmonic Reject filter in the range field to correspond to the reading viewed on the Spectrum Analyzer (direct numerical entry is a good way to do this). Start with a width of 0.2. Set the filter harmonics to 5 or 6 and check the “Keep Residue” mode. Next, click on the preview button and then point your mouse to the frequency slider. You should be hearing mostly buzz and not much signal in this mode. Now, use the up and down keys on your keyboard to move the frequency first above 60 Hz and then below 60 Hz one small increment at a time. Keep on adjusting the frequency in small increments until you hear the loudest buzz coming from your sound system. When you have found the maximum loudness value, switch back to non-keep residue mode. You will hear the signal with the buzz substantially attenuated. The next thing to do is to adjust the Maximum Harmonic number to the proper value required to attenuate the buzz without degrading the quality of your audio signal. Try increasing it until no further improvement is observed. If necessary, try decreasing it too. Do not use maximum harmonic numbers greater than necessary to accomplish noise reduction. The use of too many harmonics will damage your audio signal. Lastly, adjust the Width control to the minimum value that will do the job for you so as to minimize damage to the primary signal of interest.
Sometimes, a better result is achieved using the IIR (resonant notch filter) technique. You can enter that mode via the IIR checkbox. This allows a much higher frequency resolution adjustment capability and so you may be able to more closely hone in on the target signal of interest. However, when using the IIR method, try to minimize the number of harmonics to no more than what is needed to get the job done (Maximum Harmonic). The IIR method is much more math intensive and thus, slower, especially with high values of the Maximum Harmonic settings.
Important Notes:
For severe 50 or 60 Hz buzz situations, run at least two passes of the filter. The first pass should be run with a setting of 50 or 60 Hz, odd, and the desired Maximum Harmonics. On the second pass, run with a setting of 25 Hz (for 50 Hz situations) or 30 Hz (for 60 Hz situations), odd, and a lower Maximum Harmonics number. This sequence can be repeated more than once for further buzz reduction. You should also try running the system in “even only” mode after processing the odds first. Don’t forget that you can stack up (cascade) 2 or more of these filters in the Multi-Filter and apply them all at once as a convenience.
Note: Sometimes, when line-frequency related “buzz” is encountered containing only very high frequency components (spikes) the EZ Impulse or Expert Impulse Filter may perform a better job removing buzz and doing less damage to the main audio signal. Experimentation is the only way to know what filter will produce the best result on any given file.
This is a digital simulation of a dynamic analog filter. It is useful for dynamically attenuating "Hiss" from old record recordings or from old magnetic tape recordings. It performs better than a fixed Low-pass filter because it only attenuates high frequencies when there is no high frequency information present above the setting of its "Noise Threshold" slider adjustment. Sometimes this technique is referred to as "single-ended noise reduction". The Dynamic Noise filter's Low-pass corner frequency is frequency modulated by a rectified envelope signal that represents the amplitude of the signal content above a particular low-pass corner. So, normally, the bandwidth of this filter is limited until some high frequency content is measured by its high frequency detector. When this occurs, the bandwidth of the filter is opened up to allow the frequency of interest to pass through. When the high frequency signal diminishes again below a threshold value, the filter closes back down to a smaller bandwidth. The user has the ability to adjust a number of parameters with this filter, including noise threshold, filter frequency, attack time (the time constant associated with the signal whose job it is to increase the Low-pass filter frequency corner), release time (the time constant associated with the signal whose job it is to decrease the Low-pass filter frequency corner after a high frequency event has ceased) and HF Gain (high frequency gain). This filter should only be used on recordings that contain little or no impulse noise, or on recordings that have already been processed through the Impulse Noise filter first to minimize unnecessary filter “breathing” effects. This Filter can be used either as a dynamic noise reduction tool or as a dynamic high frequency enhancer, or both if two are placed in cascade within the Diamond Cut Multi-Filter.
The Dynamic Noise Filter
The Dynamic Noise Filter provides the following slider controls:
The Noise Threshold is the value of rectified and averaged High-pass signal level above which the output of the Dynamic Noise Filter starts to raise its corner frequency. Moving the noise threshold slider control vertically raises its value. This control must be adjusted so that when there are no highs present in the source material, background "Hiss" is attenuated, but when "highs" are present (such as cymbal crashes or the pronunciation of the letter "S"), the filter "opens up" and passes those “highs” to the output of the system.
This is the 1st order High-pass corner filter frequency which drives the Dynamic Noise Filter Detector / Rectifier / Attack & Release Time Constant circuitry. For modern reel-to-reel tapes, this parameter will be operated generally up in the 4 to 6 kHz range. For early 78s, it will be operated in the 1 to 3 kHz range. The Filter Frequency parameter range is from 200 Hz to 19.999 kHz. Operation of this setting above 10,000 Hz is rarely of any value, but it is allowable. Experimentation will be required to determine the best setting and will vary greatly depending on your source material.
Important Note: The entire frequency range of adjustment up to 19,999 Hz is only possible when utilizing a 44.1 kHz sampling rate or higher. At a 22.05 kHz sampling rate, the maximum effective frequency setting will be 10 kHz, and at an 11.025 kHz sampling rate, this value will drop to 5 kHz.
The Attack Time slider adjusts the time constant (in milliseconds) associated with the rising edge of a High-pass signal envelope. Fast music will require smaller values of attack time compared to slow music. The range of adjustment for the Attack Time parameter is 1 to 300 milliseconds.
The Release Time slider adjusts the time constant (in milliseconds) associated with the falling edge of a High-pass signal envelope. This parameter will also require smaller values for fast music compared to the requirements of slow music. Also, the release time will almost always be set to a period of time greater than the Attack time for the algorithm to sound natural. The range of adjustment for the Release Time parameter is 1 to 500 milliseconds.
Gain controls the amount of dynamic High-pass filter signal that is summed back into the output of the filter. This allows you to obtain upward or downward expansion of the high frequency portion of the audio spectrum. The "neutral" setting for this would be 0 dB that represents no expansion or compression. Setting this value greater than 0 dB will be produce a "Spectral Enhancer" function. Values of 0 dB and lower produce a Single Ended Noise Reduction function used to de-Hiss a sound source. This control is calibrated in dB. Its range of adjustment in normal noise reduction mode is from 0 to -90 dB. Its range of control in Spectral Enhancer mode is from 0 to + 10 dB.
Checking this box switches the Dynamic Noise Filter from Noise Reduction mode to Spectral Enhancer Mode. Enhancer mode provides upwards expansion of signals above Filter Frequency setting and its threshold setting. The degree of Enhancement is determined by the HF Gain control setting. Enhancer mode can add some life to dull recordings without introducing a great deal of noise into the signal (as would an ordinary Equalizer).
Important Note:
The controls can be adjusted "live" when the preview mode button is clicked.
Dynamic Noise Filter Operating Procedure (Tutorial)
Most of the parameter settings for this filter will vary considerably depending on the content of your particular .wav file. You will have to experiment to determine the values most to your liking. The values used below in the Procedure Example will get you started.
When the filter is operating properly, "Hiss" will be reduced, but when there is high frequency content on the recording, the filter should "open up" and pass through more "highs" to its output. If the Threshold is set too high, the filter will never open up, and the .wav file will sound "dull" although "Hiss" may be reduced. If the Threshold is set to low, the filter will always be opened up to full bandwidth, and there will be no noise reduction action. If the Attack time is set too long, there will be a delay heard before the filter changes bandwidth on musical high frequency transients such as cymbal crashes (loss of the leading-edge). If the Release time is set too long, there will be a residual "Hiss" left behind after a high frequency musical event, which will decay out, but too slowly and therefore, unnaturally.
When you determine the best setting of the controls for your particular .wav file, click Run filter. When the filter has completed its operation, the results will appear in the Destination Workspace.
Low Pass, Band Pass and High Pass IIR Filter Sub-Menu
The IIR based Low Pass, Band Pass and High Pass Filters are all in a sub-menu called “LP, BP, HP Filters”.
Low Pass Filter
This filter is called a Low-pass filter because it only passes through signals that are lower than its set corner frequency. It attenuates high frequency signals above the corner frequency.
The effect can be similar to turning down the treble control on a home stereo except that the Low-pass filter is much more flexible. This filter can be somewhat useful for reducing hiss in a recording, but care must be taken not to reduce the "presence" of a recording by eliminating too much of the high end musical content at the same time.
Low Pass Filter with Chebyshev or Butterworth Response with up to a 4th Order Response (Slope)
This type of filter is most useful when a recording does not contain any useful sonic information above a certain frequency, and you wish to attenuate that high frequency noise that would otherwise be present.
This is a digital simulation of a conventional Low-pass filter. It is created using an Infinite Impulse Response (IIR) algorithm having a Butterworth or Chebyshev characteristic (for the higher order slopes). Frequencies below the "corner frequency" are passed through to the output, and frequencies above the corner are attenuated. The degree to which higher frequencies are attenuated is determined by the slope (order) of the filter. Four slopes are provided. They are 6dB / Octave, 12 dB / Octave, 18 dB / Octave and 24 dB / Octave. The higher the slope, the more attenuation will occur to frequencies above the corner frequency. The corner frequency is the frequency that you choose, and it is defined as the frequency at which the signal has been attenuated by 3 dB relative to the pass-band. This filter can be somewhat useful for reducing hiss in a recording, but care must be taken not to reduce the presence of the recording by eliminating too much of the high-end musical content at the same time. When used selectively, this filter can also be used either to "De-Ess" an overly sibilant vocal, or reduce harsh harmonic distortion products that may have resulted from occasional master recording overloading (clipping). For forensic recordings, this filter can be used to remove most noise sounds whose frequencies are above the speech spectrum by setting the corner frequency to somewhere between 3,000 to 4,500 Hz. The use of steep slopes (& Chebyshev) are often very useful in these forensics audio situations.
The Low Pass Filter
The higher order (12, 18, & 24 dB / Octave) Low-pass filters are of the Butterworth or Chebyshev types, depending on your choice.
The following is a summary of the control parameters and range of adjustment provided for the Lowpass Filter:
Important Note: The frequency range of adjustment up to 19,999 Hz is only effective when utilizing a 44.1 kHz sampling rate. At a 22.05 kHz sampling rate, the maximum effective frequency setting will be 10 kHz, and at an 11.025 kHz sampling rate, this value will drop to 5 kHz.
Lowpass Filter Operating Procedure (Tutorial)
Band Pass Filter
Band-pass filters are essentially a combination of a Low-pass filter and a High-pass filter operating together. It attenuates both the high frequency and the low frequency portions of the audio spectrum. It is useful where the recording contains extraneous noise in the low frequency region such as rumble or thumps, and high frequency noise such as hiss. This filter can also be very useful for improving the intelligibility of audio recordings, especially speech, by eliminating the unnecessary portion of the audio spectrum that is not used by speech frequencies to carry useful information to the listener.
The Band Pass Filter
Band Pass Filter with Chebyshev or Butterworth Response with up to 4th Order Slope
This is a digital simulation (IIR based) of a conventional analog Band-pass filter having a Butterworth or Chebyshev response when set to the steeper slope values. Band-pass filters are passive to frequencies within the Band-pass region, but they attenuate frequencies above and below the two corner frequencies. Band-pass filters have both an upper and a lower corner frequency, and like the Low-pass and the High-pass filter, the corner frequencies are defined as the frequencies at which the signals either above the upper corner or below the lower corner are attenuated by 3 dB. Four slopes are provided for the Band-pass Filter, just like the Low-pass and the High-pass. They are 6 dB / Octave, 12 dB / Octave, and 18 dB / Octave and 24 dB / Octave. This filter can be very useful for improving the intelligibility of audio recordings, especially speech, by only passing through signals in the portion of the audio spectrum involved in human speech. The Forensics Menu “Brick Wall” filter has a much steeper version of this filter for dealing with extreme cases of out-of-band noise that needs to be eliminated.
Note:
The higher order (12, 18, & 24 dB / Octave) Band-pass filters are of the Butterworth or Chebyshev type depending on your choice.
Special effects can be produced with the Band-pass filter. These special effects can be useful when producing movies or stage plays or shows and a particular sound producing device and its environment needs to be accurately reproduced through the "House" P. A. System. Here are a few examples:
Simulation | Low Freq. Control | High Freq. Control | Slope |
1930's Vintage Table Top Radio: | 830 Hz | 2000 Hz | 18 dB / Octave |
Modern cheap Table Top Radio: | 265 Hz | 6100 Hz | 18 dB / Octave |
Loud "Walkman" personal stereo as heard by person nearby: | 3650 Hz | 9800 Hz | 18 dB / Octave |
Modern Stereo System as heard from the next room: | 95 Hz | 4100 Hz | 12 dB / Octave |
1950's Vintage Juke Box: | 30 Hz | 2700 Hz | 12 dB / Octave |
AM Transistor Pocket Radio: | 1395 Hz | 2110 Hz | 18 dB / Octave |
Telephone Receiver sound from "off the hook": | 2700 Hz | 2895 Hz | 18 dB / Octave |
Night Club Band as heard from Parking Lot: | 85 Hz | 240 Hz | 12 dB / Octave |
Old Acoustic Phonograph: | 870 Hz | 2390 Hz | 18 dB / Octave |
Public Address System at Outdoor Event: | 300 Hz | 3000 Hz | 12 dB / Octave |
Modern High End Audio System: | 15 Hz | 19,999 Hz | 6 dB / Octave |
Bandpass Filter Response Limits: | 5 Hz | 19,999 Hz | - |
You can create your own simulations of sound devices and acoustic environments through experimentation with the Band-pass filter parameters. Using the above simulations, in conjunction with the DCArt10 / DCForensics10 reverb, you can further enhance various acoustical environments. Once you discover the appropriate values, write them down or store them as presets for future reference.
Cascading this filter (using the Multi-Filter) with others like the Virtual Valve Amplifier to add distortion, and the Reverb to add room acoustical effects can further embellish these sound simulations.
The Band-pass filter can also be used as a tool to determine if any useful audio information exists in a particular portion of the audio spectrum; it becomes sort of an audible wave analyzer when used in this manner. For more information on this mode of operation, refer to the "Using DCArt10/DC Forensics10 as an Audio Waveform Analyzer" portion of the "How Do I" section of this manual or go to the section which explains the operation of the Spectrum Analyzer.
The following is a summary of the control parameters and range of adjustment provided for the Band-pass Filter:
Note: The frequency range of adjustment up to 19,999 Hz is only effective when utilizing a 44.1 kHz sampling rate. At a 22.05 kHz sampling rate, the maximum effective frequency setting will be 10 kHz, and at a 11.025 kHz sampling rate, this value will drop to 5 kHz.
Band-pass Filter Operating Procedure (Tutorial)
Note 1: If the low frequency control is set to a higher frequency than the high frequency control setting, a "no pass" filter will be created. This is of little useful value, but is allowable by DCArt10/DC Forensics10.
Note 2: You can select Chebyshev rather than Butterworth if you want a steeper filter response at the expense of some ripple within the filter pass-band.
A High-pass filter only passes signals that are above or "higher" than the corner frequency. It reduces the level of low frequency signals that are below the corner frequency. The effect can be similar to turning down the bass control on a home stereo. This filter is very useful for reducing turntable rumble, muddiness, and any other extraneous low frequency noise in a recording.
High Pass Filter with Chebyshev or Butterworth Response with up to 4th Order Slope
This is a digital simulation (IIR based) of a conventional analog High-pass filter having a Butterworth or Chebyshev response (for the higher order slopes). This filter attenuates frequencies below the High-pass corner frequency. Just like the Band-pass and the Low-pass filter, this filter has four slopes available. They are 6 dB / Octave, 12 dB / Octave, 18 dB / Octave and 24 dB / Octave. This filter is very useful for reducing the effects of turntable rumble, or microphone seismic effects from inducing "muddiness" onto an audio recording. It can also be used to eliminate any dc (fixed) offset that may have developed on a .wav file (a preset is provided which performs this function). To reduce turntable rumble, start with a setting of 60 Hz and 18 dB / Octave, and then adjust the parameters until you are satisfied. This filter is also useful when selectively applied for reducing microphone "P" popping effects on the vocal track of multi-track recordings wherein an adequate windscreen had not been utilized in the session. Effective settings to attenuate “P” popping typically are 120 Hz with a slope of 18 dB / Octave (selectively applied to the highlighted event).
The High Pass Filter
Note: The higher order (12, 18, & 24 dB / Octave) High-pass filters are of the Butterworth or Chebyshev types, depending upon your selection.
The following is a summary of the control parameters and range of adjustment provided for the High-pass Filter:
Note: The frequency range of adjustment up to 19,999 Hz is only effective when utilizing a 44.1 kHz sampling rate. At a 22.05 kHz sampling rate, the maximum effective frequency setting will be 10 kHz, and at an 11.025 kHz sampling rate, this value will drop to 5 kHz.
High-pass Filter Operating Procedure (Tutorial)
Note: For a steeper filter response at the expense of elevated pass-band ripple, choose the Chebyshev rather than the Butterworth response.
Removing DC-Offsets with the High-pass Filter (Tutorial)
The High-pass Filter can be used to remove any DC-Offset from .wav file. To do so, set the High-pass Filter to 10 Hz and 6 dB per octave, and run it on the .wav file needing correction. This feature can also be found as a preset within the High-pass filter.
Notch Filter
A notch filter attenuates signals that are near its center frequency setting. The degree to which it attenuates frequencies near the center frequency is determined by the bandwidth setting. This filter is useful for removing 50 or 60 Hz “Hum” from a recording. It is also useful for decreasing any sound system acoustic feedback that may be found on some live recordings. A "Slot" filter is also provided within the Notch filter menu item for Forensics applications. Multiple slots can be constructed using the DCArt10/DC Forensics10 Multi-Filter. Slot filters have the reverse response of a Notch Filter; it only passes signals near its center frequency setting.
The Diamond Cut Notch Filter is a digital simulation (IIR based) of a second order notch / slot filter. It attenuates all frequencies near its center frequency setting. The degree to which it attenuates frequencies adjacent to the center frequency is determined by the bandwidth setting. This filter is useful for removing 50 or 60 Hz hum from a recording (or harmonics thereof). In forensics “black-box” recordings, it is useful for reducing 400 Hz aircraft generator noise. It is also useful for decreasing any sound system acoustic resonance that may be found on some live recordings. It can be used to attenuate the heterodyning "whistle" which is sometimes heard on AM broadcast radio reception. Some audio restoration engineers also use this filter to remove some "Hiss" from old 78 RPM recordings. For this application, the filter's center frequency is set somewhere in the 8 to 12 kHz range, with a bandwidth of 0.25 Octave or less. Experimentation is the only way to determine its effectiveness in minimizing "Hiss" from your particular source material. Also, it is important to note that this method is not the most effective for "Hiss" removal. Instead, consider using either the Continuous Noise Filter, Dynamic Noise Filter or the EZ Clean Filter.
The Notch Filter
The following is a summary of the control parameters and range of adjustment provided for the Notch Filter:
This filter incorporates the "Slot Filter" feature. Essentially, a slot filter produces a variable band-pass response to its applied signal. This allows you to hear or keep only the residual component of the original signal. This feature is useful for "tuning" the notch filter to the maximum level of noise, so that when you actually run the notch filter with the "slot filter" feature turned off, the noise left behind will be minimized. The slot filter function is also useful in Forensics applications, wherein one is interested in isolating a very particular sound that exists in a very specific and narrow frequency band. If multiple slots are required, use the Multi-Filter with multiple notch/slot filters in the chain, or consider using the Harmonic Reject filter in "Keep Residue" mode, provided the slots, which are required, are harmonically related.
Note: The frequency range of adjustment up to 18,999 Hz is only effective when utilizing a 44.1 kHz sampling rate. At a 22.05 kHz sampling rate, the maximum effective frequency setting will be 10 kHz, and at an 11.025 kHz sampling rate, this value will drop to 5 kHz.
Notch Filter Procedure (Tutorial)
Note: If only a small section(s) of your .wav file is in need of Notch filtering, as is often the case when acoustic feedback is encountered on a live recording, you can use "sync mode" and just filter the sector which contains the noise which you’re attempting to reduce. "Sync mode" can be selected under the "View Menu" and is associated with the Diamond Cut Classic Edit mode.
Median Filter
The Median Filter can be used to substantially reduce "crackle" (small impulse noise) from a recording. Use a sample setting of 3 to 7 for this application as your starting point range. A “weighting” control is also provided, which affects the “timbre” of the processed sound.
The Median Filter
There is no analog circuit equivalent to the Median Filter. This filter defines a window of samples, and for that window, determines which sample is the median value within the grouping (median meaning middle amplitude value). That value is the one that is passed along to the destination file, and then the window moves over 1 sample and re-evaluates the median, again passing the new median value to the destination file. This filter is useful for improving the intelligibility of severely distorted signals and it is also useful for pulling signals out of a very poor signal-to-noise ratio situation (pulling signals out of the mud). It is somewhat similar in sound performance to a high-order Low-pass filter. (The median value of a string of sorted numbers is the one in the middle of the string. In other words, if you have seven sorted numbers by amplitude, the fourth number will be the median value.) The DCArt10/DC Forensics10 Median Filter allows you to choose the number of samples over which the median value is determined by the algorithm. The range is from 3 to 20 samples. The higher that you set this value, the greater will be the attenuation of high frequency signals and/or noise. Also, the higher the samples setting, the longer will be the processing time required for the filter. The most useful settings will generally be found to be from 3 to 7 samples. Outside of that range, you may hear a significant degradation of the top end of your recording, depending on its bandwidth. Even at 7 samples, you will notice some "fuzziness" inter-modulating with the upper end of the spectrum on some recordings. So always start with 3 to 5 samples when using the Median filter, and choose the smallest value that produces an effective de-crackling result. It is also important to note that the higher the number of samples selected, the longer it will take your computer to calculate the Median values to process your .wav file. At some high settings, your system may not be able to process the file in "real-time" due to the heavy demands that it places on your CPU.
Weighting Function
A “Weighting” function is provided with this filter that shifts the position on the number line as to which value will be chosen as the “Median.” This feature is particularly useful in forensics audio applications wherein extremely inarticulate speech needs clarification. For example, the absence of consonant or sibilant sounds can render a recording undecipherable. Recording bandwidth limitations can severely distort or eliminate the “hissing-consonants” which render speech understandable - - - a fact that has been known since the earliest ventures by Thomas Edison into the field of recorded sound. With the use of the Median filter in conjunction with the weighting control, this problem can often be corrected. The weighting control will essentially affect the “timbre” of the processed sound. Trial and error will determine the best combination of “Samples” and “Weighting” to cure a particular forensics sound problem.
The following is a summary of the control parameters and range of adjustment provided for the Median Filter:
Note 1: De-Crackling will generally be best accomplished with a "Samples" setting around 3. Intelligibility improvement of extremely distorted or garbled voice recordings will generally be accomplished with "Samples" settings anywhere between 5 through 17. You will have to experiment to determine the best settings for solving a particular problem.
Note 2: Best results on Forensics files will be had when it is first converted to a 44.1 kHz sample rate.
Median Filter Operating Procedure (Tutorial)
Note: The “Weighting” control is used to affect the Timbre of the resultant sound of the Median filter.
Averaging Filter
This filter sounds similar to that of a Low-pass filter, although it is somewhat more effective than a Low-pass filter in reducing not only "Hiss" but also "Crackle" from a sound source. It is most effective on limited bandwidth sources such as old acoustic recordings made before 1925. This filter is also useful for improving the intelligibility of highly garbled voice communications recordings.
The Averaging Filter
This is another filter that has no analog equivalent. Its interface to the operator is similar to the Median Filter, with the difference being that instead of calculating the median value of a sample window to pass into the Destination workspace, the average value of a group of samples is passed through. You select the number of samples on which the average value is calculated with a slider control in its dialog box. The greater the number of samples, the higher the degree of smoothing effect on the waveform. The higher that you set the degree of smoothing, the greater will be the loss in the higher end of the audio frequency spectrum.
The following is a summary of the control parameters and the range of adjustment provided for the Average Filter:
Average Filter Operating Procedure (Tutorial)
Equalizers
The primary Diamond Cut equalizers are found within a sub-group called “EQ” under the Filter menu. The commercial version of the product includes 4 Equalizers while the Forensics version includes a total of 5. For example, the Forensics version includes a 10, 20 and 30 band graphic Equalizers and a paragraphic Equalizer (a parametric EQ that plots it’s frequency response). Additionally, a 3 band equalizer can be found within the Virtual Phono Preamplifier, which includes bass, mids and treble controls. Its bass and treble controls are of the shelving type while the mids are of the peaking (2nd order resonant) type. All of the Diamond Cut EQs use IIR techniques to achieve their result. Here is what the EQ menu looks like after the down arrow is clicked and expanded:
The EQ Menu in its expanded state
The 10 Band Graphic Equalizer
The 10 Band Graphic Equalizer is a familiar filter that acts like an expanded tone control. The audio spectrum is broken into 10 bands, each being one octave wide. Each band's gain (volume) can be independently adjusted to achieve the desired audio result. This filter is useful for tonal shaping of the finished audio product or to enhance the bass or treble of a recording. It is also useful for improving the intelligibility of recordings or "Bringing Out" a particular instrument or vocal.
The Graphical Equalizer is the digital equivalent (which is IIR based) to the analog Graphical Equalizer found in many sound systems. It uses 2nd order resonant (peaking) techniques to achieve its results. Its primary advantage is that it can be applied to a .wav file without having to resort to adding an analog step in your sound restoration process. This results in decreased noise and distortion on your final product. The equalizer has ten bands containing the following center frequencies:
31 Hz, 62 Hz, 125 Hz, 250 Hz, 500 Hz, 1 kHz, 2 kHz, 4 kHz
8 kHz, 16 kHz
The 10 Band Graphic Equalizer
The amplification and attenuation range for each band is + / - 12 dB. A "Reset Levels" feature is provided. Clicking on "Reset Levels" will return all of the Graphical Equalizer slider controls to their 0 dB position. Since the graphic equalizer can add gain to your signal, a latching overload indicator is provided. If, at any time during the processing of a file through the graphic equalizer, the output signal exceeds the dynamic range of the system, the indicator will turn red and latch until the filter is re-run. The top and bottom bands are also peaking type filters and not shelving types. If shelving filters are needed, please refer to the Paragraphic EQ which includes two bands that can be operated in that mode.
Note 1: The top equalizer band of 16,000 Hz is only effective when using a sample rate of 44.1 kHz or higher; it becomes ineffective at sampling rates of 22.05 kHz and 11.025 kHz. The 8,000 Hz band will also be rendered ineffective when using a sampling rate of only 11.025 kHz.
Note 2: The graphic equalizer controls can be adjusted "live" when the preview mode button is clicked.
Note 3: Since the graphic equalizer can actually increase the gain of the system, it is possible to produce clipping which will result in unpleasant distortion products to appear in the Destination Workspace. This usually occurs when excessively boosting the bass portion of the spectrum. The overload indicator will change from green to red, and latch in that condition if there has been an overload. The latch will be reset, following a re-run of the algorithm, provided that the overload condition has been cleared by reducing gain in one or more bands. A good remedy for this is via the overall “Gain” control; reduce its setting if clipping occurs.
Graphic Equalizer Operating Procedure (Tutorial)
The 20 Band Graphic Equalizer is an IIR based extension of the 10 Band Graphic Equalizer. It exhibits twice the selectivity compared to the 10-band equalizer, since each band is calibrated with half its bandwidth. It is quite useful where greater selectivity is required in order to “tweak” your audio signal frequency distribution, but it is a little more difficult to use compared to the general purpose 10-band equalizer. Its amplification and attenuation range is +/- 12 dB as indicated by the numerical readouts located below each slider control. It has the following frequency band center frequency values:
22Hz, 31Hz, 42Hz, 63Hz, 88Hz, 125Hz, 177Hz, 250Hz, 350Hz, 500Hz, 710Hz, 1.0kHz, 1.4kHz, 2kHz, 2.8kHz, 4kHz, 5.6kHz, 8.0kHz, 11kHz, 16kHz
Figure 69 - The 20-Band Graphic EQ
In all other regards, the 20 Band Graphic Equalizer is operated in the same manner as the 10 Band Graphic Equalizer. Please refer to the description of the Graphic Equalizer above for more details.
Note: All bands above 45 % of the .wav files sampling frequency are disabled.
(Forensics Version Only)
30 Band Graphic IIR-Based EQ
The 30 Band 1/3rd Octave Graphic Equalizer is an IIR based extension of the 10 and 20 band Graphic Equalizers. It exhibits three times the selectivity compared to the 10-band equalizer, since each band is calibrated with 1/3rd of its bandwidth. This is very useful in Forensics applications wherein signals in a relative narrow portion of the audio spectrum need to be amplified or attenuated. Its amplification and attenuation range is +/- 12 dB as indicated by the numerical readouts located below each slider control. If this filter does not have sufficient selectivity for your application, then use the FFT based Spectral Filter, which has a choice of from 128 to as high as 32,000 bands. The 30 Band Graphic Equalizer has the following frequency band center frequency values:
25 Hz, 31 Hz, 40 Hz, 50 Hz, 62 Hz, 80 Hz, 100 Hz, 125 Hz, 160 Hz, 200 Hz, 250 Hz, 320 Hz, 400 Hz, 500 Hz, 640 Hz, 800 Hz,1 kHz,
1.3 kHz, 1.6 kHz, 2 kHz, 2.5 kHz, 3.1 kHz, 4 kHz, 5 kHz,
6.2 kHz, 8 kHz, 10 kHz, 13 kHz, 16 kHz, 20 kHz
Note: All bands above 45 % of the .wav files sampling frequency are disabled.
Figure 70 - The 30-Band Graphic EQ
Paragraphic Equalizer
This unique equalizer combines the flexibility of a parametric equalizer with the ease of use associated with a 10 band graphic equalizer. The actual frequency response of the filter is graphically controlled and/or displayed. Virtually any frequency domain transfer function that you can dream of can be created with this filter. Many presets are provided to facilitate many unusual equalization situations.
The Paragraphic Equalizer
The Paragraphic Equalizer is a unique form of a parametric equalizer employing IIR techniques. It combines the graphical representation of its transfer function (frequency response curve) with the versatility of a parametric equalizer. Additionally, it provides you with up to 10 bands of equalization. It differs from the graphic equalizer in that three parameters are adjustable for each band:
The following additional controls and displays are provided:
The Parametric Equalizer displays its frequency domain transfer characteristic graphically. Therefore, it is referred to as the DCArt10 / DCForensics10 "Paragraphic" equalizer. It can be modified using your mouse by dragging the inflection point dots, and modifying the bandwidth using the octave control. You simply draw the shape of the response, which you desire, and the algorithm adjusts the parameters to match the response curve. Each band is represented by a single square "dot" on the graph. The "active" dot (the one being adjusted) will be the larger one displayed. That is the dot for which the parameters are being displayed numerically on the control panel. You can use the mouse to drag any of the dots, which actually represents a frequency inflection point, wherever you wish. If you want to sharpen or widen the response of any inflection point, use the “Octaves” control to achieve the desired curve for a highlighted band dot. It is often very useful to use the spectrum analyzer, found under the View menu, in conjunction with the Paragraphic Equalizer. You will then be able to see the exact effect that you are imposing on the .wav file signal.
Under the factory presets listing, you will find a number of useful audio restoration functions, including the RIAA curves. Also, various inverse RIAA curves with a variety of turnover frequencies are available. These features enable you to use a standard RIAA pre-amplifier to transfer acoustical and electrically recorded 78 RPM records to your hard drive, and re-compensate at another point in time, without having to purchase specialized hardware. Also, of interest is the family of Fletcher-Munson Equal Loudness Contours at different sound pressure levels. These can be used to compensate for the response of the human ear depending on the loudness level that you expect a particular audio piece to be auditioned.
Shelving Filters: The top band (right-hand side of the graph) always operates as a shelving function (a pole-zero pair). The rest of the bands are second order resonant filter systems (often referred to as peaking filters), except the bottom band (left-hand side of the graph) which can be set either as a shelving transfer function or as a peaking routine. It defaults to a peaking filter, but can be converted to a shelving function by checking the shelving checkbox (“Low Freq Shelf”). So, you can create a system in which you have a low frequency and high frequency shelf with 8 peaking filter bands in-between if you so choose. If you only want to work with two shelving filters, just check the “Low Freq Shelf” checkbox and then reduce the number of filters to 2. One of those two will be the upper frequency shelf and the other one will be the lower frequency shelf. You can then adjust both to achieve the desired upper and lower frequency shelving response. The Amplitude and Frequency controls apply to the shelving function(s), but not the Octaves control. “Octaves” only apply to the various filter bands when they are operating in non-shelving mode(s).
Note 1:
As with all of the DCArt10/DC Forensics10 filters, sample theorem dictates useful bandwidth for the algorithms. The Paragraphic Equalizer will only have a useful bandwidth up to about 10 kHz with a 22.05 kHz sample rate, and about 5 kHz at 11.025 kHz. It will be fully useful with sample rates of 44.1 kHz and above.
Note 2:
Many of the Paragraphic Equalizer presets such as the RIAA, Reverse RIAA and NAB curves are defined over the entire audio spectrum consisting of at least 20 Hz to 20 kHz band spread values. Therefore, the use of any sampling rates less than 40 kHz will invalidate the accuracy of these curves. We recommend using only 44.1 kHz or higher in order to properly realize these equalization curves.
Note 3:
Random white noise can be converted to pink noise by feeding it through the appropriate factory preset(s) within the Paragraphic Equalizer.
Virtual Phono Preamplifier (VPP)
Phono Preamplifier Simulator including Common EQ Curves & Tone Controls
The Diamond Cut Virtual Phono Preamplifier (VPP or sometimes called the VPA) is an IIR based digital simulation of an analog based hardware pre-amplifier having magnetic phono and line level input circuits. It uses “closed form” mathematical representations of the various phonographic EQ curves resulting in near ideal amplitude and phase responses per the various phonographic EQ standards. For example, the RIAA and Reverse RIAA curve deviations from the ideal are not measureable when using a 48 kHz sample rate or higher (having less than a small fraction of a dB variance over the entire audio spectrum from the ideal curves). In addition to the standard features found on most analog circuit based preamplifiers, the VPP includes the ability to apply various phono equalization and re-equalization curves with near perfect accuracy. It can work in conjunction with three different types of analog input front-end (hardware) sources including standard RIAA preamplifiers, flat phono preamplifiers and line level inputs.
Besides creating the standard RIAA curve from a flat phono preamplifier front-end, the VPP’s versatility allows you to use a standard RIAA hardware pre-amplifier front-end to derive from its signal the most common 78 turnover curves. It accomplishes this by reversing the RIAA curve imparted by the RIAA preamplifier front end and then re-applying the desired 78 turnover characteristic curve. It can also perform the mentioned function when utilizing a flat phono pre-amp front end*. Supported curves also include the Columbia LP EQ curve found on many vintage monophonic LPs as well as two common 78 Turnover curves. Decoding of acoustically mastered recordings is also provided using an internal reverse RIAA curve so that you can use an RIAA preamp to transfer early 78s. Additionally, a 30 Hz, third order (18 dB / Octave) Rumble filter is provided and also a mono selector switch to sum the two channels together (L+R) when transferring vintage monophonic (lateral cut) LPs and 78s in conjunction with a stereo phono cartridge.
The VPP also includes a set of tone controls consisting of a 3 Band Equalizer having 2 shelving type controls and 1 peaking type. These controls have a wide adjustment range so that you can tune the output of the system to your own taste if desired. The shelving control response shapes are complimentary with the fixed phono EQ curves in the VPP, and are very useful for fine tuning the phono EQ curves of your system if desired. And of course, the VPP also includes Volume and Balance controls.
Some soundcards produce output signal levels up to roughly 1.5 Volts RMS. And, the input sensitivity of most audio power amplifiers and powered loudspeakers require only around 1 Volt RMS to produce full output power. As a result, you can create a very simple and clean sound system consisting of nothing more than your computer coupled directly into a power amplifier and speakers or powered loudspeakers. This allows you to bypass some of the usual analog hardware preamplifiers or mixers generally found in sound-labs. This reduces the overall distortion introduced into the signal path, because the analog hardware count can be reduced which is often desirable and/or convenient. So a complete playback sound system can consist of nothing more than your computer coupled to a set of powered loudspeakers with the VPP providing a comprehensive set of controls. If the VPP is used within the Multi-Filter context in Live mode, you can set up a complete real-time sound-system with your computer, a set of powered speakers and an input source. Furthermore, you can also cascade other filters (like the various INF’s, CNF or any of the EZ Filters) into the signal pathway after the VPP to remove impulsive and continuous noises from the source and do it in real-time. Of course, the entire plethora of Diamond Cut filters and effects can also be added to the chain making your real-time audio system extremely versatile. It is important to note that if the VPP is used in conjunction with multiple filters and/or effects, the VPP should always be configured as the first item in the signal chain.
The Diamond Cut Virtual Preamplifier (VPP)
Here are the VPP controls defining their functionality and range of adjustability:
On the top right side of the VPP, you will find a Volume control, which performs the obvious function. It has a range of adjustment from 0 to +20 dB or 0 to –20 dB and defaults to a unity gain mode (x 1.00, Gain = 0.00 dB).
Balance Control
Directly below the Volume control is the VPP channel Balance control. Normally, this would be set to the center position, which is designated as 0.00. Moving the control to the right moves the stereo soundstage towards the right hand side of your listening space, while moving the control towards the left hand side has the opposite effect. The range of adjustability for this control is 0 to –1 (when moved fully to the right) and 0 to +1 (when moved fully to the left). At either extreme setting of the balance control, the opposite channel is fully attenuated (producing no output).
Tone Controls
The VPP has three tone controls including Bass, Mids and Treble. The tone controls are enabled by placing a checkbox in the “Enable Tone Controls” selector when you desire to use them. To defeat them, simply uncheck the same selector box. The Tone Controls have the following characteristics:
Bass: Shelving type with its corner frequency set to 175 Hz and adjustability of +/- 15 dB (15 dB of Boost or Cut).
Mids: Peaking (band-pass resonant) type with its center frequency set to 900 Hz, 3 Octaves bandwidth. Adjustability is +/- 15 dB (15 dB of Boost or Cut).
Treble: Shelving type with its corner frequency set to 3,000 Hz and adjustability of +/- 15 dB (15 dB of Boost or Cut).
Note concerning all controls: Fine adjustments can be made using the arrow keys on your keyboard after you have used the mouse to select a particular control.
The VPP rumble filter is of the 3rd order Butterworth variety having a corner frequency of 30 Hz. Thus, its attenuation at 15 Hz is 18 dB. It can be effective for attenuating rumble sounds due to turntable (or even cutting lathe induced) record rumble, which is a low frequency random noise that often “pumps” sub-woofers. Rumble is most noticeable by the random movement of your sub-woofer’s speaker driver cone which wastes power and introduces inter-modulation distortion into the signal if not attenuated. It can also introduce a very annoying “wind” sound coming from a sub-woofer system if there is too much “Rumble” present. You will know if you need this filter simply by experimenting with it. To enable the “Rumble Filter”, simply tick off the checkbox with your mouse. If you do not have a sub-woofer, you may not notice turntable rumble even though it is there.
Preamp Hardware (Selector Box)
The top left corner of the VPP provides you with a set of three input selections from which to choose. Your options are:
Standard RIAA Preamp: If you are using a standard magnetic RIAA phono preamplifier, then you need to check this box.
Flat Preamp: If you are using a flat preamplifier (such as the CTP - XXXX family of magnetic phono preamplifiers) you will need to check this box.
Line Input / Tape: If you are feeding your soundcard directly from a tape deck or other high-level signal source, you need to check this box. This selection will bypass the phono equalization and re-equalization systems found in the “Record Type” selector box, feeding the signal directly into the Tone Controls and / or Volume and Balance sub-system.
Please note that any of the above input hardware options need to be connected to the line input of your soundcard; do not connect the output of any of these sources to the soundcards microphone input. Line level outputs will overload the high-gain input of the microphone amplifier of your soundcard creating clipping distortion which results in a very unpleasant sound.
Record Type (Selector Box)
The lower left corner of the VPP provides a group of selections based on the type of record that you are trying to transfer to your computer. This selection, in conjunction with the “Preamp Hardware” goes through a logical truth table in order to determine the proper algorithms to run to produce the correct phono EQ curve for the particular situation that you are working with. These EQ’s and re-equalization curves are highly accurate because they are calculated in a closed form mathematical technique. The most accurate transfer results will occur when you use a flat preamplifier as your systems input front end. Analog circuit parameters associated with resistors and capacitors in physical RIAA preamps render them less precise. These inaccuracies are reflected not only in the RIAA curve, but also in any of the re-equalization curves that the VPP can provide.
You have the following record options from which to choose:
This is intended to be used on all 45 RPM records and almost all LPs which were mastered post 1955 and some that were mastered prior to that date as well. The RIAA curve was originally called “The New Orthophonic Recording Characteristic” by RCA Victor which was proposed as an EQ standard in 1953 and later adopted by the RIAA. The VPP RIAA curve is defined as having the following breakpoint frequencies: (F {in Hz} = 1 /2 π (R x C) where R x C = Time Constant)
50 Hz Pullout (3180 uSec Time Constant)
500 Hz Turnover (318 uSec Time Constant)
2120 Hz Rolloff (75 uSec Time Constant)
This EQ curve is intended for many early LPs mastered during the period between 1948 through 1955. This curve was established as a standard for early Columbia LPs. The VPP Early Columbia LP curve is defined as having the following breakpoint frequencies:
30 Hz Pullout (5310 uSec Time Constant)
300 Hz Turnover (531 uSec Time Constant)
1600 Hz Rolloff (99.4 uSec Time Constant)
This EQ curve applies a turnover curve only (and the appropriate pullout) for use with 78 records having a 500 Hz characteristic. It does not implement any Rolloff, since 78s did not encode in that manner. Many American 78s were recorded with this curve. For more details regarding 78 Turnover frequencies by record brand, please refer to the “Turnover Frequency” section found in the Appendix of this user’s guide.
This EQ curve applies a turnover curve only (and the appropriate pullout) for use with 78 records having a 250 Hz characteristic. It does not implement any Rolloff, since 78s did not encode in that manner. Many European 78s were recorded with this curve. For more details regarding 78 Turnover frequencies by record brand, please refer to the “Turnover Frequency” section found in the Appendix of this user’s guide.
Acoustical
This EQ curve reverses the curve introduced by an RIAA front-end preamplifier and is passive for signals sourced from a flat preamplifier. When used in conjunction with a conventional RIAA hardware preamplifier, this setting would often be referred to as “Reverse RIAA Mode”. It is to be used on acoustically mastered material. Most recordings mastered before 1925 require this setting, including laterally cut 78s, Edison Diamond Discs, Pathé, and cylinder recordings.
Mono Checkbox
Sometimes it is desirable to convert laterally cut recordings to monophonic (Mono L+R) to reduce surface noise pickup produced by using a stereo phono cartridge. However, often it is better to de-click your recordings first before converting your file to Mono. Nonetheless, this feature is provided in the VPP as a convenience which is especially useful when using the system as a real-time phonograph playback system. It is important to note that Hill and Dale (vertically cut) records will not play correctly using this mode. To play Hill and Dale records, please refer to the Diamond Cut File Conversion Filter (Mono L-R) to properly decode these recordings. So, when you are dealing with vertically cut records, be sure to leave the VPP Mono Checkbox turned off so that the proper decoding can be applied further down the chain of events or further down the sequence of Multi-Filter filters.
Overload
Since the VPP volume control and / or its tone controls have the ability to add gain to the system, overload (sometimes known as clipping) can occur. The red overload “LED” located in the upper right hand corner of the VPP will flash when this condition occurs. If it does, lower the offending control until the Overload indicator no longer illuminates.
Presets
As with most of the Diamond Cut filters and routines, you can store your favorite settings by using the preset feature in conjunction with the “Save” button. The system will prompt you to name the state of the VPP after clicking on “Save”. To recall a preset, scroll down and click on the desired setting. To delete a particular preset, highlight it and then hit the “Delete” button.
You will see that there are around 60 factory presets provided in the VPP. Some presets are EQ Curves specified by their industry standard EQ Curve designation. For example, you can find the AES, NAB and FFRR LP EQ curves under those acronyms. You will also find EQ Curves that are specified by LP Label brand-name. Presets that are approximations have "Approximate" in the front of the name and finally, presets that are mathematically exact (closed form) have "Exact" in front of the name. These various LP preset curves apply to records recorded prior to the spring of 1954. Almost all LP labels switched over to the RIAA standard curve after that date. For LP records recorded later than the spring of 1954, simply use the RIAA curve found in the VPP. A complete set of VPP presets can be found in the Preset Listing section of this users guide.
VPP Application Example #1
You have an RIAA front-end preamplifier which you are using to play or transfer a European 78 RPM record. You want to decode it properly. To do so, set up the VPP in the following manner:
Preamp Hardware: Check the “Standard RIAA Preamp” setting.
Record Type: Check the “European 78s” setting.
Optionally, you can also tick off the Mono checkbox.
VPP Application Example #2
You are using a Flat preamplifier front-end to play Vinyl LP Stereophonic Records. To properly decode them, set up the VPP in the following manner:
Preamp Hardware: Check the “Flat Preamp” setting.
Record Type: Check the “RIAA Vinyl LP/45” setting.
VPP Application Example #3
You are using an RIAA front-end preamplifier to play early Columbia Vinyl LPs and you desire to decode them properly. To do so, set up the VPP in the following manner:
Preamp Hardware: Check the “Standard RIAA Preamp” setting.
Record Type: Check the “Early Columbia LPs” setting.
Optionally, you can also tick off the Mono checkbox.
VPP Application Example #4
You are using an RIAA front-end preamplifier to play Acoustical 78s. To properly decode them, set up the VPP in the following manner:
Preamp Hardware: Check the “Standard RIAA Preamp” setting.
Record Type: Check the “Acoustical” setting.
Optionally, you can also tick off the Mono checkbox.
VPP Application Example #5
You are using a Flat Preamplifier front-end to play American 78s having a 500 Hz turnover curve. To properly decode them, set up the VPP in the following manner:
Preamp Hardware: Check the “Flat Preamp” setting.
Record Type: Check the “American 78s” setting.
Optionally, you can also tick off the Mono checkbox.
Important Note: Never choose settings for the wrong type of Preamplifier hardware being used because the balance of the frequency spectrum of energy distribution will be extremely unbalanced and / or distorted.
VPP Application Example #6
You are using a Flat Preamplifier front-end and you desire to play some LPs in real time through your computer sound system. You do not desire to transfer them to your hard drive, but simply to listen to them. To play them, do the following:
Bring up the Virtual Preamplifier in the Multi-Filter.
Preamp Hardware: Check the “Flat Preamp” setting.
Record Type: Check the “RIAA Vinyl LP/45” setting.
To play the LP in real time, click on “Live Preview” in the Multi-Filter.
Adjust the tone controls, volume and balance for the most pleasing sound.
Note: If you want to remove noise in real time while playing your LP, drag the appropriate noise reduction filters into the Multi-Filter path after (to the right side) of the VPP and adjust them appropriately.
VPP Application Example #7
You are performing a transfer using either fractional speed mastering or high speed dubbing techniques on an electrical recording and you want to decode its EQ properly. Your front-end preamplifier is of the flat variety*. To properly re-create the appropriate EQ, you will need to do the following:
Transfer the recording and then correct the speed using the Change Speed Effect. After the speed has been corrected, run the file through the VPP using the following settings:
Preamp Hardware: Flat Preamp.
Record Type: Use the setting which best fits the description of the transferred recording.
*Note: The CTP Series of Flat Phono Preamps can be purchased from Diamond Cut Productions, Inc.
VPP Application Example #8
You are performing a 78 RPM transfer using a magnetic RIAA pre-amplifier and you are also using fractional speed mastering techniques and you want to decode its EQ properly. To re-create the appropriate playback EQ, you will need to perform the following steps in this exact sequence:
Transfer the recording to your computer and then run the file through the VPP with it set for the following:
Preamp Hardware: Standard RIAA.
Record Type: Acoustical (even though the record may have been of the electrical variety; this step reverses the RIAA curve that was imparted onto the signal by your RIAA preamplifier).
Next, correct the speed of the transfer using the Change Speed Effect. Then, re-set up the VPP as follows and then “Run” the Filter:
Preamp Hardware: Flat Preamp.
Record Type: Use the setting which best fits the description of the transferred 78 RPM recording.
VPP Application Example #9
You are using the Virtual Phono Preamp to cut vinyl masters (vinyl has come back in vogue in some circles lately). To properly encode the master with the RIAA curve, set up the VPP in the following manner:
Preamp Hardware: Check the “Standard RIAA Preamp” setting.
Record Type: Check the “Acoustical” setting.
This process will allow you to take digitally recorded material and directly create the encoded RIAA master to a very high degree of accuracy (within a fraction of a dB of the theoretical curve). This master can then be used directly to drive the cutter lathe power amplifier to create your RIAA encoded vinyl master.
The File Conversion filter is not really a filter at all, but a way to convert mono files to stereo and visa-versa. It can also be used to adjust the channel balance or reverse the channels of a stereo recording, or convert a mono source into a stereo file. It is useful in converting stereo recordings made out of phase (such as old vertically recorded acoustic discs) into a stereo or mono file that is compatible with modern systems. The Time Offset feature can be used to correct for group delay problems, correct azimuth errors from tape recordings, or to create special effects. The phase inversion function can be used to correct files that contain an inadvertent 180 degree phase shift of one channel with respect to the other (only one of the phase inversion checkboxes need to be checked to accomplish this correction on a relative basis).
The File Conversion Window
The “File Conversion” Filter includes three slider controls. One set of two controls allows you to adjust the Amplitude (gain) levels for each channel. The third control, called “Time Offset”, provides a means for azimuth correction, Forensics audio enhancement, and stereo simulation. A final important use of the file conversion filter is to simply copy parts of the source file over the destination file. This is one way to revert back to the original source file (undo) following a bad filter application.
This sometimes will be the first step that you will perform in a sound restoration project. This File Conversion Filter provides a number of file conversion options that can provide a certain degree of noise reduction in and of themselves. Gain adjustments can also be performed during the file conversion process. The following File Conversion options are available:
From Stereo to -
From Mono to -
Here are more details on the various File conversion options and their specific application:
This is generally used to convert a lateral cut record (like a typical 78, or a monophonic LP) which is monophonic to start with, but which has been transferred to the hard drive with a stereo cartridge, and convert these two signals into one signal on which you will perform further processing. The advantage of this simple conversion is that some of the noise content of the record will cancel out during this process, in particular, low end rumble, and even some higher frequency surface noise. This process alone can provide up to 6 dB of signal-to-noise improvement (depending on the condition of your source) compared to the use of only one of the lateral groove walls (i.e. using the left only or the right only signal).
Important Note:
It is advisable to set both gain controls to - 6 dB to avoid overloading of the Destination channel during this mixing process, unless your recording is extremely under-recorded to start with. Minus 6 dB is the default value for the two gain settings in the Mono (L + R) File Conversion feature.
Sometimes, 78-rpm laterals are worn unevenly due to years of improper tracking of the tone arm that played the particular record. Therefore, it is sometimes useful to compare the Left Only groove wall with the Right Only groove wall to hear if that is the case. If you hear a significant difference between one of the two groove walls, you should then compare the quieter of the two with the Mono (L + R) signal for comparison. Choose the quietest of the three possibilities for your Destination file.
This feature takes the algebraic difference between the left channel and the right channel audio signals and feeds it into the destination file. It has three applications:
This algorithm preserves a truly stereophonic Wave file in dual-channel format through the sound editing and sound restoration process. It allows you to adjust the channel levels to bring them more into loudness balance if they are imbalanced to begin with.
This algorithm transposes the left and right channels from the source file before it is transferred into the destination file. This algorithm also allows you to, while reversing the channels, adjust the channel levels to bring them more into balance if they are not balanced to begin with.
The file conversion routine includes a "Time Offset" feature. It is mounted horizontally on the file conversion control panel. For normal file conversion operations, this control MUST be set to zero. The time-offset algorithm provides you with the ability to retard or advance the timing between two stereo tracks. This will work with a stereo-to-stereo conversion or a mono to stereo conversion. The range of adjustment is + / - 20 milliseconds; when the control is set to its center (zero), the time offset between the two stereo channels will be zero milliseconds. To fine-tune this parameter (as with any of the parameters in the program) Use the UP ARROW key to increment and the DOWN ARROW key to decrement the time offset value. This is especially useful when performing the Analog Magnetic tape recording azimuth correction procedure.
This feature has three applications:
180-degree phase inversion can be applied to either channel by checking the appropriate box. This feature can be used to correct for out-of-phase stereo masters wherein the cutting head was connected incorrectly to the cutting head power amplifier, or one microphone was wired backwards on a stereo recording situation or other similar defects. Please note that if both boxes are checked, you are right back where you started. You must only check one of the two boxes to correct for an out of phase channel.
These two controls (one for the left channel and another for the right channel) are used to set the amplitude of each channel in terms of dB. Sometimes, these are referred to as “gain” controls. The amplitude level is shown in dB directly above each Amplitude slider control.
This checkbox will lock the Amplitude dB (gain) controls together so that they move simultaneously.
Note:
The gain and the Time Offset controls on the File Converter routines can be adjusted "live" after the Preview mode button has been clicked.
Cross Fade Filter
The Cross-fade filter is used to join sections of different .wav files into a single .wav file in a special way. Rather than just abruptly ending one file and starting another, the Cross-fade filter will smoothly fade from one file to another. During the time that the files overlap, the destination file is gradually faded to silence, while the source file fades from silence to full volume. This filter is also available via its icon, or from the Filter Menu or from the Edit menu as one of the “Paste” functions.
Note:
Crossfade can only be performed in Classic Edit Mode. Therefore, this menu item and the corresponding Crossfade icon will only come alive after you have files situated in both the Source and Destination workspace. One file can then be cross-faded into the other.
Using the Filter Menu Cross-fader (Tutorial)
Warning: This is not undo-able
Wind Noise Filter (speech)
High levels of wind can interfere with outdoors audio recordings. Often, audio professionals will apply a fixed High Pass Filter to the recording to reduce this annoyance. But, this approach also damages the good audio that one is trying to capture. The Diamond Cut Wind Noise Filter (speech) is a special IIR based dynamic filter using multiple bands across the lower end of the audio spectrum (ranging from 20 Hz to 500 Hz). It dynamically activates these filters depending on the measured presence of random noise within any of those bands leaving behind the good audio while attenuating the random wind noise. Although this is not a perfect filter, it is very useful in spoken word outdoor situations and can produce a greatly improved result compared to the fixed High Pass Filter approach to the problem.
Wind Noise Filter
Threshold Control: (1.0 to 50.0) Increased aggressive filtering action occurs at lower threshold control settings. The least aggressive setting is 50.0 (all the way up). Adjust this control until the “Wind Level” meter is fluctuating in sync with the wind noise, and the wind noise is dynamically being reduced by the filter.
Attenuation Control: (0.01 to 1.00) This slider control allows you to set the amount of attenuation provided by the Wind Noise Filter. The maximum degree of attenuation occurs at a setting of 1.00. Adjust this for the best balance of the sound quality vs. low frequency artifacts.
Wind Level Bar Graph: This indicator shows the dynamic activity of the wind noise filter. The higher the meter graph deflection, the greater is the action of the wind noise filter.
Operation: Bring up the file with wind noise interference. Bring up the Wind Noise Filter. Set the Threshold control to 15.0 (initially). Set the initial Attenuation value to 0.50. Next, adjust the Threshold control upwards or downwards until the Wind Level Bar Graph modulates (deflects). Keep adjusting the Threshold control until you perceive the average deflection to be around the center of the bar graph display. It may occasionally top out or bottom out - - - that is ok. Finally, adjust the Attenuation control for the optimal level of noise reduction and a minimal amount of artifacts.
Note: A Wind Noise Demo file is provided to help you learn how to use this filter. It is called “Wind Noise Filter Demo.mp3”.
The Effects Menu
The Effects Menu houses a good portion of the audio enhancement tools located in DCArt10/DC Forensics10. This is the place to head when you want to breathe new life into an old or poorly recorded file.
The Effects Toolbar
Reverb
The Reverb effect is used to add a realistic room sound to a recording. The reverb is capable of simulating different size rooms, with different types of reflective surfaces and decay times. The reverb effect lets you control the overall room size, decay time, early reflection level, and the mixture between the original material and reverb sound.
The Reverb Effect Window
Reverb can be useful when dealing with recordings, which are completely “dead” as originally mastered. As with the various other filters, the reverb effect can be applied globally or selectively (using sync mode) to a .wav file. The reverb effect can also be used to convert a monophonic recording to a simulated stereophonic recording. The following controls are provided on the DCArt10/DC Forensics10 Reverb:
The decay control affects the dampening effect of the algorithm on the reverberated signal. The higher this control is set, the longer the reverberation “dwell-time.” The lower that this control is set, the quicker will be the decay of the reverberated waveforms.
The Output mix determines the amount of the reverb effect that is fed into the system output. When the control is set to zero (dry), there will be no reverb effect. When the control is set to 99, there will only be the reverb effect, with the source signal bypassed. Useful ranges of control are usually in the 5 to 25 range, but if you are looking for extreme effects, you can get them if desired.
The Reverb is equipped with a number of descriptive presets. This is a good place to start from when using the reverb effect. Choose the desired acoustical environment (which can be selected and previewed “on-the-fly”). After you have found something close to the sound you desire, revert to the various controls to fine “tweak’” the reverb for the exact sound you are looking for.
Echo Effect
The Echo Effect is a digital simulation of the old-fashioned magnetic tape delay lines (sometimes called “Tape Delay Echo Chambers”) that were popular in the early 1950s and throughout the 1960s. These devices worked on either of the following basic principles. One method varied the distance between the recording and the playback head producing a variable time delay, a portion of which could be fed back to the system’s input. A second method used a variable speed motor driving the tape media with the recording and playback head positions being fixed, producing similar overall results. The Echo Effect contains two independent delay lines, which can be used in a number of different modes providing it with a great deal of flexibility compared to the old analog systems. Because it performs its function utilizing digital techniques, it does not suffer from the noise and distortion buildup associated with the older analog systems. However, if the so-called “retro” sounding echo chamber is desired, you can use the Echo Effect in conjunction with the Virtual Valve amplifier in the Multi-Filter. The Echo Effect is useful in any of the following applications:
DCArt10's Echo Effect
The Echo Effect has the following controls:
Important Note: This mode can produce sustained
oscillations if the feedback control is set too high.
Ancillary Echo Effect Controls:
The Virtual Valve Amplifier (or VVA) is a computer simulation of a number of vacuum tube amplifier circuits. (Valve is the British term for electron tube.) We call it the "Virtual Valve Amplifier” because that sounds cooler than "Virtual Tube Amplifier". Its effect is to add "tube-warmth" to the sound of a recording. This is sometimes desirable to apply to DDD (purely digital) recordings. It can also be used to add subtle harmonics to very old recordings. A harmonic exciter is also included with the Virtual Valve Amplifier. It is important to note that the Virtual Valve amplifier is using real tube circuits, and real tube non-linear device characteristics to produce its effect. The wide range of adjustability of this algorithm will allow you to create an amplifier that runs the gamut in sonic performance from "grit-guitar" to "high-end audiophile."
The Virtual Valve Amplifier
The Virtual Valve Amplifier (VVA) produces a variety of sounds associated with valve (electron tube) based amplifiers. The effects run the range from a nuanced “tube warmth” sound to extreme effects like “guitar amplifier overload” or “fuzz box.” The DCArt10/DC Forensics10 VVA accomplishes these effects through the use of actual electron tube circuits, which are simulated by your computer. The electronic models of the various tube amplifier circuits have been derived from the “large-signal” transfer functions of the various tubes and output transformers you can choose from. This data has been derived from extensive bench measurements of tube amplifier circuits under varying operating conditions. The circuits are not “idealized”, but real circuits. As such, the effects will sound literally as would be heard if you were to process a signal through a physical electron tube amplifier having the devices or configuration that you have chosen.
However, with the VVA, you have a great deal more control over the various sounds that can be produced, since controls, which are not normally found on electron tube equipment, have been provided. Parameters such as “Operating Point” (sometimes referred to as “Q” point by engineers) are usually fixed by the amplifier manufacturer. “Drive” is determined by how loud you play a “physical” amplifier, but with the VVA, the output level remains constant independent of drive due to an internal gain compensation algorithm. The following is a listing of the controls that are provided on the DCArt10/DC Forensics10 VVA:
This control effects the degree of modulation applied to a given tube amplifier circuit and centered about the operating point setting. The higher the drive level setting, the greater will be the production of predominantly even order harmonics due to the circuit’s asymmetrical non-linearity. As a result, there will be more “effect” as this control is increased. Also, the “depth” of the effect is determined in part by the degree of drive applied.
The operating point control performs two different functions, depending on the Tube Type / Configuration selected. When a triode or class A amplifier is chosen, it sets the operating point for the particular tube or amplifier configuration that you have chosen. Operating point also determines the device’s bias value at zero signal input. The distribution pattern of harmonics, which are introduced into the output of the amplifier, are determined to a large degree by the location of the operating point. When the control is set to + 100, (all the way up) the devices are operating close to “saturation,” and when the control is set to – 100 (down), the devices are operating close to “cutoff.” The non-linearity distortion distribution is different near cutoff as compared to operation near saturation. You can use the operating point control to achieve variations in the desired “tube effect.” Most audio preamplifier tubes such as the 12AX7 are the most linear in the middle of their dynamic operating curve (control set to the middle “0” position).
When the system is placed into harmonic “Exciter” mode, the operating point control reverts to a “Harmonics Control” which varies the distribution of harmonics that are produced by the VVA. The Harmonic Exciter is designed to provide the following audio enhancements:
When the control is set to +100, both even and odd harmonics are produced. When the control is set to –100, only the first 3 to 4 even harmonics of the fundamental are produced. Settings in between will produce varying combinations of the two extreme settings. The system is placed into harmonic Exciter mode by checking the “Exciter” box listed under Tube Type / Configuration, located at the bottom of the VVA window. (You must be in “Advanced Controls” mode to see the Exciter checkbox.) The magnitude of the inserted Exciter effect is controlled by the “Mix” control.
Vertical undulations are graphically presented proportional to signal level, drive, and operating point. The Operating point indicator will have a blue background in standby modes of operation and a blue background with vertical undulations appearing in any of the operational modes of the VVA. An orange modulating vertical bar during operation indicates the modulation adding to and subtracting from the operating point center value. The magnitude of the drive level to the amplifier is indicated by orange undulations plus and minus about the operation point. So both the effects of the drive and the operating point slider are presented via the same graphic display in an intuitive manner.
The detail control allows you to control the sensitivity of the VVA to the more delicate nuances of the musical material presented and processed. The higher the setting, the greater the effect will be on the material.
The Mix control affects the degree of VVA signal, which is re-inserted into the signal path. At its maximum setting of 100 (wet), the dominant signal pathway is exclusively through the VVA, and when the control is set to 0 (dry), only the non-processed signal is fed through the system. You can choose any level in between which appeals to your taste.
The “Spectrum” range control effects the spectral distribution of the harmonic by-products, which are passed through to the systems output. The most desirable setting is very much a function of the musical material which is being processed and the desired tube sound.
"Full Range" mode is generally used to “round out” the entire audio spectrum of a recording. It is important to note that when you are operating a tube in Full Range mode, there is a dramatic increase in the propensity for the production of inter-modulation distortion, which is not particularly desirable (except for heavy metal rock). To minimize this effect, you will have to use much smaller values of "Drive" to obtain reasonable results when compared to the "Sweet", "Warm", or “Fat Bass” modes. Sweet and Warm modes are preferable to use over Full Range mode because they dramatically reduce the propensity of the electronic valves from producing inter-modulation (IM) distortion, leaving behind only the more pleasing harmonic distortion type.
Fat Bass Mode
“Fat Bass” mode is used to add some dimension to sterile sounding bass. It restricts the VVA’s action to the excitation band of frequencies below 175 Hz. However, it allows harmonics to be produced that are higher adding that “Fat Bass” sound typically associated with tube amplifier circuits. Push-pull circuit configurations will produce dominantly Odd harmonic bass effects while Class A circuits will produce both Even and Odd harmonic effects. “Sweet” and “Warm” settings restrict the operation of the VVA to the upper portions of the audio spectrum, producing pleasing tube generated harmonic and compression effects.
This enables the more advanced controls of the VVA to be displayed to the user, if desired. When this control is not checked, default values will be chosen for some of the control settings, tube types, amplifier configuration, operating point and detail controls based on the selected VVA preset. When the Advanced Controls are turned off, you will still have control over the VVA Drive and Mix settings.
The Virtual Valve Amplifier
(with advanced controls showing)
Some extremely noisy recordings (like certain 78 RPM records) can become even noisier when the VVA is applied to their signal. So, not only will you obtain the pleasing harmonics that you desire, but you will also obtain the undesirable elevation of the recordings already high noise floor. The “Hi Noise” mode is designed to alleviate this problem. When this checkbox is activated, the system changes into a noise suppression mode. The “Detail” control reverts into what is redefined as a “Threshold” control. Harmonics are only generated when the average harmonic signal level exceeds the set threshold which can be varied by this control. The green indicator (a virtual LED which becomes visible directly above the threshold control when operating in Hi Noise Mode) will illuminate when harmonics are being generated by the system that are above the set threshold level. Moving the threshold control upwards increases the noise reduction effect, but also reduces the VVA effect. Moving the control all the way down will keep the VVA system active all the time with no noise suppression effect at all. Moving the control all the way up will keep the VVA effect off all of the time. Adjust the threshold control somewhere in the middle so that quiet passages squelch the system as indicated by an extinguished LED indicator. Reasonable levels of noise suppression are had when the green indicator occasionally flashes while previewing a track. This “Hi Noise” mode will reduce the incremental noise contributed by the VVA to an already noisy recording. Thus, you can enjoy harmonic generation and increased brilliance on dull & noisy recordings without suffering an elevation of their noise floors.
Please note that the Hi Noise Mode is designed to be used in conjunction with the VVA’s “Sweet” or “Warm” settings only.
This control allows you to quickly compare the effects of the processed signal produced by the VVA to the unprocessed signal, while the program is in “Preview” mode.
The VVA has a list of pre-sets, which will be a valuable starting point from which to fine tweak the adjustment controls to your desired taste. These presets are somewhat descriptive to help you in making a choice. The choices can be changed in real-time while running the program in Preview mode, so that you may compare the various presets.
K. 6267 / EF 86 Pentode - The 6267 / EF86 pentode was suited well for use in low-level preamplifier service where low noise and minimal microphonics were important. It was often found used as the first-stage amplifier in tape decks. Its high-gain characteristic provide it with an interesting family of operating curves that provide useful harmonic distortion and signal compression in the VVA.
L. 2SK-175 MOSFET - This device is not a tube, but rather it is an N-Channel Audio Power MOSFET (the P-Channel compliment of which is the 2SJ-55). It was commonly found in high power, high quality audio power amplifiers and is included here because it has a set of operating curves which differ in shape somewhat from the various VVA electron tubes. It will provide you with a different distribution of distortion harmonics which you may find pleasing in some circumstances.
Just like the other filters and effects, the VVA is equipped with a set of descriptive presets. This is always a good place to start from when using the VVA. After you have found the preset, which most closely resembles the sound you are looking to achieve, you can go back and “tweak” the controls more precisely. After you have established a group of settings that you would like to keep, use the “Save” settings feature to give your preset a name so that you can recall it in the future.
Note: Voltage Amplification stages usually produce a phase inversion of the applied signal (180 degrees). All of the VVA devices and/or systems are phase corrected to zero degrees for user convenience.
The dynamics processor provides you with the ability to control the dynamic signal content of the audio envelope of a .wav file. Included are Compression and Limiting, downward Expansion/Noise Gating, ALC, and De-Essing.
The Dynamics Processor
The Dynamics Processor provides you with three functions related to the control of the dynamic range of an audio signal. The functions are as follows:
(Wide Attack & Release Time Ranges are provided in version 7 on Forward)
This system is a downward dynamic expander. When the applied signal is below the threshold setting, the dynamic range of the signal is increased depending on the value of the ratio setting. In other words, the incremental attenuation of the .wav file signal is proportional to the ratio setting when it is below the threshold value. The higher that you set the value of this ratio, the greater will be the degree of downward expansion applied to the signal. Signals above the threshold value are passed through the system with no processing applied. When the ratio control is set to its maximum value (control set all the way up), the system will behave like a Noise Gate (several noise gate presets are available in the Presets menu).
When more modest values of the ratio control are used, the system can produce some improvement in dynamic range and also the average signal-to-noise ratio of a .wav file. The Expander has the following controls available:
Checking this box will enable or disable the Expander/Gate function of the Dynamics Processor.
This control establishes the signal level below which the Expander performs its process on the .wav file signal.
This control determines the degree of downward expansion applied to the .wav file for signals that are below the threshold value setting. The higher the number chosen, the greater will be the signal expansion effect.
This meter indicates the actual value of downward compression in dB, which is being applied to the .wav file signal.
This control is used for the Expander/Gate, Compressor, ALC and De-Esser functions of the Dynamics Processor. It determines the time constant associated with the onset (delay) of any of the Dynamic Processor effects.
This control is also used for the Expander/Gate, Compressor, ALC and De-Esser functions of the Dynamics Processor. Its setting determines the delay time associated with the decay of the particular process chosen.
This system is an upward compressor and is the only thing active when the Expander/Gate is turned off. When a .wav file signal level is above the threshold setting, the dynamic range of the signal is decreased, the degree of which depends on the value of the ratio setting. In other words, the incremental attenuation of the signal is proportional to the ratio setting when it is above the threshold value. The higher that one sets the ratio value, the greater will be the degree of compression. When this ratio value is set to its maximum, the system will behave like a Limiter. Signals below the threshold value are passed through the system with no processing applied. When the ratio control is set to its maximum value (control set all the way up), the system will produce the largest degree of compression. The Compressor has the following controls available:
This control is similar to the threshold control for the expander, but establishes the signal level above which the compressor performs its process on the .wav file signal.
This control determines the degree of compression, which is applied to the .wav file for signals that are above the threshold value setting. The higher the number that is chosen, the greater will be the effect on the signal.
from 0 dB to 40 dB. This meter indicates the actual value of compression in dB that is being applied to the .wav file signal.
This control is used for the Expander/Gate, Compressor, ALC and De-Esser functions of the Dynamics Processor. It determines the time constant associated with the onset (delay) of any of the Dynamic Processor effects.
This control is also used for the Expander/Gate, Compressor, ALC and De-Esser functions of the Dynamics Processor. Its setting determines the delay time associated with the decay of the particular process chosen.
Important Note: The Punch and Crunch Effect provides you with a somewhat different approach to compression and expansion using multiple frequency bands.
De-Esser
A de-esser is a form of compressor, which is only reactive to the frequencies associated with the pronunciation of the letter “s” (“ess”). It is necessary to perform this function on over-modulated signals in the “s” frequency range and is adjustable from 1,000 Hz to 10,000 Hz. This occurs due to poor mike technique, a poor initial mix, improper mic channel equalization, or insufficient “padding” of the mic input circuit during the recording session. When the frequencies in the sensitive band are detected and are above the threshold setting, compression will be applied to the degree determined by the compressor ratio control. To place the compressor in the De-esser mode, click on the box by the same name.
One global control is provided in addition to all of those mentioned above. The output gain allows you to correct for overall amplitude effects (attenuation or gain) that any of the dynamic processor functions may have on the overall output signal level. Presets have also been provided to get you started with reasonable setup parameters for the various dynamic processor functions.
The Dynamics Processor includes an automatic level control feature (ALC). Sometimes, these algorithms or systems are referred to as automatic gain controls or AGC’s. This feature provides upward expansion of signals below the threshold line and downward compression of signals above the same threshold. This feature is useful in Forensics applications where there is a large variation in signal levels between several different parties that may be communicating with one another. It is also useful for the broadcast of live sporting events (if you have the DC Forensics10 version of the product) in which the crowd reaction is of interest when the announcer is not speaking. Simply clicking on the “ALC” box in the Dynamics Processor activates this feature. The threshold, attack, and release controls are still active when this function is invoked.
Output Control and Clip LED
Since the Dynamics Processor can add considerable gain to your system (especially when operating in Expander mode), an output level control and a red LED clip indicator are provided. If you observe that the red LED indicator is flashing, then the system is clipping your signal. For the cleanest results, use the Output Control to decrease the level until this no longer occurs.
Reverse File
The Reverse file feature does just that - - - it converts a .wav file so that it will play in reverse. This has several uses:
Channel Blender
The Channel Blender provides the ability to reduce muddy bass from vinyl recordings, decrease the "ping-pong" effect from early stereophonic recordings, minimize multi-path distortion from FM stereophonic broadcast recordings and even remove vocals from stereo recordings. It can also be used as a spatial enhancer (spatializer) when one of the two channels is set for “Invert Phase”.
The Channel Blender
The Channel Blender serves (at least) 7 purposes:
7. The Channel Blender can be used as a “Vocal Remover”
using several special presets that it contains. Vocal
removal (vocal attenuation) requires a Stereo recording
source wherein the lead vocalist is contained within both
channels.
There are 4 presets to choose from including:
Lead Vocal Attenuator 1
Lead Vocal Attenuator 2
Lead Vocal Attenuator 3
Lead Vocal Attenuator 4
The Channel Blender has the following unique controls:
Punch and Crunch
Punch & Crunch is a multi-band Dynamics Expander, Compressor or Automatic Level Control (ALC). It allows you to modify the dynamics of a piece of audio in a very natural sounding manner. In some cases, you may want to restore lost signal transient response by applying the expander mode, but in other cases you may want to compress the signal in order to produce more “broadcast presence” (or perceived loudness).
Punch and Crunch has a four band Dynamics Expander (Punch) or Compressor (Crunch) or an Automatic Level Control (ALC). Each band is fully adjustable in terms of dynamic amplitude and frequency response. It is useful for a number of applications such as the following:
The Punch and Crunch Effect in Fixed Frequency Mode
The Punch and Crunch Effect in Variable Frequency Mode
It works by breaking the audio spectrum into four separate bands. Each band is independently processed when its signal exceeds the graphical display of its particular threshold line. The ratio control modifies the degree to which the bands are expanded, compressed or ALCed. The actual compression or expansion of any particular band is shown by horizontal bar graphs for each band that are calibrated in dB. The bands are broken into the following “buckets” when operated in the non “Variable Freq Mode”:
The following controls are provided on Punch and Crunch:
Variable Frequency Mode
This mode, when activated, allows you to shift the location of all of the crossover frequencies anywhere across the audio spectrum. You are not tied into the fixed frequency associated with the legacy mode of operation for the Punch and Crunch effect. Because the frequency ranges are user definable, they can be placed quite close together because the system also employs symmetrical third order slopes at the various crossover frequencies, unlike the asymmetrical nature of the crossovers used in fixed frequency mode of operation. This provides better isolation between bands thus reducing adjacent band crosstalk. To place the system into a variable frequency mode of operation, merely tick off the “Variable Frequency Mode” checkbox. Then, you can drag from side to side the various crossover frequencies (the vertical lines between each of the bar graphs). And, just like in fixed frequency mode, you can vary the threshold at which each band becomes active by dragging the horizontal component of the bar graphs upwards or downwards.
Change Speed
The Change Speed Filter is designed for use in several applications:
The Change Speed Effect
The following is a summary of the control parameters and the range of adjustment provided for the Change Speed filter:
Straight Line (2 Green Cursors)
Curved Line (4 Green Cursors)
Constant (Start and End Track each other)
The Graph shows you how you have programmed the speed to change as a function of the selected .wav file time axis. You can use the mouse to drag the two green cursors to establish the time relationship that you desire. Often, a flat line is appropriate; however, sometimes the speed of the cutting lathe would slow down towards the end of the recording. The reason this occurred is that some of the early recording lathes used wind up mechanical motors with governors rather than electrical hysteretic synchronous motors. To correct this defect, a pitch decrease (negative pitch slope) is necessary towards the end of the recording. When the curve shape is selected, two additional green cursors appear. The new green cursors can be moved both vertically and horizontally allowing you to create numerous curvilinear pitch vs. time relationships. Curvilinear correction is useful for fixing the speed of non-capstan based tape recordings that have been transferred using a capstan-based machine. It can also be used to create interesting special effects when used in conjunction with the looped preview or looped play mode.
Use the following Formulae to calculate the % Pitch Change required when using fractional speed mastering:
Δ Pitch (%) = ((R/T) – 1)(100)
Wherein:
T = Actual Turntable Speed (RPM)
&
R = Rated Recommended Record RPM
(see the RPM Chart in the Glossary of Terms section of this manual to determine the correct recommended Record RPM)
One method for determining the pitch change required for a particular recording is to measure the line frequency “Hum” on the signal. This can be accomplished with your Diamond Cut Spectrum Analyzer. Deviations from the ideal values (50 or 60 Hz) can be compensated using the Change Speed feature by applying simple ratio proportions based on the measured hum frequency value compared to the ideal value.
Note: The Change Speed Effect will not appear in the Effects list if no file has been opened.
Automatic Change Speed Compensator
Sometimes, it is hard to determine what the correct pitch correction factor that should be used for a particular recording when the line frequency hum of the original recording can’t be discerned from other noise components. But, if you know the length of the piece, you can use the Automatic Change Speed Compensator to correct its pitch. Often, the time duration of a particular track is published in the liner notes associated with the recording. Simply do the following:
A. Make sure that the recording is trimmed carefully with no lead-in or lead out dead-time. You can always add back into the file some silence after the speed compensation process has been completed.
B. Click on “Set” and then enter the published value of time into the “Resulting Time” data entry field.
C. Run the filter and thereafter the pitch should have been corrected so long as the published time duration for the track is accurate.
This method can also be used to take a track that may be a little too short or too long for a choreographed performance and correct it per the contest rules (within reason). Another feature to consider for this type of situation would be the Diamond Cut Stretch and Squish time compression algorithm, especially if large time changes are required.
Note: The Automatic Change Speed Compensator should only be used in Straight Line Slope mode.
Time Compression and Expansion (Stretch and Squish)
The Stretch and Squish filter is a variation on the theme of the Change Speed filter. It allows you to change the cadence (tempo or speed) of a piece of audio while maintaining its pitch at a constant value. You can either slow down the beat or cadence of a piece (Stretch) or speed it up (Squish).
The Stretch and Squish Effect shown in Legacy Mode
The Stretch and Squish Effect shown in Pitch Shift Mode
Stretch & Squish is actually a special case of the speed change filter. It has the ability to maintain a relatively constant pitch while modifying the cadence or beat interval of the .wav file that is being processed. Its primary purpose is for Forensics applications in which a spoken word recording needs to be slowed down for transcription to the written word; however, it can also be used to learn a fast guitar riff by slowing it down, or for other special effect situations. It has a range of adjustability that will allow you to half the cadence in “Stretch” mode which means that it is slowed down. Also, it has the ability to double the cadence of a .wav file in “Squish” mode. Stretching or Squishing a .wav file is accomplished with the Stretch control. If you set the Stretch control to 1.000, the file will play or preview at normal speed. However, if you decrease the number to its lower limit of 0.5000, you can double the speed of the recording. If you increase the number to its upper limit of 2.000, it will now play at half speed. Also, a Size control is provided which allows you to vary the update rate of the algorithm. This control affects the overall sound quality of the filter, which is subjective in nature and left up to the user. The following controls are provided on the Stretch & Squish Filter:
0.500 to 1.000 speeds up the file and represents “Squish” mode
1.000 to 2.000 slows down the file and represents “Stretch” mode
Pitch Shift Mode (Semi Tones): (Range - 12 to + 12) In Pitch Mode (operable only when Legacy Mode is unchecked) you can change the pitch of a file while keeping the tempo (rhythm or cadence) constant. Its range of adjustment is +/- 1 octave wherein +12 represents a one full octave increase in Pitch and – 12 represents a one octave decrease. The calibration is in semitones meaning that the octave above and below the source material is divided into twelfths (12 semitones in an octave). Each unit of measurement associated with the Pitch control represents one note on the chromatic musical scale. You can fine-tune the pitch of the system using the left and right arrow keys in association with the Pitch control. To do so, just click on the pitch control slider and then use the up and/or down arrow keys until you achieve the desired pitch while previewing your file. The exact semitone value being used is displayed in the digital readout located directly above the Pitch control.
The Stretch & Squish Effect includes a set of 6 “Disguised Voice Effect” presets that you can use to shroud human voices behind a sonic veil (making them unrecognizable). You should not “hot switch” between these presets while previewing them, because some of them actually change the algorithm being used to accomplish its effect. Always stop the preview process before selecting another one of these presets to assure proper algorithm initialization.
Note: This effect produces digital artifacts. Artifacts are normal for this type of mathematical manipulation when applied to a .wav file. The greater the amount of “Stretch” or “Squish” applied, the greater will be the degree of artifacts generated by the routine. Quality will decrease as you increase the amount of time compression or expansion.
In “Pitch” mode (operable only when Legacy Mode is unchecked) you can change the pitch of a file while keeping the rhythm or cadence constant. Its range of adjustment is +/- 1 Octave wherein +12 represents an octave increase in Pitch and – 12 represents a 1 Octave decrease. The calibration is in semitones meaning that the Octave above and below is divided in twelfths (12 semitones or half-tones are in one Octave).
Note: With the musical scale of twelve-tone equal temperament further divides each semitone into 100 parts called cents.
The Filter Sweeper is a novel system providing a variable frequency response versus time capability. The sweeper can be applied to an entire .wav file or any portion by using the Diamond Cut selective filtering capability. Three filter types are available in the Filter Sweeper including a sweep-able Low-Pass, High-Pass, and Notch. Besides producing interesting special effects, the Filter Sweeper has a number of very useful audio restoration applications. Here are two examples.
The hum frequency of a recording sometimes changes as a function of time. This audio defect may be due to the fact that the original analog tape recorder was battery powered and as the battery became weaker during the recording process, its speed decreased. This mechanism will have caused the resultant hum frequency to increase versus time when played back later on a constant speed system. To correct this defect, you can apply the Filter Sweeper set for operation in “Notch” mode. Set the “Start Frequency” to the appropriate lowest hum frequency value of the defective .wav file, and the set the “Stop Frequency” to the highest value of hum frequency. These two values of frequency can be determined by using the Spectrum Analyzer while using the “looped play” mode during the appropriate sections (beginning and end) of the defective .wav file. The “Sweep Type” will need to be determined empirically, because the appropriate compensation curve will depend on the type of capstan servo motor regulator that was used in the offending tape recorder in conjunction with the type of batteries that had been employed.
The Filter Sweeper
Another application of the Filter Sweeper is what we call “masked” Fade-Ins and/or “masked” Fade-Outs. These “masking” techniques not only can be used to produce very interesting effects, but also provide a very useful noise reduction tool. How can a swept filter produce noise reduction? The principle is based on a simple musical concept coupled with the non-linear nature of the human sense of hearing. Some musical material commences with very simple progressions (including only one or two musical instruments), then moving into a series of complex riffs and refrains (maybe including a few crescendos) and then often diminishing in complexity towards its ending (soft curtain). Much of the noise in such a recording is hidden by the complexity of the musical material found it the central body of the piece. The noise on the recording is heard to be most prevalent to the human ear at its beginning and its ending during the compositions simple parts. (In actual fact, the noise level is probably relatively constant throughout the entire recording.) That is why we refer to this phenomenon as “masking. This perception is a trick that the human ear plays on the listener which you can take advantage of as an audio restoration engineer. By first selecting an area at the beginning or end of the piece and then using the various Filter Sweeper presets labeled “Masked Fade-In” or “Masked Fade-Out”, you can smoothly contour the response of the restoration system during these quiet intervals at the beginning and ending of the musical rendition. If there is excessive hiss present during these time periods, use the Low-Pass Sweeping filter. If there is a high degree of low frequency noise (like rumble and or HVAC noise), use the High-Pass Sweeping filter. If there is a combination of both of these types of noises, you will have to apply two passes of the Swept filter to obtain the optimal results, running one operation with the Low-Pass and another with the High-Pass or by using the Multi-filter. Since some musical material is simple at its beginning and end, reduced frequency response will often not be observed by the listener due to the application of this new technique. The “Sweep Type” that you choose will depend on the type of musical progression that you are dealing with, and is also somewhat subjective.
The Filter Sweeper provides the following controls:
Sub-harmonic Synthesizer
Sub-harmonics are fractional multiples of a fundamental frequency. Some audio media have had difficulty recording the lowest octaves of the audio spectrum and thusly are deficient in this sonic area. The Diamond Cut Sub-harmonic Synthesizer is designed to help correct this audio anomaly. It can also be used to add “deep bass” to any recording. The sub-harmonic synthesizer takes audio signals in the bass portion of the spectrum and divides those signal frequencies in half and then adds them back into the system’s output mix. When the “Cents” control is set for 0, this division by 2 is exact. But, sometimes music sounds more natural when its subharmonics are not
perfect halves. Thus, you can vary the “Cents” control up to +/- 200 cents (each semitone = 100 cents on a 12 tone scale of equal temperament). Higher than 0 Cent value settings will make the subharmonics sound sharper while values less than 0 will make them sound more flat.
The Sub-harmonic Synthesizer
You can choose the upper frequency limit at which this process takes place via the “Frequency” control. A good frequency to begin with is 125 Hz; adjust to your personal taste using the Preview button. You can also adjust the wet/dry mixture of the synthesized sub-harmonics with the original source signal by way of the “Level” control. As an example, if the sub-harmonic synthesizer frequency control is set to 125 Hz, frequencies are generated in the range of 62.5 Hz on down to the bottom end of the audio spectrum. These signals are then added back into the main signal pathway thereby re-constituting bass (or deep bass) notes which may be missing from a recording. Bass male vocals can “bleed” into the sub-harmonics. If that occurs, try checking the Male Vocal Discriminator checkbox which should improve the sound quality. If the male voice still bleeds through, lower the frequency control.
The Sub-harmonic Synthesizer includes the following user controls:
Note 1: For “Ultra Deep” bass effects, you can cascade two sub-harmonic synthesizers together in the Multifilter. Set the second one in the chain to half the frequency value of the first. For example, set the first one to 150 Hz and the second one to 75 Hz.
Note 2: Sub-harmonic distortion can be introduced by this effect on male vocals, especially when the frequency control is set to values greater than 100 Hz.
Note 3: It is easy to over-apply this effect thereby creating an un-natural sound. Keep its “Sub-Level” control as low as possible to add in a pleasing effect, but not so much as to create an un-natural effect.
Overtone Synthesizer
Overtones are multiples of a fundamental frequency. Some audio media have difficulty recording the upper octaves of the audio spectrum and thus are deficient in this sonic area. The Overtone Synthesizer effect is designed to help correct this type of audio anomaly. The Diamond Cut Overtone Synthesizer operates in the upper portion of the audio spectrum and is the compliment to the Sub-harmonic synthesizer. It can be used to add treble or “brilliance” to any recording. It can also be used to enhance the hissy – sibilant sounds sometimes missing from highly muffled forensics recordings. The Overtone Synthesizer takes audio signals in the treble portion of the spectrum and multiplies those frequencies times two and then adds them back into the systems output mix. When the “Cents” control is set for 0, this multiplication is exact. But, sometimes music sounds more natural when its overtones are not
perfect doubles. Thus, you can vary the “Cents” control up to +/- 200 cents (each semitone = 100 cents on a 12 tone scale of equal temperament). Higher than 0 Cent value settings will make the overtones sound sharper while values less than 0 will make them sound more flat.
The Overtone Synthesizer
You can choose the lowest frequency limit at which this process takes place via the “Frequency” control. A good frequency to start with is 5,000 Hz; adjust to your personal taste. You can also adjust the wet/dry mixture of the synthesized overtones with the original source signal by way of the “Overtone Level” control. As an example, if the Overtone Synthesizer frequency control is set to 4,500 Hz, frequencies are generated in the range of 9,000 Hz on up to the top end of the audio spectrum. These signals are then added back into the main signal pathway thereby re-constituting treble (or brilliance) which may be missing from a recording.
The Overtone Synthesizer includes the following user controls:
Forensics Note: The frequency range for this control in the Forensics version is wider and is from 2,000 Hz to 9,000 Hz.
Note 1: For “Ultra Brilliant” treble effects, you can cascade two Overtone Synthesizers together in the Multifilter. Set the second one in the chain to half the frequency value of the first. For example, set the first one to 4,000 Hz and the second one to 8,000 Hz.
Note 2: Muffled Forensics recordings can be enhanced via the “Forensics Pseudo Sibilant (clarifier)” preset. Adjust the “Overtone Level” for the optimal result. Also, please refer to Note 3.
Note 3: The Overtone Synthesizer is limited for use on files that were sampled at 22.05 kHz and above. This fact is especially important in Forensics Audio applications which use lower sampling rates. If you desire to use it on files that were mastered on files that were recorded below 22.05 kHz, up-sample them to 44.1 kHz first and then apply the Overtone Synthesizer.
Note 4: Use of this effect in moderation is recommended in order to achieve the most natural sonic simulation of the upper end of the audio spectrum.
EZ Enhancer
The EZ Enhancer provides an easy-to-use method for adding some spice to your recordings. It combines three types of audio enhancement algorithms into one system including harmonic generation, dynamic processing (compression or expansion) and tonal contouring. A large number of factory presets are provided which produce combinations of various harmonic generation types coupled with dynamics signal processing. The names of these various presets are descriptive and so should make choosing the correct one for a given job quite intuitive. The presets work in conjunction with the “Exciter” and the input “Level” controls. Three tone controls are also provided including Bass, Mids and Treble. The system is capable of remembering the state of the EZ Enhancer system controls based on your own preferences via the “Save” feature. Here is a description of the EZ Enhancers controls:
The EZ Enhancer
Level Control: -100 to 0 to +100 wherein 0 represents no gain added on the input side of the dynamics processor sub-system. Since the dynamics processing elements of the various presets are non-linear in nature, you will find that there is an interaction between the Exciter and the Level Controls in terms of sound tonality. Adjust both for the most pleasing result. The level control does not directly affect the overall degree of the system, but only as a higher order effect. 0 is the default setting for this control and in most cases will produce satisfactory results without any “tweaking”.
Exciter Control: This control affects the degree to which the harmonics generator and the dynamics processor output signals are applied to the source signal. The range is 0 to 100 wherein 0 represents no enhancement (dry) and 100 represents the maximum enhancement (wet).
Bass Control: This is a shelving type of control having its corner frequency fixed at 175 Hz and having an amplitude adjustability range of +/- 15 dB (15 dB of boost or cut).
Mids Control: This is a Bandpass (peaking) type of filter having its center frequency fixed at 900 Hz and having a bandwidth set for 3 octaves. It can produce up to +/- 15 dB (15 dB of boost or cut).
Treble Control: Like the Bass Control, this is also of the shelving variety having its corner frequency internally set to 3,000 Hz and having an amplitude adjustability range of +/- 15 dB (15 dB of boost or cut).
Clip Indicator: A red clip indicator is provided to show if the dynamic range of the EZ Enhancer system is being exceeded. If this indicator illuminates, then you must determine which control is set too aggressively and lower it until the indicator extinguishes. Otherwise, clipping type distortion will occur, which is not specifically very pleasant sounding.
Note: The best results will be realized by applying the “Normalize Gain Scaling” feature (found under the CD Prep Menu) to – 6 dB before running the EZ Enhancer.
The Forensics Toolbar
Surveillance, two-way radio, noisy telephone communications and black-box analysis place special burdens on noise reduction software. The DC Forensics10 Audio Laboratory comes complete with a special set of filters and measurement tools aimed at Forensics applications that can be found under the Forensics Menu. Besides being useful in Forensics applications, these filters can be used for a variety of non- Forensics related material. The DC Forensics Audio Laboratory version has a more extensive and higher performance feature set in this regard compared to its more commercially driven DCArt10 counterpart. Certain Forensics filters require more experience to use compared to the others. They are placed under a special category within the Forensics suite called “Advanced Filters” and include the Time Domain Adaptive Filter (TDAF), the Dynamic Spectral Subtraction filter (DSS), the Polynomial Filter and the Spectral Filter. These more advanced filters can all found as a sub-group under the following icon:
Click on the down arrow on the right side of the icon to expand the menu.
In General, noise encountered in Forensics applications can be divided into several basic categories:
This type of noise is rejected with the brick-wall band-pass
filter.
This type of noise is rejected with the brick-wall band-stop
filter.
The standard Continuous Noise filter found under the Filter menu rejects this type of noise.
The Adaptive filter set up for the Keep Residue mode of operation can attenuate this type of noise. If this noise is in the form of a “buzz” you should also consider trying the Harmonic Reject filter found under the Filter menu.
This type of noise can be reduced by using the Adaptive filter set up for the Normal (random) mode of operation or the DSS.
This type of noise can be visualized using the Subsonic Explorer function and is time correlated to the primary source signal.
Several of the Forensics filters can also be used in those extreme circumstances such as when the noise level is significantly greater than the “good” signal level. In this instance, the ability to hear and understand the underlying speech is typically the goal – not a complete restoration. See the Notes below.
Note 1:
It is important to note that the Forensics filters are not optimized specifically for "high fidelity" applications, but more for improving the intelligibility of speech or the discernment of subtle sounds buried in noise.
Note 2:
The Diamond Cut Forensics Filters perform best on files that are sampled at 44.1 kHz or higher. If your native file is encoded with a lower sampling rate, up-convert it first before using the Diamond Cut Forensics Filters. While this will not improve the bandwidth of the signal, it will speed up filter processing time.
(Forensics Version Only)
The EZ Forensics Filter is a very good place to start when working with any Forensics audio file It is very easy to use and often will provide a good solution to your noise problem, even if not 100 percent optimal. It combines a dual question wizard scheme coupled with a high degree of automation, adaptive filtering techniques and 170 pre-programmed filter solutions. In some situations, the EZ Filter process will help you to hone-in on the best solution to a Forensics Audio problem. It will present you with a few filters to choose from after you answer a few questions. By previewing your file and comparing the alternative filters presented, you can then choose the best filter for the job at hand.
A graphical display shows you the amplitude vs. frequency of the input signal to the filter. The black line shows the user modified output response on the output side of the EZ Forensics filter. The adjustable blue inflection point (square dot which is adjustable with your mouse) is the user interface for adjusting the output response of the system after the best filter has been selected.
The EZ Forensics Filter
The basic process for using the EZ Forensics Filter is as follows:
1. Answer the First Question found in “Step 1: Select File Type”. Click on the “File Type” button and a “Recording Type” Dialog Box will appear. Choose (by left mouse clicking) between the alternatives based on the nature of your audio source including:
2. Click on “Next” in the “Recording Type” Dialog Box and then
answer the second question presented in the “Recording Problems” Dialog Box. You can choose between:
3. Under “Step 2:” you will notice that a number of filters are presented to you. Choose the best one by “Previewing” each one and decide on which one does the best job.
4. You can “tweak” the response of the system by left-moussing the blue inflection point on the graphic display to provide emphasis or attenuation anywhere on the frequency spectrum that you desire. Moving the mouse horizontally changes its frequency while moving the mouse vertically amplifies or attenuates the signal at that frequency. You can also adjust the “Output Level” with the slider control having the same name. Be sure that you do not “clip” the output to avoid signal distortion. A clipping condition is indicated by the illumination of the red “Clip” virtual LED indicator.
5. If and when you are satisfied with the results, then highlight the file or a portion thereof and click on the “Run Filter” button.
Now, Wasn’t That Easy?
A description of the filter type being used is annunciated just below “File Type” button. If the EZ Forensics Filter did not provide the optimal result, the DC Forensics10 Audio Laboratory provides you with a wide array of alternative filters that you can customize for a specific Forensics Audio application. They can be used individually (one at a time) or in concert with one another via the Diamond Cut Multifilter.
Advanced EZ Forensics Filters
To “Go Advanced” with the EZ Forensics approach, a good place to start is with the following two Multifilter Presets (found under the Multifilter and not under the EZ Forensics Filter):
EZ Forensics_Proto1 (A Time Domain Adaptive Filter Based
Approach)
EZ Forensics_Proto2 (An Adaptive Frequency Domain Filter
based Approach)
These two Multifilter presets provide you with the basic signal path structure used in the EZ Forensics system. But, in the Multifilter, you have complete control over a myriad of parameters which you can customize and tweak to your specific needs. Consider using this approach in the event that the EZ Forensics Filter is not providing the optimal results that you seek.
Note 1: It is important to convert all forensics .wav files (8 kHz, 11.025 kHz and 22.05 kHz) up to a 44.1 kHz sampling rate before using the EZ Forensics Filter. To accomplish this, use the Change Sample Rate feature found under the Edit menu.
Note 2: The best results will be realized by applying the “Normalize Gain Scaling” feature (found under the CD Prep Menu) to – 6 dB before running the EZ Forensics Filter.
The Time Domain Adaptive Filter (TDAF)
(Forensics Version Only – Advanced Filters)
This Time Domain Adaptive Filter (TDAF) is used largely in audio applications where the ambient noise environment is constantly changing and the filter coefficients must automatically adapt to maintain good intelligibility of an audio signal. This is the Time Domain based “older sister” to the forensics Adaptive Frequency Domain Filter (Forensics AFDF) found inside the Diamond Cut Continuous Noise Filter (one of the CNF Modes).
The Time Domain Adaptive Filter
The Adaptive filter adjusts itself to remove a modeled signal representing the unwanted time domain waveform while preserving the target signal. It uses an advanced form of an adaptive least mean squared algorithm to provide continuous adaption of the filter coefficients. It works best with a reference signal (in other words, a stereo or binaural source) containing only the noise to be rejected. This second channel or reference signal can be obtained from a second surveillance track with its microphone located near the noise source in the room such as a Jukebox or a television set. However, it can also use its own signal as a reference in conjunction with the time delay function, which is provided for monophonic situations. Additionally, the adaptive filter provides either the main processed signal or a keep-residue mode output signal for rejecting a wide variety of different types of noise sources. Sometimes it will be found that the “keep residue” mode signal is more useful than the main output signal. Trial and error is sometimes the best way to determine the best mode to use. The following controls are included with the adaptive filter:
Important Note:
Because of the wide range of convergence values allowed in the Adaptive Filter, certain audio signals may cause the filter to become unstable and cut out. In these cases, try changing the Convergence parameter until the audio is restored. Usually lower convergence settings are more stable, but adapt more slowly to changes in the audio signal. Lengthening the filter (Samples) may also increase its stability.
The Adaptive Frequency Domain Filter (AFDF)
(Forensics Version Only)
The Adaptive Frequency Domain Filter (or AFDF) is the cousin to the Time Domain Adaptive Filter (or TDAF). It uses FFT (Fast Fourier Transform) techniques in conjunction with an adaptive algorithm based on statistical models of noise versus intelligent signals to create a dynamic fingerprint of the noise. When a reference channel is not available, it will often produce better adaptive noise reduction compared to the TDAF. The overall filtering effect can be reduced or increased to varying degrees by the user. This filter is actually a subset CNF Mode of the Continuous Noise Filter, but is directly accessible by the user via the icon. It includes 10 descriptive presets which can be used to get you into the general parametric area when dealing with a noisy forensics audio file. Fine tuning can then be made by the attenuation control in conjunction with the attack and release time constant controls. The frequency resolution of the system can be increased or decreased via the FFT size parameter. Larger FFT sizes result in smaller frequency bins and thus greater frequency discrimination with the tradeoff of greater levels of digital artifact production and poorer time domain transient response.
Note: A good FFT size to use as a starting point is 2048 when working with 44.1 kHz sampled files.
The AFDF in Action
This is the time required for any of the filters to "open up" on the leading edge of a signal that exceeds the threshold line on the spectral graph.
This represents the time constant normalized value at 1 kHz. The time constant for filter frequencies operating above 1 kHz will be shorter than the setting, and the time constant for filter frequencies operating below 1 kHz will be longer.
The Attack time constant value is weighted with a -1 slope across the audio spectrum. Small values of attack provide excellent transient response, while long values provide a minimization of digital artifacts produced by the system. A good value to start with for the Attack Time parameter when using the AFDF is around 5 Milliseconds. The total range of adjustment for Attack time is 1.0 to 300 milliseconds. Smaller settings will improve leading-edge conversation response but allow more digital artifacts to pass through. Larger values will decrease the leading-edge response, but will reduce the production of artifacts during the noise reduction process. The user will need to balance between these two conflicting factors to obtain the best overall result, which will be found to be very source file dependent.
This is the time allowed for any of the filters to "close down" or "decay" following a signal that falls below the blue threshold line on the spectral graph. All remaining characteristics of the Release time Constant are the same in nature as the Attack time Constant. A good value to start with for the Release Time parameter for the AFDF is around 25 Milliseconds. If there is too much fast filter "breathing" (a digital artifact that is also sometimes referred to as “pumping”), lengthen this time until you are satisfied with the result. The total range of adjustment for Release time is 1.0 to 1000 milliseconds.
This control sets the degree of attenuation for signals that are present and below the dynamic blue threshold line. The greater that one sets the Attenuation control, the greater will be the degree of noise reduction. However, the greater the degree of noise reduction achieved, the greater will be the loss of the sense of "Ambiance" on the resultant restoration. So you must use careful judgment as to the correct tradeoff between noise reduction and ambiance for the material you are dealing with. A good value for the Attenuation parameter is around 10 to 15 dB as a starting range. If there is too much loss in signal ambiance, decrease this value. If you desire more noise reduction, increase this value. If you increase the attenuation too much, you will begin to introduce some digital aliasing artifacts into the Destination .wav file. The total range of adjustment for Attenuation is 0 to 100 dB.
This feature graphically and dynamically displays how the filter is adapting in real time to the signal being applied to the AFDF. The horizontal axis represents frequency and the vertical axis represents the varying threshold line in dB.
You should find the AFDF factory presets to be a good way to start off when using this adaptive filter. Their names are descriptive in terms of response and degree of aggressiveness. After you find a preset that is close to producing the desired results, you can go back and tweak the attenuation, attack, and release parameters optimally.
Brick Wall Filter
These filters differ from their “Hi-Fi” counterparts in that they are very steep digital filters used to attenuate signals that are interfering with a poor quality audio signal. These are FIR (Finite Impulse Response) filters that exhibit a very high degree of out of band attenuation. Also, they exhibit a phase-linear response with respect to frequency (all frequencies are delayed by the same constant amount of time). These FIR based filters are predominantly used for forensics audio applications.
The Brick Wall Filter
The Brick Wall Filters include the following choices of filter shapes:
Several controls are provided:
You can monitor the signal being removed by the brick wall filter by previewing its reciprocal filter. In other words, if you are using the Bandpass filter, switch the system to the Bandstop filter to hear what is being removed. Similarly, if you are using the Lowpass filter at a certain frequency, switch to the Highpass filter at the same frequency to hear what is being removed. The same logic applies to the Highpass filter; just use the Lowpass filter set for the same frequency to hear what is being removed.
*Note - Only applies to the Bandpass and the Bandstop filters.
Polynomial Filter
(Forensics Version Only – Advanced Filters)
This allows mathematicians, scientists, and engineers to create their own transfer function using a polynomial expression. For those not so inclined, there is a plentiful assortment of presets to choose from. Also, there are two methods of data entry possible, either numerical or graphical.
This system realizes a transfer function in terms of the input to output signal ratios. It is useful for canceling the non-linearity’s that may have been introduced during a recording process. Essentially, this feature can be useful in some circumstances for reducing harmonic distortion that was created by the recording process non-linearity. The method of data entry for the Transfer Function is in the form of the coefficients associated with a 5th order polynomial for which the actual transfer function graph is plotted automatically. You can enter the coefficients numerically for each term or you can use one of the numerous presets that are provided to get you started with a particular function. It is useful to have some mathematical background in order to effectively use this filter using coefficient data entry. However, trial and error is the best method for finding a setting that will reduce the distortion of a particular recording since the recording non-linearity is not generally known ahead of time. Furthermore, sometimes adding non-linearity’s can be useful to enhance the intelligibility of extremely muffled conversations. Limited instantaneous dynamic expansion and compression can also be realized by using this feature, for which there are several presets provided for convenience. Interesting distortion creation and frequency multiplication is also possible with this algorithm.
The Polynomial Filter
Y = A5X^5 + A4X^4 + A3X^3 + A2X^2 + A1X + A0
You have 6 fields in which you can enter the coefficients of the polynomial equation, including:
A5 =_____ A4 = _____ A3 =_____ A2 =_____
A1 =_____ A0 =_____
Note: Values of A can be positive or negative.
Range: 0.001 to 1.999 (1.000 represents unity gain.)
This controls the level of the signal being applied to the input of the polynomial expression.
Range: -1.00 to 0 to +1.00 (0 represents no DC offset value.)
This control effects the DC offset applied to the input signal to the equation.
Range: 0.001 to 5.000 (1.000 represents unity gain.)
This control effects the output level of this system after the polynomial equation has been applied to the signal.
Range: 0.000 to 1.000
This control effects the degree to which the processed signal is added to the input signal for presentation to the systems output. Zero (0) represents no polynomial effect and 1.000 represents complete polynomial effect on the output.
You can choose between “Polynomial” or “Spline” modes via the radio buttons. In “Polynomial” mode, you create your transfer function by entering your data as coefficients ranging from A0 to A5 in the appropriate numerical fields. If you choose “Spline”, you can create the transfer function you desire graphically by manipulating (with your mouse) the 4 square shaped inflection points presented on the graphical display.
(Forensics Version Only – Advanced Filters)
This filter is essentially a very high resolution Graphic Equalizer that uses FFT techniques. It includes four EQ modes of operation from which to choose. In manual mode, it allows you to create a very high-resolution frequency response contour containing up to 32,000 bands of equalization (essentially a 32,000 Band Graphic Equalizer). The user interface system is intuitive and allows you to zoom-in on a particular portion of the audio spectrum that needs accurate and specific frequency response contouring. By using the right mouse button, you can add bands or inflection points, or delete them simply by pointing and clicking on the graph. This is very useful in Forensic audio applications for removing in-band and out-of-band extraneous noises because of its high degree of frequency selectivity and its very steep slope characteristic.
The spectral filter also includes a spectral inverse filter mode which can be used either manually or automatically. This feature measures the signal amplitude per frequency bin in a .wav file and then applies an inverse response curve in order to normalize it to a reference contoured shape. Essentially, it reverse normalizes to constant signal amplitude per unit bin against a user selected (by preset selection) curve, or via a user customized curve. In other words, frequency bins with lower signal levels than the reference curve are amplified until those bands equal the reference level and those frequency bins with greater amplitude than the reference curve are reduced in amplitude until they match the reference curve. One could view this as an automatic equalizer or an Auto EQ. Spectral inverse mode is very effective for creating an automatic equalization of poorly recorded forensics audio files. This can result in dramatically improved intelligibility of distorted or muffled sound files. It can be viewed as a speech clarifier. File sampling for this feature can be performed manually by highlighting the area of interest or automatically by way of the use of the Auto Sample (checkbox) feature. In Auto Sample mode, the spectral inverse filter becomes essentially an adaptive equalizer and continuously re-samples your .wav file (or system input signal in the case of Live Preview mode) on the fly. Live Preview mode is accomplished via the Multifilter feature in your Diamond Cut suite of filters.
The Spectral Copy mode of operation of the Spectral Filter allows a.wav file to be normalized in terms of frequency content per unit bin to another file or to a certain section of a .wav file. To use the Spectral Filter in this manner, simply highlight a portion of a .wav file while in Spectral Copy mode and then click on the Sample Spectrum button. Next, bring up another .wav file and either Preview or Run the filter. The spectral response of one file will then become imposed on the second file. This mode may be found to be useful when an exemplar of a particular sound exists in one file, but is suspected to be buried in the noise of a second file. An examiner could then sample on the exemplar file containing only the sound of interest (its sound-print) and use that response to help amplify signals in that area of the spectrum on a second file in order to makes certain signals more discernable or intelligible.
A fourth Spectral Filter mode of operation is called “Spectral Difference” (sometimes referred to as Spectral Matching or EQ Matching). In this mode, you can impose the frequency response of one file onto another. This is useful if you want two independently recorded sound tracks to sound similar in terms of frequency response. Simply put, you can cause one .wav file to sound sonically similar to another. To use this mode, you must perform the following operations after switching the Spectral Filter EQ mode to “Spectral Difference”. You will note when this operation is performed, that a new button appears labeled “Sample Source”. Before proceeding, normalize the gain of both .wav files to the same value (this feature is found under the CD Prep Menu).
1. Bring up your reference .wav file (the file which you want
your other file to sound like). This first file is your “Source”
file which should be the sonically higher quality of the two
files that you will be working with.
2. Highlight a sector (around 5 to 30 seconds) of this source
reference file. The sample should be taken
somewhere in the middle of the file. It should not be taken at
the noisy lead-in sector of the file. Better signal averaging results from longer sampling time values.
3. Click on the “Sample Source” button and the system will
then perform some calculations culminating in the creation of
a green colored graph which represents the frequency
response of the sample.
4. Next, bring up your target .wav file (the file requiring
frequency response modification).
5. Click on the Spectral Filter Preview Button and you will
notice that the system will draw two more graphs.
6. You will then hear the corrected response of the Target
.wav file.
7. Optionally, you can highlight an area of the Target
.wav file and press the “Sample Spectrum” button. This will
take a sample of the target file and compute a difference
spectrum.
8. The frequency response of the Target .wav file is shown in
Blue on the graphic display.
9. The red spectral curve is the difference spectrum and is
also the equalization curve that will be applied to the Target
.wav file.
The upper and lower crossover frequencies are settable in the “Spectral Difference” mode of operation by way of the “twin green goalposts” which are visible on the graphical display. These vertical green lines can be “dragged” horizontally along the frequency axis using the left mouse button. The left-most “goalpost” controls the lower crossover frequency while the right-most “goalpost” controls the upper crossover frequency. The frequencies in-between the “goalposts” are the values for which the spectral difference is calculated and is reflected by the shape of the red graph. Those signals above and below the “goalpost” crossover frequencies revert to the native target file values. Adjust these “goalposts” until you achieve the most natural sound with the least amount of high frequency hiss and low frequency rumble.
Another mode of operation which may be found to be useful in some applications (having widely varying target frequency responses) is the Auto Sample button option. This will update the calculation of the spectral difference on-the-fly providing you with a variable spectral difference compensation system.
Note 1: Forensics Audio Work may benefit from high values
of FFT size while studio audio work (or “Hi-Fi” work) may
benefit from substantially lower values of FFT size.
Note 2: The Spectral Difference filter can be used in a variety
of ways. You can use just one file and sample different
portions to generate a difference spectrum or use two different
files and apply the spectral difference to a third file.
Note 3: When using Spectral Copy and/or Spectral Difference
modes of operation, both .wav files must have the same
sampling rate and bit depth attributes.
Note 4: When using the Spectral Difference mode to match the response of a noisy file to a clean file (Cassette and CD for example), it is important to do all of the restoration work on the noisy file before applying the spectral difference filter otherwise the noise components with be detected as signal and distort the desired response.
Note 5: When using Spectral Copy and/or Spectral Difference
modes of operation, both .wav files must use the same FFT
Size setting.
The Spectral Filter
The following controls are provided in the Spectral Filter:
*Note 1: Adding or deleting frequency bands can also be accomplished by clicking the right mouse button on the graphical display. A dialog box will pop up giving you some optional actions.
Note 2: It is important to convert all forensics .wav files (8 kHz, 11.025 kHz and 22.05 kHz) up to a 44.1 kHz sampling rate before using the Spectral Filter. To accomplish this, use the Change Sample Rate feature found under the Edit menu.
Spectral Filter Application Example #1
You have a Forensics Audio file that is extremely muffled, meaning that its intelligibility is extremely poor because of a lack of the sibilant sounds due to significant high frequency loss. To improve the intelligibility of this file, place the Spectral Filter into Spectral Inverse Mode and check the Auto Sample checkbox. Choose the Auto EQ, Normalize to White Noise or the Auto EQ, Normalize to Human Voice preset. Preview the file. If the sound is improved to your satisfaction, then “Run” the Filter. If the improvement is not adequate, experiment with some of the other Auto EQ based factory presets until you find the best one for your purposes.
Spectral Filter Application Example #2
You have a recording of a male and a female chatting with one another in an automobile. The recorder microphone is closest to the female and it is very hard to discern the male end of the discussion. The background noise is due to the high speed at which the automobile is traveling. However, there is one small sector of the recording where the car was stopped at a traffic light and both the male and female ends of the discussion are clear and discernable. To improve the clarity of the male voice during the times at which the car is traveling at high speeds, place the Spectral Filter in Spectral Copy mode. Highlight the male voice (only) at the point where the car was stopped at the traffic light and then click on the Sample Spectrum button in order to obtain a sound-print. Then, using this sample, “Preview” or “Run” the Spectral filter in the areas of the recording during which the male voice was not discernable.
Spectral Filter Application Example #3
You have a cockpit voice recording containing a lot of airplane noise. You desire to listen to hear if the flaps-down switch has been flipped at a certain point in time, but at the point in time in question, all you hear is random noise. You desire to enhance the playback of the recording to hear whether or not the sound of that switch being flipped by the pilot of the aircraft is present on the recording. You can go to a flight simulator of the aircraft in question and record the sound of that switch being flipped with a quiet ambient noise environment. Bring up that sound file and highlight the actual sound of the switch being flipped. Next place the Spectral Filter into Spectral Copy mode of operation and then click on the Sample Spectrum button. Bring up the cockpit voice recording .wav file and “Preview” it around the time period in question. This action should provide more gain of the sound-print spectrum occupied by the flipping of the switch potentially making it more audible. Obviously, you can’t prove the negative by this technique, but if the switch is heard, you can demonstrate that something took place at the point in time in question. Of course, that positive result may represent the wrong switch being thrown, but that is beyond the scope of this application example.
Spectral Filter Application Example #4
You have recordings of an old television variety show from the 1950s (created before the advent of video tape recording). Your job is to assemble a new digital edit of this television series. The dialog and music are both recorded on a cine optical track. However, a much higher quality copy of the musical portion of the show exists on magnetic tape (sans dialog). In the editing process, you need to use the optical track to assemble the edit, but you insert the magnetic track for the musical portion of the job because of its higher sonic quality. However, you observe that there is an unnatural transition between the dialog (optical) track and the musical (magnetic) track. You can create more natural transitions between the dialog and the musical interludes by employing the Spectral Difference mode of the Spectral Filter to the project. Use the Magnetic track as the “Source” Track and then apply that to the Target optical portions of the final edit using the Spectral Difference feature.
Spectral Filter Application Example #5
You have transferred an old acoustical recording of a famous opera singer to your hard drive. You have removed the noise, but the recording sounds honky, hollow, resonant and unnatural. But, you have a more modern recording of this singer created during the electrical recording period of time. You can use the Spectral Difference feature to create a more natural sounding result. Just use the more modern recording as the Source .wav file and then apply it to the acoustical recording as the Target.
Spectrograms
Both the DCArt10 and the DCForensics10 Audio Laboratory versions include spectrogram displays (sometimes referred to as “spectrographs”). The DCArt10 version includes a Standard Definition system while the DC Forensics10 Audio Laboratory version includes a High Definition system in which the user can optimize and tradeoff between optimal frequency or time resolution displays. Since the High Definition Spectrogram is similar in overall operation to the High Definition system, it is recommended that the user should read the section pertaining to the Standard Definition system before proceeding to the High Definition section of this users guide.
View Spectrogram
A Spectrogram (or spectrograph) provides a method for displaying waveform data including Time, Frequency and Amplitude (Loudness) all on the same graph. Time is represented on the horizontal (X) axis, frequency is represented on the vertical (Y) axis, while Amplitude is represented by color intensity or gray scale/brightness. The Spectrogram displays itself in the Destination window when this is checked. The Spectrogram is calculated for whatever waveform is displayed, highlighted and zoomed in on in the Source window and is time aligned with the same. What follows is a description of the Standard Definition Spectrogram found in the DCArt10 version of the product.
Figure 93 - The DC Forensics Spectrogram View
The Spectrogram Display Preferences Menu
Display Preferences:
You can choose between a number of preferences associated with the spectrogram under the Preferences menu found under “Edit” or by left mouse - double clicking on the spectrogram display area. The following preferences are available to you:
A. Linear
B. Gamma Scaling (Co-efficient of Non-linearity ranging from 0.1 to 10 with 1.0 being linear)
Choose between 32, 64, 128, 512, 1024, 2048, and 4096. The Forensics High Definition version allows more choices, including 8192, 32768, 65526 and 131072. Small values provide fast FFT update time, while large FFT sizes provide improved frequency resolution. The basic frequency resolution is the FFT size/2.
You have the choice of the following color gradients:
This inverts the polarity of the video signal providing a different visual perspective of the spectrogram which sometimes is more revealing than the normal polarity. For example, on the grayscale, black become white and white becomes black when the Inverse Palette checkbox is checked.
This feature turns the Frequency Labels along the Vertical axis On or Off.
*Note: For more information on methods for Zooming-In and Zooming-Out, please refer to that section of the User’s Guide.
Important Note: The Sync files feature found under the View menu must be enabled so that the Spectrogram operates properly (stays in sync as you zoom the time display) and should be used in Classic Edit mode.
Spectrograms are useful for applications like spectrographic voice recognition or comparison (sometimes referred to as “voice-printing.”) Physiologically, speech is produced by the interaction of two mechanisms consisting of resonance and articulation. Resonance is produced by the nasal, pharyngeal and oral passages while articulators are produced by the jaw muscles, lips, teeth, tongue, and the soft palate. The human voice is acoustically modeled as a 4th order cascaded resonant system with an excitation signal called F0 (produced by the vocal cords). These acoustical signatures are referred to as formants. There are generally 5 formants (acoustical signatures) that are identifiable starting with the fundamental which is usually designated as F0. Resonances produce formants designated as F1 through F4 are generally higher in frequency than the fundamental (F0). All of these formant frequencies lie somewhere below around 3000 Hz. F0 generally falls between around 70 Hz through around 270 Hz. Typically, audio samples that are around 2.5 seconds or less in length with the frequency display range showing information from 100 Hz to somewhere between 3kHz to 6 kHz are used for vocal comparisons. The so-called English “cue words,” often used for comparison are as follows:
{The, To, And, Me, On, Is, You, I, It, A}
Here is a sentence that you can experiment with that incorporates all of the English cue words:
“It is important that I go to the bank on Friday to get a check for you and me”.
There are three pairs of demo files in the DCForensics10 demo wavefiles directory which express the above English sentence. Three pairs of files were made for user testing and experimentation. They include a male voice, a female voice and also that of a child’s voice. Each pair of files were recorded simultaneously; in each case one file was recorded through a low quality signal path while the other was recorded via a higher quality signal path. You can use these files in conjunction with the Spectrogram (and the Voice ID System) to study the differences between male, female and child voices expressing the same exact word or the entire sentence. You can also study and compare those same voices as recorded by high and low quality recording systems. The files are as follows:
Female Voice ID Test Sentence - High Quality.wav
Male Voice ID Test Sentence - High Quality.wav
Female Child (12) Voice ID - High Quality.wav
Female Voice ID Test Sentence - Low Quality.wav
Male Voice ID Test Sentence - Low Quality.wav
Female Child (12) - Low Quality.wav
To perform a voice-print comparison, it is necessary to observe the same words contained on the two specimens (the display tile feature is helpful for this purpose). Your Diamond Cut Voice ID system is a useful tool for this purpose. You can use it to compare the vowel (generally F1 and F2) and consonant (generally F2, F3 and F4) formants of the human voice.
It is beneficial if the same recording equipment was used to record both samples of data to be compared, however impractical in most situations. It is also beneficial if the same ambient sound conditions are presented on the two samples. If there is a lot of background noise, consider applying one of the Speech filters before measuring the spectrogram. Speech filters can be found in the Band-pass filter preset menu and the Forensics Brick Wall filter preset menu. See those specific sections of the user’s guide for details. Lastly, the emotional state of the person(s) making the expressions should be similar. If one specimen, for example, has the person screaming, and the other has the person sobbing or whispering, it will be difficult to draw any conclusions with a reasonable degree of certainty. Please note that spectrographic “voice-printing” is not admissible evidence in all court systems in the United States. Contact the court system or a legal expert in your area for details.
Note 1: Hot key access to the Spectrogram is available via ALT+"S". It toggles between the Spectrogram Display and the software’s Normal Display mode. Alternatively, you can use the “Esc” key to simply turn off the spectrogram.
Note 2: To print a spectrogram, use the Print commands found under the File Menu.
High-Definition Spectrogram
(Forensics Version Only)
The DC Forensics10 Audio Laboratory version includes a very High Definition Spectrogram which allows for FFT Sizes up to 131,072 (65,536 Frequency Bands). It also includes Decimation techniques to further optimize for higher Frequency Resolution as well as Zero-Pad techniques in order to optimize for better Time Interval Resolution. Both the frequency and time resolution parameters have been integrated into one simple and easy to use “Increase Resolution” slider control. Additionally, you can choose between several window techniques depending upon your specific needs. The overall combination of features makes the High Definition Spectrogram well suited to identify tape dubs based on multiple line frequency pickup signals. It is also useful for identifying edit points in forensics audio files. And, it provides an exceptional voice print display for detailed comparison between known and unknown voice sources. The High Resolution Spectrogram dialog box is pictured below:
The High Definition Spectrogram Dialog Box
Most of the functionality of the High Definition Spectrogram is the same as that of the Standard Definition version with the following exceptions:
Note 1: The High Definition Spectrogram responds to the channel selected. When both channels are selected, it responds to the sum of the two.
Note 2: The Spectrogram Dialog Box can be accessed by either double-left mouse clicking on the spectrogram display itself or via the Preferences Menu found under “Edit”.
There is an example of an edited .mp3 file using 5 different bit rates ranging from 224k to 192k to 128k to 48k and finally to 8k. Note the obvious edit points in the file as seen on the high resolution spectrogram (note that this audio file is included with this software as a demo and is titled “Edited Composite bit rate mp3 file.wav”):
Edited File with varying bit rates shown in sync with hi-res spectrogram
(Forensics Version Only)
There are times when it is desirable to track a specific frequency as it varies over time in an audio file. The Diamond Cut Spectral Frequency Tracker, in conjunction with the Hi Definition Spectrogram provides for frequency tracking and creates an exportable file of the results for further examination (and comparison) via a spreadsheet program. An example where this is useful is involved with the authentication of a recording against the frequency vs time curve of the power grid in a certain locale. Details on this type of analysis can be found in and Application Note called “The Electric Network Frequency Analysis, AN-4” on the Diamond Cut Productions, Inc. website (www.diamondcut.com). Other applications for this function may involve plotting the RPM of an airplane engine based on the 400 Hz generator frequency variations found on a cockpit voice recorder following a forensics event (engines and generator speeds tend to decrease during a stall and speed up during a dive). Additionally, Doppler effects of sirens or bells on vehicles can be studied to help calculate vehicle velocity by exporting this data and analyzing it via a spreadsheet.
The frequency resolution of this system depends on your spectrogram FFT size and resolution settings. The Tracker allows you to choose the frequency window (Tracking Range – 0.01% to 100% of last scanned value) and the Samples (Samples to Average – up to 1000) over which the data is smoothed out. Using your mouse, simply point and click on the spectrogram to track a certain spectral line. When the “Filter Results” checkbox is checked, the data will be logged for direct visual inspection or for export. The data include Time, Frequency and Amplitude (in dB).
The Green line shows a non-constant Line Frequency
(located near the bottom of the display)
Spectral Frequency Data Ready for Export
The example above comes from a portable analog microcassette recording. Of note is the variation in the line frequency note or signal as shown by the green line on the Spectral Frequency Graph (which is overlaid upon the Spectrogram). This result is typical of a low cost battery operated analog tape recorder. These data can be dropped into a spreadsheet for further analysis and are in your choice of either .csv or .txt format. Click on the “Export” button to activate this feature.
Note 1: The Spectral Frequency Tracker responds to the channel selected. When both channels are selected, it responds to the sum of the two.
(Forensics Version Only)
Forensics audio recordings often contain very low frequency or DC offset information that can be useful in an investigation. These signals are called subsonic, because they fall below the ability of most people to be able to hear them (and/or for sound systems to be able to reproduce them). The Diamond Cut Subsonic Explorer function allows some analysis of signals that fall below 30 Hz. Some examples of subsonic signals can be distant explosions, arms-fire, earthquakes, slamming doors, vehicle collisions (located far away from the recorder) and stop-start edits produced by analog tape recorders (most commonly – microcassettes). It can sometimes be useful in detecting certain types of digital edits recorded at high signal levels due to DC Offset shifts between two different recorders quiescent operating points. The system works in conjunction with the time domain display in the “classic edit” mode. The top (source) display shows the full-bandwidth audio signal while the bottom (destination) display shows only the subsonic signals derived after processing has been completed by the routine. The horizontal time axis of both displays are in sync for ease of correlation between the two signal portions. When invoking the Subsonic Explorer, the system will automatically revert to “classic edit” mode with the source and destination placed in a “sync files” configuration. Thus, one can observe a subsonic event in the destination display and correlate it to the sonic source file directly above it. Subsonic events generally look like small “blips” or “spikes” on the destination portion of the screen when using this feature. There is usually some form of discontinuity in the Source File that can be correlated with the subsonic event seen in the destination file. In the case of a micro-cassette recording edit point, you may see an abrupt change in the signal level or wave-shape at the edit point. Often, this appears as a “blip” or “spike” in the Subsonic Explorer display. Both files can be played via the playback controls of the Diamond Cut program. Generally, little or nothing will be heard when playing the subsonic destination file (although, something might be “felt” when a high quality sub-woofer is employed). The Subsonic Explorer functionality is nicely augmented when used in conjunction with the Time Display function (found under the View menu) coupled with Markers (the “M” key on your keyboard). Additionally, numerical values are provided for the DC levels of the subsonic signals found by the system. The system is very easy to operate. Simply bring up the file that you want to analyze for subsonic signals. Then go to the Forensics menu and click on the Subsonic Explorer. Click on the run button, and the system will perform some calculations and display the results in the Destination display. Note that the Subsonic Explorer only works in Classic Edit mode. If you had been working in Fast Edit mode, the system will automatically switch over to Classic Edit mode if the “Automatically Switch to Classic Edit Mode” checkbox is checked. An amplitude vs time graph will be created showing the subsonic events, along with numerical data including Max DC Level, Average DC Level, and Ratio. The ratio measurement is a crest factor calculation of the Max DC Level divided by the Average DC Level and is expressed in linear terms (not dB). A “Enhance Gain” checkbox is provided which imposes a non-linear transfer function to the display which is sometimes useful when dealing with highly compressed files.
Subsonic Explorer Example: Micro-Cassette Recording with Analog Edits
The screen-shot shown above is that of a Micro-Cassette recording having 9 analog edits. The edits can’t be seen in the regular, full bandwidth signal shown in the upper Source display. However, they become clear in the Destination display after running the Subsonic Explorer. To hear where the potential edits are, just look and listen to the Source display proximal to each blip or spike in the lower display (study the time period 2 seconds before and after each blip or spike looking for anything that may be suspicious).
Note 1: The Subsonic Explorer responds to the channel selected. When both channels are selected, it responds to the sum of the two.
Note 2: An analog edited recording is included with this software so that you can experiment with the Subsonic Explorer. It is called:
Microcassette Recording with Analog Edits.wav.
The Subsonic Explorer Dialog Box
(Forensics Version Only)
There are times when it will become necessary to measure various amplitude related parameters associated with sections (or entire) audio files. The Waveform Statistics system provides that capability. You simply bring up the Waveform Statistics feature and then highlight the area of the file that you want measured. To calculate the data, click the “Build Statistics” button and a display like the one shown below will be created. These data can be copied to your clipboard in for use with other software programs such as a spreadsheet or a word processor. The following data are analyzed:
Start Time of the Highlighted area
Stop Time of the Highlighted area
Selected Region (Time Span)
Sample Rate of the File being examined
Bit Depth (resolution)
SHA-1 Hash of File (Unique Cryptographic representation of a file)
RMS (Root Mean Squared)* Value of the highlighted area
Rectified Average Value of the highlighted area
Maximum Positive Peak Value within the highlighted area
Maximum Negative Peak Value within the highlighted area
Crest Factor (ratio of Maximum Peak divided by the RMS Value)
Maximum Low Frequency Value below 10 Hertz
Average Low Frequency Value below 10 Hertz
Number of Clipped Samples within the highlighted area
Number of times the signal passes through zero (zero crossings)
Average Frequency based on zero crossings (this is most meaningful on periodic signals.)
*Note: RMS is the square Root of the arithmetic Mean of the Squared values of the selected set of samples.
The following specific waveform statistics can be used to assist in the estimation of the likelihood that two files (or file segments) were made of the same person(s) at the same venue using the same recording equipment. It is sort of a “litmus test” for audio file equivalence. The following data can be useful in that quest:
Sample Rate of the File being examined
Bit Depth (resolution)
RMS (Root Mean Squared)* Value of the highlighted area
Rectified Average Value of the highlighted area
Maximum Positive Peak Value within the highlighted area
Maximum Negative Peak Value within the highlighted area
Crest Factor (ratio of Maximum Peak divided by the RMS Value)
Maximum Low Frequency Value below 10 Hertz
Average Low Frequency Value below 10 Hertz
Number of Clipped Samples within the highlighted area
Number of times the signal passes through zero (zero crossings)
Average Frequency based on zero crossings (this is most meaningful on periodic signals.)
Of special importance is the SHA-1 data, which is unique for any given audio file. It is a cryptographic hash consisting of a 40 digit hexadecimal number which is essentially a unique fingerprint of the entire audio file. This number is a good way to tell if one file is identical to another file. Thus, it can be useful in Forensics audio work to uniquely identify a file or to detect a file that has been tampered with. That hash number is always calculated over the entire file regardless of the selected area or the channels selected. If even just one audio sample of a file is modified, it will create a different SHA-1 hash number. For example, if you bring up the Demo Wave file called “Male Voice Test Sentence BW” and compare it to “Male Voice ID Test Sentence High Quality” they will sound the same and have the same length and other attributes. However, the first one has one sample edited compared to the other and thus they yield completely different SHA-1 values (proving that they are not identical).
Note: The Waveform Statistics function responds to the channel selected except for the SHA-1 hash (which is always calculated for the entire file, including both channels). When both channels are selected, it responds to the sum of the two (except for SHA-1).
Selected File Portion for Waveform Statistics Analysis
Selected File Portion Waveform Statistics Dialog Box
The Waveform Statistics shown in the “Selected File Portion” example above comes from a “Make Waves Signal” having the following characteristics. You should be able to reproduce these results with your software:
Frequency: 1000 Hz
Amplitude: -10 dB
Length: 30 Seconds
File Type: Stereo
Sample Rate: 44.1 kHz
Wave Shape: Sine Wave
Resolution: 16 bits
Voice ID
(Forensics Version Only)
Your Diamond Cut Forensics10 Audio Laboratory software contains a special feature called “Voice ID” to help you identify and rank the speech formants* of a highlighted cue word or verbal expression. It also includes the ability to display the frequency response, power cepstrum,* (cepstromgram) and complex cepstrum* graphs of the highlighted signal simultaneously.
The Voice ID Dialog Box
This feature works in conjunction with your high resolution spectrogram and is found under the Forensics menu. The Voice ID feature allows you to highlight a cue word or phrase and then (after activating the Spectrogram) it finds and automatically ranks the various formants contained in that portion of the .wav file. It also provides you with a frequency response and cepstrum graph within the Voice ID dialog box. The system can measure the formants and cepstrum for time intervals up to 5 seconds based on the highlighted sector of the file. Most useful voice vowel formant identifications are performed on a much smaller range of time, usually in the 40-100 mSec range.
You can choose the number of formants that you want to be identified and ranked. Formants are always sorted based on the highest average amplitude of the formant. You can choose between having these results displayed in an Amplitude or Frequency priority order. You can also choose which formant number you want the ranking to commence with by choosing between “Start at F1” or “Start at F0”. Maximum and Minimum formant frequencies can also be defined by these features found under the “Settings” dialog box.
The system will generally show the first formant as F0 on the spectrogram (and Num 0 in the table of values). This F0 generally represents the fundamental excitation frequency. The component signals (formants) that comprise a cue word or phrase are displayed in terms of start and stop frequency, amplitude and start time by Fn.
Sometimes, you will encounter noisy files which can confuse the Voice ID System. In these cases, it may be useful to limit the range of frequencies used by the system or to raise the “Spectral Smoothing” value. By default the Voice ID frequency range is set to a lower limit of 100 Hz and an upper limit of 5,500 Hz. You can access and change the various internal parameters of the Voice ID system by using the Settings button on the Voice ID dialog.
The Voice ID Settings Dialog Box
It is recommended that files should have a sample rate of at least 22 kHz, with 44.1 kHz being a better choice. If necessary, you can convert the file using the file “Change Sample Rate/Resolution” feature found under the Diamond Cut Edit Menu.
You can adjust some of the internal parameters associated with the Voice ID function by clicking on the “settings” button. The Voice ID Settings Dialog Box will appear giving you control over the time window aperture, the spectral smoothing degree, the maximum formant frequency sought after and the application of pre-emphasis. The Window length is basically the signal frequency / time parameter of the Voice ID system. The most common value used is 20 mSec; sometimes it may be useful to try other values depending on the length of the phoneme of interest.
The Pre-Emphasis option is available via the settings dialog. This applies a +1 slope (+6 dB/Octave) from 75 Hz to 5,000 Hz to the signal being analyzed. This is used to compensate the natural roll-off of the vocal tract and flatten the vocal formant spectrum.
After the “Find Formants” has been “clicked” and the calculations have been completed, each formant and its trajectory is displayed on the spectrogram as a number displayed in a rectangular box. They are annotated with both time and frequency coordinates that correspond to the values displayed in the Voice ID dialog box (“Num” column in the table of values). “Start” and “End” frequency values for each formant are annotated in the table of values. Average amplitude values for each formant are given in dB relative to 0 dB which is the maximum value that can be displayed. Also, a column called “Delta Amp” (Delta Amplitude) displays the various formant amplitudes normalized to 0 dB for easier comparison to a reference cue word or phrase.
All of these data can be exported to a text file so that further analysis can be performed with such programs as an Excel or other equivalent data analysis systems. The data that is exported is the frequency and time values for each of the formant tracks.
The software supports two extensions, .txt and .csv, and they both provide you with the same exportable data. Csv (comma-separated values) files are comma delimited while .txt files are tab delimited. To export the data, just click on the “File” button, then select “Export to a file”. You can set the file path and extension to go to the directory of your choice. You can also choose “copy to clipboard” if you want to bypass writing the information to a file and copy it directly to another program.
Two ceptstrum graphs and a frequency response plot are also provided with the Voice ID feature. The highlighted portion of the file’s Frequency response shows the relative amplitude in dB plotted vs. frequency while the power and/or complex cepstrum can be simultaneously displayed in terms of amplitude vs. quefrency*. Use the “Graph” checkboxes to select the desired graphing mode. The Frequency Spectrum will be drawn in Yellow, the Power Cepstrum in Red and the Complex Spectrum will be drawn in White. You can select any and/or all of these graphical modes depending on your needs. The smoothing control applies to these graphs with higher values producing higher levels of graphic smoothing. The smoothing scaling factor runs from 0 (which produces no smoothing) to 20 (which results in the maximum degree of smoothing). This smoothing control also affects the formants detection functionality.
Six voice ID test files are provided including male (adult), female (adult) and female child in high and low quality versions. All files use the same test phrase for ease of comparison. These files can be found under the File menu/Open Demo Wave Files menu structure. All files include “Voice ID” as part of their file names for ease of location.
The Voice ID System Operating Procedure(s)
1. Bring up the file of interest in the time domain display.
2. If it is not 44.1 kHz, use the change sample rate feature to change it to 44.1 kHz. This feature is found under the Edit menu.
3. Optionally, go to the “View” menu and bring up the “Time Display” which makes it easier to see your highlighted “Span” time.
4. Go to the “Forensics” Menu and click on the “View Spectrogram” item.
5. Optionally modify the spectrogram properties by using the right mouse button menu to Edit the spectrogram properties.
6. Listen to the file and then highlight the cue word or phrase of interest on the spectrogram.
7. Click on the “Voice ID” function found under the Forensics Menu.
8. Set up the various “Voice ID” parameters to your preference. Generally, the Sort should be set for “Frequency” and the Max Formants would generally be set for 5 (which will allow the system to identify F0 through F4).
9. If you are interested in Frequency Spectrum or Cepstrum graphs, check the appropriate checkboxes in the “Voice ID” dialog box. If not, leave all checkboxes unchecked.
10. Lastly, click on the “Find Formants” button in the “Voice ID” dialog box.
11. The system will then calculate the various Formants and display their various numerical attributes in the table of values within the “Voice ID” dialog box.
12. Please be aware that the voice formant frequencies are very sensitive to the exact location of the selected speech. Small variations in time can cause different formants to be found. Likewise the window length time (under the settings dialog) will affect the type of formants found. Typical analysis is done with a 20 ms window (aperture).
12. The trajectories of the various Formants will appear on the Spectrogram along with their numerical formant labels.
13. If you want to analyze this data statistically or in any other way, you can click on the File->Export button and a file will be created which can be used external to your Diamond Cut software.
*Note 1: Definitions of Power Cepstrum, Complex Cepstrum, Formants and Quefrency can be found in the glossary section of this documentation.
Note 2: The Voice ID dialog box is user sizable; just use your mouse to drag the box margins to create the size that you desire.
Note 3: To print the Frequency Response and/or Cepstrum graphs, use the Alt Print Screen (Alt Prt Scr) command and it will be recorded on your system clipboard to be used as needed.
Note 4: Voices under stress may yield distorted Voice ID results.
(Forensics Version Only)
The histogram (sometimes called a histograph) of an audio signal is a probability distribution of the amplitude density of audio signal data found in a sector of an audio file. The Diamond Cut Histogram vs. Time feature plots this function vs Time. It is normalized so it displays relative frequencies of grouped amplitude occurrences as a function of time. These groups (or bins) have a displayed area which is proportional to the number of certain amplitude events occurring per unit of time. The Histogram vs. Time feature marches through the file and presents a string of histograms to show trends in the file amplitude data distribution throughout the audio file of interest. The Y axis represents counts, while the X-axis represents time. The Z-Axis (color and shade) represents the frequency of occurrence for the scaled (normalized) events. The Histogram vs. Time tool can be useful in the forensics audio authentication process, graphically presenting discontinuities that may be present in a file in question. The routine does not make qualitative determinations, but presents statistical histogram distribution data for interpretation by the examiner. If a bit weight is changed due to an edit in a file, it may show up in “View Histogram vs Time” display, begging further investigation into that region of the sound file.
To create the Histogram vs. Time graph, simply click on the item having that name under the Forensics menu and it will calculate the data and create a display for your inspection. Alternatively, simply click on the histogram icon near the upper right side of the time display. The sliders to the right side of the graphical display can be used to enhance the contrast and/or color of the graph; the leftmost slider affects the chrominance (color saturation) level of the signal and the rightmost control affects the background color of the image. To turn the Histogram vs. Time off, just click on that item again in the Forensics Menu and it will be removed from the display screen.
You can adjust the Histogram vs Time graphic display by right-clicking your mouse on the display. You will see “Edit Histogram Properties” at the top of the list and the following dialog box will appear after left clicking on it:
The Histogram Control Panel
Using this control panel, you can adjust the Histogram Size (per bin). It is advisable to use values greater than 256 bins if you care to resolve the difference between 8 bit, 16 bit and 24 bit file edits. A good starting value is 512 bins. The amplitude axis (Z-Axis) can be set for linear or a variable value of Z-axis Gamma. The Y-Axis range can be used to offset the display to hone in on a certain area of the graph.
Histogram vs. Time Example (bottom trace)
The Histogram vs. Time shown here in the lower trace is taken from the sample file called “Mary had a Histogram” demo file provided with this software. Note the obvious edit shown on the graphical display where an 8 bit edit was performed on a 16 bit file.
(Forensics Version Only)
A companion tool to the “Histogram vs. Time” feature is the “Comparative Histogram”. It provides you with the ability to compare two different file sectors in terms of their probability distributions of the amplitude density of audio signal samples found on each file segment. This feature can be useful in Forensics audio authentication situations since audio recordings in a given recording environment often display a unique statistical character. The comparative histogram can be used to determine differences in this regard.
The vertical axis represents the frequency of the events scaled to 100% while the horizontal axis represents the amplitude counts within the selected area of the file. This feature can be useful in Forensics Audio authentication situations. It is sensitive to file portions which may have had varying bit depths when originally recorded. The graphs of sampled portions of a file are graphically over-laid upon one another so that a quick comparison of histogram data is provided.
File Mastered in both 16 and 8 Bit depth and edited together
Comparative Histogram of composite 16 and 8 Bit File Edits
The file used to generate the above histograms is called “Mary Had a Histogram (8 bit edit on 16 bit file)demo.wav”. The file itself is a 16 bit file, sampled at 44.1 kHz. But, it has an edit at the second yellow highlighted area using an 8 bit file converted to 16 bit and inserted into that time sector. You can’t hear or see the edit in the time domain display, however it shows clearly using the comparative histogram function. Note that the first yellow portion of the file is shown as the yellow distribution on the histogram. The second yellow section of the file is shown on the comparative histogram in red. Their signal distributions differ substantially showing that there was an error made by the person who attempted the edit. To use the Comparative Histogram, set the bins number to around 4000 initially. Then, highlight one sector of a file and click on Capture 1 and a yellow graph will be created. Then, highlight another (suspicious) sector of a file and click on Capture 2 and a red graph will be created and laid on top of the first graph for comparison. Note that you can also choose between a line graph (default mode) and a bar graph (checkbox).
(Forensics Version Only)
The Whisper Enhancer dialog box
Forensics audio situations sometimes arise with multiple parties talking on a recording in which one of them sounds quite far away from the recording microphone compared to the others. This could involve two parties where one of them is at a far distance and the other one being close. Or three parties could be talking clearly to one another, but a third party, adding to the conversation, is at some relatively large distance from the recorder microphone. Another similar situation can occur wherein a completely different conversation may be occurring at another table or location and the investigator is interested in trying to reveal some of that ancillary conversation. Another situation could involve potential gunshots or screaming (or other potentially important events) occurring at a far distance from the recorder and also occurring during breaks in the primary parties conversation. Additionally, the flip of a switch from a flight data recording may be brought to the foreground using the Whisper Enhancer. The Diamond Cut Whisper Enhancer is a special routine designed to bring out soft voices or sounds that are occurring amidst louder voices while softening the louder voices or sounds. It can reduce the loudness of the up-front voices while increasing the loudness of the far distant voices or sounds, so long as they are not occurring concurrently. Sometimes, it will be found that passing the audio through a speech filter (a preset under the Band Pass filter) or the Auto Voice filter first will provide better results with the Whisper Enhancer. It is important to note that this is not intended to be used as a de-noising filter and it has the capability of introducing distortion into the signal when its controls are not properly set for the audio material of interest. Here are the controls that you have to work with in the Diamond Cut Whisper Enhancer:
Threshold: This control sets the signal level at which the system begins to invoke its action.
Range: -60 dB to 0 dB (0 dB is the least aggressive; – 60
dB will yield the most aggressive setting)
Enhance Level Bar graph: Use this to aid in finding the “sweet-spot” for Whisper Enhancement. The higher that the green bar graph moves, the greater will be the action of the enhancer.
Ratio: This controls the magnitude of loudness between the loudest and softest sound processed. Higher values of ratio produce a greater “Whisper Enhancement” effect. Generally speaking, your best results will occur with ratio values set somewhere between 15 and 50 depending on the nature of your audio material.
Range: 5 to 50 (relative units of measurement)
Response Time: This determines the time delay before the system activates. Small values of response time produce very fast transient response to changes, but produce the greatest amount of distortion. Conversely, high values of response time produce slower transient response to changes, but less signal distortion.
Range: 1.0 mSec to 100 mSec
Output (Level): Adjust the signal level coming out of the Whisper Enhancer algorithm.
Range: -40 dB to +19.9 dB
Clip Led: This red indicator lights up when the output signal hits full scale (maximum = 0 dB). Use the Output (Level) control to reduce the signal level until this indicator extinguishes.
Bypass: Defeats the Whisper Enhancer for signal comparison purposes.
Keep Residue: The difference between the input and processed signal.
Presets: 15 Descriptive Factory Presets are provided; start with the one that best describes your audio issue and then fine-tune the various parameters for optimal whisper enhancement. After you find the best one, you can “Save” it for future reference using a name of your choosing.
WARNING: THE WHISPER ENHANCER CAN PRODUCE EXTREMELY HIGH SOUND VOLUME LEVELS WHEN NOT PROPERLY ADJUSTED. KEEP YOUR AUDIO SYSTEM VOLUME LEVEL SET TO A LOW VALUE WHEN STARTING OUT WITH THIS ROUTINE. ALWAYS BEGIN A PROJECT WITH THE OUTPUT LEVEL SET TO – 40 dB AND ADJUST TO A REASONABLE LEVEL THEREAFTER.
Note: The Whisper Enhancer works best with files that have been converted to a 44.1 kHz sample rate & having 16 bit depth (resolution).
Remove Silence Tool (Automatic)
(Forensics Version Only)
The Remove Silence Tool Dialog Box
Audio surveillance recordings often include periods of silence. Often, these “dead spots” can last for long time periods. The process of manually marking and/or removing the silent sectors can be quite laborious. The Diamond Cut silence remover automatically deals with this issue. It can automatically mark the silent passages and, if desired, can then remove those “dead spots” from the recording. The system includes pre and post triggering buffers. Thus, leading and trailing edge sounds are preserved to some degree. The removal process is performed in two steps; the first step involves marking the silent sectors and the second step can be used to remove those silent sectors from an audio file. A marker will be placed at the beginning and at the end of each silent sector in the file (2 markers are used per silent sector). Here are the controls that you will need to adjust to use the Diamond Cut Forensics Remove Silence tool:
Threshold: Sets the volume level (in dB) below which the system identifies “silence”.
Range: 0 dB to – 100 dB (lower settings increase the systems sensitivity to “silent” passages.) If this is adjusted too low, it will trigger on background room noise; it this is adjusted too high, it will not find the silent passages. An initial setting of around -30 dB is a good place to start, but experimentation may be required on a file by file basis.
Minimum Interval (Time): This control sets the minimum time interval that will be defined as “silence” by the systems detector. Time intervals less than this setting will not produce marked sectors of the file. This setting will vary based on the nature of the conversation on the surveillance recording. Again, experimentation is required to find the proper setting.
Range: 1 Second to 30 Seconds
Add Silence Between segments (Time): This allows you to insert “dead silence” in between audio segments for easier identification of the location of the breaks in conversation.
Detect Silence (button): Clicking on this button activates the Remove Silence tool to search out silent sectors in the file. It will drop a marker at the beginning and ending of each silent sector.
Remove Silence (button): After the silent sectors have been identified and marked by the detector portion of the algorithm, this button can be used to remove those silent sectors, if desired.
Clear All Markers (under the Marker Menu): If you are not satisfied with the placement of the markers, you can re-adjust the “Threshold” and/or the “Minimum Interval” parameters after “Clearing All Markers” produced by an earlier attempt. Clear All Markers is not found within the Remove Silence tool dialog box; it is only found under the Marker Menu.
Export: Allows you to export the time data via CSV formatting for use in other programs (like spreadsheets).
Presets: A number of presets (19) are provided for use as starting points. They are expressed in the following form:
Type XX-YY-ZZ
Wherein -
XX is the negative threshold in dB, YY is the Minimum Time interval in Seconds and ZZ is the Silence Added between segments.
Note: Up to 100 markers will be shown on the time domain graph; silent sectors requiring more than 100 markers are logged and the silent areas in between those hidden markers will still be removed with the “Remove Silence” button. Silent sectors greater in 50 in number are still logged and their locations are kept in .csv format and the data can be exported.
The De-Clipper is provided to reduce the distortion which results from an over-driven or clipped signal. When viewed in the time domain via the Source display window, this problem often looks like the signal has a “crew cut” or is “maxed-out.” The De-Clipper is equipped with two modes of interpolation, one having adjustable strength while the other uses a complex frequency domain method of interpolation. The “Adjustable Strength” mode is most useful on signals having a fairly high level of coherence while the “non Adjustable Strength” mode is best suited to signals having a higher level of randomness in their makeup. The “non Adjustable Strength” routine requires a high level of CPU and thus is quite slow, whereas the “Adjustable Strength” mode is much faster. Experimentation is the best way to find the optimal mode to apply to your particular clipped file. We recommend starting with the Adjustable Strength mode first, since it contains the fastest running replacement algorithm.
The De-Clipper
The De-Clipper can be used to repair signals, which were either clipped by digital or analog mechanisms. It performs its magic by detecting signals with very low or zero values of slope (user adjustable from 0 - 0.5) above a settable threshold amplitude value. When this condition is detected, the routine mathematically interpolates a new signal and replaces the zero slope portion of the bad waveform with one containing curvature. This results in decreased distortion. If the material being de-clipped has been directly clipped by the digital recording process (in other words, the signal is clipped at full scale output as indicated on the destination window), then you must first decrease the overall gain of the .wav file by 6 dB (- 6 dB) before applying the De-Clipper. This sort of de-clipping can be accomplished with very low values of slope. If the signal was clipped previous to the transfer to the digital domain by an overloaded analog amplifier, the signal can be de-clipped by raising the slope control until the “total clips fixed” display starts incrementing. The following is a listing of controls available on the De-Clipper:
This checkbox determines which of two different replacement algorithms are used by your De-Clipper. Check this box when dealing with audio signals which are fairly coherent in nature and un-check this box for signals which are more random (or stochastic) in general nature.
The threshold setting determines the amplitude above which signals will be applied to the de-clipper detector. Lower values imply a more aggressive response. The range for this control is from 10 to 100 on a relative and normalized percentage scale.
The clipped level of your signal is measured and displayed on this bar graph and is useful for setting the “Threshold” control. Close alignment of the “Threshold” control with the “Clip Level” while watching the “Total Clips Fixed” display will allow you to find the best “Threshold” setting. The “Total Clips Fixed” indicator will begin to increment when the proper threshold is found. Do not overdrive the system by setting the “Threshold” control to an excessively low setting as this may introduce distortion into the process.
The Slope control determines the “flatness” of the clipped waveform that will be interpreted as a “clipped” event. Low numbers like zero, imply a perfectly flat line as will be found in digital clipping. Higher numbers represent slight slopes associated with analog clipping. The range for this control is from 0.000 to 0.500 with 0 representing zero slope and 0.500 representing a 45 degree slope.
The Strength control affects the curvature of the applied interpolated waveform. Adjust this for the best sounding (or looking) replacement waveform. The range for this is from 1 to 5, with 5 being the most aggressive.
This is a numerical display indicating how many “clips” were detected and fixed by the De-Clipper. It is useful when using “preview” mode to assure that the routine is detecting the clipping while adjusting the various controls.
This bypasses the De-Clipper so that you can preview and hear the before and after results of the de-clipping process in an instant.
De-Clipper Operating Procedure (Tutorial)
File Preparation: Before de-clipping a .wav file, it is necessary to reduce its amplitude by 6 dB before applying the following procedure. To reduce the gain of the .wav file, use the Gain Change feature found under the Edit menu. The reason for this step is to provide the de-clipper algorithm enough headroom to interpolate the clipped peaks of the .wav file.
Note: You can look at the results produced by the De-Clipper after you have run the Filter. You will notice that the flat-topping has been replaced with smooth rounded waveforms if the controls have been set properly.
DSS Dynamic Spectral Subtraction
(Forensics Version Only – Advanced Filter)
The DSS Dynamic Spectral Subtraction feature in the DC Forensics10 software is a unique and powerful tool capable of recovering speech from recordings containing loud music or other coherent noise. Until now, a recording that was covered or masked by loud music was basically a lost cause. DSS decoding is designed to make it possible to attenuate this ambient music and uncover the speech. A demo file is provided to test the DSS called: “DSS Demo”.
Basic Approach of the DSS Filter
DSS works by performing a continuous and intelligent subtraction of one audio signal from another. Normally, with a Forensic recording containing speech masked by loud audio, you will require a reference recording containing just the audio that needs to be removed. The audio track containing the music or other audio to be removed is called the “Reference Track.”
The DSS Controls
The following four controls are active when operating in DSS mode.
The DSS User Interface
Recording a Reference Track
There are many ways that you can obtain a reference track. These examples should make this clear:
Real Time Methods*
Non Real Time Methods* ‡
* Note 1: Digital Recorders produce better results than Analog recorders in DSS decoding applications due to their crystal controlled speed regulation. This may not be as optimal, however if the digital recorder uses “lossy” compression such as .mp3.
‡ Note 2: If the interfering source of audio was a radio or television, many broadcast stations maintain an archive of “air-checks”. You may be able to access the required broadcast “air-check” recording through either the use of diplomacy or a court order.
Obtaining a reference recording is an important step in removing loud coherent noise sources such as music. Using the Real Time Methods described above, technique number 1 (there under) will produce the best results. In the Non Real Time methods described above, number 2 (there under) will produce the best results since it will rely on a reference recording that closely resembles the noises that you will be attempting to remove from the target signal.
Modes of DSS Operation
There are 3 DSS modes of operation available in the Forensics software product. To select one, drop down the “DSS Mode” selector box. As you can see, you can select either the right or the left channel as the reference track.
If you have no reference track recording and cannot re-create one, you can try to use the setting called “Mono DSS-Delay Reference”. This mode will attempt to attenuate the noise by comparing the audio at an instantaneous point in time and comparing it with a point at some other time before or after the comparison point. This has the effect of allowing the program to create its own reference signal.
Note: This method is inferior in comparison to any method utilizing a true reference track.
Creating a Stereo track from two discrete tracks in non real-time situations: *
The audio file that you will actually clean up using DSS decoding is ideally going to be a stereo file that you recorded in real time at the venue. However, often that is inconvenient and non real-time methods must be used. In these cases, one channel of the file will be the recording with the speech you want to recover (the Forensic recording) and the other channel will contain just the music or other non-random audio. These two recordings will have to be combined into a single stereo (binaural) .wav file recording. The easiest way to accomplish this is to use the File Split and Re-Combine function found under the Edit menu. Here’s the procedure:
*Note: If the interfering audio came from a live performance, having the live performance re-created by the talent after the fact will not produce a useable reference track for DSS decoding.
DSS Adjustments:
The controls that are active in the DSS filter are Attenuation, FFT Size and Delay. The Attenuation setting will control the amount of noise reduction that is performed by the DSS filter. You can think of this control as being analogous to balancing the weight(s) on a balance scale. Moving it up will reduce the noise more until you pass through a “null” point in the background music or noise. You need to tune the attenuation control for the most music reduction, which generally will occur around an Attenuator setting of 50, as long as both discrete channels are relatively balanced in amplitude with respect to one another.
The FFT size controls the size of the frequency “buckets” that are being used internally by the filter. Smaller numbers allows for more “self- adjustment” of the filter to the mismatched forensic and reference recordings. Larger values produce better frequency discrimination and overall attenuation. We find that settings of 1024 or 2048 generally produce good overall results, but smaller or larger settings should be tried as well.
The Advance % control is generally set to 50%. However, it is worthwhile experimenting with other values of Overlap in order to minimize the introduction of digital artifacts into the final resultant signal.
The Time Offset control can also help with time alignment mismatched audio channels. You can calculate the actual delay time between the reference microphone and the target microphone in milliseconds by applying the following formulae:
TD = (Delay Setting – 1)(FFT Size)(Advance % x 0.01) / Sample Rate
wherein:
Delay Setting is an Integer value from 1 to 10
&
Overlap is a value from 10% to 50%
&
Sampling Rate is a value given in Hertz
&
TD is the resultant delay time given in milliseconds
After adjusting the Channel Time Offset for a minimization of background music or noise, you can ascertain the distance between the reference microphone and the target microphone by looking at the Offset Time Display Window. Each mSec represents about 1.1 feet of distance between the two. As always, simply preview the audio and make your adjustments in the DSS filter window and also with the Time Offset slider in the File Conversion filter.
Primary Compensation Issue with the DSS Filter in Real Time Situations:
The primary problem encountered when using the DSS filter in real time applications arises from the distance between the two microphones used to make the binaural recording. Because a physical distance in the venue separated the two microphones, the propagation delay (sometimes referred to as group delay) of the signal between the two microphones in the room may need to be compensated for. Since sound travels at 1131 feet / second at 70 degrees F (or 1.131 feet / millisecond), large distances between microphones can cause mis-alignment between the two tracks of the binaural file. In real-time situations, the noise signal on the Target Track will lag the Reference Track at the rate of 0.884 milliseconds per foot. The File Conversion Filter and its Time Offset control can be used to compensate for up to 20 milliseconds of propagation delay representing a distance between the microphones of up to about 23 feet. If more distance had existed between the two microphones, multiple File Conversion Filters can be cascaded in the Multi-Filter to increase the total compensation time.
Primary Compensation Issue with the DSS Filter in Non Real-Time Situations:
The primary difficulty encountered when using the DSS filter in non-real time applications arises from the lack of acoustical matching between the Target Forensics recording and the re-created Reference Track. In other words, room resonance, frequency response or natural room reverb may not exactly match your re-created Reference Track. Performing some pre-processing on your Reference Track can compensate for these acoustical mismatches. You can use the 20-band or paragraphic equalizer to match the resonance and frequency response of the room. Also, you can use the Reverb to simulate the acoustical reflection characteristics of the venue. These steps will rely on your own sense of hearing to create the match. When you listen to the music on the Target Forensics recording, focus your listening on its musical content. Then try to create that same sound on your re-created reference track using the above-mentioned tools. Then use this pre-processed track as your final Reference Track to be applied to the DSS filter.
Dynamic Spectral Subtraction™ and DSS™ are Trademarks of Diamond Cut Productions, Inc. 2003
Cell Phone Noise Filter
(Forensic Version Only)
Some cell phone systems can interfere with audio equipment despite their use of signals well outside of the audio spectrum. Their carriers operate in the Giga Hertz range (0.850 – 1.9 GHz). GSM (Global System for Mobile Communications) based cell phones send out their packets of data in short bursts. These RF (Radio Frequency) bursts (pulses) can be radiated into audio system front end amplification devices like bipolar junction transistors or field effect transistors found discretely or inside operational amplifiers. The non-linear nature of these devices coupled with the integrating effect of collector to base (in BJT based circuits) or drain to gate (in FET based circuits) Miller capacitance creates a parasitic AM (Amplitude Modulation) de-modulator circuit. Thus, the envelopes of these RF bursts of energy are de-modulated into the audio range of frequencies. The repetition rate of these RF bursts lie within the audio spectrum. Thus, they can be detected and heard in an audio signal chain that is not sufficiently shielded. Because these noise bursts become audible, they can render an audio signal pathway extremely noisy, contaminated with a “buzz” like sound and thus, often unintelligible. The Diamond Cut Cell Phone Noise Filter is designed to attenuate the noise found in this situation.
The Cell Phone Noise Filter
The filter has two modes of operation. The first and more basic mode is more automatic, but often less effective while the second mode (Matched Filter) is more discriminating. When the Matched Filter is not checked, the system automatically attempts to find the cell phone noise pulses and interpolate them out of the audio signal. When the “Matched Filter” box is checked, you will need to highlight a sample of one of the noise pulses in the time domain display of the software and then click on “Save Sample”. The system will then use a time domain technique of pattern matching to detect further pulses in your audio stream and then replace them with interpolated audio.
Automatic (Non-Matched Filter) Mode
Un-check the “Matched Filter” checkbox. Click on the Preview button and then adjust the ratio control until the pulses are detected and reduced in amplitude. Then, adjust the “Size” control for the best overall signal intelligibility. Size relates to the length of the noise burst and not its amplitude.
Matched Filter Mode
Check the checkbox labeled “Matched Filter”. Zoom-in on a chain of cell phone pulses in the time domain display. Then, highlight a single pulse event making sure to capture the entire event. Do not highlight a train of pulses, just a single impulsive event. Be sure not to highlight any of the voice signal surrounding the noise pulse or burst. Next, click on the “Save Sample” button of the Cell Phone Noise Filter dialog box. Zoom back out on the time domain display and then hit “Preview”. Adjust the Ratio for the best level of detection (noise reduction). Note that the “Avg Time” control is not active in Matched Filter Mode.
Note: This filter works best after your file has been up-sampled to 44.1 kHz, 16 bits.
Auto Voice Filter
(Forensics Version Only)
The Auto Voice Filter is an adaptive system optimized for separating voice signals from random noise automatically. It uses two independent mathematical processes that work in harmony with one another in order to perform its job. One process identifies statistical noise while the other process identifies the human voice component of a signal. The Auto Voice Filter uses both of those pieces of information to separate the voice from the noise using sort of a “push-pull” methodology. The Auto Voice filter will continually adapt itself to varying signal to noise ratio conditions. It can improve the signal to noise ratio of spoken word recordings. It can also be used to reduce room reverberation (de-verb) sound on speech recording made in large venues. To operate this filter, merely adjust the “Attenuation” slider control for the optimal signal quality while previewing. The optimum quality will be found as the best balance between noise and/or reverberation reduction and speech intelligibility. Moving the attenuation slider upwards raises the aggressiveness of the filter and vice versa. Adjust the “Output Level” control such that the “Overload” LED does not light up on transient signals in order to minimize the creation of distortion. When you have discovered the best settings, highlight the entire sector of the file in need of filtering and then click “Run”. As with other Diamond Cut filters, you can save your favorite presets for future recall. This filter is limited to files using sample rates between 22.05 kHz to 48 kHz. If your file uses a different sampling rate, convert it to 44.1 kHz first before attempting to use the Auto Voice Filter. It works best with 16 bit resolution files. The Auto Voice Filter is monophonic only. Stereophonic files are summed to monophonic first and then processed. The resultant processed output file is presented in a dual-channel monophonic format.
The Auto Voice Filter
Note: This filter is optimized for Forensic Audio only; as such, it is not what one might call a “High Fidelity” system.
Voice Garbler
(Forensic Version Only)
Sometimes it is necessary to disguise a person’s voice in order not to break cover or to protect a person’s anonymity that may be providing certain types of legal testimony. Your Diamond Cut Forensics10 Audio Laboratory software includes a Voice Garbler (voice disguiser or voice garbler) for that purpose.
The Vocal Garbler
The algorithm used renders the garbled voice almost impossible to reverse when the controls are set properly. This attribute distinguishes this “garbler” from others that you may have worked with. To help maintain its security, we are not going to reveal anything about the method of operation of this algorithm. As a matter of fact, we are not going to use accurately descriptive naming conventions for the primary controls. They are simply “Pitch” and “2nd Pitch Level”. There are no units assigned to the numeric values associated with these controls either. To operate the Voice Garbler, simply adjust “Pitch” and “2nd Pitch” until you achieve the disguised voice effect that you desire. Switch the “Bypass” checkbox on and off as you vary the controls until the persons voice can no longer be uniquely distinguishable while maintaining the intelligibility of the content of the speech. The only accurately descriptive control is the “Output Level”. Adjust this so that the Clip LED does not illuminate if you are concerned about output signal clipping. As with other Diamond Cut filters and/or effects, you can save your settings by clicking on the Voice Garbler “Save” button.
Note: The Voice Garbler is not a high-fidelity system. Glitches (discontinuities in the signal) are a normal byproduct of its method of operation and are an element (artifact) of its non-reversibility.
Additional Forensics Features
There are additional tools that will be of value for forensics work which are not found in the Forensics menu. Some of them are as follows:
Sometimes, these algorithms or systems are referred to as Automatic Gain Controls or AGC's. This feature provides upward expansion of signals below the threshold line and downward compression of signals above the same threshold. This feature is useful in forensics applications where there is a large variation in signal levels between several different parties that may be communicating with one another. It is also useful for the broadcast of live sporting events (if you have the DC Forensics10 version of the product) in which the crowd reaction is of interest when the announcer is not speaking. Simply clicking on the ALC box in the Dynamics Processor activates this feature. The threshold, attack, and release controls are still active when this function is invoked. Many Forensics specialists have also found the automatic level control feature (ALC) in the Dynamics Processor to be very useful in their work. This feature is particularly useful for correcting near-party / far-party loudness discrepancies of recorded phone conversations and other situations where signals vary greatly from time to time.
This is useful for improving the intelligibility of signals having very small values of dynamic range in the speech portion of the spectrum. It is advised that a speech filter is run first before applying this filter for enhancement. For more information, please refer to the section of this documentation that describes the Punch and Crunch effect.
This can be very useful for decreasing “in-band” noise found on Forensics recordings. A noise fingerprint will have to be taken from a section of the recording having only noise and no signal in order to use this filter. For more details, refer to the section on the Continuous Noise Filter.
Note: The Continuous Noise Filter in Auto-Spectrum CNF mode can often produce good results on high quality forensics audio signals that need only slight noise reduction in changing noise environments. Compare it with the results produced by the CNF Forensic AFDF mode. The Auto Spectrum CNF mode will maintain a higher level of “fidelity” compared to the AFDF mode, but will not be as effective in extremely noise situations.
This is very useful for attenuating buzzes found on some recorded phone conversations. Several passes through this filter are often required for severe noise situations. Also, it is worth trying both odd and even harmonics of the fundamental buzz frequency. The fundamental buzz frequency can be found by using the Spectrum Analyzer located under the “View” menu.
This is very useful for eliminating static from body mike recordings transmitted via an RF carrier. It can also be useful for reducing line frequency related buzz consisting of narrow spikes having a repetition rate of 50 or 60 Hz.
This can be useful for isolating specific sounds buried in a recording.
This is useful for bringing out the subtle articulations of speech in low-bandwidth or muffled voice recordings, especially when used in conjunction with its “Weighting” function.
This is useful for tape authenticity verification and other forensics analysis functions.
These are useful for precisely measuring the time between multiple events such as gunshots.
Please refer to the Multi-filter section of this documentation for details concerning the real-time capability of the Forensics Version of this software.
17. Overtone Synthesizer – The Overtone Synthesizer in the Forensics version of this software uses a different set of internal filters and ranges compared to the standard version making this effect more useful for enhancing the intelligibility of garbled speech. Its range of frequency settings overlap that of the standard version (DCArt10) and so it will do things similar to that which the standard version does and more. The lower limit of the frequency setting is reduced from 3,500 Hz down to 2,000 Hz.
18. Expert Impulse Filter – This can also be used to eliminate 2-way radio static or very high frequency buzz which is at the power line frequency repetition rate (like the sound of a phase controlled light dimmer interfering with an audio system). The Vinyl LP setting is a good place to start with and the size set to 10 (on 44.1 kHz material), Threshold set to 1 and the Tracking set to around 50. Adjust the Tracking for optimal noise rejection and minimal distortion.
DCArt10/DC Forensics10 provides you with movable red timing markers that can be placed within either the Source or Destination workspace. They are the .wav file equivalents to bookmarks. You will find them to be useful tools when utilizing such editing features as the Copy, Cut, Mute, etc. The Marker menu is also complimentary to the CD Prep menu. It is very useful when you need to take a very long .wav file and Chop it up into smaller files manually for indexing onto a CD-R. Markers are stored as part of the Diamond Cut peak file (.pkf). The following commands are provided under the Marker Menu:
Add Markers:
This feature adds up to 100 markers to the desired Workspace. Clicking here will drop a marker at the beginning of a selected area. If no area is selected, by default, the marker is dropped at the far left of the .wav file. This command can also be accomplished by use of the mouse right click menu.
This feature erases all existing markers from the Diamond Cut peak file (.pkf).
Highlight Marked Area:
This feature highlights in Yellow (or the color of your preference) the area of a .wav file located between two previously defined Red markers.
This command allows you to drop a marker during playback so you can audition your audio while “marking it up” for in-depth study later. Simply hitting the “M” key on your keyboard during playback can also drop markers. When selecting (highlighting) an area, the marker dropped by the “M” key occurs at the end of the swipe. For example, if swiping from left to right, the marker is then dropped by the “M” key at the right side of the selection. If swiping from right to left, the marker will be dropped by the “M” key at the beginning of the selection.
Go To Next Marker:
Exactly as the name implies…allows you to quickly navigate to the next marker on the right. This can also be accomplished by simply pressing the “N” key on your keyboard.
Go To Previous Marker:
Same as above, only this command takes you to the previous marker on the left. This can also be accomplished by simply pressing the Shift + “N” keys on your keyboard.
Re-Number Markers:
If your markers have become out of order, you can have the system automatically re-order them numerically by clicking on this function. This is useful if you are going to use the marker numbers as individual track number indicators.
Label Marker:
By default, DCArt10/DC Forensics10 just places a number on each marker. If you use several markers, it may be necessary to label them more descriptively. Select the marker you want to label by left clicking on it (it will change from Red to Black). The Label Marker command allows you to be more precise with your markers; right clicking with your mouse and activating the Label Marker command can also accomplish this same task.
Lock Markers:
To lock the position of your markers, simply click on this menu item and your markers cannot be accidentally moved while you’re working on your file. In order to move them, you’ll need to press the Ctrl button plus drag the mouse. You can still remove markers if desired; this feature is a positional lock, not a marker erasure protection feature.
Merge Source Markers into Destination:
There are situations where it may be desirable to transmit the marker locations from a Source file into a Destination file when working in Classic Edit Mode. Clicking on this feature will facilitate this operation when markers are present in a Source File and a file of equal length is present in the Destination time display window.
The CD Prep Menu
This menu contains the tools that help you prepare for the final stages of your restoration project. The CD Prep Menu does everything but copy your files to CD.
This feature moves a marker to a multiple of 2,352 Bytes to provide compatibility with CD data grouping so that glitch-less indexing can occur. This feature is particularly useful when chopping a large (continuous concert type) .wav file into pieces for transfer to CD-R. If you have a .wav file open, merely click on this menu item and the file will be properly quantized.
Using Quantize on a Single File (Tutorial)
Using Quantize and Chop File on Large File (Tutorial)
This command breaks long .wav files into smaller .wav files as defined by the locations of your various markers. This command will remain grayed out until your file has markers placed.
The Chop File Into Pieces Dialog Box
If you’ve chosen to record a full album length file onto the hard drive and are now ready to break the large file into the smaller “song” files, this feature, used in conjunction with either your markers (manually finding the beginning and ending of your “songs”) or with the Find and Mark Silent Passages tool (automatically finding the song tracks by the silence in between two songs…described below) allows you to accomplish this task. It allows you to choose from any or all of the following options:
Find and Mark Silent Passages
DCArt10/DC Forensics10 includes a feature, which will automatically find and mark the silent passages of your .wav file. This is particularly useful when you desire to process an entire vinyl record album (or tape) in one shot through the various Diamond Cut filter and/or effect algorithms, and then break them up into separate .wav files at the end of the process. You have the ability to select the detector system’s threshold of silence, and its time duration for the silence. After you have invoked this feature, you will see all of the markers moved to the quiet area between cuts. You can move the markers manually, if you are not satisfied with the separations that were automatically determined by the program. After this has been completed, you can chop the file into pieces, and separate .wav files will be created.
The “Find and Mark Silent Passages” feature will also be found to be useful for identifying long silent sectors of surveillance recordings automatically. This can save a lot of time for the Forensics examiner who must deal with very long recordings, most of which contains no conversation.
The Find and Mark Silence Controls
A more versatile system is available in the Forensics version of this software called the “Remove Silence Tool”. For details, refer to that section of this User’s Manual.
Gain Normalize
The “Gain Normalize” feature searches an entire .wav file looking for the peak signal level and established that value as its 0 dB reference point. It can be used in fast edit mode or classic edit mode in the source window. Then, it adjusts the overall gain applied to the file so that the overall level is below that value. This will provide the best signal to noise ratio and a reasonable volume balance for each "cut" on your final master. Gain Normalize should be applied before burning a CD-ROM or making your final tape.
Important Note:
In Classic Editing mode, Gain Normalize will search the entire file for the peak and adjust the gain based on that peak. It will ignore any selected area. In Fast Edit mode, Gain Normalize will abide by a selected area, find the peak there and adjust the selected area only with the appropriate gain normalization.
It allows you to scale the gain of a .wav file to values other than 0 dB (full-scale output). The range of adjustment provided is +/- 20 dB, which corresponds to a gain factor range of +/-10X. If you apply gain scaling above 0 dB, some portion(s) of the .wav file will be clipped. This could be useful in a situation wherein a single transient pulse or two are dominant in the .wav files amplitude, and "clipping" it is irrelevant to you. Sometimes, forced clipping (above 0 dB) can provide a useful or interesting effect (sometimes called “overdriving”). If you apply scaling below 0 dB, all resultant signals shall be below full-scale output.
Note 1: Both the “Gain Normalize” and the “Normalize Gain Scaling” functions will query you “Do you want to save UNDO information for this operation?” If you say yes to this, the process will take about twice the amount of time that’s required if you choose to answer no.
Note 2: The CD Prep functions can be performed in either the fast edit or the classic edit mode. When using the classic edit mode, some of these functions are only supported for use in the Source Window.
CD Burner
The Diamond Cut CD Burner allows you to create CD’s in conformance with the Red Book Audio CD standard. Its integration into the DCArt10 software package coupled with drag and drop capability from the DC Tune Database simplifies the CD creation process after a restoration has been completed.
The Diamond Cut CD Burner
Song lists can be imported directly into the CD burner from your play lists or from the DC Tune Library, and these can be either in the .wav, .mp3, or .wma format. The software will automatically convert these file formats for compatibility with the Red Book standard. The software will query your CD ROM burner to determine its maximum speed capability and use that value during the burn process.
To import files from a Play list, click on the “Open Playlist” button and then select the files that you wish to burn to your CD –R. The WLS, XML, CUE, M3U and PLS playlist formats are supported by the CD Burner. If you have your DC Tune Library open, just drag and drop the desired sound file(s) into the CD burner. You can add or delete tracks from the list using the “Add Tracks” or “Delete Tracks” button(s). For example, to delete a track, just click on it in the CD burner (to highlight it) and then click on “Delete Track”. To hear a particular file in the list before burning the CD, highlight it by clicking on it and then click on “Preview”.
When adding tracks, be sure that the “Space Used” graph does not exceed the capacity of the media that you plan to use, or an error will be generated. Place a blank CD-R into your ROM burner and wait a few seconds. A message should appear at the top of the Burner routine indicating “Blank CD-R. If you are satisfied with your song listing, click on the “Burn CD” button to commence the CD burning process. A Progress Bar will appear indicating the progress in terms of “% Done”. The system will report when the process has been successfully completed with the following message:
Success: The CD has been burned successfully. Please remove the disc from the drive. Also, a “Gong” sound will be heard at the completion of a CD burn process.
Clicking on the “Burn Options” reveals a number of user selectable alternatives associated with your CD burner. They are as follows:
Maximum Writing Speed: You can limit the burning speed anywhere from 1X to 24X depending on the characteristics of your optical drive. Sometimes, slower burn speeds improve the accuracy of a CD Burn cycle with the obvious tradeoff (longer burn-time).
Recording Mode: The system is capable of the two primary CD Burning modes including Disc At Once and Track At Once.
Disc At Once Mode (Gapless) Recording: This feature (DAO) is useful for concert or orchestral recordings wherein one does not want to produce any glitches at the point where the track changes during play. A minimum of 2 tracks are required for DAO. After you drop your markers and before you break your file into pieces, you should “Quantize for CD Audio” (found on the CD Prep Menu) so that this feature works seamlessly.
Write CD Text: Incorporates Text into the file header of your CD when checked. The text information comes from the name field in the file list. It could be the track name if it comes from specific files. Note that only certain CD players are compatible with this feature and can take advantage of this mode of operation.
Track At Once: This mode (TAO) is the most common mode in which CDs are burned. It places a gap between each track. The between track time-gap is settable anywhere from 0.013 seconds to 20 seconds. The factory default for this setting is 2 seconds, but it will remember your last data entry value.
Enable Optimal Power Calibration: This optimizes the burn power used to create your CD. This will produce the highest quality and therefore the most robust CD burns. However, it takes a longer period of time to burn a CD when this mode is used.
Note 1: The Diamond Cut CD Burner can import files consisting of the WLS, XML, M3U, and PLS playlist formats.
Note 2: The DCArt10 CD burner defaults to a 2-second gap between each track selection when Track At Once Mode is used.
Note 3: Some of the CD burner features are only available in the Forensics version of the product.
The View Menu
The View menu allows you to access the commands that affect the manner in which files, controls, and parametric displays are presented to the user. To activate a particular feature, click on it with the left mouse button. Once it has been activated, a check mark will appear next to the chosen command (feature).
Toolbars and Docking Windows
The Toolbars and Docking Windows provide you with a great deal of flexibility with regard to the look and feel of the user interface. It includes controls over some of the commands, the toolbars, the keyboard assignments, and so forth. Of particular interest are the toolbar selectors. On the most basic level, simply check the box associated with the toolbar that you want to show. Of special interest is your ability to turn on or off the Tasks Pane via it’s checkbox.
Toolbar Selector Dialog Box
Further personalization of the system can be had via the “Customize” checkbox. It brings up numerous options that you can choose between via the Customize dialog box.
The Customize Dialog Box
The Diamond Cut Spectrum Analyzers
There are two versions of the Diamond Cut Spectrum Analyzer available in the version 10 product family. The DCArt10 version provides a Standard Precision Spectrum Analyzer providing excellent resolution especially at the low frequency end of the audio spectrum. The DC Forensics version provides a High Precision Spectrum Analyzer with higher frequency resolution over the entire audio frequency spectrum coupled with a display which can zoom in on a specific frequency range via a start and stop frequency feature. The High Precision Spectrum Analyzer also offers the user the option of octave based 10 and 30 band displays for use in acoustical measurement situations.
Spectrum Analyzer – Standard Precision (DCArt10)
The Spectrum Analyzer command in DCArt10 brings up the floating and user sizable Standard Precision Spectrum Analyzer. The Spectrum Analyzer is capable of resolving frequency increments as small as 0.02 Hz on 44.1 KHz sample rate files when it is set appropriately. This Analyzer can be used with any of the filters or effects. It is connected to the output of the filter or effect, so that you can see, in the frequency domain, how you have affected the file. If you want to compare the output of the filter or effect to the input, use the Bypass function on the filter or effect window. Since the Diamond Cut Spectrum Analyzer utilizes constant Hertz per frequency band, it will display white noise as a flat, horizontal line. This is unlike octave weighted real time audio analyzers in which white noise produces a diagonal, positive sloped line, and pink noise produces a flat horizontal line. Conversely, pink noise displayed on the Diamond Cut Spectrum Analyzer will be displayed as a negative sloped diagonal line. Normally, the Spectrum Analyzer displays the algebraic sum of the left and right channels. The Dual Waveform Display option will provide discrete displays for each channel. Keep in mind that the use of the Spectrum Analyzer will slow your system down slightly. Therefore, when you are done using it, shut it down.
The Standard Precision Spectrum Analyzer
The following displays are provided on the Spectrum Analyzer:
The following controls are provided:
Spectrum Analyzer Resolution Chart
0.02 | 0.04 | 0.08 | 0.17 | 0.34 | 0.68 | 1.35 | 2.96 | 5.38 | 10.77 | 21.53 | 43.07 | 86.13 | 172.27 | 344.53 | 689.06 | Res. Hz | | FFT Size |
NA | NA | NA | NA | NA | NA | NA | NA | NA | NA | OK | OK | OK | OK | OK | OK | | 64 | |
NA | NA | NA | NA | NA | NA | NA | NA | NA | OK | OK | OK | OK | OK | OK | NA | | 128 | |
NA | NA | NA | NA | NA | NA | NA | NA | OK | OK | OK | OK | OK | OK | NA | NA | | 256 | |
NA | NA | NA | NA | NA | NA | NA | OK | OK | OK | OK | OK | OK | NA | NA | NA | | 512 | |
NA | NA | NA | NA | NA | NA | OK | OK | OK | OK | OK | OK | NA | NA | NA | NA | | 1,024 | |
NA | NA | NA | NA | NA | OK | OK | OK | OK | OK | OK | NA | NA | NA | NA | NA | | 2,048 | |
NA | NA | NA | NA | OK | OK | OK | OK | OK | OK | NA | NA | NA | NA | NA | NA | | 4,096 | |
NA | NA | NA | OK | OK | OK | OK | OK | OK | NA | NA | NA | NA | NA | NA | NA | | 8.192 | |
NA | NA | OK | OK | OK | OK | OK | OK | NA | NA | NA | NA | NA | NA | NA | NA | | 16,384 | |
NA | OK | OK | OK | OK | OK | OK | NA | NA | NA | NA | NA | NA | NA | NA | NA | | 32,768 | |
OK | OK | OK | OK | OK | OK | NA | NA | NA | NA | NA | NA | NA | NA | NA | NA | | 65,536 | |
64 | 32 | 16 | 8.0 | 4.0 | 2.0 | 1.0 | .5 | .250 | .125 | .0625 | .0312 | .0156 | .0078 | .0039 | .002 | | (In Secs) | Latency |
Note 1: Because the FFT creates solutions in both the real and imaginary planes, the actual number of frequency bands created is the FFT Size/2.
Note 2: NA = Not Applicable
The following chart shows the performance of several of the provided Window functions. Others are provided with the software for completeness.
Note: Hanning is the recommended default window to use for general applications.
Distortion Analyzer (THD Mode in the Option Menu)
This selector box (Show THD) found under the Option Menu converts the Spectrum Analyzer into a high performance Harmonic Distortion Analyzer when enabled. It measures % THD (percent Total Harmonic Distortion). A pure Sine wave obtained from either a very high quality external signal generator or the "Make Waves" generator must be used as the stimulus for an external device under test (DUT) or algorithm under test. The THD meter measures the fundamental signal component separating it from the rest of the total harmonic signals presented to the system. It also "notches" out the fundamental and sums the remaining harmonics. Then it takes the ratio of the fundamental signal component to the square root of the sums of the squares of the measured harmonics and expresses it as a percentage on the digital readout. Even and Odd order distortion components are produced by transfer function non-linearity, both of which are measured by this system. Even-multiple harmonic products are dominantly due to transfer function asymmetry.
Note 1: The Show Peak checkbox must be checked before enabling the THD display.
Note 2: When not using the Distortion Analyzer, turn it off to minimize CPU utilization.
Using the High Resolution Mode:
Set the FFT Size to 4,096 (or greater). If you then click on 0.67 Hz, the system will re-scale the horizontal (X) axis of the spectral graph to indicate 1,380 Hz full scale rather than 20 kHz when you run the Spectrum Analyzer. You can resolve frequency increments as small as 0.02 Hz as indicated by the settings shown on the resolution chart. To augment this capability, use the “Range” control setting set to 20 dB and the “Offset” control to zoom in on the signals of interest. This combination of features are particularly useful when trying to determine if a forensics recording is a "dub" of the original by looking for two discrete "hum" frequencies on the spectrum. For more information on tape authentication, please refer to the “How do I?” section of this user’s manual.
Important Note:
When using the Spectrum Analyzer in High Resolution mode, it will take a long time for the system to integrate. A message will appear at the bottom of the display during this interval stating “Sampling, Please Wait”. Refer to the resolution chart for latency details.
Measure the Spectrum of Either L or R Channel(s) (Tutorial)
The Spectrum Analyzer displays the algebraic sum of both channels in normal operation. If you want to obtain the spectrum of only one channel, use the following procedure:
Measuring the %THD of an Electronic component (Tutorial)
The Spectrum Analyzer contains a special feature which allows you to measure the % Total Harmonic Distortion of a piece of electronic equipment, whether it be a CD player or an audio amplifier. It does this with a high degree of accuracy. This measurement will require, however, the use of a professional grade, high performance sound card and/or CD player in order to achieve accurate results. To achieve accurate results, it is necessary that the signal sample rate be at least 44.1 KHz in order to account for all of the Harmonic Distortion products within the audio spectrum. There are two procedures that you can choose from. The first procedure is simple to perform, but less accurate than the second procedure which is more complicated.
Spectrum Analyzer settings for %THD Measurements:
Display Mode: Fast
FFT Size: 16,384
Frequency Resolution: 2.69 Hz
Range: 150 dB
Mode: Bar or Line (your choice)
Show Peak: Check the checkbox
Show THD: Check the checkbox
Note 1: The Distortion Analyzer feature is accessed via its Options Menu.
Note 2: If you are using the High Precision Spectrum Analyzer found in the Forensics version of the software, set the Start Frequency at 10 Hz and the Stop Frequency at 22,050 Hz.
%THD(DUT) = (((%THD(T))^2) – ((%THD(I))^2))^1/2
* Note: Lower Frequency .wav files can be used.
‡Note: If a power amplifier is being tested, appropriate resistive loading must be connected to its output, along with an appropriate attenuator between the amplifier output and the sound card input. DO NOT connect the output of a high-output audio power amplifier directly to the input of your sound card. Direct connection of the output of an audio power amplifier to a sound card input is a hazard that could result in injury and could result in the destruction of your hardware.
Spectrum Analyzer – High Precision
(DC Forensics Version Only)
A High Precision Spectrum Analyzer is provided in the DC Forensics version of the Diamond Cut version 10 product family (which is sometimes referred to as an FFT analyzer in the Forensics field). It uses techniques including higher FFT sizes, chirp Z-Transforms, decimation methodology, a widened array of window types, waveform storage, and a new graphical display interface in order to achieve its higher level of precision compared to its standard precision counterpart. This high precision spectrum analyzer is useful for making acoustical measurements, authenticating forensics audio recordings by analyzing for potential dubs, verifying that forensics recordings have not been edited, assuring compliance with OSHA Noise Standards (both broadband as well as pure tones), performing mechanical vibration testing, measuring feedback control loop performance, and many other applications.
The High Precision Spectrum Analyzer
The High Precision spectrum analyzer is described here, highlighting the features which are different compared to that of the Standard Precision version found in DCArt10. It is highly recommended that you read the section that precedes this section before learning about the High Precision Analyzer, since many features are shared by both. Here are the salient differences provided by the High Precision Spectrum Analyzer over the Standard Analyzer:
*Note: The selectivity of the High Precision Spectrum Analyzer is still limited by the basic FFT size and the Window choice.
The first difference that you may note between the DCArt10 and the DC Forensics High Precision Spectrum Analyzer is the extensive list of functions provided under the drop-down menu on the left side of the system labeled “Options”. Clicking on this menu provides you with the following options from which to choose.
Option Menu (Forensics Version)
Note 1: The two IIR based Analyzers are useful for measuring relative noise levels against local Environmental laws, especially pure tones. For more information about pure tones, please refer to the Glossary of Terms section of this User’s Manual.
Note 2: The 10 Band Analyzer breaks the audio spectrum down into the following center frequency buckets:
31 Hz, 62 Hz, 125 Hz, 250 Hz, 500 Hz, 1 kHz, 2 kHz, 4 kHz
8 kHz, 16 kHz
Note 3: The 30 Band Analyzer breaks the audio spectrum down into the following center frequency buckets:
25 Hz, 31 Hz, 40 Hz, 50 Hz, 62 Hz, 80 Hz, 100 Hz, 125 Hz, 160 Hz, 200 Hz, 250 Hz, 320 Hz, 400 Hz, 500 Hz, 640 Hz, 800 Hz, 1 kHz,
1.3 kHz, 1.6 kHz, 2 kHz, 2.5 kHz, 3.1 kHz, 4 kHz, 5 kHz,
6.2 kHz, 8 kHz, 10 kHz, 13 kHz, 16 kHz, 20 kHz
Display Mode
Amp Range (Amplitude Range)
This feature controls the Vertical Axis full scale range. You can select between the following:
Note: Lower values of dB produce greater degrees of amplitude resolution.
FFT Size
The FFT Size determines the basic frequency resolution of the system with the number of frequency bins equal to the FFT size / 2. Higher FFT sizes produce higher selectivity or frequency resolution with the tradeoff of longer integration time. You can choose between the following FFT sizes:
64, 128, 256, 512, 1024, 2048, 4096, 8192, 16384, 37768, 65536, 131072
Note: Frequency resolution in terms of absolute Hertz value at a given fft size will be degraded as file sample rate is elevated. For example, a file having a certain value of frequency resolution at 4096 ffts and 44.1 kHz will have a frequency resolution twice as wide with 88.2 kHz sampled files with all other factors being equal. In other words, bins will become twice as wide at 88.2 kHz compared to 44.1 kHz with all other things being set equally.
Start and Stop Frequency Values
The Start Frequency and Stop Frequency Data Entry fields allow you to establish the horizontal axis frequency range displayed on the Spectrum Analyzer. The Start Frequency sets the left-most graphical setting while the Stop Frequency sets the right-most setting. The frequency set-ability of this system is 1 Hz for each of the two parameters. The maximum range of adjustability for Start and Stop Frequency runs from 1 Hz to half the file sample rate*. So, by way of example, using a 44.1 kHz file, you can set a Start Frequency as low as 1 Hz and a Stop Frequency as high as 22,050 Hz (which covers more than the entire audio spectrum of 20 Hz to 20,000 Hz). On the other hand, you can set a frequency range as small as 1 Hz. For example, you can set a Start Frequency of 59 Hz and a Stop Frequency of 60 Hz. It is important to note that sample theorem comes into play and the highest frequency that you can actually plot with the Spectrum Analyzer shall be the .wav file sample rate / 2.
*Note: As an example, a 44.1 kHz sampled rate file will allow for a maximum Stop Frequency of 22,050 Hz. Similarly a 96 kHz sampled file will allow for a maximum Stop Frequency of 48,000 Hz.
Frequency Axis Scroll Bar
At the bottom of the Spectrum Analyzer display, you will find a scroll bar. This allows you to move horizontally along the frequency axis in the spectrum display. Use your left mouse button coupled with a drag motion, either in the left or in the right direction with your Scroll Bar.
Window Type
You can choose between the following Window types:
Bessel, Blackman, Hanning, Hamming, Kaiser 10, Kaiser 20, Kaiser-Bessel, Rectangular, Triangular, Welsh
Descriptions of the characteristics of many of these Window types can be found in the section describing the Standard Precision (DCArt10) Spectrum Analyzer.
This button activates the trace storage and trace recall features of the High Precision Spectrum Analyzer. You can store a large number of Spectrum Analyzer traces in the directory of your choice. The file extension is .spt for these data. You can only display one set of recalled data at any given time along with the present display data. This feature is very useful for comparing spectral data to a reference set of data and presenting it on the same graphical display. Clicking on it (Mem) brings up the following options:
Close Button
Clicking on this button closes down the Spectrum Analyzer Display Window.
Hold / Run Button
Clicking on this button alternately freezes (holds) the display or runs the Analyzer in a toggle manner of operation.
To measure the Amplitude and Frequency of any given spectral line or signal, just point your mouse at the signal of interest and left – mouse click. The two numeric values are then displayed in Yellow in the upper left hand corner of the Spectrum Analyzer. Its format is: Frequency in Hz, Level in dB (Hz, dB).
Settings for High Accuracy Measurement of %THD with the Precision Spectrum Analyzer
Display Mode: Fast
FFT Size: 65,536
Start Frequency: 20 Hz
Stop Frequency: 20,000 Hz
Frequency Resolution: 0.67 Hz
Resolution Mode: Check “Standard FFT” in the Options Menu
Range: 150 dB
Display Mode: Bar or Line, your choice as found in the Options Menu
Show Peak: Check this checkbox in the Options Menu
Show THD: Check this checkbox in the Options Menu
Using the Spectrum Analyzer in Real Time Mode
X-Y (Vector) Display
The X-Y Vector Display plots the phase relationship between two waveforms. The instantaneous vector is displayed with a green trace while the averaged angle is displayed in red (provided that the averaging mode is enabled). **The Averaging feature is enabled by using the Averaging Selector and choosing between “None”, “Short”, or “Long”. “None” turns off the averaging display leaving only the instantaneous trace active on the X-Y display. “Short” displays the moving averaged vector displacement angle between the two signals over a 4095 samples interval. “Long” displays the average vector displacement angle over the interval commencing at the time when the play button is started until the time when the stop button is depressed or over the interval of time highlighted in the play source time display. The averaging interval for the “Long” mode is therefore a variable determined by the user depending on the length of the played file or the highlighted area of the waveform selected to be played and therefore measured. The “Averaging” mode is very useful when trying to measure the phase angle of signals having significant amounts of phase jitter. (Low cost tape recorders often display high levels of phase jitter especially at the upper frequencies in the audio band making the instantaneous graph difficult to use while making azimuth adjustments to the units playback head.) This feature is primarily used to align the azimuth of analog tape deck recording and playback heads. To do so, a known pre-recorded azimuth alignment tape is required containing a fixed frequency tone. The X-Y Vector display in conjunction with your azimuth tape and the Time Offset feature can be used to fine-tune a recorders time alignment without the necessity of having to take a screwdriver to your tape deck's head alignment adjustment screws*. The goal here is to correct the azimuth of the .wav file using the File Conversions Filter with the Time Offset slider control. Preview the .wav file with the X-Y Vector Display showing, and adjust the Time Offset slider control until a 45 degree positive sloped (up and to the right) straight line is seen on the display. That will be the optimum value of azimuth correction.
*Note: The optimum method for adjusting analog tape head azimuth is via the X-Y display in conjunction with an analog azimuth reference tape and by directly adjusting the playback head azimuth screw on the tape player.
The X-Y Vector Display Showing Proper Azimuth Alignment
The following features will be found on the X-Y Vector display:
Here is a listing of some common vector displacements, which can be observed on the X-Y Vector Display. They have the following meaning and are sometimes referred to as Lissajous figures :
The X-Y Vector Display Showing a Stereophonic Signal
*Note 1: In these examples, the Right channel would be twice the frequency of the Left input. If the figure 8 were lying on its side, then the Left channel would be twice the frequency of the Right input.
**Note 2: The Vector Angle Averaging feature is only available on the DC Forensics10 version of the software.
Time Display
The Time Display view displays all of the time related parameters associated with a Source or Destination workspace. When activated, a display window will appear containing four sets of timing numbers. This window can be dragged and placed anywhere in your workspace. The following time related parameters are displayed:
1. Cursor Location (largest numerals).
2. Start Location of a highlighted area (small numerals).
3. Stop Location of a highlighted area (small numerals).
4. Span - This represents the total time of a highlighted .wav file area (small numerals).
The Time Display Window
You can monitor “Samples” rather than “Time” in this display if desired. Go to the Preferences Menu and choose the “Display” option. Under that category, you will find a “Display Time Format” choice. Click on “Samples”.
You can set the start time of your wavefile to any point in time that you desire. You simply bring up the file of interest and type in the new start time in the dialog box shown here:
Set Start Time of File Dialog Box
This feature is of value in circumstances where you need to sync your audio file up to other recorded events. An example would be aircraft black box analysis where you need to be in sync with ground communications recordings.
Two 100 segment VU meters can be displayed which will indicate the output of any filter or multiple filters that are being used by DC Forensics10 or DCArt10. These meters indicate the level of the left and right channels and have both average and peak reading ballistics. They are calibrated to indicate values from -60 dB to 0 dB, with 0 dB being full-scale output when operated in linear mode. The VU meters are calibrated to indicate -100 dB to 0 dB (with 0 dB also being full-scale output) when operated in log mode. The selection between linear and log modes is made via the “Edit/Preferences/General/VU Meter Scale” preferences tab. Any signal above the 0 dB level will be clipped by the system. Signals that are clipped are indicated by the illumination of a small red “LED” indicator at the top and in the middle of the meter display.
The VU meters includes two peak indicators. The white horizontal bar is designed to “hold” the indication of an overload for two seconds after it occurs so that it will be more obvious to you that a clipping event has occurred. The green horizontal bar is a peak hold indicator and will hold the value of the audio peak until such time as the reset button, located at the bottom of the VU meters, is activated by the mouse. These VU meters can be activated or de-activated under the View Menu. Also, they can be "dragged and dropped" anywhere on your desktop workspace using your left mouse button or docked and enlarged at the right or left hand margin of the software user interface. The right mouse button can also be used to “hide” or “auto hide” the VU meters.
Volume Control
This feature allows you to view and adjust the primary sound card volume controls. Two controls are presented:
Important Note:
This volume control is only useful for sound cards that make use of the Windows Mixer. For any sound card that doesn’t use the Windows Mixer, adjustment of volume will take place using the proprietary mixer provided by the manufacturer of that product.
Fast Edit History
When working in Fast Edit mode, this cool little panel on the left side of your screen is like having your own personal secretary. It keeps track of every edit and allows you to navigate quickly from one change to the other. If you decide to start at midpoint in this list and want to eliminate all edits done after this point, just double click on that edit and the system will ask if you’re sure…then eliminate all edits after that point. All of the data pertaining to the fast edit history profile are contained in .ses (session) files. These files are stored with your .pkfs (peak files) and can be deleted once you’ve finished with the file. Fast Edit temp files include elements of the source file name for ease of identification.
A Typical Fast-Edit History Panel View
DC Tune Library
The DC Tune Library provides you with a full-featured audio file archive capability within the context of your DCArt10 or Forensics10 software. It will search your hard drive and find all audio files and store their path, name, genre and other pertinent data within its file structure. After this database is constructed, it provides lightning speed access to any of your audio files, whether they are in .wav, mp3, or wma format(s). You can search your database, order it in terms of various parameters and create and recall playlists. You can play any file directly through the normal play features of your Diamond Cut software, or you can listen to a file or series of files by using the Preview feature found on the Diamond Cut filters and/or effects. You can even listen to the database by way of a complex series of filters and effects by previewing a file via the DCArt10 or Forensics10 Multifilter.
Details pertaining to the various functions associated with the DC Tune Library can be found in an earlier section of this users guide dedicated to this topic.
The DC Tune Library Spreadsheet Display
Zoom In
The Zoom In feature allows you to magnify any portion of your .wav file, no matter how small it may be. It can be used with either the Source, Destination or Fast Edit workspace. The zoom-in process may be repeated any number of times for a really close and detailed look of your audio waveforms. However, only the last 5 zoom levels are remembered. You can also access this feature by using the Z hotkey or the Right Click Menu. Your mouse wheel will also control the Zooming In (or Zooming Out) feature.
Zoom-In X2
Allows you to Zoom in on a waveform by a factor of 2 (binary zooming). The amount of time displayed is decreased by a factor of 2 each time the Zoom-In button is pressed. This zoom differs from the other Zoom function, which zooms in on the selected area. Pressing the + key on the numeric keyboard will also activate this zoom function. It can be used with either the Source or Destination or Fast Edit workspace. The “Zoom In X2” process may be repeated any number of times for a really close and detailed look at your audio waveforms. It’s complimentary function is “Zoom-Out X2”.
Zooming-In/Out on a portion of a .wav file (Tutorial)
To Zoom-In and Zoom-Out on a portion of a .wav file, use the following procedure:
The Zoom In X2 and Zoom Out X2 buttons function in a different manner and give you the option of zooming in or out without changing the selected area of the .wav file. Pressing Zoom-In X2 will take whatever area of the waveform that is currently displayed and magnify it by a factor of 2. Similarly, the Zoom-Out X2 button will take the displayed portion of the .wav file and decrease the time resolution by a factor of 2. Both of these zooming operations can be performed multiple times if a higher degree of focus or de-focus is desired.
Zoom Out
This key performs the inverse function of the Zoom-In key. It allows you to progressively back out of a .wav file which you had previously Zoomed-In on. Hitting this key allows you to backpedal through your last 5 zooms. You can also access this feature by using the X hotkey or by using the Right Click Menu. Your mouse wheel will also control the zooming In - Out feature. For a brief tutorial, see above.
Zoom-Out X2
This feature allows you to back out of the displayed area by a factor of 2. The amount of time displayed is increased by a factor of 2 each time the Zoom Out button is pressed. Pressing the – key on the numeric keyboard will also activate the Zoom function. It can be used with the Source, Destination or Fast Edit workspace. It’s compliment is “Zoom-In X2.
Zoom Out Full
This feature allows you to quickly zoom back to square one. It will display your entire .wav file waveform on the screen. You can also access this feature by using the Ctrl + Z hotkey or the Right Click Mouse Menu.
Zoom to Markers
This feature is only activated when markers are dropped. When used, it fills the screen with the material located between two markers.
To zoom into an area of a waveform without time or amplitude limits, you can use Box Zooming. This is accomplished by holding down the Shift key and then holding down the left mouse button to draw a rectangle around the area you want to zoom in on. When you release the mouse button, the system will zoom into the circumscribed area of the file. To zoom back out, just use one of the zoom out commands.
Waveform Overview Zooming Feature
You can also zoom in and zoom out on a time domain waveform via the waveform overview feature. The feature is located in the upper left corner of the waveform overview display. It includes two zooming buttons, one having a plus sign and the other having a minus sign as shown here:
Waveform Overview Zooming feature
Each time that you click on the plus sign (on left side of the waveform overview display) the system zooms in closer on the main time display, with its relative position shown with respect to the overall file in the overview display. Zooming out is similar, but it requires you to click on the minus zoom button.
This feature, when enabled, mutually synchronizes the Filter and other commands such as Zoom-In and Zoom-Out between the Source and the Destination .wav files. This feature is useful for selective filtering or viewing of a portion of a .wav file. For example, if you run a particular filter, and then find a sector (or sectors) that need further filtering, you can highlight only the portion that needs the additional processing, and apply the filter accordingly. Sync mode will also accommodate different filters being applied to different sectors. Also, when enabled, highlighting and Zooming-In on a particular area of a source file will correspondingly Zoom-In on the same timing co-ordinates in the Destination file. The converse is also true such that Zooming-In on particular set of co-ordinates in a Destination file will also cause the Source file to contain the same Zoom-In co-ordinates. This feature is of particular use when you want to visualize how a particular filter may have modified a waveform from your Source file. Clicking on it with your mouse enables this feature via the Sync Files icon or via the View Menu. When it is active, a check mark will appear to the left of it in the View Menu.
Note: The Sync Files function is only useful in Classic Editing Mode.
To use Sync Mode to apply selective filtering to a .wav file, it is first necessary to create a Destination file from your Source file. This can be done through the normal processing procedure of any of the filters, or it can be accomplished with one of the file conversion options such as Mono-to-Mono or Stereo-to-Stereo. Thereafter, merely highlight the portion of the Source file that needs filtering, click on the appropriate filter, select the appropriate filter values and run the filter. Only the highlighted sector of the two files will be enacted upon by the filter, with the results appearing in the Destination file. If another filter (or the same filter that you had just been working with) is then required to be applied to another portion of the .wav file, just repeat the outlined process.
Non-Sync mode of operation
In non-sync mode, the highlighted section of the source file is read and processed by the filter. The processed section is then written to the destination file starting at the beginning of the file. If a destination file already exists, it will be overwritten (a prompt warns you of this). This mode is useful when only a section of the source file needs to be extracted, or for testing a filter's settings before processing an entire file.
Selective Filtering with Sync Mode (Tutorial)
Display Themes (Application Looks under View Menu)
Application Look - - - have it your way; this feature offers different skins and themes for your Diamond Cut Windows, Filters, Effects and Dialog Boxes.
You can choose between the following depending on your taste:
Windows 2000, Office XP, Windows XP, Office 2003, Visual Studio 2005, Visual Studio 2008, Office 2007, and Windows 2007.
The “Application Look” Dialog Box
You can choose between a wide variety of skins, themes, colors and fonts. Experiment with this until you obtain your favorite look, or if you get bored with a given look, change it on occasion for variety.
If you prefer the classic old way that the software looked with Windows XP, you can get back to that appearance by choosing the Windows XP selection. Also, please note that not all skins and themes support variable color schemes or font sizes. The “Display” preference for showing the dialog color schemes (found under the Edit\Preferences\Display tab) is by default left on when you enable a theme. Users may want to turn these off to see the full effect of the display theme that they have chosen.
Enabling or Disabling Toolbars In DCArt10/DC Forensics10
The following toolbars may be turned on or off by the user by simply checking or un-checking them from the View menu item. The Diamond Cut Toolbars are both movable and dock-able.
Customizing Your Toolbar(s)
One of the Customize Dialog Boxes
You can custom configure your toolbars using the following technique:
1. Click the Toolbars Tab.
2. Click Customize.
4. Click Toolbars.
5. Click New.
6. Add name of new Toolbar.
7. Click “ok”.
8. Click on Commands Tab.
9. Select Tools from menu options.
10. Drag and Drop the Command from the Right window onto the Toolbar.
11. Close customize when you have your toolbar set up as you want it.
12. Reposition or Dock the toolbar depending on your needs.
Toolbars and Customize Windows will bring up this Dialog Box
Channel Toolbar
Just beneath the filter and effects toolbar and towards the left of the display can be found the Channel Selector Toolbar. This allows you to choose which channels are to be operated on by the system. Your choices are as follows:
1. L/R (Both channels)
2. L (Left channel only)
3. R (Right channel only)
The Channel Selector applies to all Filters, Effects and Editing functions accept for tools that change the overall length of the file. Generally, one would tend to leave this feature in the L/R (Both channel) position unless dealing with special editing or sound restoration issues.
Note: You can click on any of the Channel controls while playing to select either the Left, Right or Both channels. When previewing a filter, both channels will always be previewed, but only the channel selected before the preview starts will be affected by the filter.
File Toolbar
The main DCArt10/DC Forensics10 File Toolbar resides along the top of the program window. It contains the most commonly used file functions of the program. Clicking on them with the left mouse button activates them.
Filter and Effects Toolbar
The Filter and Effects Toolbar also resides near the top of the program window. It contains buttons for the most commonly used filters and effects. This toolbar, like the others, "floats" and can be dragged and dropped anywhere within the DCArt10/DC Forensics10 window using the mouse. Clicking on them with the left mouse button activates them.
Forensics Toolbar
The Forensics Toolbar contains buttons for the most commonly used Forensics filters and tools.
Play Controls Toolbar
This toolbar contains the “Transport” controls for recording and playback of the audio.
Status Bar
The Status Bar resides along the bottom of the program window. Six Diamond Cut Software related parameters are displayed therein:
Note: Clicking on the various menu items will also activate a one-line help text file, which describes each item.
File Info
The following information will be displayed regarding the current highlighted .wav file when "File Information" is clicked:
Rebuild Peak File
Peak files (.pkf) provide a graphical representation of the .wav files and its data are stored along with any .wav file created or operated upon by DCArt10/DC Forensics10. It takes 1 sample per 200 .wav file samples and extracts the peak value in that time interval for time display purposes. After many editing processes, it may be desirable to update this file to more accurately represent the present state of the displayed .wav file in the Source or Destination workspace(s). To do this, click on this function, and you will see that the displayed .wav file will become updated after a short period of time, accurately representing your edits. Peak files may be deleted by the user at any time.
The Window Menu
The Window Menu contains all of the commands that affect the manner in which the files are displayed to the user. The following commands are available:
Cascade
The "Cascade" command arranges all of the open Windows so that they appear on the display one behind the other. The most recently opened Window will appear on top, with the remainder arranged in the order in which they were opened.
Tile
The "Tile" command arranges all of the open Windows so that they appear on the display in a matrix configuration (in the same plane) on your display. This feature is used when you need to see all of the workspaces concurrently.
Arrange Icons
The "Arrange Icons" command will arrange all of the "iconized" windows in a row near the bottom of the workspace.
Close All
As the name implies…click here to close all Windows and Files via one command.
Open Files
A listing of all of the open files is provided at the bottom of the Window Menu. The file that is active will have a check mark indicated to the left of the file name.
The Help Menu
With this product, we strive to provide you with the best possible documentation, help and support. To that end, in addition to this in-depth User’s Manual, we also include a computerized Help File that is always available at the click of a mouse. Integrated into the Help File are a Table of Contents, a comprehensive Index, a Search Engine and a Favorites selector (Add, Display or Remove items). If you find a topic that you consider to be of great importance, you can print the displayed topic via the Help file print feature.
Tip of the Day
This feature is normally displayed on the splash screen after you launch the software. It can also be invoked under this menu item. It provides useful hints on the operation of the software contained within roughly 330 total tips. It advances through the list one item at a time each time the software is opened. When it gets to the last tip, it returns to the first item in the listing and starts the sequence over again. The tip file is common to two Diamond Cut Software programs, so some tips may not be relevant to your application(s). If you are not interested in using the tip of the day feature, uncheck the box that indicates "Show Tips on Start-Up" found in it’s dialog box.
Restoring a Recording
This feature links you to a section of the Help File that describes step-by-step details regarding the restoration of an old recording.
Restoring the demo1.wav
This feature links you to a section of the Help File that describes in step-by-step detail the process for restoring the demo1.wav file that is included with the software package. This is an excellent exercise to go through to get an initial idea of the operation of the system.
Contents
The DCArt10 & DC Forensics10 program contains an extensive Help file. These topics are printable from within the help file for your convenience. The following types of information are available:
Context Sensitive Help
This button will provide you with on-line context sensitive Help from the DCArt10/DC Forensics10 Help file.
Using Context Sensitive Help (Tutorial)
Method #1
Method #2
Note:
Under some circumstances, Method #2 will not activate the context sensitive Help file. When this occurs, use method #1.
The Help file search engine includes some special search filter checkboxes located in the lower corner of the search box including:
1. Search Previous Results
2. Match Similar Words
3. Search Titles Only
Important Note:
Features which have not been implemented in your particular version of DCArt10/DC Forensics10 but which may be provided in different releases of the program will be described in italics.
About DC-Art
The following information is obtainable under the “About DC-Art” feature:
Section 3 - How To
Tutorials
Do you need help with a specific problem? This could be the place for you. Here, we provide you with procedures that may require more than one tool or one step to accomplish.
Where are the Demo .wav Files?
You will find a number of demo .wav files in the following directories or accessed directly under the File menu: The path to navigate to these files is as follows:
For DCArt10 version 10.x
Using the Windows XP operating system:
<user>\MyDocuments\ DCArt10\Wavefiles
Using the Vista or Win7, Win8 or Win10 operating systems:
<user>\Documents\DCArt10\Wavefiles
For DC Forensics version 10.x
Using the Windows XP Operating system:
<user>\MyDocuments\ DCForensics10\Wavefiles
Using the Vista or Win7, Win8 or Win10 Operating systems:
<user>\Documents\DCForensics10\Wavefiles
Note: For the Win 7 Operating System, the “Documents” folder appears in the “Libraries” folder.
Shortcuts to the demo .wav files can be found in the “Diamond Cut Audio” program group. From the “Start” menu, choose “All Programs”, then “Diamond Cut Audio” then “Demo Wave Files” and select the desired demo file shortcut.
These files are intended to help you understand through experimentation the use of some of the features found in your software. Here is a listing and description of the demo .wav files and some of their possible tutorial uses:
demo1.wav This file is a raw transfer of a Edison Lateral Cut Disc (thin-cut) test pressing recorded circa the late 1920s. It is just a snippet of a song called “My Sin” and can be found in its entire form and completely cleaned up on the Diamond Cut CD entitled “The California Ramblers - - - Edison Laterals 2”. This demo .wav file contains a large number of clicks and ticks (and some hiss too) and thus is primarily designed to be used to demonstrate the operation of the various impulse filters in your software. In particular, you will find a preset titled “demo1.wave de-clicker” within the EZ Impulse filter. This preset will de-click that file, but you can also use this demo file to experiment with the various parameters within that filter. It can also be used in conjunction with the EZ Clean and the Expert Impulse filters for experimentation purposes.
RadioDemo.wav This file is a recording made on the East Coast of the USA of a German Broadcast as received on a short wave radio receiver at around noon time, EST. It contains a lot of hiss and the audio level varies a bit throughout. This .wav file is useful to show the multiple filtering/effect capability of the Diamond Cut Multifilter. To hear what it can do, just bring up the Multifilter and then bring up the preset called “Short Wave Radio Anti-fade and Cleanup”. You will see a lineup consisting of 5 filters and effects connected in cascade. Use the Preview button in the Multifilter to hear the result and use the bypass button to hear the unfiltered sound. Experimenting with the various filters and parameter settings contained within this preset in conjunction with this .wav file should prove instructive.
BigClickCracked78Demo.wav This .wav file is taken from an electrically recorded 78 RPM record which has a crack running from the outside rim all the way through to the center hole. It is a snippet of “The Blue Danube” and was recorded in the early 1950s. This demo file is intended to instruct you in the operation of the “Big Click” filter. Note that ratio settings of around 1.4 to 1.5 are effective and that the “thump” produced once per revolution of the record can be squelched by turning on the “De-Thump” feature.
Wind Noise Filter Demo.mp3 This file is taken from a field recording of a jam session and contains wind noise mixed with musical content. Use this file to help you learn how to use the Wind Noise Filter.
HissBurstDemo.wav This .wav file has a hiss burst roughly 8 seconds into it. The hiss burst was likely caused by the momentary loss of the RF carrier during an FM broadcast. This hiss burst is used to demonstrate the various functions associated with the Direct Spectral Editing feature as well as the Bi-Modal Interpolation feature. You can highlight the hiss burst and experiment with the various features found in those filters.
dssdemo.wav This .wav file is a simulation of a loud bar room situation in which a male person is discussing a situation on the phone with loud rock music playing on the jukebox in the background. One side of this phone conversation is picked up by another nearby party in the bar via a “wire” that he or she is wearing. The recording is binaural in nature with one microphone located close to the jukebox and the second microphone hidden on a person and located in proximity to the person who is on the telephone. It is intended to demonstrate the usefulness of the DSS (Dynamic Spectral Subtraction) Forensics filter in terms of rejecting loud background music (or other types of coherent noises) from a surveillance recording. To hear this demo in action, bring up this file and then the DSS filter found in the Forensics menu. Then, bring up the DSS preset titled “dssdemo”. To compare the results, switch the filter between normal “Preview” operation and “Bypass” mode. You may want to increase the “Output” control on the right side of the DSS to hear the conversation more clearly.
Note: The dssdemo.wav is only available in the DC Forensics version of the software.
Male Voice ID Test.wav This file uses a Broadcast Wave (BW) format for testing that software feature and can also be used to experiment with the spectrogram.
ForensicDemo.wav This file is a snippet of an air-check recording of the famous inaugural speech made by F.D.R. in 1933 in which he stated that “We have nothing to fear but fear itself”. This recording was captured in real – time via an AM radio on a Victor Pre-Grooved Record recorder at that time. It was recorded from a radio transmission out of the New York metropolitan area and was received in Newark NJ via a combo Victor AM radio / disc record recorder machine. This file includes a combination of random and coherent noise signals (hiss and heterodyning) which are damaging to its intelligibility. Much of the noise that you hear is native to the original air-check recording. Other noises have been added in to demonstrate the de-noising capability of 8 filters/effects cascaded in the Multifilter. To evaluate this functionality after bringing up this file, go to the Multifilter and click on the preset titled “Forensic Demo Clean-up Filter”, and then Preview it. You will note that the voice is barely intelligible until you enable the preset. You can easily switch back and forth between the raw file and the enhanced version by using the “Bypass” checkbox in the Multifilter.
Note: This demo .wav file is only available in the DC Forensics version of the software.
Composite Bit rate mp3.wav This file is useful when experimenting with the Histogram vs. Time and the Comparative Histogram features. Suspicious edit points can be seen with this file.
Whisper Enhancer Demo.wav This file shows the power of the Whisper Enhancer feature found in the Forensics version of this software.
Voice ID / Voiceprint Demo Files: Six sample .wav files are provided with the software to help you learn more about the voiceprint patterns of a female’s, male’s and child’s voice as recorded through high and low quality signal paths. These files consist of three persons saying the same “cue word” sentence. The low quality versions were recorded simultaneously with the high quality versions for ease of comparison using the Diamond Cut Spectrogram and Voice ID feature. Here are the files that are included:
Female Voice ID Test Sentence - High Quality.wav
Male Voice ID Test Sentence - High Quality.wav
Female Child (12) Voice ID - High Quality.wav
Female Voice ID Test Sentence - Low Quality.wav
Male Voice ID Test Sentence - Low Quality.wav
Female Child (12) - Low Quality.wav
The “Low Quality” files were recorded using a very low cost dynamic microphone manufactured circa 1970 and a commercial grade mixing board manufactured in the mid-1970s. The “High Quality” files were recorded with a studio grade large diaphragm condenser microphone in conjunction with a “dedicated” studio grade microphone pre-amplifier. All 4 of these files were digitized via a high-end soundcard. All of the files are sampled at 44.1 kHz with 16 bit depths.
Note 1: These demo .wav files are only available in the DC Forensics Audio Laboratory version of the software.
Note 2: The persons whose voices you hear on these demos were born, raised and live in Northern NJ, USA, in case you are trying to identify their accents.
Note 3: The Female Child’s voice is that of a 12 year old.
Forensics Files with Edits:
Microcassette Recording with Analog Edits.wav.
This file has analog edits made on a microcassette machine which can be detected using the Subsonic Explorer feature.
Mary Had a Histogram (8 bit edit on 16 bit file).wav
Use this file to experiment with the Forensics Comparative Histogram and/or the Histogram (vs. time) feature. You will discover the edit point.
Analog tape recording Transfer Tips
Analog tape recording was developed in Germany sometime in the early 1940's. This technology was brought to the United States sometime after the end of WW-II. Ultimately, tape recording replaced other methods of audio recording, such as direct to disc mastering, acetate and wire recording. Early recorders held the recording media (ferrous oxide) on paper tape backing. The grainy texture of paper produced discontinuities with the contact with the recording and playback heads, producing numerous analog artifacts. Later, more sophisticated backings were employed to get around that problem, but new problems were introduced that only showed up in subsequent years. Some of the problems that were introduced are of concern to the audio restoration engineer or archivist, since the effects of age on the tape backing may have degraded the oxide material. Care in handling and pre-processing the tape should be considered when transferring old tape recordings to your hard drive for restoration. The following pre-processing and handling precautions should be taken depending on the tape medium.
*Note: Some plastic tape reels may deform using this process depending on their chemical make-up. To assure that this does not occur, it would be best to transfer the tape to a metal reel before proceeding with this process.
Tape Dropout Repair (reel-to-reel)
One problem often plaguing old reel-to-reel magnetic tapes is tape warpage, which is one cause of tape dropout. Tape dropout is observed as a periodic loss of signal, especially in the high frequency portion of the audio spectrum. You can easily note if warpage is the source of the problem by observing the tape as it glides over the playback deck tape guides and heads. If the tape moves evenly over the guides and heads, then the source of the dropout may be lost magnetic coating. However, if the tape moves unevenly (wobbles) across the tape guides, the probable cause of the audio dropouts is tape warpage. The reason for the dropout is that the magnetic tape surface does not maintain good physical contact across the playback head thereby lengthening the magnetic coupling pathway (and increasing the magnetic reluctance) of the system. This will impact the top-end of the spectrum to the greatest degree (random fading in and fading out of the high-frequency signals). There are two solutions for curing this problem at the transfer stage of your project. If you have an old cheap tape recorder that used pressure pads, it will do a better job of transferring such a tape compared to a pro-machine which does not employ pressure pads. But, if all you have is a professional / high-grade machine, you can create your own homegrown pressure pad for the transfer. Follow these steps:
Enhancing Reel-to-Reel Tapes Recorded at Slow Speeds
Sometimes, old reel-to-reel tapes were recorded at low speeds such as 3 ¾ ips (inches per second). These tapes lost much of the high end because the magnetic recording head used had relatively large gaps. These tapes can be brought up to a much higher level of performance by applying the following procedure in the prescribed order:
Archival Recording Philosophy & Methodology
The archival recording process should be approached differently than audio restoration recording. The goals are quite different between these two concepts. When producing an archival recording, one should strive to capture all of the information possible on the source recording and then store its media under controlled environmental conditions. When performing audio restoration, one is involved in the modification of that source material by eliminating noises and modifying the spectral distribution of acoustical energy so as to be more pleasing to the ear. The philosophy behind archival recording is that the resulting product should contain as much information as possible for future use, and this includes all of the noises, clicks, pops, thuds, hum, buzz and any other extraneous noises from the audio source recording. These noises can always be removed at a later point in time without disturbing the master archive.
Applying any type of filter prior to producing the archival recording is a very bad practice. Transfer the recording either “flat” or via its known inverse equalization curve. If the inverse equalization curve is not known, the best fallback position is to transfer it flat. Also, if you are archiving a collection of monophonic recordings from a disk or cylinder source, it should be transferred by using a stereophonic magnetic phono cartridge. This way, both the left and right groove walls are recorded and maintained as individual entities, and since one may be in better shape than the other in certain areas of the transfer, you want to capture both. You should use the best equipment that you can afford for this task. Keep in mind that today’s technology will always be poorer than the technology of the future. And in some cases, the only material that someone in the future will have to work with will be derived from what you have done today. Even if this statement is not exactly true, when you take an analog recording and digitally archive it, you are stopping the chemical degradation process dead in its track at that particular point in time. Perfect clones of your digital master can be reproduced every five years or so in order to insure that no further degradation occurs.
If you are working with old full track tape recordings, and do not have a high quality full track recorder available, use a half track machine and record both channels independently. You may find that one track contains some dropouts while the other does not. And even if both tracks have drop-outs, sometimes you will find that the drop-outs do not occur simultaneously, which will allow someone in the future to fix the problem using a tool like DCArt10/DC Forensics10.
Note: The digital archival recording standard established by the US Library of Congress is, at present, Linear PCM @ 96 kHz Sampling Rate in conjunction with 24 Bit Resolution (.wav meets the requirement when set to these parameters during digitization).
CDR Prep from a Commercial Cassette Tape
CDR Prep from a Vinyl Record
Characterize Frequency Response / Equalize Audio Response (Forensics only)
The following describes how you can use your Diamond Cut software to characterize the frequency response of an audio system including the acoustical environment in which it operates. This method involves the use of random (white) noise in conjunction with the Spectrum Analyzer used in "Live" mode. The general theory is to stimulate the sound system and its acoustical environment with a known distribution of noise (White Noise - constant energy per unit Hertz, in this case). Then, a signal representing a portion of the acoustical output of the system will be fed back into the software program via a microphone and a full duplex soundcard in order to measure the resultant response. The Hi-Resolution Spectrum Analyzer will display the real time result of this measurement. If the sound system has an equalizer in the signal chain, it can be used to "flatten out" the measured response while viewing the Spectrum Analyzer. The following equipment will be required to perform this measurement and/or system equalization:
Equipment:
Setup:
Procedure:
a) Wave shape: White Noise
b) Length: 600 Seconds
c) Amplitude: -10 dB
d) File Type: Stereo
e) Sample Rate: 44.1 kHz
*See the optional System Stimulus method outlined below.
a) Display Mode: Slow
b) Range: 50 dB
c) Frequency Bands: 4096
d) Frequency Resolution: 2.69 Hz
The Spectrum Analyzer should now be displaying the frequency response of your system. The horizontal (x) axis indicates frequency and the vertical (y) axis indicates relative amplitude in dB. If the displayed signal is not flat and you desire it to be, you can engage your systems’ graphic equalizer and adjust it until the spectrum display is as "flat" as possible.
*Optional System stimulus method:
Rather than using two versions of the software program operating at the same time on your computer, you can create a CD ROM of the .wav file containing the white noise signal. Play this CD on your system CD player while using the spectrum analyzer operating in "Live" mode. This method has the added potential benefit of including your sound systems’ CD player in the measurement results.
Converting White Noise into Pink Noise
De-clicking a Vinyl LP Record with the EZ Impulse Noise Filter
This procedure makes use of the EZ Impulse Noise Filter. In extremely rare and difficult cases, consider trying the Expert Impulse Noise Filter.
Important Note: The EZ Impulse Noise filter works best on .wav files that have been sampled at 44.1 kHz or higher. The setting examples given below are based on .wav files that have been recorded at a 44.1 kHz sampling rate only. Different sampling rates will require different settings.
De-clicking a Vinyl LP Record with the Expert Impulse Filter
This procedure makes use of the Expert Impulse Noise Filter. You may also want to try the powerful EZ Impulse Noise Filter for quick and pain-free de-clicking.
1. Download the Vinyl LP .wav file into DCArt10/DC Forensics10 using the "Open" command.
2. Highlight the portion of your .wav file on which you desire to apply the Impulse Noise Filter. (You may also choose to highlight the entire file.)
3. Click on the Filter Menu and then “Expert Impulse Noise”*.
4. Click on the "Vinyl LP" checkbox.
5. Set the Threshold Control to its minimum setting of 1.
6. Set the "Tracking" Control somewhere in the 25 to 30 range to start.
7. Set the "Size" control to a value somewhere in the range of 10 to 15 samples.
8. Run the filter or use Preview mode, and determine if the .wav file is being adequately de-clicked. If it is not, lower the tracking control. If it is de-clicking, but producing distortion on the sibilant sounds, then raise the control. Continue this process until a good balance is established of minimum sibilant distortion and minimum click feed-through. If it is de-clicking, but leaving a bit of an artifact behind, increase the value of the "Size" control.
9. When you determine the best setting of the control for your particular .wav file, click on Run filter. When the filter has completed its operation, the results will appear in the "Destination" workspace.
Important Note 1: Vinyl LP mode works best on .wav files that have been sampled at 44.1 kHz or higher. The setting examples given below are based on .wav files that have been recorded at a 44.1 kHz sampling rate only. Different sampling rates will require different settings.
Important Note 2: Unlike all of the other DCArt10/DC Forensics10 controls, Vinyl LP mode cannot be turned on or off "live" in Preview Mode.
*Important Note 3: Alternatively, you can use the EZ Impulse Filter which is very effective on Vinyl LPs, 45s, or 78s. The EZ Impulse Filter is probably the best place to start except in extreme impulse noise or forensics audio (static) circumstances.
Manually de-clipping an over modulated Wave file*
Sometimes in the process of digitizing an analog signal into a .wav file, clipping can occur if proper attention had not been paid to the signal level during the recording process. Clipping is the process wherein the analog signal's amplitude is occasionally requiring more than the full-scale capability of the A/D converter in the recording system. This produces "flat-topping" of signals at their peaks that can yield a harsh sounding distortion upon playback if it happens too frequently. An automatic De-Clipping filter is now included with this product, but some prefer to perform the de-clipping function manually. The following is a procedure for manually de-clipping the sections of an over-modulated digital signal:
*Note: Alternatively, consider using the automatic de-clipper (found under the Forensics Menu) which often will do an effective de-clipping job on most material.
Decode Touch Tone Signals into Alpha-Numeric Values
*Note 1: Alternatively, you can select DTMF Comb Filter (Narrow) in very noisy situations. Also, you can choose DTMF Comb Filter (Ultra-Wide) in situations where the tone frequencies are off tolerance.
‡Note 2: The Forensics Brick Wall filter also has a special DTMF Band-pass Filter which can be used instead of the Paragraphic Equalizer when you encounter situations where there is an extreme amount of out-of-band noise which needs to be rejected.
Forensic Tape Authentication
(Forensics Version Only)
Audiotape authentication is necessary if it is to be used in a legal proceeding. The process of making this determination is called tape authentication, meaning to determine that the tape specimen is the original.
Two separate "hum" signals existent on the media usually suggests the presence of a "dub." The reason for this is related to the imperfect nature of analog tape recorders that are commonly used in the forensics world due to their small size. These recorders pick up small stray electromagnetic waves from the power distribution grid in proximity to the machine. An "original" recording will have just one noise signature at either 50 Hz or 60 Hz or harmonics thereof depending on the line frequency of the power grid of the environment in which the recording was made. Since analog recorders produce a certain amount of tape slippage, this frequency will be slightly offset from the actual line frequency. If a "dub" is then made of the master, a new noise frequency will appear on the specimen being analyzed with the spectrum analyzer (or the high definition Spectrogram). For example, if you see two spectral lines at, let’s say, 60.1 and 60.4 Hz, this usually indicates that the test specimen is a dub. On the other hand, if you only see one spectral line, the tape is usually an original. To perform tape authentication utilize the following steps:
Important Note:
The power grid in the United States & Europe can have an instantaneous frequency variation of up to +/- 0.5 Hertz for up to a 10 second interval. However, when measured and averaged over a 24-hour time interval, the frequency tolerance is much tighter. Analysis of a recordings hum frequency vs. the power grid frequency is possible based on historical frequency records of a power grid. The technique known as Electric Network Frequency (ENF) analysis, is helpful when forensic scientists need to separate genuine, unedited recordings from those that have been altered. For details, please refer to Diamond Cut Productions Applications Note titled – “AN4 - Using DC Live/Forensics: The Electric Network Frequency Analysis”. It can be downloaded from the Diamond Cut website which is located at www.diamondcut.com.
Automatic Micro-cassette Tape Start-Stop Sequence Detector
(Forensics Version Only)
Forensics examiners are often confronted with the problem of authenticating a recording. Often, these recordings are of the micro-cassette variety. At issue is the question of whether or not the tape has been edited or modified in some way. Often, tapes are edited on a different machine rather than on their original recording device. If a different machine was used to edit the tape, and since each machine leaves its own distinctive stop / start pattern when viewed in the time domain (display), it can be determined if the start / stop breaks were all made on one machine or two or more.
But, often the examiner is confronted with hours of tape and needs to focus in on the start / stop sequences rather than sitting through the entire tape(s) looking for these interruptions.
The best utility to use for this is the Subsonic Explorer (found under the Forensics Menu/Authentication). Please read that section of the Users Guide for more information.
Alternatively, the “Microcassette Tape Start-Stop Detector” Multifilter preset will provide a way to Mark the file where these breaks occur so that a close examination of the file can be made in the time domain display without listening to the entire file(s) to look for recorder erase / record head signatures on the recording.
Here are two methods that one can use to operate this Multifilter Preset.
Method 1:
This method is the easiest to use, but is not self-documenting. In Classic Edit mode, run the attached preset on the Source file with the system (View Menu) set for Sync mode. Each start / stop sequence will be identified by a very large rail to rail pulse which shows up in the destination display. You can then zoom-in on the various start / stop events in the Source Display for further study.
Method 2:
This method is a bit more complicated to use, but it is self-documenting (meaning that the audio material and the markers are integrated into the same .wav file).
1. Use the File Converter Filter to make a Stereo File out of the Mono one that you have from the Microcassette recording.
2. Make the Destination the Source.
3. Clone the File.
4. Run the above mentioned Multifilter preset on either the Left or Right Channel only.
Results: You will see a large pulse appearing on one channel wherever there is a Microcassette start / stop sequence. The pulse should be clear and obvious and “rail-to-rail” in amplitude.
Attenuating GSM Cell Phone Noise from Forensics Recordings
(Forensics Version Only)
There are two common cell phone standard systems in wide use. One of the two, GSM (Global System for Mobil Communications) can cause interference to electronic equipment proximal to a cell phone (by a process involving Amplitude De-Modulation from non-linear devices interacting with Miller capacitance(s) in your recording device or other electronic system(s)). The high crest factor pulsing sound produced by these cell phones can overwhelm a Forensics audio recording making it indiscernible in its native format. Your software has a dedicated Cell Phone Noise Filter found under the Forensic Menu designed to attenuate this noise type. Refer to that section of this documentation for details. If that filter is not effective for your purposes, consider using the following alternative.
There are some Multifilter presets that may be useful for cell phone noise attenuation. Here is a procedure to try on recordings plagued with this type of cell phone noise that were not able to be reduced by the Cell Phone Noise Filter:
Note 1: These Multifilters require a great deal of processing power. As a result, your CPU may not be able to keep pace with them in real time in “Preview” mode. Thus, you may hear some stuttering when previewing. This stuttering will not be heard after the filter has been “Run”.
Note 2: CDMA (Code Division Multiple Access) phones do not cause this type of interference to other electronic equipment.
Security Tips for Forensics Audio Laboratories
Here are a few security tips one should consider when setting up a Forensics Audio Laboratory:
1. The laboratory should be secured in a manner in which only authorized personnel are permitted entry into the Forensics audio laboratory proper.
2. When unauthorized persons need to gain access to the laboratory area, written protocols should be established and strictly followed to allow clients and visitors entry into the laboratory including sign-in/sign-out sheets. But, these persons should never be provided with unfettered access to the lab; these persons should be made to leave the lab area when there are no authorized persons therein.
3. Unauthorized persons should never be left alone in a Forensics Audio Lab. This is very important and that is why we repeat it.
4. A security system should be installed in the laboratory portion of your Forensics facility. This should include intrusion detectors on windows, passive infrared detectors, and a keypad or biometric entry system coupled to an electrically activated locking system on the labs entrance.
5. An independent computer system (not associated with your Forensics Audio Workstation) should be used to monitor the security system. This system should be hard-wire monitored by a central security service.
6. Video cameras located in the lab area are recommended and should be enabled 24/7.
7. Your Audio Forensics Workstation computer(s) should NOT be connected to the internet in any way. Wireless connections to these workstations should be disabled. You need to be able to assure clients and the legal process that files on these computers were not tampered with in any way. One way to reduce that possibility of tampering is to eliminate outside communications connections with your Forensics Audio Workstations.
8. Another major security risk is portable USB drives. Extreme care needs to be taken when using a portable USB drive. These drives can carry virus files to your system and be used to extract critical information. The use of USB (thumb-drives) should be controlled.
9. Your Forensics Audio workstation(s) should not be networked with computers outside of the audio forensics laboratory proper. The network within the lab should be hard-wired via a hub and not wireless and should have no internet connectivity.
10. Keep only software programs that are absolutely necessary for your Forensics Audio work on your Digital Audio Workstation (DAW). Billing and admin computers should be located elsewhere in the facility and not networked with the Forensics audio workstation(s).
11. Software registration should be performed manually. Use an administrative computer outside the lab to obtain the necessary registration codes for your software and "sneaker-net" that information to your Forensics Audio Workstation(s).
12. Master (originals) audio materials should be stored in a fireproof safe. Backup copies of these audio materials should be kept in a secure area off-site. Audio materials should always be kept under lock when not being transferred to your Forensics Audio Workstation Computers.
13. Client Audio materials should never be left unattended outside of the laboratory proper.
14. Master hard-copies of your clients source materials, audio restoration software and work-product files should be kept in the laboratories fireproof safe and this safe should be locked when the hard copy materials are not needed.
15. Cell phones should not be allowed to be used within a Forensics Audio Laboratory. They should be turned off (not just silenced) or left outside the laboratory proper. This rule should apply to authorized personnel and visitors to the lab.
Forensics Audio Handling & Chain of Custody
If you are dealing with Forensics Audio materials or evidence, certain protocols need to be followed. There are several reasons for this.
1. The need to protect the evidence from potential tampering by anyone, especially third parties.
2. The need to prevent accidental damage from occurring to the materials while in transition or while they are in your possession.
3. The need to survive legal scrutiny under examination in a legal venue pertaining to the proper handling of the materials.
In terms of maintaining a traceable “Chain of Custody”, the following procedures should be followed:
1. Shipment to or from a client should be traceable via Registered or Certified US Mail.
2. A packing slip or letter should be included with the shipment describing the material enclosed.
Certain precautions should be followed when shipping Forensics Audio materials to assure its integrity throughout the process. The following recommendations should be followed:
1. Do not ship the audio materials in the same container with any other non-related items.
2. Six inches of packing material should be provided around the extreme dimensions of the media. This is to minimize the effects of shock and magnetic fields on tape based materials such as analog tapes, diskettes, or hard drives.
3. Use only non-shedding packing materials such as bubble wrap. Do not use shredded newspaper or anything similar since fibers can negatively affect tape mechanisms.
4. Use anti-static packing materials whenever possible (like pink bubble wrap).
5. Keep a written and photographic record of the packing process used and maintain that in a document folder for your client’s project.
When you receive Forensics Audio materials from a client, it is advisable to follow this procedure:
1. Immediately inspect the outside of the package for damage. If there is any damage to the package, photograph it and document your findings in writing and place that documentation in the clients project folder. Immediately notify the carrier of the damage noted on the shipping material and inform your client of the damage noted.
2. Open the container and inventory the contents found therein. Compare the contents against the packing list or letter. If there are any discrepancies, note these in writing, place those notes in the client’s project folder and inform your client of your findings.
3. Save all shipping labels & documents attached to the shipping materials/package.
4. Carefully inspect all packing material to be sure nothing of evidentiary value is discarded.
5. Photograph the recording(s) media as received.
6. Date and mark the recording(s) for identification.
7. Conduct a detailed physical examination of the recordings. Points of interest should be photographed. Keep detailed written notes as you examine the materials and maintain those notes in the client’s project folder.
8. If not already removed, remove the safety recording tab(s) from Cassette tapes before playing. Do not discard the tab(s). Put each tab in a separate envelope. Identify the original location of each of the tabs. Seal the envelopes and document their contents and keep this in the client’s project file.
Use the following guidelines whenever handling a client’s audio evidence:
1. Use white cotton gloves whenever handling Forensics Audio materials (like tapes or discs). Alternatively, you can thoroughly wash your hands prior to handling the materials. Only handle the material when absolutely necessary for examination, playback, or return to the client. Avoid any unnecessary handling of the material and be sure not to touch the actual media recorded surface with a bare hand or ferrous tool.
2. Create a direct digital copy of the material onto your DAW. Perform all of your analysis using the digital copy rather than working continuously with the original. Using the Diamond Cut recorder, transfer the recording with 24 bit resolution and a 96 KHz sampling rate. Keep a written record of the time that the recording was transferred and the file name assigned. Make a backup copy of the digital recording on a CD, DVD, USB thumb drive, or external hard-drive. Keep this copy in a secure location off-site.
3. Always be sure to keep magnetic media away from all sources of magnetic fields such as computer monitors, loudspeakers, permanent magnets, power amplifiers, backup power supplies, power tools, etc…
4. Make sure that the analog playback machine’s heads and tape guides had recently been de-magnetized (degaussed). This is an operation that should be performed outside the forensics laboratory proper and at least ten feet away from all client magnetic based media.
When you are not using the Audio Evidence, you should abide by the following rules:
1. Limit access to the material to those in your laboratory who have a need to know based on their involvement with the project.
2. Keep the material in a fireproof safe which is kept locked. Preferably, this safe should be located in the basement of your building near a 90 degree corner of a foundation wall.
3. Assure that the material is kept in a constant temperature and constant humidity environment, keeping it stored away from any source of magnetic fields. Ideally, storage temperatures should be around 60 degrees F and the relative humidity should be 40% or less.
Selective De-Clicking file sectors with the Impulse Filter and "Sync Mode" and Classic Edit Mode
Impulse Noise Generation
(Forensics Version Only)
Sometimes it is desirable to be able to generate Random Impulsive Noise. One application involves room acoustical propagation delay testing. Another application is theatrical in nature; that is to say that a modern recording may need to have some “aged patina” added to give it the sound of a time gone by and contemporaneous with the time of a particular theatrical performance.
The following Presets can be found under the Multi-Filter for Random Impulse Creation:
The first set of 5 presets will allow you to generate Random Impulses using the DC Forensics version of the software. You will need to start with a "Makes Waves" file consisting of Monophonic, 44.1 kHz, 16 bit Random noise at the -10 dB level. Next, apply the resultant signal to any of the first five presets in your Multi-Filter and the result will be randomized impulses of varying characteristics. This signal can be used to simulate an olde recording by “Paste Adding” it to a modern recording. (Please refer to the Bandpass Filter preset listing for additional theatrical sound simulations.) If you do not have the DC Forensics version of the software, download the DC Forensics / Forensics demo from our website located at www.diamondcut.com and use it to create the file that you desire. If you need more than a one- minute duration of random impulses, use the concatenate function in your DCArt10 software to elongate it.
*The sixth preset (78 RPM Record Simulator) requires a different stimulus signal that can be created using the following procedure:
1. Create a Make Waves file of Random Noise, - 10 dB, 16 bits, 44.1 kHz, Mono, 30 seconds long (which represents 39.00 revolutions of the record).
2. Copy that file to the clipboard.
3. Create a Make Waves file of Sine waves, 1.3 Hz, -30 dB, 16 bits, 44.1 kHz, Mono, 30 seconds long.
4. Paste Mix this file to the one on your clipboard.
5. Apply the White to Impulse Noise Converter.
6. Preview and/or Run that filter preset on the file that you had just created.
The resultant file, (or concatenated groups of files) when added to a musical source, will give you an excellent simulation of 78 RPM record crackle which can be useful if you are trying to create an artistic effect for theatrical purposes.
If you need to perform acoustical room propagation delay testing, use White to Impulse Noise Converter 5. If you only want one impulsive event every 10 seconds, use the Edit/Mute function to establish that relationship. If you need to modify the shape of the impulse(s), Zoom-In and use the Pencil Tool to make the desired changes.
Note: If you desire a stereophonic simulation of Impulsive Noise, simply “Make Waves” in stereo instead of mono. Then, use the file conversion filter to create stereo using a time offset value of 20 mSec before applying the stimulus signal to the White Impulse Noise Converter preset of choice.
Nudging the Highlighted portion of the Workspace
Stanton 500 RIAA Compensation Curve Preset for the Multifilter
Under the Multifilter you will find a preset called “Stanton 500 RIAA Compensation Curve”. This preset is to be used in conjunction with a Stanton 500 cartridge and a "Flat" phono preamplifier. This preset will not only convert a flat transfer using a Stanton 500 to the RIAA curve, but will also compensate for deficiencies in the flatness of response of the phono cartridge itself. This was accomplished through the use of a test record made by "Hi-Fi News" in conjunction with the Diamond Cut Spectrum Analyzer. The Stanton 500 was chosen for compensation because it is very popular, readily available, relatively low in cost, and can be outfitted with LP and 78 styli. It is important to emphasize that this preset is not to be used with a transfer through an RIAA preamplifier, but only via a Flat preamplifier such as the CTP series.
Record Transfer to Hard Drive Technical Hints
The first order of concern when transferring records to your hard drive should be your system setup’s electrical hygiene. Also, it is important to apply the proper EQ to the transferred file. Proper cartridge termination is also critical to success. Here are some things to consider in those regards:
Note: If the input impedance of your microphone pre-amp is less than the recommended cartridge load impedance, this technique will not work.
1 / Rshunt = 1 / RL - 1 / Rin
whereby - - -
1 / Rshunt = This is the reciprocal value of resistance that you must add in parallel with the input of your system, given in Ohms.
&
1 / RL = The reciprocal value of required load resistance specified by the manufacturer of your magnetic phono cartridge, given in Ohms.
&
1 / Rin = The reciprocal value of input resistance for the existing microphone input which you will be using, given in Ohms.
Removing a Lead Vocal from a Stereo Recording
The following procedure will very often be effective in removing a lead vocalist's performance from a stereophonic recording. This is useful when you desire to over-dub your own rendition of the performance onto the original orchestration. If there is a lot of ambient sound (reverberation) associated with the original artist, it may not be removed along with the vocal itself. This is seldom a problem, since the ambient sound is not very distinct, and will not drastically deter from your own over-dub performance. It is important to note that this technique will not work with a monophonic source. It is also important to note that this technique very much relies on the type of material you are using. It will produce better results on more acoustical types music and sometimes no success on music with heavy walls of instruments.
Note: This technique works using the same methods as hardware boxes costing many times the price of this product. However, it has the same limitations as many of these hardware solutions in that the vocals to be removed must have been mixed in the exact center of the stereo field by the recording engineer. Many recordings are made this way, but some are not.
Restoring an Old 78 RPM Recording: In Depth
The following are the steps in the process that we have been using for the restoration of early disc and cylinder recordings. You may find it useful to learn from our experience before undertaking an audio restoration of an old phonograph recording on your own. Please note that although most of these steps are based on 78s, the principles can usually be applied to all types of record restoration projects, including LPs and 45s.
When dealing with a one-of-a-kind or a very rare recording, it is strongly advised that you make a transfer of the recording before beginning any cleaning process. The reason for this is so that you at least have something to work with in the event that you inadvertently damage the recording in the cleaning process.
Use a machine designed for this purpose if you have one available. The type that deposits a "bead" of distilled water and then removes it with a stylus, string, and a vacuum system are probably the best for this purpose (like a Keith Monks RCM system or similar). If a system such as this is not available, clean your record with a lint-free cloth and distilled water. Avoid the use of solvents or wetting agents which are non-aromatic* as they have the propensity to leave behind a residue. These residues can attract particulate matter over time and clog the bottom of the record groove. If you are cleaning either wax cylinders or Edison Diamond Discs, or other records containing wood or paper cores, do not use water because of the potential for damage by the solvent. Use only a lint free cloth on these items. Also, be very careful not to get fingerprints on wax cylinders. The oil in your fingerprint will provide the "seed" necessary to trigger fungus growth on the wax surface. This will destroy the cylinder groove wall in time. Blue Amberol cylinders can be cleaned with a cloth that has been moistened with distilled water. However, be careful not to allow any water to come into contact with the plaster core, because it may swell up cracking the record surface.
Important Note:
Do not use solvents such as alcohol or acetone on acetate (transcription) recordings! These solvents will destroy the recording. We have seen grown men cry after utilizing this method of cleaning on acetates (and in one case the transcription was a one-of-a-kind recording of a once famous German opera star).
*Note 1: Aromatic solvents such as ethanol, methanol, or isopropyl alcohol diluted with distilled water are sometimes used to clean vinyl recordings. Never use benzene, gasoline, naphthalene or any other similar hydrocarbon based solvents to clean the surface of any type of recording!
Note 2: Acetate recordings are often covered with a white coating that appears as a powdery substance on their surface. This material (hexadecanoic acid) is not soluble in H2O. It is suggested that records with this problem be played "wet" using distilled H2O for the best transfer. Do not attempt to use solvents to remove the acid. You will need to play it several times. The stylus will clean out the groove. Clean the stylus between plays. Record each play of the record, even if it is a poor and non-final transfer.
Play the record once on your turntable using one of your smaller tip styli (approx. 2.3 mils). Obviously, you do not need to be able to listen to the recording during this process, and so you may want to consider using a separate turntable that you will use exclusively for this purpose that is not necessarily connected into your sound reproduction system. The purpose for this step is to kick up any accumulated dirt located at the bottom of the groove before re-cleaning the record surface.
Clean the surface once again using the procedure outlined in step #2.
Set your pre-amp to stereo mode for lateral cut 78 RPM records or use a flat Diamond Cut CTP-xxxx preamplifier. You are going to digitize in stereo not because your 78 record was recorded in stereo, but the left and right groove walls will both be recorded independently utilizing this technique. Later, using some of the file conversion options available in DCArt10/DC Forensics10, you will make some decisions regarding the best way to use this left and right groove wall information. If you are transferring Vertical Cuts (Hill and Dales) like Edison Diamond Discs or cylinder records, you will either have to place your pre-amplifier in Stereo (Left - Right) mode (which may be difficult since not all pre-amplifiers have this feature) or you will have to record in stereo, and use a File Conversion feature to convert the signal to its vertical component using DCArt10/DC Forensics10. If your pre-amplifier does not have the feature, the record will sound a bit noisy and weak as you listen to it. However, often when the file conversion is performed via your software, the gain will increase and the signal-to-noise ratio will improve at that point in the restoration process. Make sure that your pre-amplifier is providing the full audio bandwidth to the digital recorder. Use no filters at this point in the restoration process. The DCArt10/DC Forensics10 program will need as much bandwidth later to perform its magic. Do not concern yourself with the theory of producing aliasing as some have suggested, since that problem has been solved by all reputable sound card or digital recorder manufacturers.
As mentioned, a flat pre-amplifier can be used such as the Diamond Cut CTP series. The Diamond Cut software Virtual Phono Preamplifier (VPP) can impart the correct equalization curve onto the recording after the transfer has been made, if that step is necessary. EQ is only required for electrically recorded records. Acoustically recorded records do not require any equalization. If an acoustically recorded 78 was transferred via an RIAA preamp, that incorrect curve can be reversed via the Diamond Cut VPP.
If you are using a RIAA preamplifier to transfer electrical 78s, you can use the Diamond Cut Virtual Pre Amp to reverse the RIAA curve and impart the correct Turnover curve to your transfer. Please refer to the section of this users guide pertaining to the Virtual Preamp (VPP) for details.
Verify that the speed of your turntable is correct. Your Diamond Cut software includes a set of Strobe discs. Printable Stroboscope Disc Metafiles can be found in the install directory for your Diamond Cut software. The 50 Hz strobe disc is called “Strobe50Hz.wmf” and the 60 Hz version is called “Strobe60Hz.wmf”. These strobes are found in the following directory:
<Users Documents>/DCForensics10/Strobe50Hz.wmf
or
<Users Documents>/DCForensics10/Strobe60Hz.wmf
Just print the desired disc and cut it out to be placed on your turntables platter. A fluorescent light will be needed to illuminate the disc properly. Most Victor, Columbia, and other 78s were actually recorded at 78.26 RPM, however, Edison laterals were recorded at 78.8 RPM. Edison Diamond Discs were recorded at 80 RPM. Use a strobe disc and a fluorescent or neon lamp operating from of your AC line for this purpose, provided that you live in an area where the power line frequency is accurate and stable. If the speed is incorrect, use the turntable pitch control to correct the anomaly. If you do not have a pitch control on your turntable, no need to worry. You can correct the speed later using the Diamond Cut Speed Change effect.
Note whether or not the record groove is rotating concentrically. If it is not, there will be a "Wow" effect on the recording transfer. This problem can be corrected if your turntable has a removable spindle. With the spindle removed, adjust the position of the record with respect to the turntable platter until the stylus tracks the record concentrically. If your turntable does not have a removable spindle, AND the record is not a priceless artifact, you might consider using a ream to enlarge its centering hole. Then, with the stylus playing the record, bump the edge of the record lightly with your finger until your tone-arm is operating concentrically. We must repeat - - - DO NOT use the ream method on an important artifact or a record that you care about!
Verify that you are utilizing the correct equalization curve for the particular type and brand of record that you are about to transfer. Turnover and sometimes Roll-off are critical breakpoint frequencies that must be matched in a complementary manner to the recording process in order to preserve the "flat" response of the original recording session. Turnover frequencies for electrical recordings are between 200 to 629 Hertz. Acoustical recordings should always be transferred "flat" and "electricals" should be transferred with equalization that is the correct inverse of the recording equalization that was used in the mastering process. Also, it is important to have a system that has the ability to adjust the turnover (and roll-off frequencies for early vinyl) or to use the Diamond Cut Virtual Pre Amp to apply the correct EQ. Again, we recommend the use of a flat transfer via a flat phono preamplifier and to perform the EQ process via your Diamond Cut software. More esoteric EQs can be found in the preset listing under the Virtual Phono Preamplifier or the Paragraphic EQ filter. For more information on this topic, refer to the section entitled "Record Transfer to Hard Drive Technical Hints". Below is a list of common Turnover Frequencies for some of the more common brands of lateral cut 78-RPM records:
Type, Brand, or Process | Turnover Frequency |
|
|
Acoustical Recordings | 0 Hz |
|
|
Columbia (1925 - 1937) | 200 Hz |
Victor (1925 - 1937) | 200 Hz |
Westrex | 200 Hz |
|
|
Decca (1935 - 1949) | 250 Hz |
EMI | 250 Hz |
English Columbia | 250 Hz |
HMV (1931) | 250 Hz |
EMI (1931) | 250 Hz |
London | 250 Hz |
Blumlein | 250 Hz |
|
|
Columbia (1938 – End) | 300 Hz |
|
|
BSI | 350 Hz |
|
|
Capitol | 400 Hz |
Mercury | 400 Hz |
|
|
Brunswick | 500 Hz |
Decca (1925 – 1929) | 500 Hz |
Edison Laterals (1929) | 500 Hz |
MGM | 500 Hz |
Parlophone | 500 Hz |
Victor (1938 – 1952) | 500 Hz |
|
|
“629 Curve” | 629 Hz |
Choose the best stylus for the record transfer. In most cases, truncated elliptical styli are the best for transferring olde 78s, since a truncated stylus tip will not be in contact with any dirt and grit at the bottom of the record groove. The criteria for stylus selection should be based on two parameters. The first is signal-to-noise ratio (in more common terms it would be referred to as surface noise). The second is distortion. Keep in mind that it is always possible to improve the effective signal-to-noise ratio of a recording, but it is much more difficult to decrease the harmonic distortion content of a recording in any post-transfer process.
So find the stylus that produces the lowest distortion as the first criteria, and listen for the stylus that produces the best signal-to-noise ratio as secondary criteria. Styli are available in different diameters specified in mils, and in geometries such as spherical, conical, and truncated versions of both. Although there are charts which call out the best stylus to use for a particular record brand and era, you will probably find that the best one is always determined by trial and error, since the charts have no way to account for the wear pattern of the particular disc which you desire to transfer. However, if you prefer a more deterministic approach, you can use the following stylus list to get into the right ballpark:
Important Note:
Actual Groove widths can be measured with a 200X to 300X microscope equipped with a calibrated reticle. The location of the wear pattern can also be observed, so that you can choose a stylus having a dimension that will either ride above or below the groove-wall wear zone.
If the record is severely warped and is having trouble tracking, try the coin trick that your grandparents used. Neutralizing the counterweight of the tone-arm, and applying some mass in the form of coins on the tone arm shell works wonders for warped, skipping discs. There is a "physics" basis for this technique. Ask your grandparents, and they will explain it to you. If they are not available, the technique involves the "second moment of inertia" as the culprit. The rear counterweight has little variable effect on this parameter. So, placing coins on the cartridge shell dramatically decreases the time constant of the second moment of inertia, allowing the tone-arm system to better track warped records without launching the tone arm into deep space. Pennies are used for mild cases, dimes are used for slightly tougher cases, nickels for more serious cases, and quarters are used for basket cases! Although it is best not to bottom out your stylus, do not worry too much if a basket case causes the pickup cartridge to do that. Bottomed- out cartridges will produce severe thumps in your stereo reproduction system. Most of these thumping artifacts can be removed later with the DCArt10/DC Forensics10 tool-set.
If your record still skips, try using this fractional-speed re-mastering technique. To perform fractional-speed re-mastering, you will need a turntable with wide-ranging speed variability. Set the turntable down from 78 RPM to 45 RPM. Then, use the Change Speed filter to correct the pitch. If you transfer the record onto your hard drive with the turntable running at 45 RPM, then, using the Change Speed filter, correct the pitch according to the following list:
When this procedure is utilized, equalization gets a bit messy. For example, if the correct turnover frequency was supposed to be 500 Hz, the setting on your pre-amplifier must be re-adjusted to 250 Hz to compensate for the fact that you are reproducing the disc at half its intended speed. If you are not using exactly half speed as your re-mastering speed, then you must use ratio-proportioning to determine the correct turnover frequency setting for your pre-amplifier. This is another argument in favor of flat transfers via a flat phono preamp. That way, EQ is not an issue since you will apply the correct Turnover curve after the speed has been corrected and it will fall onto the proper area of the audio spectrum. "Coin therapy" and/or half speed mastering should solve most warped record transfer problems. If these do not work, consider these two alternatives. The first involves utilizing a microscope to view the stubborn portions of the record. Look at the problem groove under a microscope with 50x, and with a very sharp tipped hobby knife; clear a pathway in the groove for the stylus to follow during reproduction. Minimize, but do not become overly concerned with groove damage because the software program can compensate (via interpolation) for this defect to a large degree later in the restoration process. Remember that if you are dealing with an acoustical recording, equalization speed compensation will not matter because you should be transferring with a flat pre-amplifier response, no matter what the value of re-mastering speed that you use.
* Warning! Listening to the Blues half-speed can be very, very,
d e p r e s s i n g .
Adjust the gain and balance of the audio input signal feeding your sound card. Play a portion of the song which you believe has the loudest crescendo or passage, and make sure that the system does not overload on any of the musical transients as indicated on the Level Meters. On the other hand, make sure that the gain is not so low that you are recording "in the mud". If you do, you will lose signal resolution and the signal-to-noise ratio will not be optimal.
Important Note:
Occasional overloading due to severe clicks and/or pops is allowable and will not adversely affect the sound restoration process. However, it is imperative to be sure that any overloading is due to noise transients, and not due to musical transients such as drum "rim shots", etc.
Choose the File Conversion that is most appropriate for your .wav file, if necessary. In a few cases this procedure is not necessary. For example, if you are starting with a monophonic .wav file, there is no need for a file conversion. Also, if you are starting with a stereo .wav file and intend to maintain it as a stereo .wav file, no file conversion will be necessary. However, in many cases, you will be dealing with a stereo-recorded .wav file of a monophonic source that must be converted to the cleanest format for further processing. This is the case with most 78-RPM laterals and some vertical (hill and dale) transfers wherein the A-B function was unable to be performed by your pre-amplifier. The method for determining the best file conversion for a 78-RPM lateral transfer is something you will have to subjectively judge for yourself. Use the preview function in the File Conversion feature found under "Filter". This will allow you to quickly hear the results of your selection.
First, try to listen to the material in stereo. This will be your baseline for comparison (reference). Next, listen to a file conversion from Stereo to Mono (Left Only). Compare the results of this audition to a file conversion to Mono (Right Only). This is essentially allowing you to compare the effects of the wear on the inner versus the outer groove wall of your recording. In many cases, these two will sound the same. However, in some cases with extremely worn recordings, one groove wall will sound much cleaner compared to the other. If this is the case, make a note of which of the two sounded cleaner (containing the least distortion).
The next comparison will be between the best of the two groove walls and the Mono (L+R) file conversion. In most cases, Mono (L+R) will be the cleanest version of all of the alternatives. This is due to the cancellation effect of the record vertical displacement component that contains record and turntable rumble when using this file conversion.
So listen carefully to the "bottom end" (bass) differences between the various conversion alternatives. Also, very often, some of the clicks and pops will diminish in intensity with the Mono (L+R) conversion. If you have transferred a vertical recording using a stereo cartridge, the only file conversion that generally makes any sense is the Mono (L-R) feature. This rejects the entire lateral component of noise signal from the transfer, preserving only the important vertical vector. After these decisions have been made, create a new file using the appropriate file conversion algorithm to be used in the next step in the restoration process. It is worth noting that sometimes the most effective de-clicking of the recording occurs when done before making a file conversion.
Important Note: When using the Stereo to Mono file conversion, it is imperative to verify that both gain controls are set to -6 dB in order to assure that you do not overload the Destination channel input. -6 dB is the DCArt10/DC Forensics10 default setting for this feature.
Filter out any residual "rumble" left on your Source File, by implementing the High-pass Filter. Cutting all frequencies below values in the range of 30 to 50 Hz with an 18 dB / Octave or 24 dB / Octave slope can be useful for this purpose. The Diamond Cut Virtual Phono Preamp (VPP) includes a 30 Hz Rumble filter feature making this process simple. If you are dealing with acoustical material, you will probably want to set the frequency of the filter even higher to something in the range of around 100 Hz to 120 Hz since very little information generally exists below that range of frequencies. For this, you will have to use the High Pass Filter because the VPP rumble filter is fixed at 30 Hz. Don't be afraid to experiment and use "Preview" mode to help choose the best value for your material.
First, remove Big Clicks due to cracks in the record with the Big Click Filter. Next proceed to De-click the record using the EZ Impulse Filter (or, in extreme cases, the Expert Impulse Filter). Usually, the EZ Impulse filter will perform this function just fine. If your record is very "hissy" (lots of top-end noise as will be found in many early 78s) then it is sometimes useful to run a low-pass filter first set for around 15 kHz and 6 dB/Octave. The reason for this is that sometimes a lot of "hiss" can fool the algorithm into thinking that there are a lot of sibilant sounds on the recording, which will move the algorithm's threshold too far up to capture ticks and pops effectively. This filter should never be run at a frequency lower than 12 kHz at no steeper than 6db/Octave. (This rule never applies to vinyl LPs or 45s.) See the section on Low-Pass Filtering for details on its operation. If your record is not extremely "hissy", it is directly ready to be de-clicked by an Impulse Filter. If you are using the EZ Impulse Filter, start with all three control settings at 50 and adjust as necessary. If you are using the Expert Impulse Filter, for 78-rpm records, a good initial setting for the "Size" control is 5. Make sure that the filter is not in "Vinyl LP" mode. Set the Tracking adjustment all the way down (to a setting of 1) and perform all of your adjustments with the threshold control. Adjust the threshold downwards until the clicks are removed, but not so far down as to cause the process to distort the sound signal. Remember to utilize the preview feature to establish the best settings for your particular restoration job. Only in rare circumstances, as may be found on a very "high fidelity" 78 rpm record, will you have to employ the services provided by the tracking control, to move filter threshold out of the way on high-frequency musical transients. The use of the to the Expert Impulse Filter should be a last resort since the EZ Impulse Filter usually does a very effective job and is much easier to adjust.
Sometimes, two lightly applied applications of any of the Impulse filters will be more effective than one heavy application. The Multifilter can help with this process since multiple Impulse filters can be placed in tandem with that tool.
After running the Impulse Filters, listen to the entire recording and drop markers anywhere you find any clicks, pops, or thumps that the Impulse Filter did not eliminate. Try selective De-clicking utilizing "Sync Mode" (found in the "View Menu") and the Impulse filter or use one of the manual de-clicking processes (like the manual interpolation “I” key) to eliminate these. You can choose between the manual de-clicking process using copy and paste over, or you can use a much simpler process utilizing the interpolate feature. In extremely rare cases, it may be necessary to use the “Cut” feature when the anomaly is extremely long in time duration. Sometimes, the use of the Oterpolator (O) key will become a valuable tool to consider in some short impulse event cases.
Some of these techniques may not re-insert a signal as close to the original signal as does the Impulse Filter, so manual de-clicking should only be performed as a last resort (except for the use of the “I” key or the DSS). If there are a high number of impulse events that were not eliminated by the Impulse Filter, you should consider re-adjusting the filter's parameters and/or running it again before attempting to manually de-click the remaining noise artifacts. Multiple passes through the impulse filter with different settings for each pass is often useful.
When choosing a manual de-clicking technique, consider the following tradeoffs:
Note: Consider using the highlighter coupled with the “Snap Selection to Zero Crossing” (right-mouse) feature before manually correcting an impulse noise event in order to achieve the best manual interpolations.
Many 78s have clean surfaces, and do not require this step in the restoration process. However, some very worn records, or records that were stamped utilizing low quality resins and fillers benefit from this step. So use the Narrow Crackle or the Median Filter to reduce "crackle" on recordings that need it. Crackle is essentially low amplitude clicks and which occur much more frequently than standard impulses. (It sort of sounds like “Rice Krispies”.) It is important to perform this step only after the initial "de-clicking" step has been completed, and before the de-hissing step is performed, if the best results are to be obtained. Usually, “Size” (in the case of the Narrow Crackle Filter) or "Sample" (in the case of the Median Filter) settings from 3 to 6 produce the best results. Using too many samples will create a distortion (sort of an "edge"), which is particularly pronounced on vocals. But experimentation is the only way to determine the most appropriate “Size” or “Samples”, since material varies widely in crackle content. Use the "Preview" feature to aid in the selection of the most appropriate setting.
Important Note:
Very early cylinder recordings may benefit from the application of the "Average" filter for de-crackling. Start with a small number of "Samples" and work your way up until you have achieved a good result. If you are not sure whether to use the Median or the Average filter, try both and decide which one works the best based on your own specific observations.
De-Hiss the recording using one of two methods. Even if you have a relatively quiet record, there will still be some residual hiss that you may wish to reduce. There are two alternatives to choose between. The Continuous Noise Filter (CNF) is the most effective at eliminating wide band noise all the way down to the bottom-end of the audio spectrum. Consider using the Artifact Suppression or Smoothing mode when performing this step. For details, please refer to the Filter section describing the Continuous Noise Filter.
However, the CNF has the possibility of introducing some digital artifacts onto your .wav file if it is not set correctly, particularly with high settings of the attenuator control. Start with a setting around 10 dB and try moving the control both directions. If you set this control too high, it will also reduce some of the "ambiance" of the recording with the tradeoff of providing a great deal of noise reduction.
Your other option is to use the Dynamic Noise Reduction filter. It will not produce as much noise reduction as the Continuous Noise filter, but it is easier to set up without introducing digital artifacts onto your Destination .wav file. So the choice will have a lot to do with the condition of your Source File, and your own taste with regard to the tradeoffs that were just outlined. Trial and error is a good method for sorting this one out.
Eliminate 50 or 60 Hz hum and their harmonics from your recording utilizing the Notch or Harmonic Reject filter. When "notching" out hum, be sure to set the bandwidth control to the smallest value that is effective in order to minimize any effects on adjacent frequency information. Similarly, when attenuating a “Buzz” with the Harmonic Reject Filter, minimize the number of harmonics required to do the job at hand. Some early recording had some hum induced by the amplification system used to cut the master. Two frequencies will sometimes be heard. One is often the line frequency fundamental of either 60 Hz on American made records, and the other is 50 Hz on European makes. Another frequency sometimes heard is at twice the line frequency and is usually due to faulty filter components in the full-wave rectifier dc power supply section of the master cutting-head amplifier. If you hear any of these noises, they can be greatly attenuated with the Notch filter. This filter can be set to have a very narrow bandwidth, and so will have very little sonic effect on the adjacent frequencies. Remember, if your recording should contain "Buzz" rather than “Hum”, use the Harmonic reject filter instead. You will learn through experience to discern the difference based on the sound that these two anomalies produce. And, usually, when a recording contains a lot of “Buzz” that usually means that your record transfer setup has a technical problem and the “Buzz” is not on the master. For example, an un-grounded turntable will often induce “buzz” onto your transfer. Low quality light dimmers are a common source of line induced “buzz’ into an audio system. It is always best to clean up your record transfer setup rather than trying to fix this kind of problem with the software post facto.
Provide a smooth Fade-In and Fade-Out sequence using the features with the same name. DCArt10/DC Forensics10 allow you to choose between a linear or a logarithmic gain vs. time curve. Experiment to determine which curve is the best for the material you are dealing with. After you are done setting up your Fade-In and Fade-Out process, use the "Mute" function to eliminate any extraneous noises or signals that precede the Fade-In and succeed the Fade-Out sequence.
DCArt10/DC Forensics10 provides you with a 10 & 20 band Graphic Equalizer and a 10 band Paragraphic Equalizer that you can use to create a more pleasing tonal balance to your audio restoration. It can be found under the Filter Menu. Additionally, the Virtual Phono Preamplifier provides you with three tone controls, two of which are of the shelving type. Alternatively, as you listen to the restored .wav file via the DC Tune Library, you can consider feeding the signal through various analog signal-processing devices via the Multifilter in real-time to give it your own personal flare at that point in time. The Diamond Cut software systems such as paragraphic equalizers allow you to bring out sounds that you consider to be too understated, and you can attenuate sounds that you may believe to be overemphasized
Some people like to add some ambiance to the transfer with a little bit of reverberation, which can be accomplished with the Reverb tool, or the echo effect. Devices and effects such as Spectral Enhancers and Harmonic exciters (found within the VVA effect) can provide interesting effects especially on vocals. If your recording is missing too much of the "top-end" you can enhance it with the Virtual Valve Amplifier exciter. It will synthesize harmonics of the upper registers of the musical scale, and allow them to be mixed back into your original source material. If your material is exceptionally noisy, consider using the “High Noise” mode when applying the VVA to old 78s. Another interesting Effect to consider is the Punch and Crunch multiband Dynamics processor. This can be used to restore some of the original dynamics which may have existed during the recording session. Lastly, you have a Sub-Harmonic Synthesizer and an Overtone Synthesizer that may be used to create pleasing effects (when used in moderation).
If you are performing a sound restoration for commercial release, it is important to provide a product that will sound good on most audio systems to most people. For example, if you have a very low quality reproduction system, you may be providing equalization, which is really compensating for the fact that your sound system has a poor frequency response, rather than compensating for a lack of certain frequencies on the recording itself. On the other hand, if your system is the state-of-the-art, you may want to listen to your results on a cheaper sound system as well, to be sure that the recording does not "break up" due to excessive bass. With any reproduction system (and sound room), it is a good idea to "flatten it out" before making subjective decisions regarding your final EQ. Use a pink-noise generator and a Real Time (spectrum) Analyzer (RTA) as the stimulus / response system for the measurement. (Your Diamond Cut Software Spectrum Analyzer is capable of making these measurements.) Connect a graphic equalizer (preferably 1/3rd Octave, 30 band) between the output of your reproduction system pre-amplifier and its power amplifier. Flatten out the response of the system / room utilizing the graphic equalizer, moving the measurement microphone to various locations in your listening area. Flatten out each channel independently. Lastly, when making your final EQ decisions, get someone else's opinion as well as your own (and include both sexes). Since audio "quality" is a highly debated and subjective area of discussion, some "opinion averaging" is in order when engaging in commercial releases. If you do not seek the opinions of others at this phase, you may find that your customers will volunteer it to you, and at a point where it will cost a fortune to fix! (If the reviews have already gone out, it may be too late to fix it at all.)
When you are done with the restoration process, you will have to transfer the contents from your computer hard drive and into some other format. The most obvious method simply involves the use of the D-A converter in your sound card. However, this method will produce a poorer transfer compared to direct digital, since it will introduce a small amount of distortion and noise (hum) onto the recording. If the audio restoration you are performing is for commercial release, or you are simply interested in obtaining the highest possible transfer quality back to another medium, you should consider using a digital-to-digital transfer. There will be no generational losses if this technique is used. Another alternative for achieving a loss-less transfer of your Destination .wav files would be to use a CD-R drive. These units are readily available, low in cost, and can be mounted directly in one of your computer bays. Alternatively, you can purchase one that is USB based.
Restoring a Recorded Telephone Conversation
Recorded telephone conversations sometimes are very difficult to decipher due to gain variations and/or the "out-of-spectrum noise", "in-spectrum-noise", poor frequency response and high levels of distortion. This is particularly true of sound transfers made from Digital Communications Recording Systems. The following five-step procedure is useful for restoring such recordings. It is recommended that these steps be performed in the order outlined below. The process is arranged in an order that will require only the poorest recordings to require all of the steps outlined. Some recordings will require only one or two steps to yield adequate intelligibility. Keep in mind that you are not trying to tune for high fidelity here; improved intelligibility of the conversation is the only goal of this procedure.
Standard Speech Filter:
Steep Slope Speech Filter:
If none of these setting improves the signal-to-noise ratio of the signal, experiment with your own values for the Band-pass filter.
*Note: If there still remains a large variation in loudness between the two speaking parties, apply the ALC feature found in the Punch & Crunch Effect.
Rumble Reduction
Rumble is a low frequency random noise found on record recordings. Generally, the noise in the spectrum below 30 Hz is considered to be “rumble”. However, with very old 78 and 80-RPM recordings, rumble can often be heard with higher frequency content (as high as 120 Hz). DCArt10/DC Forensics10 provides you with three possible methods for substantially reducing rumble on a recording. But first, it is important to perform your transfers with a low rumble turntable to begin with. There is no sense in making the problem worse by using a cheap turntable (especially the types which use a thrust bearing which is of the ball-bearing race variety). Turntables whose platters are thrust supported on a single ball (or point) will offer the lowest degree of turntable rumble.
Method #1:
If you are transferring a lateral 78, or a lateral monophonic LP or Monophonic 45 RPM record, transfer it to your hard drive via a stereo cartridge. Then, using the File Conversions feature, convert the file from "Stereo" to "Mono L+R." Since most of the rumble on these types of records are contained in the vertical vector only, the Mono L+R algorithm will cancel out this noise signal, and only preserve the lateral (horizontal) component, which does not contain much rumble.
Important Note:
Method #1 will not work on Hill and Dale or Pathe´ (groove width modulated) or stereophonic recordings.
Method #2:
Use the Continuous Noise Filter as prescribed in an earlier tutorial. It is only important to realize that the signals you are dealing with will be those at about 60 Hz on down. So when you experiment with the threshold line position, only adjust it in the lowest octave to eliminate rumble. When adjusted correctly, you should be able to preserve the last octave of the audio band in terms of actual signal, while rejecting the lower signal level rumble. Use high values of fft and move the threshold line down to the bottom above 200 Hz.
Note: This technique will work on all types of recordings, not just monophonic lateral recordings.
Method #3:
Use the High-pass Filter, with settings of 60 Hz on down, and the slope control set to 18 dB / Octave or 24 dB / Octave. Experiment with different frequency values and/or slopes until you achieve the desired results using Preview mode.
Note: This technique will also work on all types of recordings, not just monophonic lateral recordings. However, it is not as good as method number 2 because it will also eliminate some of the low bass of your recording as well as its rumble content.
Method #4:
Use the Channel Blender Effect with the "Vinyl LP Cancellation Filter" or the "Vinyl LP Bass Clarifier" preset enabled. Often, this method produces the optimum rumble reduction results on Vinyl LP Stereo recordings or Stereo 45s.
Simulate Stereo from a Mono Source – Method #1
Simulate Stereo from a Mono Source – Method #2
1. Open the Monophonic File to which you desire to add “Stereo
Simulation”.
2. Click on “File Conversions” found under the Filter Menu.
3. In the “Source File” box, click on “Mono”.
4. In the “Destination File” box, click on “Stereo”.
5. Click on “Run Filter”.
6. When the conversion process is completed, close the File
Conversions dialog box.
7. Under the File Menu, click on “Make Destination the Source”.
8. When the “Save As” dialog box appears, click on “OK” if you are
satisfied with the automatically assigned temp file name.
9. Under the Filter/EQ Menu, open the Paragraphic EQ.
10. Activate the Left (L) channel by clicking on the “L” button on the
Toolbar (on the top of the Diamond Cut software program).
11. Find the Paragraphic EQ preset called Stereo Simulator Left
Channel Comb Filter* and then click on “Run” in the Paragraphic
EQ dialog box.
12. Make the Destination the Source.
13. Activate the Right “R” channel by clicking on the “R” button on
the Toolbar and then click on “Run” in the Paragraphic EQ dialog
box.
14. Make the Destination the Source.
15. Activate the Right channel by clicking on the “R” button on the
toolbar.
16. Find the Paragraphic EQ preset called Stereo Simulator Right
Channel Comb Filter* and then click on “Run” in the Paragraphic
EQ dialog box.
17. Close the Paragraphic EQ and open up the File Conversion Filter.
18. Click on the “LR” button on the Toolbar.
19. Set up the File Conversion Filter for “From Stereo to Stereo”
mode.
20. Set the Time Offset for 10 mSec and Preview the filter. Adjust the
Time offset while previewing until you obtain the stereo effect
that you like and then Run the filter.
*Note 1: Paragraphic EQ Presets with a (W) suffix will provide a stronger stereo effect.
Note 2: Sometimes, you may want to combine methods 1 and 2 for the strongest stereo effect.
Manual Splitting & Recombining a Stereo Wave file
Though we have recently implemented a new automated Split and Recombine tool, some users may prefer performing this process manually.
Using DCArt10/DC Forensics10 as an Audio Waveform Analyzer
DCArt10/DC Forensics10 can be used as a waveform analyzer. It is capable of both time and frequency domain analysis. This waveform information may be useful to know when trying to determine what useful frequency range is present in a .wav file. It also will allow you to measure resonance or acoustic feedback, and periodic noise sources such as 50 or 60 Hz Hum (or harmonics thereof). Once this information is known, it will be easier to set up the parameters for the Notch, High-pass, Low-pass or Band-pass Filters, so that you can retain useful portions of the spectrum, while rejecting unwanted noise signals. This information is also useful in Forensic applications for measuring the time between gunshots or other events of critical importance. The waveforms, either in the time or frequency domain, can be printed out using the Print Screen procedure.
Method #1
Using the time scale in the workspace to determine a signal's frequency:
Method #2
Using the Band-pass Filter as an Audible Wave Analyzer:
Note: This method only works well if your computer is fast enough to run the Band-pass Filter algorithms in real time in Preview Mode. Otherwise, the system will "stutter" making it difficult to interpret the results. Also, it is important to realize the subjective nature of this method of analysis. Your own ability to hear frequencies at the extreme ends of the audio spectrum is critical. You need to consider that most men begin to lose their high frequency response after the age of around 21, and most women begin to lose their high frequency response after the age of around 30 (although there are always exceptions). You may want to engage the opinion of your kids (whose hearing is generally exceptional, believe it or not) when performing these subjective tests. You will also need a very high quality sound system for these measurements. It is very useful to have one that utilizes a sub-woofer for making the low-end measurements.
Method #3
Using the Audio Spectrum Analyzer
Method #4
Ogg Vorbis Lossy Compression Tag Support
Your Diamond Cut software can both play and encode files using the Ogg Vorbis format. You can also rip files from a CD into this format as well as play then via the DC Tune Library. It also supports the following Ogg Vorbis tags:
TITLE: This field is the Track/Work name and it is initialized with the name of the file being used.
ALBUM: This field is related to the collection name to which the track belongs.
TRACKNUMBER: This field contains the track number of the piece if it is a part of a specific larger collection or if it is part of an album.
ARTIST: This field contains the artist generally considered responsible for the work. In popular music, this is usually the performing band or singer. For classical music it would be the composer. For an audio book it would be the author of the original text.
GENRE: A short text indication of music or track genre.
FLAC Lossless Compression Tag Support
Your Diamond Cut software can play and encode files using the FLAC (.flac) lossless file compression format. FLAC produces a reduction in file size of roughly one-half without any loss of sound quality. The “encoding / compression” control actually affects the degree of compression that the system will achieve and not the actual audio quality of the resultant file. However, higher values of “compression” will take longer for your machine to create due to the increased complexity of the math involved, but the resultant file size will be smaller. The software supports the following FLAC tags:
TITLE: This field is the Track/Work name and it is initialized with the name of the file being used.
ARTIST: This field identifies the artist or songwriters who are involved with the creation of the file.
ALBUM: This field is related to the collection name to which the file belongs.
GENRE: This field allows you to specify a type of music relating to the file.
TRACKS: (Numerical Value) This provides you with a field to identify the number of tracks involved in the file.
YEAR: Use this to identify the year of the file creation or the year of the audio restoration or re-mastering date.
mp3 Lossy Compression Tag Support
Your Diamond Cut software can supports the following mp3 lossy compression file tags:
NAME: Use this as a description field for the mp3 file.
ARTIST: Use this to describe the author or artist associated with the file.
GENRE: This field allows you to specify a type of music relating to the file.
TRACK: (Numerical Value) This provides you with a field to identify the number of tracks involved in the file.
YEAR: Use this to identify the year of the file creation or the year of the audio restoration or re-mastering date.
Trouble Shooting
This is your one stop shop for problems or questions (FAQs) that you may encounter while working with our software. This list of problems and solutions constitutes about 90% of the overall problems our techs deal with. Chances are…if you have a problem with our product, the solution is listed below. Please read this before contacting us.
This section lists common questions and problems users have with DCArt10/DC Forensics10.
Q: Onto how many computers am I permitted to install the Diamond Cut software based on one license purchased?
A: The Diamond Cut software is licensed for use by one person on up to two computers (typically a desktop workstation and a laptop). One license of the software does not permit installation on two or more computers to be used by two or more separate persons.
Q: How do I control the recording level of the audio signal?
A: In Windows, there is a speaker Icon in the lower right hand corner of the Taskbar. Double-click on this Icon to bring up the control panel for your sound card. There are level controls for the Mic or Line inputs of the sound card. For Sound Blaster type cards, double click the yellow speaker icon and then choose Options/Properties. Click on Recording, and then click OK. You'll now have your input mixer up. Also be sure that the correct input is selected (Mic, Line, or Aux) for your particular recording setup.
Some sound cards have their own audio control panels that are better suited to controlling the audio inputs. These are usually available from the Start Menu
Q: I’m trying to record and I hear the audio, but the Record meters are not jumping.
A: Most sound cards come with the Line Input not selected. This causes a "no recording" symptom. But first, make sure that the sound card is installed correctly. Just go to the Control Panel/Multimedia and make sure that the sound card is selected as the default playback and recording audio device. If it is, the sound card is most likely working okay. Next, bring up the Preference dialog box and select the "Sound Card" Tab and make sure that the inputs and outputs are set to the correct sound card. If the system still is not recording, double click on the yellow speaker icon on the tray and choose Options/Properties and click on the Recording radio button. Click OK. This brings up the input mixer. Make sure that the slider labeled "Line Input" is selected (it usually will not be). When you do this, the meters in the Record window will start modulating immediately, indicating that the system is now working fine.
Q: I get a Windows error message when I try to record that says something about "this is beyond the capability of this device" or "The specified format is not supported". What's this?
A: This just means that your sound card is not capable of recording with the sample rate or bit width you have selected. For example, if you try to record a 24-bit file with a 16 bit sound card, you'll get this message. Most sound cards will work with 44.1 kHz Sampling rate, 16 bit, stereophonic recording settings. This could also mean that Windows is assigning .wav files to be played by some device other than a sound card…like a modem. Make sure Windows is aware that you want .wav files assigned to your sound card’s output.
Q: I click on Play and don't hear anything but the VU meters are jumping fine in the software program.
A: If the cursor is moving across the screen during playback and the VU meters are jumping, you can be pretty sure the audio is indeed playing. Usually, this just means that you don't have your speakers plugged into the soundcard output where the audio is appearing. Check under Edit/Preferences/Soundcard to see what the output device is set to and make sure your speakers are plugged into that set of outputs.
Q: My levels are low during recording.
A: Maybe not. You should normally not record all the way up to 0db (the red area) with digital systems. Remember, you'll likely need some "head room" in order to be able to increase volume with some of our tools such as the Paragraphic EQ. Peak levels of -4 or –6 db will give great results. If your levels are REALLY low, check to make sure you have the right type of signal going into your sound card. You cannot plug a turntable directly into a soundcard, for example - you'll need a preamp for this.
Q: My sound recording is distorted and monophonic despite a stereo line level signal input. Why is that happening?
A: It is likely that you have plugged your line level device into the microphone input of your desktop computer or laptop. If your computer has a line level input jack, simply re-plug the cord into that input. However, some computers only have one input jack. In many cases, the mic input can be converted into a stereo line level input via the computer sound card control panel.
Q: DCArt10/DC Forensics10 contains a Fast Edit mode and the Classic Edit (two-file) mode. Which one should I use?
A: Beginners tend to like the Fast Edit mode since it works more like other audio editing programs. It's intuitive, simple and fast. However, as you learn the program, we think you'll find the classic two-screen mode to be the most powerful audio restoration environment. Our "Source and Destination" way of working is optimized for those situations where you want complete control of the files being edited, created, and saved. This is especially useful for forensic situations where an audit trail is required.
Q: I clicked Fast Edit in the Preference box and I'm still in the Classic mode.
A: You need to close the program and restart it for this change to take effect.
Q: I am getting crashes when I try to play audio. What do I do?
A: DCArt10/DC Forensics10 uses both the newer Windows Driver Model (WDM) method of communicating with sound cards as well as the older MME method. WDM is new to many sound card manufacturers and some of these new sound card drivers may have bugs in them. If you are getting a crash when you try to play or preview a filter, please check to see if a new sound card driver is available from the manufacturer of your card. If this doesn’t do the trick, look under Edit/Preferences/Sound Cards and check the box which says “re-initialize on play”. This makes the sound card return to a known state every time you play and may help you. You can also select between WDM and MME in this area to coincide with the most reliable support from your sound card.
Q: Why does Preview mode sound like it is stuttering?
A: All of the filters in DCArt10/DC Forensics10 require a fair amount of processing power. If your computer cannot complete the processing fast enough to keep up with the audio stream, then the preview mode will stop and start in short bursts that sound like stuttering. This effect can be reduced or eliminated by increasing the number of "Preview Buffers" in the Edit/Preferences/Soundcard dialog box. Regardless of stuttering in Preview, all "Run” filter operations will be stutter free. Putting many filters in the Multi-Filter box will likely cause stuttering even on very fast machines. You may also want to check and see that you’re using your sound card’s most recent drivers.
Q: I noticed that a Live Mode is now included in DCArt10/DC Forensics10. What's this for?
A: This allows you to take a "live" audio stream and process it without first recording it to hard disk. With this function, you can make your computer an integral part of your home stereo system, ham radio station or SWL station. Imagine adding the sound of a $15,000 vacuum tube amplifier to all your audio without having to record and process it. As an example - take your CD player and plug its outputs into your sound card input. Take the sound card output and plug it into your home stereo receiver. Now run DCArt10/DC Forensics10 and choose Multi-Filter. Put some enhancement modules and/or noise filters into the signal path and click on "live preview". All these tools will be applied to every CD you play in real time.
Q: I get an error when I try to use Live Preview mode. What's up?
A: Your soundcard must be able to play and record at the same time. If you have a cheap soundcard, it's time to upgrade!
Q: I have a Whackmaster 6000 sound card I bought in 1992. Is this OK?
A: Who knows? We don't remember that year at all. Just about all of the new sound cards include a new type of driver called WDM. This is Microsoft's effort to fix a lot of earlier problems with various sound card implementations. If your really old soundcard works, then you're OK. Again, you can try going to the Preferences/Sound Card area and selecting MME as your method of communication. In many cases, even the old Whackmaster is supported by this driver method.
Q: I have a 192 kHz / 24 bit sound card. Should I record using these settings?
A: Remember, your recordings will never be better than your originals. If you are recording vinyl records and are making CDs, we recommend 44.1 sample rate, 16 bit, Stereo. If you have high quality masters or are making DVD audio disks, then go with the higher settings. The DCArt10/DC Forensics10 Impulse Filters can benefit from 48 kHz or 96 kHz sampling rates, but higher sample rates and wider bit widths will result in larger files and more processing time.
Q: How do I record my records using a turntable?
A: A magnetic phono cartridge puts out a very tiny signal. You cannot plug a turntable having a magnetic cartridge directly into your soundcard since it doesn't amplify the incoming signal enough. You'll need a preamp. If you have a stereo receiver with a control labeled "phono" on the front, you're probably all set since this has a preamp built in. If your receiver doesn't have this (many modern ones don't) or your receiver is too far from the computer, get a stand-alone phono preamp and seriously considering the use of a flat response unit (like the CTP-xxxx series.
Q: How do I connect my computer into my existing stereo system?
A: On your receiver or master component, take the "tape out" or other line level output and plug it into the line level input of your soundcard. You can also take the line out of your soundcard and plug it into the "tape in" of your receiver though most folks just connect the soundcard output to their computer speakers.
Q: My computer crashes in Preview mode with the Multi-Filter.
A: If there is any weakness in your system, a Multi-Filter preview will likely find it. This can require very large numbers of calculations per second while audio is flowing. The audio can be presented to your sound card in a start/stop fashion as well (though the buffering on your sound card and in DCArt10/DC Forensics10 makes for smooth playback). Sound card designers seldom test for this environment and you can uncover bugs in the drivers when using the Multifilter. Make sure you have your latest sound card and video card drivers and try reducing the amount of video acceleration your video card is set for (this reduces the overall system overhead a bit).
Q: Will increasing the amount of RAM in my computer make DCArt10/DC Forensics10 run faster?
A: DCArt10/DC Forensics10 does not require huge amounts of RAM. If your computer system has 2 GBytes of RAM, then further increases will not appreciably speed up the program. The software uses disk-based processing so hard drive speed and raw processor speed will generally have a greater effect than increased RAM beyond a certain minimum. A faster processor will make a big difference in the number of simultaneous filters you can use in the Multifilter.
Q: I want to purchase a system optimized for use with the software. What sort of system will provide me with the fastest performance of all of the various DCArt10/DC Forensics10 filters, effects, and editing features?
A: You should purchase a computer with the fastest clock speed in your price range. Look for hard drives with fast access times and rotational speeds. Purchase a high performance sound card. Lastly, turn off all superfluous programs that may be running in background.
Q: How do I avoid producing dropouts during recording or playback?
A: Make sure that you have reviewed all of the following:
Q: I have a vinyl LP that is very noisy, and still has too many clicks after processing. What can I do?
A: Try running the Big Click Filter first, followed by the EZ-Impulse filter. If there is still some impulsive noise left behind, consider running the Expert-Impulse filter, as the third step in the process. Running it twice or more at moderate settings can be quite fruitful. When using the Expert Impulse filter, first run it with the Tracking control set to zero, and adjust the threshold control to remove just the largest clicks. When done, make the destination the source, and re-run the filter with the Threshold set back to 1, and adjust the tracking control to get the smaller clicks. Another thing to try is to use the File Reverse feature, and then process the vinyl recording through the Impulse Noise filter. When done, re-reverse the file. Also, consider trying HQ mode, which is especially good for detecting very small clicks when adjusted correctly (small size values around 5). If you still have clicks left, it's likely because the clicks are longer than the program is allowed to automatically identify and repair. Use the manual Interpolate function (‘I” key) to get rid of any remaining clicks.
Q: I have a record with one major scratch on it running from the center to the outside in a spiral pattern. How do I eliminate the loud "click" which I hear which occurs once per revolution of the record?
A: Try using the Big Click filter on it first. This filter will only remove the major clicks and not the smaller ones, so do not try to get everything with it. Then, you should consider using either the EZ Impulse Filter or perhaps the Expert Impulse Noise filter to remove the remaining noises. Alternatively, you can try to use the Expert Impulse Filter in the following way. Set the Tracking control to its minimum value. Set the Threshold to its maximum value. Set the "samples" to about five. While in Preview mode, slowly decrease the Threshold control until you see the click counter increment once for each click, which is occurring. Do not increase the Threshold control any further than necessary. Next, increase the "Samples" control until the click is no longer audible. This technique is also useful for getting rid of the clicks produced by cracked 78-RPM shellac records. It is even possible to take a broken 78, glue it together, and then after transferring it, remove the clicks which occur at the breakage points with one of these techniques.
Q: I just transferred an old stereo recording to my hard drive for processing, but I am not sure whether or not the left and right channels are in their correct positions or transposed. How can I determine if they are correct?
A: If the material is contemporary pop, it is difficult to make this determination. However, if the music is orchestral in nature there are some obvious orientations to listen for. For example, the left channel should be dominated by any cymbal crashes or the tinkling sound of a triangle. Also, when Violins come in they should dominate the Left channel. Double basses should be more prominent on the right side of the soundstage. French horns should be heard behind the woodwinds, while trumpets and trombones should generally project from the right rear. If this is not the case, the channels are probably reversed and should be corrected by applying the File Conversion Filter Stereo Reverse feature.
Q: Some of my vinyl records sound more distorted as the play moves towards the end of a side. Why is this? What can be done?
A: This distortion can be due to several sources. A poorly mastered lacquer could have been the culprit. Not all mastering engineers were careful to "hold down" the dynamic range as the recording progressed, creating a great deal of groove wall over-modulation. However, a more likely scenario is that the record was played with a worn stylus. Have someone who is familiar with styli check it out under a microscope to be sure that it is not worn out or damaged. If it checks out to be okay, then your vinyl recordings may have been damaged in past times as a result of being played many times with a defective stylus. One thing that can be done is to selectively apply a Low-pass filter to the last few cuts of the recording to reduce this annoying anomaly. Also consider applying the Filter Sweeper to compensate for this problem. Sometimes, the Continuous Noise Filter (CNF) operating in “Artifact Suppression” mode can reduce some inter-modulation types of distortion.
Q: How do I generate a simulated stereo Wave file from a monophonic Wave file?
A: Start with a monophonic file that has been de-noised, and convert it to stereo using the File Conversion Filters. Some stereo effect may be added here by applying a little "Time Offset" during this process. Next, make the destination the source, to get a new source file. Run the Reverb effect with a Small or Medium hall, setting the decay to a low number and the early reflections level nearly to zero.
Q: Does the order in which I process noise out of a Wave file matter?
A: Yes. Always remove impulsive type noises like clicks and pops with the Impulse Noise filter before de-hissing a recording using either the Continuous Noise filter or the Dynamic Noise filter. Never reduce the bandwidth of an audio signal before applying any of the Impulse Noise filter(s) (and this applies both in the analog side of your signal path as well as the digital side).
Q: I have an analog tape recording with clipping distortion due to over-modulation during the recording process. Is it possible to "soften" the clipping sound in order to reduce the harshness produced during the overloads?
A: Clipping distortion can usually be substantially reduced by applying the De-clipping filter. Analog de-clipping will require slope values greater than 0, however. The de-clipper is the preferred method for resolving this type of audio problem. However, clipping distortion can sometimes also be reduced by utilizing the Impulse Noise filter. If the clipping distortion occurs at the peaks of the waveform, set the tracking control set to its minimum value, and the threshold set to maximum. Highlight a segment of the recording that contains distorted and non-distorted material. In preview mode, adjust the Threshold control until the clipping distortion is reduced. In some cases, it may become necessary to run the Reverse NAB curve before following the above procedure. After the distortion has been reduced with the impulse filter, it will be necessary to run the NAB curve to re-correct the recordings equalization. These two curves can be found in the factory preset listing under the Paragraphic Equalizer filter. The reason for the above two steps is that the saturation overload occurs at the tape-to-tape head interface. The resultant overload is then phase shifted during playback by the NAB equalization circuit in the tape recorder. Utilizing the Reverse NAB curve places the clipping distortion closer to the peak of the waveform, where is actually occurred.
Q: I enjoy removing "clicks" and "thuds" manually from my recordings using the Interpolate feature. Sometimes these signals are so small that, although I can hear them, I can't see them in the waveform. What can I do to make them more visible?
A: In order to improve the view of these signals, first put the system in Sync mode which is found under the View menu. In order to see the "clicks" more clearly, run the High Pass filter with it set to 6 dB / Octave and 10 kHz on your .wav file. The "clicks" will now be more visible in the Destination window and they will be time aligned with the Source Window. Similarly, if you want to view "thuds", run the Low Pass filter with it set to 6 dB / Octave and 100 Hz on your .wav file. As with the clicks, the "thuds" will be more visible in the Destination Window.
Q: I’ve been using the product for extensive editing, it has always worked perfectly, but now I’m experiencing lockups and shutdowns. What’s the deal?
A: Obviously, these problems are not common with this product, but one area you may want to check is your Temp files. DCArt10/DC Forensics10 has a maximum Temp file limit of 999, so if you’ve been doing extensive editing in Fast Edit Mode, you may have hit that limit and need to clean those temps file out before it will work properly.
Q: How do I determine which version of Direct X that I am running on my system?
A: Go to the windows “Start” button and click on Run. In the “Open” field, type in “dxDiag” and then click OK. A lot of data will be presented, some of which includes the version of Direct X that you are using.
Q: The highlighted display and play cursor appear to be visually “jittery” when editing. How to I eliminate this visual effect?
A: You probably have a second instance of your Diamond Cut software open which is competing for resources. Close the second (minimized) instance and the “jitters” will be alleviated.
Q: Where do I find my exact User Name, Serial Number and Registration Code in an earlier version of my Diamond Cut Software so that I can perform an upgrade to a newer version?
A: These data are found under the “Help About Diamond Cut xxx ” (DC-Art menu item of your older software program.)
Q: What characters can legitimately be used in my product registration “User Name”? (Legitimate characters)
A: The following characters are legitimate for use in a User Name:
abcdefghijklmnopqrstuvwxyzABCDEFGHIJKLMNOPQRSTUVWX YZ 1234567890~-_.!*(),
Q: What are the minimum number of characters required for a legitimate User Name for registration of Diamond Cut Software Products?
A; 5 (five)
Q: Where is the printable form of the product documentation found in .pdf format?
A: Printable Documentation is found under the Diamond Cut Program grouping. The Forensics version is called DC Forensis10 Users Manual.pdf and the DCArt version is called DCArt10 Users Manual.pdf. For example, one pathway to the DCForensics10 documentation is as follows:
Go to the Windows Start button and click it.
Click on “All Programs”
Click on “Diamond Cut Audio”
Click on “Forensics10 Users Manual.pdf”
Q: Is the Diamond Cut Users Forum free and where can I find it?
A: The Diamond Cut Users Forum is free, but registration is required if you want to post questions. It is found at the following link:
http://www.diamondcut.com/vforum/
Q: Are educational and training programs provided for the use of Diamond Cut Software?
A: Yes. We have a line of DVD Videos for training at your leisure which can be purchased on our store at:
http://www.diamondcut.com/st3/product-category/videos/
We also offer three day training courses which are given throughout the USA which provides a certificate of course completion at the end of the program. Call us at 973-316-9111 to learn about the next one scheduled near you. Also, several colleges and universities include training in the use of Diamond Cut Forensics Software as part of their Forensics Science undergraduate programs.
Q: What are the various file paths used by the DC Forensics10 Software?
A: All of the user data is consolidated into a directory called DC Forensic10 in the users “Documents” or “My Documents” directory. The file paths under this directory are as follows:
DC Tunes database: \DCForensics10\DCTunDb.xml
Presets: \DCForensics10Presets
Example Wavefiles: \DCForensics10\Wavefiles
TempFiles: \DCForensics10\Tempfiles
To get to these Files, use the following paths:
For Vista and Windows 7 or Windows 8 or Windows 10
C:\Users\<user>\Documents\DCForensics10
C:\Users\<user>\MyDocuments\DCForensics10
Forensics version 10 also provides shortcuts which are located in the user’s program menu to access these files.
Note: For DCArt10 versions, just substitute DCArt10 where you see DCForensics10 in the path.
Reporting a Problem
Your software distributor has operators available during most days during normal business hours. They provide technical support for registered users only. When you contact the distributor from which you purchased your software, please be prepared to provide the following information:
Most distributors prefer email for an initial contact, in that it gives their technicians a chance to study the problem before they provide you with an answer, rather than experimentation while you’re waiting on the phone. Our distributors normally will have an answer for you within one business day. If you need to communicate with the factory directly, here is the contact information:
Contact and Support Information
Diamond Cut Productions, Inc.
P.O. Box 305
Hibernia, NJ
07842
support@diamondcut.com
Telephone: 973-316-9111 Fax: 973-316-5098
Section 5 – Useful General Information
Acoustical impedance is the total opposition provided by acoustical resistance and reactance to the flow of an alternating pressure applied to a system. More specifically, it is the complex quotient of the alternating pressure applied to a system by the resulting volume current. The unit of measurement is the Acoustical Ohm.
Acoustical reactance is the imaginary part of the acoustical impedance. Energy is not dissipated by acoustical reactance; it is only stored there. The unit of measurement is the Acoustical Ohm.
Acoustically mastered record recordings utilized only the energy of the sound waves created by the sound source to modulate the master cutting lathe stylus. This recording technique had none of the benefits which signal amplification can provide to the recording process. This is the method that was utilized from the time of the invention of the phonograph by Thomas Edison in 1876 up until around 1925, when vacuum tube amplifiers and microphones began to be employed in the mastering process. By 1929, all of the major record companies had switched over to the "electrical process" of record mastering.
Acoustical Resistance is the real term of the acoustical impedance relationship. This is the term responsible for the dissipation of energy. The unit of measurement is the Acoustical Ohm.
A device used to convert analog signals into digital (discrete time) signals, so that they can be signal processed by a computer algorithm. The sound card in your computer contains an A-D converter and also a D-A (Digital to Analog) converter. To be compatible with DCArt10/DC Forensics10, it must have at least 16-bit resolution to realize the performance of the product. However, the software does support 8 through 24 bit resolution sound cards. In other words, your sound card must be able to divide the amplitude of audio signals into numerically sampled representations, the smallest division being one part in 65,536 (2^16). 16 bit audio has the same resolution as "red book" CD Audio.
This is a slight variation of Mu-law compression, which is used in Europe. For more information, please refer to Mu-law Compression. DCArt10 & DC Forensics10 support this format.
(Adaptive Differential Pulse Code Modulation)
ADPCM is a data compression method in which an audio signal is quantized by the difference between the input reference signal and a prediction that has been made of that same signal. When the prediction between the actual and the predicted audio signal exhibits bits having a low variance, it is accurately quantized and fewer bits are required for digitization compared to standard PCM. Your software supports this file format.
The Audio Engineering Society
60 East 42nd Street, Room 2520
New York, NY
10165-2520
USA
1-212-661-8528 / http://www.aes.org
Automatic Gain (AGC) or Level Control (ALC). This is a set of algorithms, which can be found in the Dynamics Processor and Punch & Crunch effects that maintain the system gain at a relatively constant value independent of input signal level. Signals below a set threshold value are upwardly expanded while signals above that threshold are compressed. This is particularly useful in forensics applications wherein the various parties who are communicating with one another are recorded at greatly varying relative levels.
AIFF is the acronym for a PCM (Pulse Code Modulation) audio file format known as “Audio Interchange File Format”. It is used primarily on the Macintosh platform. DCArt10 and DC Forensics10 facilitates conversions from this format to .wav.
In sampled data systems, aliasing can occur on signals higher than the Nyquist frequency. These are not real representations of the source material. They could be looked at as parasitic signals or digital artifacts. For example, if an audio system is sampling data at 44.1 kHz, its Nyquist frequency is 22.05 kHz. If an audio signal exists at 23 kHz, an alias signal will be produced at the difference between those two (or 0.95 kHz). That 0.95 kHz signal would sound like a digital artifact to the listener (and be quite unpleasing). An anti-aliasing (brick wall) filter is usually applied to the signal before the A/D conversion process to avoid this problem. In the example above, the brick wall anti-aliasing filter would be set for around 22 kHz.
An algorithm is a step-by-step procedure for solving a mathematical problem.
(I)
The unit of electric current that is equal to one Coulomb of electric charge flowing per second.
I = V / R,
wherein:
V = Voltage in Volts,
and
R = Resistance in Ohms
(also, see Ohms Law.)
An amplifier is an electronic system which enables an input signal to control power from a source independent of the signal and thus be capable of delivering an output that bears some relationship to, and is generally greater than the input signal. An audio amplifier performs this function producing a relatively linear relationship between the input signal and the output signal. For more information on audio amplifiers, refer to Pre Amplifier and Power Amplifier in the Glossary section of the Help File.
Amplitude is the loudness (or intensity) of a sound at any given moment in time, which is represented on the vertical axis of the Diamond Cut time domain workspace areas. Amplitude in audio terms is usually expressed in relative terms (the ratio of two levels) in dB (decibels), although sometimes it may be represented in absolute terms such as Volts or SPL (Sound Pressure Level).
Amplitude-Frequency Distortion
Amplitude-Frequency distortion is a deviation from a perfectly flat frequency response over a range of interest (usually 20 Hz to 20 kHz).
Amplitude Modulation is a technique for producing a radio carrier containing an audio signal in which the envelope of the carrier is varied in amplitude in proportion to the level of the audio modulating signal. With Amplitude Modulation transmission, the rate at which the carrier amplitude changes is proportional to the audio modulation frequency. AM carriers are ideally fixed (constant) in frequency.
An electronic system in which signals are represented, amplified, and processed utilizing continuous Voltages and/or currents (whose value could be expressed as an irrational number at any point in time) which are not quantized. DCArt10/DC Forensics10 utilizes many digital simulations of analog systems within its algorithms.
Solvents that are made up of cyclic hydrocarbons or their derivatives such that, after they evaporate, tend to leave little or no residue on the surface on which they had been applied.
Attenuation is the process of signal reduction, which is the opposite of the process of signal amplification. Most filters attenuate signals outside of their pass-band and feed signals through with no attenuation (or amplification) within their pass-band. Some filters, such as parametric and graphic equalizers are configured to provide either amplification or attenuation at any given frequency. Devices such as volume control potentiometers, "L" Pads, "T" Pads and "H" Pads are used to attenuate signals independent of frequency, i.e. flat. "L" Pads hold either the input or the output impedance constant as the attenuation factor is modified. "T" Pads hold both the input and the output impedance constant as the attenuation factor is changed. "H" Pads perform the same function as "T" Pads, only for balanced line systems. See a table of resistance multipliers for a symmetrical (equal input and output impedance) “T” Pad attenuator in the Charts, Graphs and Other Useful Info section of this User’s Guide.
The range of frequencies between 20 Hz and 20 kHz. A very high quality audio system capable of reproducing this frequency range should be able to do so within +/- 3 dB.
When analog magnetic tapes are recorded or reproduced, the gap of the respective head (recording or playback) should ideally be perfectly normal (perpendicular) to the direction of the tape movement. If, in either
of the two mentioned processes, the respective head gap is off-normal (off-azimuth,) two types of signal degradation will occur. The first phenomenon results in the loss of the high-end of the audio spectrum frequency response. The second effect produces a phase shifting of one channel with respect to the other, thereby "smearing" the stereophonic image. A similar phenomenon occurs when a monophonic half-track reel-to-reel tape is reproduced on a quarter track machine. Azimuth problems can be corrected to some degree by utilizing the "Time Offset" feature found in the File Converter, which is found under the Filter Menu.
A Band-pass filter allows only a range of frequencies to be passed from its input to its output without attenuation. A wide Band-pass filter is one in which an upper and a lower corner frequency need to be defined, and often several octaves will be passed in between without attenuation. A narrow Band-pass filter is one in which only a center frequency needs to be defined, and often has a bandwidth of an octave or less. The center frequency for a narrow Band-pass filter is sometimes referred to as its resonant frequency. There are different Band-pass shapes that can also be defined for narrow Band-pass filters.
A Band-stop filter provides the inverse response of a Band-pass filter. You can find a Band-stop filter within the Brick Wall filter suite found under the Forensics menu of your software.
Emile Berliner is widely known as the one who commercialized the lateral cut disc record format. He first introduced his products into the market place in 1895, although he had spent the previous 10-year period developing his system. However, Emile Berliner was not the inventor of the disc format or the lateral cut method for creating the undulations on a surface. These principles were outlined in the earlier Edison phonograph patents.
"Blast" is a term that is used to describe a passage of sound on a recording which is disproportionately louder (and often distorted) compared to the rest of the recording. "Blasts" can be created by poor instrument placement on acoustic recordings, poor mixes on electrical recordings, or by poor planning of microphone placement in live recordings. The term "blast" was used by recording engineers at least as early as the 1920's.
Blue Amberols were the third (and final) generation of cylinder records which the Edison Company commercialized. They were about 4 minutes in length. These records were made of a celluloid recording surface mounted on a plaster of Paris core. They were an improvement on the Edison Gold Molded black wax cylinders, which were only two minutes in length. The rotational speed for Blue Amberols (and black wax cylinders) is 160 RPM.
Broadcast Wave (.wav) Format (BWF)
Broadcast Wave or BWF (.wav) is an audio file format that facilitates the inclusion of certain metadata within a .wav file header. It adds a “Broadcast Audio Extension” chunk to the basic Microsoft .wav format. It is a European standard per EBU document Tech 3285, version 1 (July 2001). BWF provides a seamless exchange of audio data between differing broadcast environments and equipment based on varying computer platforms. This format is supported by your Diamond Cut software program. You can create BWFs via the Save As feature found within the File Menu. You can edit the BWF header information via a dialog box within the Edit Menu. Complete information regarding this format is beyond the scope of this document and can be found on the internet.
Brown noise is a form of random noise exhibiting a Gausian distribution, which mimics Brownian motion. Its power spectrum is proportional to 1 / f^2, exhibiting a – 6dB / Octave slope. Your Diamond Cut software can produce Brown noise via two steps. First, create a random noise file using the Make Waves Generator. Then, bring up the LIVE/Multi-Filter and apply the preset called “White to Brown Noise Converter”.
A buffer is a memory sector that is used as a temporary storage location during input and output operations. The "preview buffer" length is programmable in DCArt10/DC Forensics10, and is found in the Preferences section of the Edit Menu.
A Butterworth Filter produces a maximally flat amplitude characteristic in the pass band or the reject band (depending on whether it is used as a Band-pass or a notch filter). Its characteristic also applies to higher order (2nd order or higher, IIR type) high-pass and low-pass filters. It produces a critically dampened response at their corner frequency(s), having no ripple, and therefore it introduces little distortion into the signal that is feeding it. The Butterworth filter’s poles of signal transmittance are uniformly spaced on a semicircle, having its center on the imaginary axis. Its half-power frequencies are those at which the circle intersects the imaginary axis. The low-pass, high-pass, and band-pass filters offer the Butterworth response as an option.
Buzz usually refers to a series of harmonic noise signals related to the frequency of the AC power mains. It differs from "Hum" in sound, because it usually contains a large number of higher frequency harmonics (created by phase controlled lighting dimmers or other non-linear systems connected to the power line). Buzz is best attenuated using the Harmonic Reject filter, the Spectral Filter or either the Expert Impulse or Narrow Crackle Filter(s).
An eight-bit word. Each sample of a monophonic .wav file is generally represented by two eight-bit bytes. Two eight-bit bytes are used to represent all of the integer numbers between 0 to 65,535 (actually +/- 32,768), which is the total dynamic range of DCArt10/DC Forensics10 when it is operating in 16-bit mode.
1 Kilobyte (or 1 Kbyte) = 1,024 bytes
(C)
Capacitance is the ratio of the electric charge given to a body compared to its resultant change of potential. It is usually expressed in Coulombs of charge per Volt of potential change and its basic unit is the Farad. Energy is only stored (but not dissipated) in theoretical (ideal) capacitance. Time constants for audio filters are created with a combination of resistors and capacitors in various configurations. High-pass, Low-pass, Band-pass, and Notch filters can all be created with the appropriate combinations of resistors, capacitors, and amplifiers (usually op-amps). The corner frequency for a simple first order RC filter = 1 / 2 pi* (R x C). The principle of capacitance (and conservation of charge) is involved in the operation of condenser and electret microphones and electrostatic loudspeakers and headphones.
F = (Farad) and F = micro Farad
F = 1 X 10 ^ -6 Farads
pF = 1 X 10 ^ -12 Farads
*Note: pi = 3.141592654 (approximately)
Cassette Tape Equalization Time Constants
Compact Cassette tapes (which operate at 1 7/8 ips) commonly utilize one of the following two equalization time constants based on the tape type:
1. Normal (IEC Type 1) (Usually Ferrous Oxide based): 120 Sec
2. High (IEC Type 2) (Usually Chromium Oxide based): 70 Sec
Cent
1,200 cents = 12 semitones = 1 Octave in the scale of “Just Intonation”. In other words, the interval between two tones whose basic frequency ratio is the twelve-hundredth root of two is the “cent”.
Power Cepstrum displays are a way of graphically representing speech patterns using a specialized transform of an audio signal. It is not a reversible transform. It produces a unique view of the information relating various frequency bands associated with a signal and is useful for separating vocal tract information from the exciting pitch in voiced speech. Mathematically, the Power Cepstrum of a Signal = |F{log(|F{f(t)|²)}|². You can create cepstrum graphs using your DC Forensics10 version of this software package. The feature is found under the Forensics Menu under the Voice ID feature.
A Complex Cepstrum is a reversible transform and can be useful for the graphic display of the vowel sounds produced by the human voice. It is also useful in identifying echoes created by acoustics in a room. Mathematically, the Complex Cepstrum = FT (log)|FT(f(t))|) + j2πm) where FT is the signals Fourier Transform and m is the integer value needed to unwrap the imaginary component of the complex log function. The horizontal axis is called the quefrency which is related to the rate of occurrence of a particular harmonic contained within the signal. This transform is implemented in the Voice ID feature found under the Forensics Menu of the DC Forensics Audio Laboratory version of this software.
Charge in units of Coulombs is the product of Voltage & Capacitance (Q = CV). Also, refer to “Ampere” for the time relationship of the Coulomb..
Compact discs are digital storage devices, typically 120 mm in diameter by 1.2 mm thick that are made of a polycarbonate compound. They can be used to store data, audio, video, and photographs. The active region of a compact disc begins at 46 mm from its center and runs to 117 mm. Reading of such discs is accomplished typically with an AlGaAs laser diode (producing light in the infrared region of 780 nM) in conjunction with a phototransistor sensor. There are a number of standards for data contained on Compact Discs. For a chart that describes these details, simply turn to our Charts, Graphs and Other Useful info pages.
A Chebyshev responding filter is one in which the pass-band produces a variation in attenuation between zero and its maximum value, and the band-stop requirement is only to increase monotonically to infinity. These filters display relatively steep roll-off characteristics, but, unlike the Butterworth filters, have ripple in their pass-band. Our IIR based Low-pass, High-pass, and Band-pass filters offer the Chebyshev response as an option.
A Chirp Z-Transform (CZT) is used in the Diamond Cut High Precision Spectrum Analyzer to produce a higher resolution and signal processing speed compared to the Standard Precision Spectrum Analyzer. It is essentially a more advanced FFT technique or algorithm used to numerically calculate the Z-Transform of a sequence of a defined and limited number of samples relying on the fact that the values of the Z-Transform lie on a circular or spiral contour.
Audio Amplifiers can be broken down into several classifications based on their devices degree of conduction relative to its input signal. The VVA Virtual Valve Amplifier utilizes two of the following classifications. The others are included in the description for completeness*:
Class A: The device or devices conduct for a full 360 degrees of the input signal. These amplifiers can be wired either in single-ended or push-pull configurations. Class A Audio amplifiers are usually used in pre-amplifier stages, or low power amplifier applications. This circuit has the poorest electrical efficiency, but produces predominantly even order distortion.
Class B: Two devices are operated out of phase with respect to one another. Each device conducts for only 180 degrees of the input signal. When the two amplified signals are combined, the full input waveform is represented, only amplified. This type of circuit is plagued by a phenomenon known as "crossover distortion" at low signal levels. This configuration is reserved for low performance PA amplifiers or AM (Amplitude Modulated) communications modulators. It is electrically efficient, but produces relatively large values of harmonic distortion especially at small signal levels.
Class AB: Two devices are operated out of phase with respect to one another, just the same as the Class B configuration. However, each device conducts for more than 180 degrees of input signal, but less than 360 degrees. This configuration produces a reasonable tradeoff between electrical efficiency and low distortion. This configuration is especially good at reducing crossover (notch) distortion (at zero crossing). It is commonly used in high power, high quality audio power amplifiers. Since the circuit is symmetrical, distortion levels can be quite low (especially even order products).
Class C: This configuration can consist of one or two devices which are conducting for anywhere between 90 to 180 degrees of the applied input signal. It is reserved for RF circuits only.
*Note: There are additional classifications of amplifiers involving tap switching, multiple rail, and pulse width modulation techniques, which have not been included in this listing.
Class D: Instead of operating power amplifier active devices in their linear range of operation, these same electronic devices can be used as state machines meaning that they are either on or off, and only in their linear region during transition (a parasitic state). Class D amplifiers operate in that manner, thereby minimizing power dissipation. The devices, which are acting as switches, are controlled by a pulse width modulator (PWM) and deliver power to the load via a Low-pass filter, which is used to attenuate the carrier or switching frequency. The rate of change of pulse width is proportional to the modulating audio frequency, while the magnitude of the change in pulse width is proportional to the modulating audio frequency amplitude.
Class G & H: These are “special case implementations” of classes A, B, and AB in which multiple power supply rails or variable rail voltages are used to minimize the power dissipation in the output devices while still allowing them to operate in their linear region.
Clipping is a phenomenon, which occurs when a signal (or numerical value) exceeds a system's headroom. This concept applies to both analog and digital systems. The result of clipping is distortion. The amount of distortion produced depends on the amplitude of the over-driven signal. In DCArt10/DC Forensics10, clipping will occur anytime a signal or calculation produces a numerical value greater than 2^16 (or 65,536 counts or LSB's) when using it in 16 bit mode of operation. Clipping can be observed as a flattening of the slope (horizontal line) of a signal at its peak on the Source or Destination workspace displays.
CMRR (Common Mode Rejection Ratio)
CMRR, or Common Mode Rejection Ratio, is the ability of a balanced audio transmission system to reject in-phase signals that appear on the two input lines. It is usually expressed in dBu. For example, a CMRR figure of –60dBu means that 1 / 1000th of a common mode signal presented to the transmission line is converted into a normal mode signal (which is the signal of interest).
A coaxial cable is one constructed in a manner in which the signal conductor is located within the center of the return conductor with a dielectric located in-between. This provides three notable characteristics for the cable:
Co-Axial cables are often used to carry low-level signals from one audio device to another because of the first two mentioned characteristics.
Codec is an acronym for Coder-Decoder and pertains to the process of data compression and decompression. Audio examples include such algorithms as the Mp3, A-Law, Mu-Law, and the ADPCM formats. Video examples of Codec’s are the various MPEG formats.
Columbia LP Equalization Curve
This equalization curve pre-dated the RIAA curve and was in use by the Columbia label and others in the early LP days of the 1950’s. Here are the key frequency inflection points for the early Columbia LP Curve:
This curve can be decoded with the Diamond Cut Virtual Pre Amplifier.
A comb filter (or Harmonic Reject filter) is a wave reject filter whose frequency rejection spectrum consists of a number of equi-spaced elements resembling the tines of a comb. This filter is useful for getting rid of "Buzz" type noise containing more than just the line frequency fundamental component. In DCArt10/DC Forensics10, it is called the Harmonic Reject Filter, and for more details, please refer to the same. The Spectral Filter found in the Forensics version of the software can also be used to create comb and inverse comb filters.
A compressor is an electronic device that is used to reduce the dynamic range of an audio signal. They are often used to prevent overloading on certain mixer inputs (i.e. drums and vocals) in live performance applications. Radio stations often use compressors to make their signal "sound louder" when a potential listener is tuning across the radio band. This technique avoids violation of any FCC regulations regarding maximum % modulation or modulation index, yet still raises the perceived loudness of the station.
The corner frequency of a filter is the frequency at which the signal has been attenuated by 3 dB relative to the pass band region of the filter.
Crackle is a term used to describe relatively low levels of impulse noise found on old phonograph recordings. It is very similar to impulse noise, only the peak amplitude is much smaller in comparison. Crackle sort of sounds like Rice Krispies just after you pour the milk into the dish. Crackle is usually caused by slight imperfections in the record-playing surface due to the use of coarse grain fillers in the record composition. Sometimes, crackle is caused by gas bubbles that occur in the surface as the record "cured" after the stamping process. Crackle can be filtered out most effectively with the EZ Impulse, Median, or Continuous Noise Filter. Very old acoustic recordings may be even more effectively de-Crackled (and de-Hissed at the same time) with the Average Filter.
Crest Factor is the ratio of the peak value to RMS value of a signal (acoustical or electrical) over a defined time interval. For a 50 % duty cycle steady state square wave, this value is 1.0000. For a non-distorted sine wave, this value is 2^-2 (or about 1.4142). For audio signals, crest factor varies greatly depending on the material and the integration interval over which it is calculated. Classical music, for example, generally exhibits much higher values of crest factor compared to contemporary pop music when measured over an entire performance.
Crosstalk is a figure of merit describing the degree to which one audio channel “bleeds” into another and expressed in dB. For example, a crosstalk figure of –60 dB indicates that the specified channel is affected by adjacent channels with an insertion ratio of 1000:1.
1/10 of a Bel. A Bel is the basic unit for the measurement of sound intensity. It is a log scale measurement system used for relating the ratio of two acoustical or electrical parameters. Since electrical Voltage, Current, and Power are used to represent sound through audio signals, the following mathematical relationships may be found to be useful when relating them in terms of outputs and inputs:
dB (Voltage) = 20 log V output / V input
dB (Current) = 20 log I output / I input
dB (Power) = 10 log P output / P input
Note: A doubling of a Voltage or Current represents a 6 dB change. A doubling of Power represents a 3 dB change. For a table detailing the relationship between Voltage, Current and Power ratios in Decibels, turn to our Charts, Graphs and Other Useful Info section of this User’s Guide.
dBm is the power level of a signal expressed in dB, and referenced to 1 milliWatt (0.001 Watt).
Since:
V = (P x Z) ^ ½
wherein:
V = Voltage in Volts
P = Power in Watts
and
Z = Impedance in Ohms
therefore:
In a 500 Ohm audio line distribution system,
V at 0 dBm = 0.707 Volts
Pro-level analog signals are often called out in terms of dBu and are at values of +4 dBu which is 1.228 Vrms or 3.47 Volts pk-pk (sine wave based).
dBv is the Voltage level of a signal expressed in dB, and referenced to 1 Volt rms sine wave. If a pure sine wave is the reference signal, its value would be 2.83 Volts peak to peak at 0 dBv. Most consumer audio equipment produces output levels of – 10 dBv (line level).
A D-A Converter is a device designed to convert digital signals back into analog signals so that they will be compatible with analog sound reproduction equipment. DCArt10/DC Forensics10 requires a D-A converter with 16-bit resolution (2^16 = 65,536 counts). It also supports sound cards capable of up to 24-bit resolution (2^24 = 16,777,216 counts) .
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A DC offset is a fixed value of Voltage that may have been added to a signal inadvertently. It contains no audio information. It is the “b” term in the general expression y = mx + b. It can be eliminated by feeding the signal through the DCArt10/DC Forensics10 high-pass filter set to 10 Hz and a slope of 6 dB/ Octave. The High Pass Filter includes a Preset to eliminate DC Offset from a file.
The reversal of a pre-emphasis process. See Pre-Emphasis for more information.
De-essing is the process of decreasing the sibilance of over-modulated "ess" sounds on recordings produced by the human voice. The DCArt10/DC Forensics10 dynamics processor contains an algorithm for De-essing a signal containing this particular anomaly.
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The trade name for the records in the disc format produced by the Edison Company was "Diamond Disc". These records were cut vertically (hill and dale) and could only be played on Edison Diamond Disc phonographs designed for this purpose. They rotate at a speed of 80 RPM. To extract the vertical component of a signal provided by a stereo cartridge when transferring Diamond Discs, use the DCArt10/DC Forensics10 Mono (L-R) File Conversion feature.
A De-Esser is a non-linear system designed to attenuate the overly sibilant pronunciation of the letter “s” which can occur on some recordings. A De-Esser can also be used to reduce other forms of harmonic distortion which may be present on a recording. The Diamond Cut De-Esser is found within the Dynamics Processor routine and is enabled via a checkbox.
A Differentiator is a device, system, or process which evaluates the rate of change of one parameter with respect to another. In its generic form, it is expressed as f”(x) = dy/dx. The reversal of the process of Differentiation is Integration. The Differentiator is found as one of the presets under the Diamond Cut IIR based High Pass Filter.
DIM (Dynamic Inter-modulation Distortion)
Refer to TIM
Distortion is a general term used to describe the undesirable effects that an audio system or process can have on the source input signal. There are many types of distortion, with some of them listed below:
In control loops, dither is the addition of a useful oscillation or noise signal into the system to overcome friction or hysteresis. This improves the response of the control loop to very small changes of the system reference signal. This principle has been extended to digital audio. In this case it implies the addition of a random noise signal inter-modulated with the LSB of the audio signal, effectively increasing the resolution of the system. Dither (with various options) is included in the File Sample Rate Conversion feature.
Double-Ended noise reduction involves encoding an audio signal when recording the same by some form of compression and reversing that process on playback. There are many different schemes for performing this function, and you can even create your own using the various algorithms contained within DCArt10/DC Forensics10. The Dynamics processor or the Dynamic Noise Filter can be used to create various encoding / and or decoding schemes. It is important to match the encoding and decoding corner frequencies, thresholds, attack and release times in order to achieve good Double-Ended noise reduction results. The rest is left up to the creativity of the user.
Drive refers to the amplitude of a signal that is applied to an amplification device such as an electron tube or transistor. It represents the ac component, rather than the dc (or quiescent) component applied to the input. Since the above-described devices are intrinsically non-linear with regard to their transfer function, the larger the value of drive applied to the device, the greater will be the harmonic by-products. The DCArt10/DC Forensics10 Virtual Valve Amplifier allows you to adjust the drive level to the various amplifiers to vary the degree of "tube warmth" produced by the system. The program automatically compensates the output level, so that large values of drive do not produce substantial changes in overall system gain.
"Dry" is the term used to describe the signal output of a special effects generator (such as the Reverb) which contains only the non-processed signal. "Wet," on the other hand, refers to the effect signal alone. Like most special effect generators, the Reverb has an output mix control which allows you to transfer a signal from the effects generator which ranges from completely dry, to completely wet (no source signal), or to some mixture in between.
DTMF (Dual Tone Multi Frequency)
(Also known as Touch Tone)
DTMF is the dual tone encoding system used on the telephone system for dialing. Two frequencies are allocated for each number on a telephone keypad. For a chart that contains the Touch Tone dual frequency pairs, simply turn to the Charts, Graphs and Other Useful Info section of this User’s Guide.
A filter in which its corner frequency is varied as a function of another parameter associated with the signal content of a sound source. Most often the corner frequency is that of a Low-pass filter that is modulated by the rectified output of a High-pass filter, although other schemes are possible. This sort of system changes bandwidth on the fly, and in co-ordination with the occurrence of high frequency content present in the source. It can be done either in a feedback or in a feed forward manner, with advantages and disadvantages attendant to each technique.
An electronic device used to modify the characteristic dynamic amplitude response of an audio signal. These circuits or algorithms can compress, expand, and de-ess (remove overly sibilant "esses") audio signals.
The dynamic range of an audio signal theoretically is the ratio of its smallest to its largest resolvable level or value. For a digital system, each bit represents a doubling of the signal so its dynamic range is simply its number of bits x 6 dB. In practice, with very high-resolution digital systems, other parameters may come into play such as the value of the systems noise floor, which may render some of the systems dynamic range unusable. For a table of common values of audio system resolution and their associated dynamic range, simple turn to our Charts, Graphs, and Other Useful Info section.
Your "ear" is the most critical piece of equipment that you will be using in the audio restoration process. It is important to realize that audio restoration is half science and half art. If you are only restoring audio for yourself, the audio restoration process is much less demanding as compared to situations where you may be performing the job for broad-based public consumption or for forensics purposes. In the latter cases, there are two very critical aspects of your "ear" which must be considered:
a. You must have a good sense of hearing. If you have a hearing deficiency, you may have a difficult time making the subjective judgments that are critical to the production of a commercially viable product, which will be acceptable to the "ear" of the general public. For example, if the "top-end" of your hearing is missing, it is more likely that you will produce restorations that seem harsh, hissy, and containing too many digital artifacts as far as the general public is concerned.
b. Even if you have an exceptional sense of hearing, you will need to develop a good "ear" for what the general public expects in terms of audio restoration. This requires good judgment, and a great deal of experience.
The standard hearing test evaluates your ability to hear pure tones between 250 Hz to 8000 Hz, at 8 discrete frequencies. If you are performing forensics audio work, it is advisable to have you hearing response evaluated/plotted by a professional audiologist routinely.
Thomas A. Edison was the inventor of the phonograph in 1877 at his laboratory in Menlo Park, New Jersey. Edison also invented the Carbon and the Condenser Microphone, and the "Edison Effect" which is the principle behind the early rectification and amplification devices that were used to develop the field of modern electronics.
“Electrical Recording” is the term given to a process which was commercialized around 1925 for mastering records in which microphones and electrical signal amplification was utilized to supply the energy required to modulate the cutting head stylus of the recording lathe. Prior to the invention of electrical recording, the acoustic energy of the various sound sources in the recording studio was the only source of energy that modulated the cutting head stylus. Electrical recording allowed more of the subtlety and detail of music to be captured on the wax master.
The predecessor to the modern transistor was the Electron Tube (also sometimes referred to as an electron "Valve"). Dr. Lee DeForest invented the device around 1906 and called it the “Audion”. He took a Fleming diode (a derivative of the Edison Effect light bulb - 1883), and installed a grid structure between its cathode and anode. He observed that small Voltage signals applied to the grid with respect to the cathode produced large changes in the devices plate current. This device became known as the "triode", having three active elements within it. Thus was born the key device that became the foundation building block for the development of modern electronics, as we know it today. Electron tubes are basically amplification devices, which can be used in a myriad of applications such as oscillators, mixers, detectors, etc. The Diamond Cut Virtual Valve Amplifier (VVA) uses the measured characteristics of real electron tube triodes and pentodes in various amplifier and rectifier circuit models to produce a versatile array of "tube-warmth" effects.
The shape of the tip of certain phonograph record playing styli is elliptical which improves the high frequency response as compared to standard conical styli.
The art of managing engines (Merriam-Webster).
The sampled peak amplitude values of a .wav file as displayed in the DCArt10/DC F9 workspace when zoomed-out.
An Expander is a device that performs the opposite function of a Compressor. These devices increase the dynamic range of an audio signal source. When the process of compression is used in the recording or transmission process, and the process of expansion is used in the playback or reception process, the technique is known as companding. It is sometimes employed because it increases the signal-to-noise ratio of the analog recording or transmission process.
FFRR (Full Frequency Range Recording)
This is the equalization curve used on records marketed by London (Decca) Records. It claimed a frequency response of 50 to 14,000 Hz as early as the mid 1930's. Details can be found under “Equalization Curves” in the Charts, Graphs and Other Info section of this User’s Guide.
First In First Out or FIFO is a term used to describe the data flow in one form of a digital buffer. The first data into a FIFO buffer is the first data to exit out the other end of the buffer.
FIR is a digital, non-recursive method for creating filters which can produce a phase linear response characteristic. FIR filters are always stable and are used in the Diamond Cut Forensics Brick-Wall filter suite.
Fletcher-Munson Loudness Contours
The Fletcher-Munson Contours are graphs developed in the 1930’s that identify the human perception of equal loudness as a function of frequency. Simply stated, the human ear provides the most perceptible flat response at very high loudness levels. At low loudness levels, the response falls off dramatically at the low end of the audio spectrum, and to a lesser degree, at its upper end. The curves indicate the region between 1,000 to 5,000 Hz are the flattest and most independent of loudness. The flattest region lies between around 600 to 1,500 Hz.
FLAC (Free Lossless Audio Codec)
FLAC is an audio file format that uses linear predictive coding techniques and provides lossless file compression. It reduces an audio file size roughly by 50%. FLAC is supported by Diamond Cut and is found under the File\Save As feature. Its file extension is .flac.
Flutter is a relatively rapid frequency modulation of the information on a recording due to rapid changes in the velocity of the record, tape, or the soundtrack of the source. Flutter is the rapid counterpart to Wow, occurring at a deviation rate in the range of 6 to 250 Hz. This distortion could have been introduced in the mastering process, or the playback process, or a combination of both. DCArt10/DC Forensics10 is not capable of correcting this sort of problem in a sound recording at this time.
Fractional speed mastering is the process of transferring a record at a slower speed to a new media, and then converting it to the proper speed at a later time. This has two potential benefits:
DCArt10/DC Forensics10 supports fractional speed mastering using the speed change filter. Presets will be found which accommodate various fractional speed-mastering situations.
Frequency Modulation is a technique for producing a radio carrier containing an audio signal in which the frequency of the carrier is varied in proportion to the amplitude level of the audio modulating signal. With Frequency Modulation transmission, the rate at which the carrier frequency changes is proportional to the audio modulation frequency. FM carriers are ideally constant in amplitude.
Frequency Response is the range of frequencies that a system will pass through without attenuation. The frequency response of audio equipment is generally specified with the upper and lower corner frequencies defined at the -3dB points. For most high performance audio system electronics, the frequency response will be at least as good as 20 Hz to 20 kHz +/-3dB. However, loudspeaker systems rarely are able to reproduce that same spectrum within the specified linearity band.
Spectral concentrations of acoustical energy found in human vocal patterns produce resonances referred to as formants which can be used in the field of voice identification. Formants having the lowest frequency are designated as F0 and the sequence proceeds in an ascending rank up to Fn (usually between F1 to F4 in total number aside from the fundamental, F0). Comparing the relative amplitudes of these formants between a known reference and unknown samples can help establish the probability of a voice print match. Your Diamond Cut Forensics Audio Laboratory Spectrogram in conjunction with the Voice ID function (Find Formants) can be useful for plotting formant trajectories. These data are exportable for use in other software programs (like Excel) which may be useful for statistical analysis purposes.
A Fourier transform is a set of mathematical relationships which allow complex waveforms to be resolved into a series of fundamental frequencies, plus a finite number of terms which describe the waveforms harmonics. Fourier transforms are said to allow signals in the time domain to be represented in the frequency domain. Certain mathematical manipulations are more easily performed in the frequency domain as compared to the time domain, and DCArt10/DC Forensics10 takes advantage of this characteristic. After the mathematical manipulations have been completed, the resultants are re-converted back into the time domain via Inverse Fourier Transforms in order to re-create the processed version of the original time domain waveforms. For example, this method is utilized in the Diamond Cut Continuous Noise Filter (CNF).
In the context of audio restoration, the term “full-duplex” refers to a sound card that is capable of performing input and output functions simultaneously. For example, an analog sound card that has full duplex capability will be able to take an analog signal and convert it into a digital signal, at the same time that it is converting a separate digital signal into an analog form. The Diamond Cut Live Feed-through mode requires a full-duplex card in order for it to operate.
Gain is the amplification effect of an electronic system that is often expressed in decibels (dB). For example, an amplifier that has a Voltage gain of 20 dB produces an output Voltage signal that is 10 times greater in amplitude compared to its input. Many special effects audio processors produce "unity" gain. This implies that its output Voltage will be equal to the input Voltage (X 1 gain). Unity gain allows many signal processors to be placed in cascade without concern that the last processor in the chain will become overloaded due to the amplification build-up through each previous processor in the chain.
In general:
Voltage Gain = Av = Vout / Vin
or -
Voltage Gain in dB = Av (dB) = 20 log Vout / Vin
Total System Gain in dB = Subsystem #1 Gain in dB + Subsystem #2 Gain in dB + Subsystem #N Gain in dB (when the subsystems are connected in a cascaded configuration).
Note: If the subsystem gains are not given in dB, (but given in multiplication factors) the total system gain is the product of the various subsystem gain values. For example, the total Gain = (Subsystem #1 Gain) X (Subsystem #2 Gain) X (Subsystem #N Gain).
The gain (A) of an electrical system can be given in terms of any of the following:
1. Voltage: (Av = Vout / Vin) --- (Voltage Gain in dB = 20 log Vout / Vin)
2. Current: (Ai = Iout / Iin) --- (Current Gain in dB = 20 log Iout / Iin)
3. Power: (Ap = Pout / Pin) --- (Power Gain in dB = 10 log Pout / Pin)
Each time an audio signal is transferred from one medium to another, it will suffer some degree of "generational loss." These losses include noise buildup, distortion, phase jitter, quantization errors, etc. In analog systems, generation loss is much more of a significant factor in signal degradation compared to that which will be found in digital systems. In practical terms, analog signal transfers should be minimized in audio restoration work. The best results are produced if the analog to digital conversion process is performed only once. Ideally, the only analog process would be the original A-D transfer. Once in the digital domain, all processing, including the final transfer to DAT or CD-R, can be performed by your computer and the DCArt10/DC Forensics10 program. The only future conversion back to the analog world would occur during the playback process of the CD or the DAT through your audio system.
A Graphic Equalizer is a signal processor in which the audio band is divided into smaller spectral bands (portions). Each spectral band can be adjusted in terms of either the gain or the attenuation of the frequencies that fall within that band. Most Graphic Equalizer are Octave based, and contain about 10 bands. However, some are 1 /3 Octave based and have about 30 bands. Octave based graphic equalizers (including the one contained within the DCArt10/DC Forensics10 application) typically break the audio spectrum down into bands with the following center frequency values:
31 Hz, 62 Hz, 125 Hz, 250 Hz, 500 Hz,
1 kHz, 2 kHz, 4 kHz, 8 kHz, 16 kHz
Your DCArt10 software program also includes 20, and 30 Band Graphic Equalizers. The DC Forensics version includes a 32,000 band EQ called the Spectral Filter.
A ground loop is a potentially detrimental conductive pathway formed when two or more points in an electronic system that are nominally at ground potential are connected by another conducting path. The term usually is employed when, by improper design or by accident, unwanted noisy signals are generated in the common return line of relatively low-level (audio) signal circuits by the return noise currents or by magnetic fields generated by relatively high-powered circuits or components.
A Harmonic Exciter is an electronic device or algorithm, which synthesizes odd and/or even harmonics of the upper end of the audio spectrum presented to it, and then re-inserts them back into the signal path. This device or system will "liven-up" olde recordings in which the upper musical registers are missing due to generational losses or lack of response to begin with. It can also be used to enhance vocals, or stringed instrument recordings. The Exciter is found under the Virtual Valve Amplifier (VVA) system located under the Effects Menu. It uses real models of Electron Tube rectifier and amplifier circuits to accomplish its synthesis.
Harmonics are the odd and even multiples of a fundamental frequency. In music, it is the distribution of these harmonics that provides the characteristic (or timbre) that gives each musical instrument or human voice a unique sound.
Harmonic Distortion results from the interaction of a non-linear transfer function of a system on a signal. The non-linearity of the system creates undesirable harmonic products (except in rock and roll) that modify the sound of the original signal. Devices like transistors, vacuum tubes, microphones, phonograph cartridges, loudspeakers, and A to D converters all have non-linearities to some degree. In some cases, feedback is used to correct for non-linearity and in other cases using the device only in a very limited portion of its total dynamic range is the method used for minimizing the production of harmonic distortion. For information on the measurement of this parameter, see THD (Total Harmonic Distortion) which can be measured using the Diamond Cut Spectrum Analyzer.
DCArt10/DC Forensics10 can produce signal distortion when one of the algorithms attempts to drive the system to full scale or beyond. It is therefore necessary to be careful when applying the Gain Change or the Graphic Equalizer algorithms, both of which can increase the gain of the system causing signals to exceed the programs dynamic range. The distortion produced as a by-product of this mechanism is called clipping.
Please refer to "Comb" or "Multiple Notch Filter.
A Helmholtz resonator is the most basic resonant system found commonly in musical instruments and consists of an enclosed volume of air and an opening (or aperture). It is the acoustical analogue to the electrical LC resonant tank circuit.
Hertz is a unit for the measurement of frequency. 1 Hertz = 1 cycle per second (CPS).
When two frequencies mix with one another through a non-linear system, sum and difference signals are produced. These signals are referred to as heterodynes and are also sometimes referred to as "beat frequencies". In 1918, Major Edwin Armstrong patented the use of heterodyning radio signals against a local oscillator into a single intermediate frequency (IF) to create greatly improved radio receivers. Also, early audio oscillators constructed before 1935 used the heterodyne technique for producing output signals in the audio range by "beating" two RF (radio frequency) oscillators against one another. They were referred to as Beat Frequency Oscillators (BFOs,) and were eventually replaced with a gain-stabilized form of the Wien Bridge oscillator. Spurious heterodyne signals are produced on the various AM radio bands due to adjacent channel interference. In the US, these signal are 10 kHz, and in Europe, they are 9 kHz. The DCArt10/DC Forensics10 notch filter can be used to remove them.
See Vertical Cut
A filter that attenuates all frequencies that fall below its corner frequency. The degree of attenuation of a signal outside of the filters pass band depends on the frequency of interest, and the corner frequency and slope (order) of the High-pass-filter. This type of filter is often used to reduce rumble, muddy bass and wind noise on a recording.
Hiss is random noise located at the top end of the audio frequency spectrum. Generally this is considered to be the random noise that is heard above 5 kHz. A good example of "hiss" is the sound you will hear if you tune a FM tuner to the top or bottom end of the band where there are no stations transmitting with the "mute" button disabled. (This is a form of limited bandwidth "white noise".)
Hum is noise introduced into a recording or sound system that is harmonically related to the power line frequency. In the US, this will be 60 Hz and in Europe, this will be 50 Hz., and in both cases, it will include harmonics of the line frequency. The most common "hum" frequencies are the fundamental (usually due to ground loops) and /or its second harmonic (due to defective power supply filter capacitors in electronic equipment). To attenuate Hum on a recording, use the DCArt10/DC Forensics10 Notch filter set to either 50 or 60 Hz, depending on the hum frequency. Start with a bandwidth setting of around 0.2 Octave. Adjust the bandwidth to the minimum value required to effectively attenuate the Hum. This will minimize the Notch filters effect on all other frequencies. Hum on cockpit voice recordings will be at 400 Hz (and harmonics thereof).
See “Voice Frequency Range”
IIR is the acronym for “Infinite Impulse Response” which is a form of recursive filter. It employs, in the simplest example, a simulation of at least one resistor and one capacitor in a circuit, which are represented by a pair of recursive equations. The types of filters employing IIR techniques in the “Filter” menu are such functions as the Low-pass, High-pass, Band-pass, Notch, and Slot filters as well as the Graphic and Paragraphic Equalizers.
(Z)
Impedance is the total opposition, including resistance and reactance, which a circuit element(s) offers to the flow of an alternating current, measured in Ohms.
Z = ((R^2) + (Xc^2) + (Xl^2)) ^ ½
Wherein:
Z = Impedance in Ohms
R = Resistance in Ohms
Xc = Capacitive Reactance in Ohms
Xl = Inductive Reactance in Ohms
Some standard Input and Output Impedance values that you will encounter are as follows:
Mathematically, an impulse function is an event of infinite amplitude, and infinitesimal time duration. In DCArt10/DC Forensics10 terms, an impulse is a transient that begins and ends within somewhere between 50 S to 1 mS, with amplitudes which are generally higher than the average program material in a .wav file.
(L)
The inductance of a circuit component (most often a coil) is the rate of increase in magnetic linkage with an increase of current. The unit of measurement of inductance is the Henry which corresponds to a rate of linkage increase of 10 ^ 8 Maxwell-turns or one Weber-turn per Ampere of current. Energy is stored (but not dissipated) in theoretically ideal inductors. The principle of inductance is a strong element in the operation of electronic transducers such as loudspeakers, magnetic phono cartridges, dynamic microphones, and transformers. Resonant circuits can be created utilizing a combination of capacitors and inductors. The basic resonant frequency of such a circuit is given by Fr = 1 / 2 pi (L x C) ^1/2. This principle can be used to create narrow Band-pass and notch filters.
The unit of measurement of inductance = H (Henry)
Note: pi = 3.141592654 (approximately)
This is where the initialization constants, factory presets, and user presets were stored by the software the earliest versions of the software. Because of the 64 Kbytes total .ini file length limitation; a special presets directory is presently used for this function allowing a much larger number of total presets. The old .ini file extension used to be found in the Windows directory. DCArt10/DC Forensics10 uses the system registry for all other settings storage.
Instantaneous Sound Recordings
Instantaneous sound recordings are ones in which playback can immediately follow the recording process. The first sound recording made by Edison was “Instantaneous”. The following is a brief history of this form of recording technology:
An Integrator is a device, system or process which evaluates the area under a curve of one function vs. another. It is the inverse process of Differentiation (also refer to “Differentiator”). The Diamond Cut Integrator is found as one of the presets under the Low Pass Filter.
Inter-modulation distortion is a very specific type of distortion that results from the amplitude modulating effect which one frequency has on another in a non-linear system. This form of amplitude modulation results when one frequency appears as the “carrier” and the other as the “modulating” signal. Since IM distortion is due to non-linearity’s in the transfer function of a system creating an AM effect, this results in the production of frequency components that are equal to the sums and differences of integral multiples of the components of the original complex wave. A two-tone test source is used to measure this parameter, typically consisting of (approximately) a 60 Hz test signal added to a 7,000 Hz test signal feeding the device or system under test. The low frequency signal is applied to the system being tested with an amplitude value much higher than the upper test frequency, typically by a factor of four or more to one. Using 60 and 7000 Hz test signals as an example, vestiges are measured at 6,940 and 7,060 Hz and divided by the value of the 7,000 Hz fundamental in order to determine the level of Inter-modulation Distortion.
The property by which matter that is at rest will tend to remain at rest, and matter that is in motion will tend to remain in motion (in the absence of friction).
Input / Output refers to the ports into which electronic signals are fed to an electronic device and the ports from which electronic signals are derived from an electronic device. DCArt10/DC Forensics10 allows you to choose between several I/O ports, provided you have the sound cards to support the feature.
The linear velocity of magnetic tape moving past a recording or playback head is referred to in terms of its IPS (inches per second) value. For a table of common tape deck speeds, please refer to our Charts, Graphs and Other Useful Info page.
The unit used in the measurement of frequency equal to 1000 Hertz. In earlier times, this term was Kilocycles (per second).
The unit used in the measurement of electrical resistance equal to 1000 Ohms.
Latency is the delay time encountered when operating in Preview mode or in "Live" feed-through mode. Maximizing the speed of your computer system minimizes latency.
A record recording technique in which the groove modulation (undulations) occurs in a side-to-side direction, as opposed to up and down. This technique was popularized by Emile Berliner with his “Victrola” phonograph.
Starting a program. This is accomplished by double clicking on the appropriate program Icon (usually found on your desktop).
The smallest quantified increment which an Analog to Digital or Digital to Analog Converter can resolve an analog Voltage or current. (LSB's are sometimes referred to as "counts.) In DCArt10/DC Forensics10, this value is 1 part in 65,536 (or 1 part in + / - 32,768), for 16 bit system applications. For 24 bit system applications, this value increases to 1 part in 16,777,216 (or 1 part in + / - 8,388,608). For other sampling depths (values of resolution) use the formulae:
+ / - LSB's = (2^(SD)) / 2
wherein SD = Sample Depth (or resolution) in bits
A Limiter is an electronic circuit or system consisting of non-linear elements that will not allow signals above a certain threshold value to pass through to its output. An upward compressor will produce this effect when its ratio is set to a high value. The Dynamics Processor can be used as a signal limiter when used in compressor mode when high values of "ratio" are selected. It also includes “Limiter” presets to make setup easier for the user.
A Line Level analog signal is one that develops -10 dBv nominally without clipping and is usually associated with consumer grade audio equipment input and output ports. This translates into 0.316 Vrms or 0.894 Volts pk-pk (based on a sine wave). They are usually unbalanced (often using RCA type interconnections).
Note – Pro-level analog signals are often called out in terms of dBu and are at values of +4 dBu which is 1.228 Vrms or 3.47 Volts pk-pk (based on a sine wave). They are usually balanced (XLR or TRS type interconnections).
When two sine waves are displayed on an X-Y display, with one applied to the X-axis and the other to the Y-axis, the interacting vectors of the two waveforms are displayed. These waveforms are referred to as Lissajous figures. Signals having the same frequency but of differing phase (other than 180 degrees) will form elliptical patterns, the phase of which can be calculated from the intercepts of the waveform with the display axis. This technique if often used to adjust the azimuth of tape recorder recording and playback heads. A properly aligned tape head will produce no ellipse, but only a 45-degree line with a positive slope. This can be somewhat compensated for using the Time Offset feature found in the File Conversions Filter in conjunction with the X-Y plotter found under the View menu.
The loudness of a sound is the perceived magnitude due to the auditory sensation produced by an acoustic signal. It is a function of frequency and signal amplitude. A 50 Hz tone requires sound field intensity 250,000 times larger than a tone at a reference of 1,000 Hz to achieve the minimal level of perception. The unit of measurement for loudness is the Sone. See Sone for more details.
A Low-pass Filter is one that attenuates all frequencies that fall above its corner frequency. The degree of attenuation of a signal outside of the filters pass-band depends on the frequency of interest, the corner frequency, and slope (order) of the low-pass filter. This type of filter is often used to reduce the hiss on a recording. However, low-pass filters will also attenuate the "highs" on a recording at the same time, which make them generally undesirable for this application.
A magnetic phono cartridge is a device for converting the mechanical motion of a record stylus into electrical signals utilizing the properties of magnetic circuits. There are three types of magnetic phono cartridges. They are:
1. Variable Reluctance (early magnetic cartridges)
2. Moving Magnet (the most commonly used)
3. Moving Coil (quite expensive and having costly stylus replacement)*
* The output impedance of moving coil (MC) cartridges are in the 10 to 100 Ohm range. Therefore, they require special matching transformers or pre-pre-amplifiers in order to be able to drive a conventional magnetic cartridge input on an audio pre-amplifier.
One million Bytes. (Sometimes 1024 kBytes for disks)
The median value of a series of numbers is the number that resides in the center of the sorted string. For example, in the series of numbers 2, 4, 7, 3, 8, 0, 7, 1, 9, the median value is 4. (Sort = 0,1,2,3, 4 ,7,7,8,9)
The unit used in the measurement of time equal to 1/1000 of a second.
The unit used in the measurement of distance equal to 1/1000 of an inch. The diameter of phonograph styli are generally specified in "mils". (If the stylus is elliptical in shape, the larger of the two dimensions is generally given.)
An electronic process in which one source modifies the characteristics of another signal source. For example, an audio signal may be used to Amplitude, Frequency, or Phase Modulate a sine wave signal (called a carrier). The result would be an Amplitude Modulated carrier in the first case (AM). In the second case, the result would be a Frequency Modulated carrier (FM). In the last case, the result would be a Phase Modulation (PM) carrier. These are techniques used for transmitting radio, television, and data. Sometimes, in audio, one refers to the undulations on a record as record groove "modulation".
An audio signal or a .wav file that contains only one unique channel of aural information is sometimes referred to as being monophonic.
The small signal amplification factor that a device exhibits in a circuit, often associated with Electron Tubes (and Field Effect Transistors or FETs).
Voltage Amplification = μ x Rl / (Rl + Rp)
Where u = Tube Amplification Factor
Rl = Plate Load Resistance in Ohms
Rp = Plate Resistance in Ohms
This is a form of data compression primarily used in telephonic applications. It takes advantage of the logarithmic nature of the sense of human hearing to accomplish its task effectively. It compresses a 16-bit signal into 8 bits using logarithmic signal mapping, producing a 2:1 compression ratio while maintaining 13 bits of dynamic range. The bottom 3 LBS’s of precision are dropped. Typically, this is used in 8 kHz Monophonic formats. DCArt10 supports this format.
Multi-path distortion is a phenomenon that can occur during FM broadcast reception. It occurs when the receiving antennae picks up two (or more) signals from the same transmitter. This dual pickup consists of the direct signal from the transmitter (usually a line of sight trajectory) and a second parasitic signal arriving at the antenna some time later. The second signal is a reflected signal off of a mountain, building or other object, and arrives at the antennae sometime after the main signal had arrived. The time shift between the main signal and the reflected signal creates phase distortion of the de-modulated audio signal when these two signal mix together. This phase distortion manifests itself in the last two octaves of the audio spectrum and sounds like "slurring" of the pronunciation of the letter "s" and general harshness. It will sound worse on a stereo broadcast than on a monophonic one. There are several cures for this problem. Purchase a directional antennae (one with a high front to back ratio) and install it as high as possible, aiming it towards the transmitter of interest. Secondarily, you can minimize the problem by switching over to monophonic during a particularly distorted broadcast. And lastly, when all else fails, you can reduce the distortion by utilizing the "de-esser" found in the Dynamics Processor or apply one of the appropriate presets found in the Diamond Cut Channel Blender effect.
This is the term used in the DCArt10/DC Forensics10 program used to describe a comb filter. A comb filter is a wave reject filter whose frequency rejection spectrum consists of a number of equidistant elements resembling the tines of a comb. This filter is useful for getting rid of "Hum" type noise containing more than just the line frequency fundamental component. This type of noise is line frequency related noise and sometimes described as "Buzz." This results from the interaction of non-linear systems with the finite output impedance presented by the power line sine wave Voltage waveform, adding harmonics to the same. Buzz can also be introduced into and audio system through non-sinusoidal current waveforms producing "H" fields which couple into noise sensitive loop areas (or ground loops) in audio systems. The Diamond Cut Harmonic reject filter is one example of a Multiple Notch filter.
There are two relatively common musical scales. They are the “Scale of Just Intonation”, and the “Scale of Equal Temperament”. The Scale of Just Intonation requires at least 30 discrete frequencies for each octave, making it relatively impractical to build musical instruments with fixed tones to play in the Just Scale. Therefore, the scale of Equal Temperament containing only 12 notes per octave is the one in general use.
For a chart which displays the frequencies of four octaves of the tempered scale, simply turn to our Charts, Graphs, and Other Useful Info section.
(National Association of Broadcasters)
The NAB Curve is a set of equalization frequency response contours, which are used by manufacturers of analog tape recorders to compensate for the inductive nature of a tape head. The equalization time constants specified depend on tape speed. One pair of time constants are specified for 1 7/8 ips (inches per second) and 3 3/4 ips. Another pair of time constants are specified for 7 1/2 ips and 15 ips. The low frequency breakpoint for all speeds is 50 Hz. The high frequency breakpoint for 1 7/8 and 3 3/4 ips is specified as 1770 Hz. The high frequency breakpoint for 7 1/2 and 15 ips is specified as 3180 Hz. These curves can be found as presets within the Diamond Cut Paragraphic Equalizer. Additional curves can be found on the presets sharing section of the Diamond Cut User’s forum.
Nepers are units of ratios of measurement like the dB, except using base e (~2.71828183) rather than base 10. For details, please refer to “dB” in this glossary. To convert between Nepers and dB, use the following relationships:
1 Np = dB x 0.115129255
or
1 dB = Np x 8.685889638
Noise are unwanted disturbances superimposed upon a useful signal that tends to obscure its information content. Also, refer to Signal-to-Noise ratio for more information.
A noise gate is an electronic device, which turns off a signal path when an input signal is below a predetermined threshold value. The Dynamics Processor produces a noise gate effect when you check the Expander/Gate function. You must set the ratio to the highest number for the best noise gate effect.
Notch Distortion (crossover distortion)
A discontinuity in a signal waveform sometimes produced by power amplifiers is referred to as “Notch Distortion”. It is always found in class B Amplifiers and sometimes found in inadequately biased class AB Amplifiers. It is usually associated with audio power amplifiers. High levels of “Notch” distortion results in a raspy sound at low signal output levels.
A notch filter is one which attenuates all frequencies close to the center frequency of the filter setting. The degree of attenuation and the range of frequencies which are attenuated by this filter are determined by the filters Q or bandwidth. This type of filter is often used to minimize hum or acoustic feedback from a recording. This type of filter is sometimes referred to as a "band reject filter."
An octave is a group of eight musical notes and also a doubling of frequency. For example, the range of frequencies from 440 Hz to 880 Hz is 1 octave. The next octave will end at 1,760 Hz. Note that in two octaves, the frequency has increased by a factor of four.
A fixed or DC value of Voltage or current added into a circuit to shift the quiescent operating point of a device or display. Offset is used in DCArt10/DC Forensics10 to allow small features to be seen in a signal when the detail exists towards the top or bottom of the signal workspace display area. DC offset can be removed from a .wav file by applying the high pass filter set to 10 Hz, Butterworth response, and 6 dB/octave.
(R) (or the Greek Letter Omega)
The Ohm is a unit of electrical resistance in which a potential difference in a circuit of 1 Volt produces a current flow of 1 Ampere.
V = I x R
wherein:
V = Voltage in Volts,
I = current in Amperes,
R = resistance (in Ohms)
When an audio signal is applied to an audio device, which is greater than the device can handle in a linear transfer manner, this creates a condition of "over-modulation". It results in a distorted sound in the output of the device being over modulated. Sometimes, this condition is referred to as "clipping," meaning that the amplification devices of an electronic system are either cutting-off or saturating due to overdrive.
Overtones are multiples of a fundamental frequency. The Diamond Cut Overtone Synthesizer is capable of creating signals of this type (even multiples) at the upper end of the audio spectrum (above 6000 Hz). The Virtual Valve Amplifier (and its Exciter) are also capable of creating overtones (odds and evens) referenced to various fundamental frequencies.
This is a Diamond Cut invention in which a parametric equalizer is coupled to a graphic display of its transfer characteristic. It yields the best of both worlds produced by a graphic EQ and a parametric EQ.
A variable electronic filter in which the following three parameters may be adjusted on each parametric channel:
1. Frequency
2. Level (attenuation or amplification)
3. Bandwidth
Parametric equalizers are usually equipped with several parametric channels, which can all be used simultaneously or each one can be individually bypassed. DCArt10/DC Forensics10 includes a 10 band Paragraphic equalizer, which is a combination of a parametric and a graphic equalizer.
Pathé Freres Phonograph Company was a European based record and phonograph company, who utilized a somewhat unique groove modulation technique. Their method produced a vertical stylus displacement (like Edison Hill and Dale Diamond Discs and Cylinders) however; this was accomplished by a different mechanism. The groove on these recordings is "width" modulated, and so when a conical stylus interacts with these groove width modulations, a vertical displacement is thereby produced. If you are transferring a Pathé 78 rpm recording with a stereophonic pickup cartridge, you will need to use the DCArt10/DC Forensics10 Mono (L - R) file conversion algorithm.
A Pentode is an electron tube (or valve) containing five elements. They include a cathode, anode, control grid, screen grid and a suppressor grid (or beam deflector electrode which replaces the suppressor grid in beam power pentode configurations). They are most commonly used in audio power amplifiers, but are sometimes found in microphone pre-amplifiers. Typical beam power pentodes listed in ascending power levels include types 6BQ5/EL84, 6L6GC, 5881, 7591, KT-66, 6CA7/EL34, KT-88, and 6550. Some pentode tube types are available in the Diamond Cut Virtual Valve Amplifier (VVA).
(Sometimes referred to as P48)
High performance microphones (such as large diaphragm condenser types) require an external source of power to drive their internal circuitry. The Voltage of this power source is generally between 12 to 48 VDC (most commonly 48 VDC). The negative side of this power source is connected to pin 1 (the shield side) of a 3 pin XLR style connector. The positive side of this source is connected (via two ~ 6800 Ω resistors) to pins 2 and 3 on the connector with one resistor located in series with each leg at the source end.
Phase inversion is the phenomena that occurs when one of two signals has become 180 degrees phase shifted with respect to the other. This sometimes accidentally occurrs on vinyl stereo recordings because the input leads to one of the two cutting lathe driver heads became "swapped" in location. This can be corrected by using the File Converter, using the Left or Right Phase-Invert feature.
The Phon is a measurement of the perceived loudness of a sound which takes into account the non-flat frequency response of the human sense of hearing. The perceived loudness of a sound in Phons is equal to the sound intensity in dBs of an equally loud 1 kHz pure tone signal; 1 dB SPL @ 1 kHz = 1 Phon. Also, refer to the glossary topic “Fletcher-Munson Loudness Contours”.
Pi (π)
Pi (Greek Letter) is the symbol that relates the ratio of the circumference to the diameter of a circle.
π = C / D
wherein:
C = Circumference of a Circle
D = Diameter of a Circle
π =
3.1415926535897932384626433832795029
(approximately because it is an irrational {non-repeating} number.)
Pink Noise is random noise, which is characterized as containing equal energy per unit octave. When viewed on an octave based spectrum analyzer, it will produce a flat horizontal line on the display. Pink Noise is useful for characterizing the frequency response of electronic systems and for analyzing room acoustic transmittance and resonance. Pink noise can be created through a two-step process using DCArt10 or DC Forensics10. First, create white (random) noise with the Makes Waves generator function. Next, process the signal through the Multifilter using the factory preset labeled "White to Pink noise converter, 20 kHz." You can also convert Pink Noise to White Noise by applying the Multifilter preset called “Pink to White Noise Converter” to a Pink Noise File.
These are "peak files" (.pkf) which represent the .wav files for display purposes in the source and destination windows. They are a small subset of the .wav file consisting of one sample for every 200 .wav file samples. The data point selected is the peak value of the .wav file found within that 200 sample window. Each .wav file is stored with an attendant .pkf file that is created by the software at the time when the file is recorded or modified or when the "rebuild peak file" command is used.
Power is the time rate for the transfer of energy in any system. In other words, Power = Energy / time. In electrical terms, power is given in Watts and has the following relationships to Voltage, Current, and Resistance:
P = V x I (Cos θ)
wherein:
P = Power in Watts
V = Voltage in Volts
I = Current in Amperes
θ = the displacement phase angle between the Voltage and Current Waveforms (assuming that they are both sine waves)
also (for purely resistive situations),
P = (I ^ 2) R
and
P = (E ^2) / R
wherein:
R = Resistance in Ohms
(Power Amp)
A power amplifier is a device that provides power amplification of an audio signal. Generally, this is the device that is used to drive a loudspeaker, the cutting head of a record lathe, or an audio transmission line, and is the final stage of amplification in an audio system. Audio power amplifiers generally develop somewhere between 10 to 1000 Watts of output power, depending on make and model (although shake table audio amplifiers and AM radio transmitter modulators can be found which produce well over 50,000 Watts).
To minimize power loss in the transmission process, and to maximize the systems dampening factor, it is important to minimize Voltage drops across loudspeaker distribution cables. Poor dampening factor can produce an ill-defined bottom-end (bass). Long distances between your power amplifier and your speaker system will require larger diameter cables. To determine the correct cable for your application, refer to the Wire Table provided in the Charts, Graphs and Other Info section of this User’s Guide.
See “Cepstrum”
(Pre-amp)
A Preamplifier is a device that provides Voltage amplification of an audio signal. Sometimes these devices also include equalization networks and/or tone (bass, treble, loudness, etc.) controls. Pre-Amplifiers generally produce about 100 milliwatts of output power and require a power amplifier connected in cascade in order to be useful for driving loudspeakers.
Pre-emphasis is the intentional added amplification which is sometimes applied to the top end of the audio spectrum during a recording or radio transmission process in order to raise the signal level at high frequencies substantially above the noise (hiss) level of the system. This process is reversed during the reproduction process of the signal in order to recreate an overall flat frequency response. The result of this process is an improvement in the signal-to-noise ratio of the system. For example, the third specified time constant of 75 Sec associated with the RIAA equalization curve is pre-emphasis. Also, FM broadcast transmission utilizes a 75 Sec (or sometimes a 25 Sec) pre-emphasis to improve its signal-to-noise ratio. This process is reversed at your receiver (de-emphasis). The Paragraphic equalizer contains 75 Sec pre-emphasis and de-emphasis preset curves.
Most of the Diamond Cut filters and effects have a plethora of descriptive presets. Usually, the most efficient place to start when using a particular filter or effect would involve selecting one of the factory presets, and then tweaking the parameters to fine tune the system to your own personal taste. If you desire to keep a separate copy of your presets on external media, they can be found in the Diamond Cut directory under this pathways: * \DCForensics10Presets
Pure Tones (as related to Noise Laws)
A pure tone occurs when the noise level in any one Octave weighted frequency band exceeds those in an adjacent frequency band by 3 dB or more. The High Precision Analyzer found in the DC Forensics version has the characteristics needed to evaluate compliance with the various state and federal laws in this regard when used in conjunction with a calibrated / certified / NIST traceable microphone.
(Quality Factor of Resonant Systems)
Q is the ratio of the reactance of a system (or filter) to its resistance (or losses). Q determines the systems bandpass width. Higher “Q” values producing sharper (narrower and more selective) responses.
Q = Reactance (@ system resonance) / Resistance.
Quefrency is the unit of measure associated with the horizontal (X) axis of a complex ceptstum graph. The units are not frequency or time in the standard sense of those terms. Rather it is the ratio of the sample rate divided by the number of samples that a peak persists. For example, if a signal persists for 50 samples and is sampled at 48,000 samples per second system, its quefrency will be 48000 / 50 = 960 Hz.
The Quiescent Point (or operating point) of an amplification device like an electron tube or a transistor, refers to the bias established on its linear portion of the transfer function curve when the device is "at rest" (i.e. no signal input applied). For example, the Virtual Valve Amplifier allows you to adjust the Quiescent (operating) point of Class A amplifiers anywhere from near cutoff to near saturation.
RAM is a digital electronic device for storing binary information temporarily. RAM performance is generally characterized in terms of its size in Mbytes, and its access time in nanoseconds. Your computer will need a minimum of 2 GBytes of RAM to run the DCArt10/DC Forensics10 application correctly.
A system that can process a signal and output the signal at the same rate at which it is being fed into the system is said to be a real-time processor. The DCArt10/DC Forensics10 algorithms can process signals in real-time or faster provided your platform is a 500 MHz Intel Pentium or higher.
A Real Time Analyzer is a form of spectrum analyzer used for the analysis of audio signals. Unlike conventional spectrum analyzers, it does not use a single filter in a scanning mode to produce an Amplitude vs. Frequency display, which is a relatively slow process. Instead, it processes audio signals in parallel, so that all frequency bands are displayed simultaneously. Generally, RTA's have 31 bands (in 1 / 3 octave increments) covering the frequency spectrum from 20 Hz to 20 kHz. They usually come with a calibrated electret microphone and a built-in pink noise generator for making acoustical measurements. Your Diamond Cut Spectrum Analyzer has 1/3rd Octave-based RTA capability.
This is a process wherein an alternating current signal is converted into a direct current, amplitude modulated envelope representation of the source signal. Often, some smoothing is applied to this signal with a set of time constants referred to as "attack" and "release". This signal is used in such devices as dynamic filters, companders, compressors, expanders, spectral enhancers, etc. and is digitally simulated in some of the DCArt10/DC Forensics10 algorithms.
The residue of a filtered signal is the algebraic difference between the filter output and its signal input. DCArt10/DC Forensics10 allows you to hear the "residue" of two of its filters by enabling the "Keep Residue" function. Several filters that include this feature are the Continuous Noise Filter and the Harmonic Reject Filter. This feature has been included because in some cases, it may be useful as an aid to hear what you are filtering out of the signal source. This is particularly useful when adjusting the Harmonic Reject Filter when attempting to remove "Hum" or "Buzz" from a recording.
(R)
(Ohms) ()
A resistor is a basic electrical device that has electrical resistance, and is used to control the amount of current that flows in a circuit. The unit of measurement for a resistor is the Ohm.
R = E / I
wherein:
R = Resistance in Ohms
E = Voltage in Volts
and
I = Current in Amperes
Resonance occurs in a system in which two elements are operated in quadrature (each element operating at ¼ the signals period) to produce a minimization or maximization of said signal.
Fr = 1/2 π (L x C)^1/2
wherein:
Fr = Resonant Frequency in Hertz (Hz)
L = Inductance in Henries
C = Capacitance in Farads
Resolution is the minimum amplitude increment into which the A-D converter of a discrete time system can divide an analog signal. The resolution of DCArt10/DC Forensics10 is usually 16 bits, which is 1 part in 65,536. However, with the appropriate sound card, DCArt10/DC Forensics10 does support up to 24-bit I/O resolution. Resolution can also refer to the minimum "time slice" into which a sampled data system is divided or displayed.
DCArt10/DC Forensics10 is equipped with a family of reverse RIAA curves, allowing you to use a standard RIAA phonograph pre-amplifier to perform your mastering of old acoustical and 78-RPM recordings. A straight reverse RIAA curve is supplied for acoustical recordings, and a number of reverse RIAA curves with varying values of turnover frequency are supplied for electrically recorded 78s. These reverse curves can be found as several of the Paragraphic equalizer factory presets. An RIAA curve encoded recording can also be decoded using the Diamond Cut Virtual Phono Preamp.
The process whereby the acoustical reflections of a room or concert hall are reproduced artificially, with devices such as tapped delay lines working in conjunction with mixing and phase shifting devices or algorithms.
Equalization Curve (Record Industry Association of America)
The RIAA Curve is a non-linear frequency response contour which was utilized by some manufacturers of LP records after around 1950 and was made pretty much the industry standard by 1955. It’s purpose was to improve the S/N of the disc recordings. It specifies three R*C time constants to be used by playback pre-amplifiers in order to reverse the record cutter equalization. The three time constants and their corresponding breakpoint frequencies are as follows:
This curve can be de-coded using the Diamond Cut Virtual Phono Preamp if you are using a flat hardware preamplifier.
The RIAA / IEC equalization curve is defined in terms of the same time constants as the RIAA curve, with one additional time constant added of 7960 S. This provides 3 dB of attenuation at 20 Hz rolling off at -6 dB / Octave thereafter. Below is a listing of all of the time constants associated with the RIAA / IEC Equalization Curve:
1. 7960 S (20 Hz) (low
frequency roll-off)
2. 3180 S (50 Hz) (pull-out
frequency)
3. 318 S (500 Hz) (turnover
frequency)
DCArt10/DC Forensics10 implements the following six functions with the right mouse button:
Note: A pop-up menu will appear when using the right mouse button containing the above-mentioned items that you can select from when they are active. Items that are not active will be grayed out.
RMS is the square root of the average of the squared instantaneous values of a waveform taken over the waveforms time duration (sometimes referred to as the "effective" value or the "heating" effect value). In electrical terms, a.c. Voltages and Currents can be described in terms of their RMS value; in acoustical terms, sound pressure (acoustomotive force) can be described in terms of its RMS value.
In the record industry, roll-off usually refers to the amount of attenuation in dB @ 10 kHz which must be applied during record playback in order to achieve a flat response on the high end of the audio spectrum. It is a form of de-emphasis. For example, the roll-off for the RIAA curve is –13.7 dB and –12 dB for the AES curve.
For a Low-pass filter or for an equalization curve (such as the RIAA curve), the upper cutoff frequency is sometimes referred to as the Roll-off Frequency.
Some common record speeds are 33.33 RPM for LPs, 45 RPM for records with the same name, 78.26* RPM for most so called electrically recorded lateral 78s (like Victor), 78.8 RPM for Edison Lateral's, 80 RPM for Edison Diamond Discs, and 160 RPM for most Edison Cylinder recordings. Additional speeds such as 16.66 RPM will occasionally be encountered. A comprehensive listing of record speeds can be found in the Charts, Graphs, and Other Useful Info section of this User’s Guide.
Rumble is a low frequency noise signal, typically below 50 Hz, which is often found on records. This phenomenon can be caused by seismic effects during the mastering process or during playback. On low quality or worn turntables or cutting lathes, it can also be produced by irregularities in the main thrust-bearing race. To attenuate turntable rumble using DCArt10/DC Forensics10, use the High-pass Filter. Start with settings of 30 Hz and 18 dB / Octave (or steeper), and adjust the frequency upwards or downwards until you are satisfied with the results. Acoustical recordings will benefit from settings as high as 125 Hz, depending on the material.
The rate at which an analog signal is converted to discrete numbers by an A-D converter. For audio systems, sample rate is expressed in kHz. DCArt10/DC Forensics10 supports any number of standard sample rates including:
*If your sound card supports intermediate sampling rates, you can also enter the numeric value of any sample rate you desire, between 100 Hz (0.1 kHz) to 192 kHz for recording purposes.
In a sampled data system (like the environment in which your DCArt10/DC Forensics10 program is operating), sampling theorem tells us that regularly spaced sampling must occur at least at the Nyquist rate, which is twice the frequency of the highest frequency signal or noise component that is expected to be resolvable by the system (without aliases). In other words, in a system expected to exhibit a frequency response up to 20 kHz, the minimum sample rate will have to be 40 kHz. Because it is impossible to construct an ideal Low-pass filter, the sampling rate will have to be somewhat larger than 2X the desired maximum frequency response value. In practice, a 44.1 kHz sampling rate is generally used in 20 kHz frequency response audio applications (although sometimes 48 kHz and 96 kHz are also used).
Shielded cables are special cables which are designed to minimize stray noise fields (particularly E fields) from entering an audio system through the interconnection wiring from component to component due to extraneous sources. Most often shielded cables are of the co-axial type so that loop area is also minimized, resulting in a minimization of "H" field pickup. However, some systems use a balanced pair of shielded wires which further minimizes pickup, provided the appropriate terminating transformers or differential amplifiers & line drivers are used on each end of the cable.
Slewing-Induced Inter-modulation Distortion. This is similar to TIM. See TIM for details.
The ratio of signal-to-noise (Voltage, current, or acoustical sound pressure level) that is expressed in dB. Signal-to-Noise ratio in dB = 20 log (signal / noise).
SINAD (Signal, Noise And Distortion)
Essentially, SINAD is the reciprocal value of a THD measurement and is expressed in dB.
SINAD = 20 log(signal rms value + noise & distortion) / (rms value of noise & distortion)
Single-Ended Noise Reduction are the processes wherein noise is removed from an un-encoded audio signal. Algorithms like the Impulse, Continuous, Dynamic, Harmonic Reject, and Notch filters are examples of Single-Ended Noise Reduction tools.
Slew rate is the maximum dv / dt (and sometimes the maximum di / dt) that an audio system component can react to. Parasitic Miller capacitances in operational amplifiers are generally the cause of this parametric limitation (collector to base or drain to gate in the case of transistors). When an audio component is confronted by a signal exceeding its maximum slew rate capability, the system reverts to slew rate-limited mode of operation. During this time interval, all audio information is lost resulting in severe distortion of the applied input signal.
In the context of DCArt10/DC Forensics10 and audio filter terminology, slope is the linear rate of change of amplitude vs. frequency of a filter past its corner frequency. This is expressed in dB / Octave or dB / Decade. 6 dB / Octave = 20 dB / Decade, 12 dB / Octave = 40 dB / Decade, etc.
A slot filter is the compliment to the "notch" filter. It is a variable narrow Band-pass filter; capable of greater selectivity than a typical Band-pass filter. It is often used in Forensics work for isolating particular sounds like the ringing of a telephone on a recording in a crowded noisy bar situation, or anything similar. By allowing only a very narrow "slot" of frequencies through the system, one can observe the "slotted-band" with a much improved signal to noise ratio compared to the wideband signal. The DCArt10/DC Forensics10 slot filter can be found under the Notch filter and is activated by checking the appropriate box. Multiple slot filters can be run via the Multi-Filter. If the slots that are desired are harmonically related, you could use the Harmonic reject filter in "keep-residue" mode to produce up to 500 slots in one pass.
A Sone is a unit of measurement for sound loudness. A simple tone of a frequency of 1 kHz and at a level 40 decibels above a listener's threshold of perception represents a loudness of 1 Sone. A loudness of any sound which is judged by a listener to be “n” times greater than that of the 1 Sone tone is defined as “n” Sones.
Sound Level is a weighted sound pressure level obtained by the use of a metering system and any of three weighting standards as established in the American National Standard Specification for General Purpose Sound Level Meters. The reference pressure is 2 X 10 ^ -5 Newton per meter ^2. The two most common standards are the "A" and the "C" weighting factors. The "A" weighting characteristic responds mostly to frequencies in the area of the greatest sensitivity of the human ear in the 500 to 10,000 Hz range. The "C" weighting characteristic is nearly uniform over most of the audio spectrum. The 0 dB reference sound pressure level (SPL) for a sound level meter is 0.0002 microbars using a simple tone of 1000 Hz.
For a chart showing several common sound sources and their Acoustic Power and Sound Power levels (from 10 meters distance to the source), simply turn to the Charts, Graphs, and Other Useful Info section.
Sound Wave Velocity in air as a function of temperature is given by the following:
c = 33,100 (1 + 0.00366t)^1/2
wherein:
c = Sound Wave Velocity in air in centimeters per second
and
t = temperature in degrees centigrade
Therefore at 70 degrees C, sound will travel at 37,098.6 centimeters per second, or around 830 miles per hour.
Sound Wavelength
The Wavelength of a sound wave is given by the following equation:
λ = c / f
wherein:
λ (lambda) = wavelength in centimeters
and
c = Sound Wave Velocity
and
f = frequency in Hz (cycles per second)
S/PDIF (Sony / Philips Digital Interface Format) is a serial digital signal format used to connect digital audio devices together. It is a subset of the IEC 60958 (or AES/EBU) standard. It is electrically characterized as a coaxial system terminated with 75 Ohms on each end and typically using RCA (orange in color) or BNC connectors.
A filter which typically has a Band-pass only between the frequencies of 300 Hz to 3 kHz, and which is used to improve the basic intelligibility of speech. Often, this type of filter uses slopes of -12 dB / Octave. This characteristic can be replicated with the Diamond Cut IIR based Band-pass filter. An alternative speech filter that is sometimes useful is called the Steep Slope Speech filter. Its response is 250 Hz to 3.5 kHz with a slope of 18 dB / Octave.
See RPM
A Spectrogram is a system for presenting audio data in a graphical form and is a special case of a spectrum analyzer coupled to an oscilloscope. The horizontal (X) axis represents time, the vertical (Y) axis plots frequency and the gray scale brightness (or color) (Z axis) represents the signal intensity. Audio Spectrograms are used forensically for spectrographic voice recognition (sometimes referred to as voiceprints) and acoustical analysis applications. The software includes a Spectrogram feature, which is found under the Forensics menu.
Spectrum is band or range of frequencies as in the audio spectrum, the light spectrum, or the electromagnetic spectrum.
A spectrum analyzer is a device for analyzing and displaying the Amplitude versus Frequency characteristic of a portion of a spectrum. They fall into two general categories:
1. Swept Band-pass Filter (a serial process of analysis).
2. Real Time Analyzer (a parallel process of analysis).
An electronic device or system which is used to expand the dynamic range of the upper and/or the lower octaves of the audio frequency spectrum, leaving the mid-band portion of the spectrum unprocessed. This has the effect of increasing the "definition" of a recording without continuously amplifying hiss and rumble which may be present on the source material. It is a form of dynamic filter which uses the principle of "upward expansion" to improve dynamic range. The Diamond Cut Dynamic Noise Filter contains a Spectral Enhancer mode of operation, which can be enabled.
Spectral subtraction is a method for reducing the unwanted noises associated with a recording using the amplitude elements of the frequency domain information contained in a .wav file. A noise fingerprint is taken, and this frequency domain information is then subtracted from the rest of the file and then re-converted back to the time domain. This technique is primarily used in forensics audio applications, and can be found as one of the CNF Mode options in the Continuous Noise filter.
A stroboscope is a device which indicates the RPM speed of a turntable by creating an optical illusion of the slowing-down, freezing, or speeding-up of a pattern when illuminated by a pulsating light source operating at a known frequency. You can create your own stroboscope disc by dividing a circle evenly into black and white segments. Use the following formulae to calculate the number of segments required per 360 degrees (1 rotation of the disc) into which the disc must be marked:
60 Hz power systems: # of segments = 7,200 / RPM*
50 Hz power systems: # of segments = 6,000 / RPM*
For example, assume that you want to construct a strobe for use in the United States where the power system operates at 60 Hz in frequency. We want to design it "to freeze" at 78.2 RPM. 7,200 / 78.2 = 92.07.Round the number to 92 segments. Divide your circle into 92 evenly spaced segments, and voila, you have your strobe. Because of the rounding error, the strobe you constructed will be in error by 0.08 %. Your strobe will have to be used under a fluorescent or neon light connected to the power line in order to function. Incandescent lamps will not work because of the long thermal time constant of their filaments.
For a chart that will help you create your own strobe using common line frequencies and RPM values, go to our Charts, Graphs, and Other Useful Info section.
Note: DCArt10/DC Forensics10 provides two bitmaps that you can print and use as phonograph strobes covering the important speeds. These can be found in the Diamond Cut Directory at “Strobe50Hz.wmf” and “Strobe60Hz.wmf”.
Sub-harmonics are fractional multiples of a fundamental frequency. The Diamond Cut Sub-harmonic synthesizer is capable of creating certain signals of this nature in the bass end (below 75 Hz) of the audio spectrum.
A square wave is a signal consisting of a fundamental frequency and the sum of all of the odd harmonic components of that fundamental frequency on the spectrum up to an infinite number of harmonics. An ideal square wave contains approximately 43% Total Harmonic Distortion (THD).
Styli are the devices used to transmit the mechanical undulations of a phonograph recording to its pickup or reproducer. Early styli were made from cactus needles or steel. Later, Osmium (osmiridium), Sapphire and Diamond became the norm for phonographic styli use. A chart of styli (sizes and shapes) for various record types can be found under the Charts, Graphs, and Other Useful Info section of this User’s Manual.
A tape head is an electromagnetic device used in a tape recorder to apply and read magnetic signals onto (and from) magnetic tape media. It consists of a coil mounted on a magnetic structure having a “gap” where the tape comes in contact. The tape head gap width in conjunction with the magnetic particle size on the tape media determines the frequency response of the system. This process follows Faradays Law of electromagnetic induction:
Vhead = - N dø / dt
wherein
Vhead = Tape Head Voltage
N = Number of turns of wire on the tape head structure
dø / dt = The time derivative of magnetic flux
Since dø / dt is proportional to and increases with frequency, this tape head Voltage signal increases at a rate of 6 dB / Octave and must be compensated for to prevent tape saturation. The process to provide this compensation is called tape equalization.
The Tape head gap is the discontinuity in the magnetic pathway (or circuit) formed in the tape head structure which runs perpendicular the direction of the tape movement. Ideally, the playback head gap should be smaller than one half the Lambda (or wavelength as it relates to the speed of the tape) of the highest frequency signal to be recorded. The following is a listing of typical Tape Head Gaps by Tape Head type:
Playback Heads: 1 to 5 microns (micro-meters)
Recording Heads: 3 to 13 microns (micro-meters)
Erasure Heads: 25 to 150 microns (micro-meters)
See IPS
THD (Total Harmonic Distortion)
THD is a figure of merit as to how much non-linearity a system is imposing upon an audio conduit. The Spectrum Analyzer has the ability to measure the THD of an item under test when used in conjunction with either the Make Waves generator or an external hardware equivalent. %THD = Amplitude of the Harmonic Content of a signal / Amplitude of the Fundamental Component. When using hardware to make this measurement on very low distortion equipment, it is necessary to account for the Generator THD. Therefore, one must measure the test Generators THD at each test frequency as well as the System Measured THD (of the whole system). Then, one must apply the following equation:
Actual THD = (((System Measured THD)^2 – (Generator THD)^2))^1/2
THD + N (Total Harmonic Distortion plus Noise)
This is what is actually measured by most THD meters, including not only the harmonic distortion created by the device being tested, but its noise as well.
Any electrical conductor produces a random noise Voltage as long as it exists at a temperature above 0 degrees K and/or has an electrical resistance greater than zero Ohms. The following formulae can be used to calculate the Root Mean Square value of the thermal noise Voltage of a terminating or source resistance:
E = (4RkT x ∆f) ^1/2 or E = √(4RkT x ∆f)
Wherein:
R = Resistive Component in Ohms (Ω)
k = Boltzmann’s Constant = 1.38 x 10^-23
Joules / Kelvin (1 Joule = 1 Watt x Second)
T = Absolute or Thermodynamic
Temperature in degrees Kelvin
∆f = Bandwidth of the system in Hertz
(Hz)
E = Root Mean Square (RMS) Noise
Voltage
T (in degrees Kelvin) = Temperature in
Degrees C + 273.15
Example: Assume an audio mixer/microphone preamplifier is terminated with a 50K Ohm Resistance. It is operating at 40 degrees C internally, has a 60 dB Voltage Gain and exhibits a usable flat response from 20 Hz to 20 kHz. What is the RMS noise floor of the output of the mixer?
60 dB Voltage Gain = 1000 : 1 = 1000
Eout = (4RkT x ∆f) ^1/2 x 60 dB = ((4 x 50,000) x (1.38 x 10 –23) x (30 + 273.15) x (20,000 – 20)) ^1/2 x (1000)
Eout = 0.004 Volts RMS = 4.0 Millivolts RMS
It is important to note that this is the Noise Floor for the defined system and can’t be made to be any quieter than this number unless special techniques are employed. Cryogenic cooling techniques are sometimes used on first-stage amplification devices of specialized amplifiers to improve the noise performance of highly sensitive systems.
TIM (Transient Inter-modulation Distortion)
This is a form of distortion that occurs when a system enters into a “slew limit” mode of operation during a fast audio transient. The result is the loss of all sonic information during the “slew interval”. It is usually the result of poorly designed amplifiers having slow error amplifiers or insufficient high frequency current drive provided to power amplifier output transistors. This type of distortion is sometimes referred to as SID (slewing induced inter-modulation distortion) or DIM (Dynamic inter-modulation distortion).
Time constants are exponential amplitude vs. time functions, which are realized with resistors and capacitors, or resistors and inductors and are often called “Tau”..
Tau = R x C for Resistor/Capacitor circuits
or
Tau = L / R for Resistor/Inductor circuits
wherein:
Tau = time constant in seconds
R = resistance in Ohms
C = capacitance in Farads
and
L = inductance in Henries
The relationship between a simple first order filters corner frequency (Fc) and time constant is as follows:
Fc = 1 / (2 x pi x Tau)
Note that the higher the value of time constant, the lower the corner frequency created. Some common time constants found in audio applications are as follows:
25 Sec - Dolby based FM de-emphasis
70 Sec - Type 1 (Normal Bias) Cassette Tape Eq.
75 Sec - Standard FM Broadcast de-emphasis
120 Sec - Type 2 (High Bias) Cassette Tape Eq.
Additional audio time constants can be found under RIAA and NAB in this glossary.
This is the instantaneous rate of change of a parameter (such as Voltage, amplitude, or sound pressure level) with respect to time. (i.e. dV / dt, dP / dt, etc.)
Tremolo is the amplitude modulation of a musical note. For example, the tremolo control on a guitar amplifier modulates the gain of its signal by way of a low frequency sine wave oscillator in the 1 to 10 Hz range. A Tremolo effect can be observed easily using the Diamond Cut Spectrogram.
A transformer is an alternating current device used to impedance match transducers and electronic circuits to one another. Sometimes, these devices are used with a unity turns ratio to provide isolation from one circuit to another rather than to impedance match the two. Unity coupled transformers (1:1 turns ratio) are useful in audio applications when it is necessary to break a ground loop source of noise in a system.
A Triode is an electron tube (or valve) containing three elements. They consist of an anode, cathode, and a control grid. Small changes in grid Voltage produce large changes in values of current in the plate circuit (the ratio of delta plate current to delta grid Voltage is its gain in transconductance or mu.) They are most commonly used in audio pre-amplifier, and other low-level applications. Typical triodes found in audio applications include the 12AX7 and 6SL7 high mu (gain), and the 12AU7 and 6SN7 medium mu devices. All of the devices listed are "dual" (two in one envelope).
See Electron Tube and/or Valve
Turnover (frequency) is the frequency in a phonograph equalization curve below which the master was recorded with the cutting head operating in constant displacement mode rather than in constant velocity mode. This is used to limit the excursions of the cutting stylus so that bass notes do not cause the cutting stylus to break through to the adjoining groove wall. For a chart listing the most common Turnover Frequencies utilized by 78 RPM records, refer to our Charts, Graphs, and Other Useful Info section.
Valve is the British term for an electron tube. It arises out of the valve like effect that a grid has on the flow of electrons between the devices cathode and anode (or plate). Also, refer to Electron Tube.
Any physical quantity, like the displacement of a record stylus, whose specification involves both magnitude and direction and which obeys the parallelogram law of addition. The Diamond Cut X-Y display provides a visual indication of the Vector Quantity consisting of one audio channel plotted against the other.
(Also known as “Hill and Dale”)
A record recording technique in which the groove modulation (undulations) occur in an up-and-down direction as opposed to side-to-side. This technique was used by Thomas Edison in his original invention of the phonograph, and was maintained as the recording method used by his companies cylinders and Diamond Discs.
Vibrato is the frequency modulation of a musical note. It results in what is perceived as a pulsating change in timbre. A typical vocal embellishment of this type created by singers will occur at a rate of change in frequency occurring around 6 to 8 Hz. This effect can be observed via the Diamond Cut Spectrogram.
Voice Fundamental Frequency (F0)
The fundamental frequency of a human voice is sometimes referred to as formant F0. For adult females, that range runs from 165 to 255 Hz and for adult males the range runs from 85 to 180 Hz. Speech articulation uniqueness is the result of the ratio of formant frequencies F1 through F4.
Human Vocal ranges (relative to middle C = C4 = 262 Hz) can be broken down from lowest to highest as follows:
Bass: E2 to E4
Baritone: F2 to F4
Tenor: C3 to C5
Contralto: F3 to F5
Mezzo-Soprano: A3 to A5
Soprano: C4 to C6
The notes in these ranges can be created via presets found in the Make Waves Generator.
The fundamental component frequency range for mature adult, healthy human voices are as follows:
Female: 165 to 255 Hz (Harmonics up to 10 kHz)
Male: 85 to 155 Hz (Harmonics up to 8 kHz)
Volt
(V)
(Voltage)
The unit of measurement of electrical potential difference (or electromotive force) equal to the difference in potential which occurs in a conductor which is carrying 1 Ampere, and the power being dissipated in the conductor is 1 Watt, with the resistance of the conductor being 1 Ohm.
Vorbis is a lossy audio compression technique (codec) that is supported by your Diamond Cut software. It is especially useful in low bit rate audio applications (less than 128 kbit/sec). Its file extensions are .ogg and .oga.
VOX is an acronym for “Voice Operated Transmit” which is derived from the half-duplex two-way radio field. In DC terms, it applies to the automatic activation of the recording function when a signal is detected by the system. The VOX system also ceases recording after the signal vanishes for more than a user settable period of time.
(P)
(Power)
The Watt is a measurement unit of electrical power equal to the ability to do work at the rate of 1 Joule* per second.
P = V x I wherein P = power in Watts, V = Voltage in Volts, and I = current in Amperes.
*1 Joule = 1 Watt x Second
Wave (.wav) files are the primary and native PCM (Pulse Code Modulation) sound file format that DCArt10 & DCArt10/DC Forensics10 supports. This (.wav) is the standard Windows file format.
“Wet” describes the signal output of a special effects generator (such as the Reverb), which contains the modified (processed) signal. "Wet" refers to the effects signal alone. The non-processed signal from such a generator is referred to as "Dry". As with most special effect generators, the Reverb has an output mix control which allows you to transfer a signal from the effects generator, which ranges from completely dry to completely wet (no source signal), or to some mixture in between.
White Noise is random noise that is characterized as containing equal energy per unit frequency (Hertz). White Noise is sometimes referred to as Johnson, shot, or thermal noise. White noise derives its name from the analogous definition of white light. Audio white noise can be created using the Diamond Cut Make Waves function using the function by that same name. White Noise can be converted to Pink Noise with a Multifilter preset. Please refer to the Pink Noise section of this Glossary for more information..
Window weighting is a concept that pertains to systems, which involve fast Fourier transforms (FFT's). Signals, which are observed for finite intervals of time, may contain distorted spectral data in the transform due to the ringing of the Sin(f)/f spectral peaks of a rectangular window. This distortion is minimized by the use of a window-weighting function, which is applied before the DFT is performed. The window weighting functions used some of the FFT based DCArt10/DC Forensics10 algorithms is proprietary. The window weighting shapes in the frequency domain measurement tools are user selectable.
.wma File Format (Windows Media Audio)
Windows Media Audio format is Microsoft’s implementation of compressed audio files and uses the file extension .wma. You can create files of this type using the Diamond Cut “Save As” command found under the File Menu. Both lossy and lossless compression routines are available.
A slow periodic change in the pitch or low frequency flutter which may be present on phonograph, tape, or soundtrack recordings due to a non uniform velocity of the recording medium. Wow is generally a frequency modulating effect that occurs at a deviation rate between 0.5 to 6 Hz. The “Wow” could have been introduced in the recording process, the playback process, or a combination of both. Wow found on record recordings is usually caused by a non-concentric spindle hole. Wow found on tape recordings is generally caused by warped take-up or supply reels. DCArt10/DC Forensics10 is not capable of correcting audio problems of this nature at this point in time.
Wow and flutter is the combined FM effect of both mentioned parameters. The frequency spectrum in which this rate of frequency deviation is made is in the spectrum that exists between 0.5 to 250 Hz.
This is the horizontal axis of a graph. In DCArt10/DC Forensics10, it contains the time information for your .wav file that is divided up into ten equally spaced grids.
This is the vertical axis of a graph. In DCArt10/DC Forensics10, it contains the amplitude information for your .wav file that is divided up into four equally spaced grids.
This represents the gray scale intensity or chroma modulation level that you find in the spectrogram/spectrograph display.
Charts, Graphs and Other Info
Additional Technical Information
We’ve recently added a section to our web site with specific Application Notes making use of our products. These App Notes provide stimulating specific information on varied uses for this software. These currently include the following Application Notes:
AN1 - Using DC5 or DC Live/Forensics as an Audio Signal Generator
AN2 - Using DC5 or DC Live/Forensics to test your sound cards performance
AN3 - Using DC5 or DC Live/Forensics to Create 3 Audio Test CDs
AN4 - Using DC Live/Forensics: The Electric Network Frequency Analysis
AN5 - Audio Archival Recording
AN6 - Speaker Cable Power Loss Wire Chart
AN7 - Power Line Frequency by Country (hum)
AN8 - The New Way of recording LPs
AN9 – Land Line Telephone Interface Circuit
AN10 - Bringing Acoustic Recordings Back to Life
They are located at the following link:
http://www.diamondcut.com/st3/application-notes/
The Engineers at Diamond Cut Productions also maintain a very active BBS / Forum where users intermingle with the programmers and ask questions about the products. As of 3-2017, there are roughly 5,000 topics covered via 28,000 posts along with a search engine. You may find a visit here to be very informative. You can join for free, but you must register in order to create postings.
http://www.diamondcut.com/vforum/
A Presets Sharing Forum is available for your use at:
Download Demo’s and Patches can be found at the following site:
http://www.diamondcut.com/st3/support/
The Diamond Cut Productions, Inc Home Page URL is:
Hot Key Index
Here is a list of all known factory-based Hot Keys/Combos and their real world equivalent. These keyboard accelerators (sometimes just referred to as “Accelerators”) are listed below:
"1" Play selected area + 0.25 seconds on each side
"2" Play selected area + 0.5 seconds on each side
“3" Play selected area + 1 second on each side
"4" Play selected area + 2 seconds on each side
"A" Select displayed area (same as double click)
CONTROL+"A" Select entire file
CONTROL+"C" Copy selection to clipboard
"D" Select destination
CONTROL+ "E" Select/deselect the pencil (need to be zoomed in far enough to see waveform)
"I" INTERPOLATE Full File (Bi-Modal {BM})
"J" INTERPOLATE LEFT channel only {BM}
“SHIFT + I” INTEROPLATE LEFT channel only {BM}
"K" INTERPOLATE RIGHT channel only {BM}
CONTROL + “I” INTERPOLATE RIGHTchannel only {BM}
“O” INTERPOLATE (Time Domain Mode)
"L" PLAY LOOPED
"M" DROP MARKER
CONTROL+"M" MUTE
"N" GO TO NEXT MARKER
CONTROL+"N" NEW File,
SHIFT+"N" GO TO PREVIOUS MARKER
CONTROL+"O" OPEN File
"P" Open PREFERENCES
Plus Sign (+) Zoom In X2
Minus Sign (-) Zoom Out X2
CONTROL+"P" PRINT
“Q” Activates "Snap Selection to Zero Crossing"
CONTROL+"R" Brings up Record screen
"S" SELECT SOURCE
CONTROL+"S" FILE SAVE
CONTROL+"U" UNDO LAST EDIT
CONTROL+"V" PASTE
ALT+BACKSPACE UNDO
SHIFT+DELETE CUT
END REWIND TO Start
F1 Launch HELP file system
SHIFT+F1 CONTEXT SENSITIVE HELP
F6 NEXT PANE
SHIFT+F6 PREV_PANE
HOME FORWARD TO END
CONTROL+INSERT EDIT COPY,
SHIFT+INSERT EDIT PASTE,
LEFT ARROW NUDGE RIGHT edge of selected area to the left
RIGHT ARROW NUDGE RIGHT edge of selected area to the right
SHIFT+LEFTARROW NUDGE LEFT edge of sel. area to the left
SHIFT+RT ARROW NUDGE LEFT edge of sel. area to the right
RETURN Default button (this is the cancel button on all filters)
SPACEBAR Play File or Record/Pause (toggle) when the
record dialog box is active.
UP ARROW Increments the selected parameters
DOWN ARROW Decrements the selected parameters
CONTROL+"X" CUT
"X" ZOOM OUT
"Z" ZOOM IN
CONTROL+"Z" ZOOM OUT FULL
CONTROL+"B" Paste Bleep
ALT+"S" Toggles between Spectrogram& Normal
Mode
Esc Exits from the Spectrogram Mode
CONTROL+"T" Paste Insert
-----------------------------------------------------------------------------------------
Mouse Wheel Zoom In & Zoom Out
Note: You can customize some of the keyboard accelerators. To do so, go to the View Menu / Toolbars and Docking Windows / Customize / Keyboard
Sync Mode/Non Sync Mode Explanation Process Diagram
The following diagram illustrates the standard filtering process of DCArt10/DC Forensics10 using Classic Edit mode.
Sync Mode
Sync mode is the default mode of operation for the Classic Editing screen of DCArt10/DC Forensics10. In Sync mode, both the Source and Destination files track each other. If you zoom into a section of the Source file, the Destination file will zoom to the same section. When you process the Source file using a DCArt10/DC Forensics10 filter, the program reads the Source file, processes it, and writes it to the Destination file at exactly the same position as the Source file. This means that if you want to reprocess a section in the middle of a song, just highlight the section in the Source file that needs processing and run the filter again.
Non-Sync Mode
In Non-Sync mode, the highlighted section of the Source file is read and processed by the DCArt10/DC Forensics10 filter. The processed section is then written to the Destination file, starting at the beginning of the file. If a Destination file already exists, it will be overwritten (a prompt warns you of this). This mode is useful when only a section of the Source file needs to be extracted, or for testing a filter’s settings before processing an entire file.
Function Finder Table
In a program that has as many tools as both DCArt10 and DC Forensics10, we thought it might be helpful if you could look up the function to help you more easily find the tool you need.
Functions Unique to DC Forensics10 are shown in Italics
Function | Feature | Feature Location |
3 Band EQ | Phono Pre Amp (VPP) | Filter Menu |
10 Band Graphic EQ | Graphic EQ | Filter Menu Under “EQ” under “Graphic EQ” |
20 Band Graphic EQ | 20 Band Graphic EQ | Filter Menu Under “EQ” |
30 Band Graphic EQ | 30 Band Graphic EQ | Filter Menu Under “EQ” |
32,000 Band Equalizer (FIR Based) | Spectral Filter | Forensics Menu |
33 RPM Record Click Filter | Expert or EZ Impulse Filter | Filter Menu |
45 RPM Record Click Filter | Expert or EZ Impulse Filter | Filter Menu |
78 RPM Record Click Filter | Expert or EZ Impulse Filter | Filter Menu |
80 RPM Record Click Filter (Edison Diamond Disc or Pathé) | Expert or EZ Impulse Filter | Filter Menu |
A-Law Compression | A-Law To .wav Conversion | Open/Save File As x.y |
About DCart | About DCart | Help Menu |
Acoustical Recording Transfer | Phono Pre Amp | Filter Menu |
Adaptive Filter | Adaptive | Forensics Menu |
Adaptive Noise Rejection | Forensics AFDF | Continuous Noise Filter |
Add File to End of Existing File | Append To End | Edit Menu/Paste |
ADPCM Compression | ADPCM to .wav Conversion | Open/Save File as x.y. |
AIFF | Saving a file in the AIFF Format | File\Save As Menu |
ALC (Multiband) | Punch & Crunch | Effects Menu |
ALC (Wideband) | Dynamics Processor | Effects Menu |
Ambience Enhancer | Reverb | Effects Menu |
Ambience Reduction | CNF Spectral Subtraction | Continuous Noise Filter under Filter Menu |
American 78 RPM Turnover Curve | Phono Pre Amp | Filter Menu |
Amplifier Non-linearity Reversal | Polynomial Filter | Forensics Menu |
Amplifier Non-linearity Simulation | Virtual Valve Amplifier | Effects Menu |
Amplify Display | Right Slider Control | Next to Right Side of Display |
Amplitude Measurement (Relative in dB) | VU Meter | View Menu |
Amplitude Measurements and Statistics | Waveform Statistics | Forensics Menu |
Annotate Printed Document | Page Setup | File Menu |
Automatic Noise Reduction | EZ Clean Filter | Filter Menu |
Automatically Assign Names To Tracks Using CD Internet Database | CD Data base (Internet) | File Menu |
Averaging Filter | Averaging Filter | Filter Menu |
Average Phase Angle Management | XY Display | View Menu |
Background Noise Amplification | Whisper Enhancer | Forensics Menu |
Band Pass (FIR Based) | Brick Wall Filter | Forensics Menu |
Balance (audio sound level) | Virtual Phono Preamp | Filter Menu |
Balance (gain controls) | File Conversion Filter | Filter Menu |
Band Pass (IIR Based) | Band Pass Filter | Filter Menu |
Band Pass Filter (Butterworth Response) | Band Pass Filter (Butterworth Checkbox) | Filter Menu |
Band Pass Filter (Chebyshev Response) | Band Pass Filter (Chebyshev Checkbox) | Filter Menu |
Band Stop Filter (FIR Based) | Brick Wall Filter | Forensics Menu |
Bass Control | Phono Pre Amp | Filter Menu |
Bass Sound Enhancement | Fat Bass | VVA Under Effects Menu |
Batch File Editor | Batch File Editor | Filter Menu |
Batch Processing | Batch File Editor | Filter Menu |
Binaural DSS – Left Reference | Continuous Noise Filter | Filter Menu |
Binaural DSS – Right Reference | Continuous Noise Filter | Filter Menu |
Both Channels Processed | L/R Icon | Toolbar |
Break a File into Smaller Pieces at Markers | Chop File into Pieces | CD-Prep Menu |
Brick Wall Filters | Brick Wall Filters | Forensics Menu |
Broadcast .wav (BWF) | Create a File having the Broadcast .wav format | File\Save As Menu |
Burn a CD ROM | Burn a CD | CD Prep Menu |
Buzz Reduction | Harmonic Reject Filter or Impulse Filter | Filter Menu |
Cascade Multiple Filters | Multi-Filter | Filter Menu |
CD Creation | CD Burner | CD Prep Menu & DC Tune Library |
Cell Phone Noise Interference Reduction | Cell Phone Noise Filter | Forensics Menu |
Cepstrum Plots | Voice ID | Forensics Menu |
Change Resolution of File | Change Sample Rate / Resolution | Edit Menu |
Change Sampling Rate of File | Change Sample Rate / Resolution | Edit Menu |
Channel Mixing / Blending | Channel Blender | Effects Menu |
Channel Toolbar Activation | Channel Toolbar | View Menu |
Chop File into Pieces at Markers | Chop File into Pieces | CD-Prep Menu |
Clone a File | Create a replicate of the opened file | File Menu\Clone Source |
Clipping Repair | De-Clipper | Forensics Menu |
Columbia LP Curve (Early) | Phono Pre Amp | Filter Menu |
Comb Filter 1 | Multiple Notch Filters / Multi-Filter | Filter Menu |
Comb Filter 2 | Spectral Filter | Forensic Menu |
Combine 2 Mono Files into a Stereo File | File Split and Re-Combine | Edit Menu |
Comparing File Histogram Statistics | Comparative Histogram | Forensics Menu |
Compress File Size | Save as .mp3 or .wma or .ogg or .oga | File Menu |
Compressor (Instantaneous) | Polynomial Filter | Forensics Menu |
Compressor (multiband) | Punch & Crunch | Effects Menu |
Compressor (wideband) | Dynamics Processor | Effects Menu |
Context Sensitive Help | Point At Feature | Hit F1 Key |
Convert a Stereo .wav file to Monophonic | File Conversions | Filter Menu |
Convert CDs to MP3s | CD to MP3 Conversion | File Menu |
Convert Monophonic .wav file to Stereo | File Converter | Filter Menu |
Convert Random to Brown Noise | Multi-Filter (preset) | Filter Menu |
Convert Random to Pink Noise | Multi-Filter (preset) | Filter Menu |
Convert Random to Seismic Noise | Multi-Filter (preset) | Filter Menu |
Convert Redbook Audio on a CD to a .wav file. | Rip CD Feature | File Menu |
Convert Stereo .wav file to Stereo Reverse .wav file | File Converter | Filter Menu |
Convert .wav file to AIFF Type | Save As | File Menu |
Convert .wav file to MP3 Type | Save As | File Menu |
Copy a Portion of a .wav file | Copy | Edit Menu |
Corner Frequency vs. Time | Filter Sweeper | Effects Menu |
Cracked Record Click Remover | Big Click Filter | Filter Menu |
Create a Playlist | Open / Create Playlist | File Menu |
Create Silence | Mute | Edit Menu |
Create Your Own Filter | Multi-Filter | Filter Menu |
Cross fade Two .wav files | Paste - Cross fade | Edit Menu |
Data Base of Files (DC Tunes) | Open/Create Playlist | File Menu/View Menu |
Data Disc Burner | Burn A Data Disc | File or CD Prep Menu |
DC Offset Eliminator | High Pass Filter | Filter Menu/Preset |
DC Offset Generation | Polynomial Filter | Forensics Menu |
Deep Bass is Missing | Sub-harmonic Synthesizer | Effects Menu |
De-Esser | Dynamics Processor | Effects Menu |
Delay or Advance timing of One Channel compared to the other | Time Offset feature in File Conversions | Filter Menu |
Delete .wav files | Delete Files | File Menu |
Differentiator | High Pass Filter (Preset) | Filter Menu |
Disguise a Voice | Voice Garbler | Forensics Menu |
Display Colors | Preferences / Display | Edit Menu |
Display Setup | Preferences / Display | Edit Menu |
Distortion Reduction | Polynomial Filter | Forensics Menu |
Distortion Synthesizer | Polynomial Filter | Forensics Menu |
Dithering | Change Sample Rate / Resolution | Edit Menu |
Draw Waveform Segment | Pencil Tool | Toolbar |
DSS – Delay Reference | Continuous Noise Filter | Filter Menu |
DTMF Filter | Paragraphic EQ | Filter Menu under “EQ” |
Dynamic Enhancer | Dynamic Noise Filter | Filter Menu |
Dynamic Noise Filter | Dynamic Noise Filter | Filter Menu |
Dynamic Spectral Subtraction (DSS) | Continuous Noise Filter | Filter Menu |
Dynamics Compressor (multiband) | Punch & Crunch | Effects Menu |
Dynamics Compressor (wideband) | Dynamics Processor | Effects Menu |
Dynamics Expander (multiband) | Punch & Crunch | Effects Menu |
Dynamics Expander (wideband) | Dynamics Processor | Effects Menu |
Echo 1 | Reverb | Effects Menu |
Echo 2 | Time Offset Feature in File Converter | Filter Menu |
Echo Chamber | Echo Effect | Effects Menu |
Editing History | Fast-Edit History | View Menu |
Enhance Audio Quality | EZ Enhancer | Effects Menu |
Enhance Sibilance | Overtone Synthesizer | Effects Menu |
European 78 Turnover Curve | Phono Pre Amp | Filter Menu |
Evens Harmonic Reject | Harmonic Reject Filter | Filter Menu |
Exciter (Harmonic) | Checkbox under the Virtual Valve Amplifier | Effects Menu |
Exit the Program | Exit | File Menu or “X” on the Top Right of screen |
Expander (Instantaneous) | Polynomial Filter | Forensics Menu |
Expander (multiband) | Punch & Crunch | Effects Menu |
Expander (wideband) | Dynamics Processor | Effects Menu |
Export Presets | Manage Presets | Edit Menu |
Extract Audio From AVI Video | Open Video Files | File Open |
EZ Clean Filter | Automatic Impulse, Hiss and Hum Filters | Filter Menu |
EZ Enhancer | Complex Audio Enhancement Effects | Effects Menu |
EZ Forensics Filter | Adaptive Forensics Audio Filters | Forensics Menu |
EZ Impulse Filter | Multiple & Adaptive Impulse Type Filters | Filter Menu |
Fade In | Fade-In | Edit Menu |
Fade Out | Fade-Out | Edit Menu |
Fast Edit Mode | Preferences / General | Edit Menu |
File Conversions | File Conversions Filter | Filter Menu |
File Information | File Information | View Menu |
File Time Reversal | Reverse File | Effects Menu |
File Toolbar Activation | File Toolbar | View Menu |
Filter Toolbar Activation | Filter Toolbar | View Menu |
Find Peak Value | Spectrum Analyzer (Checkbox) | View Menu |
Forensics Adaptive Noise Reduction | Auto Voice Filter | Forensics Menu |
Forensics Adaptive Noise Reduction; Frequency Domain | AFDF Mode in the CNF Filter | Continuous Noise Filter – choose AFDF Mode |
Forensics Adaptive Noise Reduction; Time Domain | Adaptive Filter | Forensics Menu |
Formant Identification | Voice ID | Forensic Menu |
Frequency & Amplitude vs. Time | Spectrogram | Forensics Menu |
Frequency & Amplitude vs. Time – High Resolution | High Resolution Spectrogram | Forensics Menu |
Frequency Domain Measurements | Spectrum Analyzer | View Menu |
Frequency Doubler | Polynomial Filter | Forensics Menu |
Gain Change | Gain Change | Edit Menu |
Gain Change vs. Time | Gain Change | Edit Menu |
Gain Normalizer | Normalized Gain Scaling | CD-Prep |
Gain vs. Time | Gain Change | Edit Menu |
Generate Overtones (Evens) | Overtone Synthesizer | Effects Menu |
Generate Overtones (Odds and Evens) | Virtual Valve Amplifier |
|
Generate Sub-harmonics | Sub-harmonic Synthesizer | Effects Menu |
Harmonic Reject Filter | Harmonic Reject Filter | Filter Menu |
Hear Removed Signal or Noise | Keep Residue Checkbox | In Filter Dialog Boxes where appropriate |
High Pass (FIR Based) | Brick Wall Filter | Forensics Menu |
High Pass (IIR Based) | High Pass Filter | Filter Menu |
High Pass Corner Frequency vs. Time | Filter Sweeper | Effects Menu |
High Pass Filter (Butterworth Response) | High Pass Filter (Butterworth Checkbox) | Filter Menu |
High Pass Filter (Chebyshev Response) | High Pass Filter (Chebyshev Checkbox) | Filter Menu |
High Resolution Frequency Response Contouring | 30-Band Graphic EQ | EQ Menu |
Highlight an Area of the .wav file | Left Mouse + Drag | Mouse |
Hiss Reduction 1 | Continuous Noise Filter | Filter Menu |
Hiss Reduction 2 | Dynamic Noise Filter | Filter Menu |
Hiss Reduction 3 | Hiss Filter | Hiss Filter in EZ Clean Filter |
Hum Reduction | Notch Filter | Filter Menu |
Import Presets | Manage Presets | Edit Menu |
Impulse Filter (Easy) | EZ Impulse Filter | Filter Menu |
Impulse Filter (Expert) | Expert Impulse Filter | Filter Menu |
Insert a Segment into a .wav file | Paste - Insert | Edit Menu |
Insert File at Beginning of Another File | Insert at Start | Edit Menu/Paste |
Instant Audio Review | Flashback | Multi-Filter |
Integrator | Low Pass Filter (Preset) | Filter Menu |
Inter-modulation Distortion Reduction | CNF used in Artifact Suppression Mode | Filter Menu |
Interpolate a Portion of a .wav file | Paste - Interpolate | Edit Menu |
Interpolate Both Channels | “I” Key on Keyboard | Paste Interpolate or Keyboard |
Interpolate Left Channel Only | “J” Key on Keyboard | Keyboard |
Interpolate Right Channel Only | “K” Key on Keyboard | Keyboard |
Last 4 Files Opened | Listing Near the Bottom of the Menu | File Menu |
Lateral Cut Record to Monophonic Conversion | File Conversions / Presets | Filter Menu |
Lead Vocal Removal | Channel Blender | Effects Menu |
Left Channel Process Only | L Icon | Toolbar |
Limiter | Dynamics Processor Presets | Effects Menu |
Log to Disc | Multi-Filter / Log to Disc Button | Filter Menu |
Lossless File Compression | FLAC (.flac) | File Menu (Save As) |
Loudness | Volume Control | View Menu |
Loudness Maximizer | Punch & Crunch in Compressor Mode | Effects Menu |
Low Pass (FIR Based) | Low Pass Filter | Forensics Menu |
Low Pass (IIR Based) | Low Pass Filter | Filter Menu |
Low Pass Corner Frequency vs. Time | Filter Sweeper | Effects Menu |
Low Pass Filter (Butterworth Response) | Low Pass Filter (Butterworth Checkbox) | Filter Menu |
Low Pass Filter (Chebyshev Response) | Low Pass Filter (Chebyshev Checkbox) | Filter Menu |
Marker (Add) | Right Mouse Click on Display | Right Mouse Button |
Marker (Annotate or Label) | Right Mouse Click on Label Marker | Right Mouse Button |
Marker (Clear All) | Clear All Markers | Marker Menu |
Marker (Clear an Individual Marker) | Right Mouse Click on Delete Marker | Right Mouse Button |
Marker (Drop) | Drop a Marker | Marker Menu |
Marker (Got Next One) | Got Next Marker | Marker Menu |
Marker (Got Previous One) | Got Previous Marker | Marker Menu |
Marker (Highlight in between two) | Double Left Mouse click between 2 markers | Left Mouse Button |
Marker (Highlight in between two) | Highlight Marked Area | Marker Menu |
Marker (Move) | Drag with Mouse | Left Mouse button |
Markers (Lock all in Place) | Lock Markers | Markers Menu |
Median Filter | Median | Filter Menu |
Medium Resolution Frequency Response Contouring | 20-Band Graphic EQ | EQ Menu |
Mids Control | Phono Pre Amp | Filter Menu |
Mix two .wav files together | Paste - Mix | Edit Menu |
MME Drivers Setup | Preferences / Soundcard | Edit Menu |
Monitor Input vs. Output | Bypass (Checkbox) | All Filter and Effects Dialog Boxes |
Mono DSS – Delay Reference | Continuous Noise Filter | Filter Menu |
Move .wav file from Destination to the Source Display | Make Destination the Source | File Menu |
MP3 Encoder Setup | Preferences / MP3 Encoder | Edit Menu |
Mu-Law Compression | Mu-Law To .wav conversion | Open/Save File As x.y |
Music from Speech Separator | DSS in the CNF | Filter Menu |
Narrow Crackle Impulse Noise | Narrow Crackle Filter | Filter Menu |
Narrowband Noise Rejection | 30 Band EQ | EQ Menu |
Noise Gate | Dynamics Processor Presets | Effects Menu |
Noise Reduction (Wideband) | Continuous Noise Filter | Filter Menu |
Non-linear Transfer Function | Polynomial Filter | Forensics Menu |
Normal Continuous Noise Filter | Continuous Noise Filter | Filter Menu |
Normalize Loudness between Multiple .wav files | Auto Leveling Feature | Batch Processor |
Notch (IIR Based) | Notch Filter | Filter Menu |
Notch Filter vs. Time | Filter Sweeper | Effects Menu |
Odds & Evens Harmonic Reject | Multi-Filter | Filter Menu |
Odds Harmonic Reject | Harmonic Reject Filter | Filter Menu |
Offset Display | Left Slider Control | Next to Right Side of Display |
On Line Help | Help, Contents | Help Menu |
Open a Playlist | Open / Create Playlist | File Menu |
Open a .wav file into Destination Display | Open Destination | File Menu |
Open a .wav file into Source Display | Open Source | File Menu |
Overtone Synthesis (x 2) | Overtone Synthesizer | Effects Menu |
Paragraphic EQ | Paragraphic EQ | Filter Menu under “EQ” |
Parametric EQ | Paragraphic EQ | Filter Menu under “EQ” |
Paste as a New .wav file | Paste as New File | Edit Menu |
Paste Over a Portion of a .wav file | Paste - Over | Edit Menu |
Paste Tone | Paste Bleep | Edit Menu/Paste |
Pause Play | Play / Record Toolbar | Pause Button on Toolbar |
Peaking Filter(s) | Paragraphic EQ | Filter Menu |
Pencil Editing | Pencil Icon | Toolbar |
Pencil Tool | Pencil Icon | Toolbar |
Phase Inversion 1 | File Conversions | Filter Menu |
Phase Inversion 2 | Channel Blender | Effects Menu |
Phono Equalization Curves | Paragraphic EQ Presets | Filter Menu |
Pitch Shift | Stretch & Squish Effect | Effects Menu |
Place Markers Automatically on Silent spots | Find and Mark Silent Passages | CD-Prep Menu |
Play a CD | DC Tune Library | File Menu\DC Tune Library |
Play Controls Activation | Play Controls | View Menu |
Play File | Play / Record Toolbar | Play Button / Spacebar |
Play in a Loop | Loop Play | Loop Play Button on Toolbar |
Playlists | DC Tune Library | File Menu/View Menu |
Preview Filter or Effect | Preview Button | All Filters and Effects |
Print Document | | File Menu |
Print Preview | Print Preview | File Menu |
Printer Setup | Print Setup | File Menu |
Process in Batch Mode | Batch File Editor | Filter Menu |
Quantize for CD Audio | Quantize for CD Audio | CD-Prep Menu |
Ranking Filter | Median Filter | Filter Menu |
Real Time Feed through | Multi-Filter / Live Preview Button | Filter Menu |
Rebuild the Peak File (Waveform) | Rebuild Peak File | View Menu |
Recorder | Record File | Edit Menu or Toolbar |
Rectifier | Polynomial Filter | Forensics Menu |
Reduce File Size | Save as .mp3 or .wma or .ogg or .oga | File Menu |
Remove Portion of a .wav file | Cut | Edit Menu |
Remove Silence from a file Automatically | Remove Silence Tool | Forensics Menu |
Reverberation Simulation | Reverb | Effects Menu |
Reverse RIAA EQ Curve | Paragraphic EQ Presets | Filter Menu |
Review Real-time Audio | Flashback Mode | Multi-Filter |
Rewind to Beginning | Rewind Button | Rewind Button on Toolbar |
RIAA EQ Curve | Phono Pre Amp | Filter Menu |
Right Channel Process Only | R Icon | Toolbar |
Rip a CD | Rip CD Tracks | File Menu |
Rumble Reduction 1 | Continuous Noise Filter | Filter Menu |
Rumble Reduction 2 | High Pass Filter | Filter Menu |
Run Function | Run Button | All Filters and Effects |
Save a Destination Display .wav file | Save Destination As | File Menu |
Scalar Amplitude Measurement | VU Meter | View Menu |
Scratch & Crackle Filter | EZ Impulse | Filter Menu |
Scrub Feature | Variable Speed Playback using the Mouse – Forward and Reverse | Toolbar |
Selective Filtering | Sync Files | View Menu |
Shelving Filters (Low or High Frequency) | Paragraphic EQ or VPP | Filter Menu |
Simulate Tubes and Transistors | VVA | Effects Menu |
Sine Wave Synthesis | Make Waves | Edit Menu |
Slot Filter (IIR Based) | Notch Filter | Filter Menu |
Software Revision Number | About DCart | Help Menu |
Sound Activated Recording | Record File / VOX Recording Checkbox | Edit Menu or Toolbar |
Sound Card Set Up | Preferences | Edit Menu |
Spectral Subtraction Filter | Continuous Noise Filter | Filter Menu |
Spectral Inverse Filter | Normalize a Signal to Constant Power Spectral Density | Forensics Menu under Spectral Filter “EQ Mode” Selector |
Spectrogram | View Spectrogram | View Menu |
Spectrogram Options | Preferences / Spectrogram | Edit Menu |
Spectrum Analyzer | Spectrum Analyzer | View Menu |
Speech Filter (FIR based) | Brick Wall Filter (presets) | Forensics Menu |
Speech Filter (IIR based) | Band Pass Filter (presets) | Filter Menu |
Speed Correction | Change Speed Filter | Effects Menu |
Splash Screen – On / Off | Preferences / Display | Edit Menu |
Split Stereo File into 2 Mono Files | File Split and Re-Combine | Edit Menu |
Square Wave Synthesis | Make Waves | Edit Menu |
Static Remover | Expert Impulse Filter | Filter Menu |
Status Bar Activation | Status Bar | View Menu |
Stereo Simulation 1 | File Converter (Time Offset) | Filter Menu |
Stereo Simulation 2 | Reverb | Effects Menu |
Stereo Simulation 3 | Paragraphic Equalizer, Presets | Filter Menu |
Stroboscopes, Printable | Diamond Cut Install Folder | Strobe50Hz.wmf Strobe60Hz.wmf |
Sub-Harmonic Synthesis ( | Sub-harmonic Synthesizer | Effects Menu |
Swept Waveform Synthesis | Make Waves | Edit Menu |
Sync Files | Sync Files | View Menu |
Synchronize Two .wav files | Sync Files | View Menu |
Synthesize Round Bass | VVA | Effects Menu |
Synthesize “Sweet” Treble | VVA | Effects Menu |
Synthesize “Warm” Treble | VVA | Effects Menu |
System Setup | Preferences | Edit Menu |
System Status | Status Bar | View Menu (Bottom of Screen) |
Tape Equalization Curves | Paragraphic EQ Presets | Filter Menu |
THD Measurement | Spectrum Analyzer (Checkbox) | View Menu |
Time at Cursor | Time Display | View Menu |
Time Compensation Calculator and Corrector | Change Speed | Effects Menu |
Time Compression | Stretch & Squish | Effects Menu |
Time Delay | Echo Effect | Effects Menu |
Time Expansion | Stretch & Squish | Effects Menu |
Time Offset | File Conversions | Filter Menu |
Time Span | Time Display | View Menu |
Time Stamp the Segment | Multi-Filter / Checkbox | Filter Menu |
Time Start | Time Display | View Menu |
Time Stop | Time Display | View Menu |
Timer Recording | Timer Record | Edit Menu |
Timing Measurements | View Time Display | View Menu |
Tip of the Day Activation | Tip of the Day / Checkbox | Help Menu |
Tip of the Day De-Activation | Tip of the Day / Checkbox | Launch, and then after the Splash Screen |
Tone Controls | Phono Pre Amp | Filter Menu |
Top Octaves Missing | Overtone Synthesizer or Virtual Valve Amplifier | Effects Menu |
Total Harmonic Distortion Measurement | Spectrum Analyzer (Checkbox) | View Menu |
Track a Frequency | Frequency Tracking feature used in conjunction with the Spectrogram | Forensics Menu |
Track Sub-sonic events | Subsonic Explorer | Forensics Menu |
Treble Control | Phono Pre Amp | Filter Menu |
Triangle Wave Synthesis | Make Waves | Edit Menu |
Tube Simulator | Virtual Valve Amplifier | Effects Menu |
Turnover Curves | Paragraphic EQ Presets | Filter Menu |
Undo Edit | Undo | Edit Menu |
Universal Impulse Filter | Expert Impulse Filter | Filter Menu |
User Discussion Group (BBS / Forum) | User Discussion Group | Help Menu |
User Preferences | Preferences | Edit Menu |
Valve Simulator | Virtual Valve Amplifier | Effects Menu |
Variable Frequency Response vs. Time | Filter Sweeper | Effects Menu |
Variable Noise vs. Time | Adaptive Filter | Forensics Menu |
Vector Measurement | XY Display | View Menu |
Vertical Cut Record to Monophonic Conversion | File Conversions / Presets | Filter Menu |
Vinyl LP Click Filter | Expert Impulse Filter | Filter Menu |
Voice Activated Recording | Record File / VOX Recording Checkbox | Edit Menu or Toolbar |
Voice Print | Voice ID | Forensics Menu |
Volume Control | Volume Control | View Menu |
Volume Control | Virtual Phono Preamp | Filter Menu |
Vorbis (Conversion to Ogg Vorbis File format) | Save as .ogg or.oga | File Menu\Save As |
VOX Recording | Record File / VOX Recording Checkbox | Edit Menu or Toolbar |
VU Meter | VU Meter | View Menu |
VU Meter Scale, Log or Linear | Preferences / General | View Menu |
Weighted Median Filter | Median Filter | Filter Menu |
White Noise Synthesis | Make Waves | Edit Menu |
Wideband Noise Reduction | Continuous Noise Filter | Filter Menu |
Wind Noise | Wind Noise Filter (speech) | Filter Menu |
WMA Format File Saving | Save As .wma | File\Save As Menu |
WMD Drivers Setup | Preferences / Soundcard | Edit Menu |
XY Display | XY Display | View Menu |
Zoom (Binary) | Zoom In or Out X2 | View Menu or Toolbar |
Zoom (Highlighted) | Zoom In or Out | View Menu or Toolbar |
Measurement | Stimulus System | Response System |
Acoustical Signature | Calibrated microphone driving sound card input | Spectrogram |
Aliasing Products | Swept Sine Wave (Make Waves Generator) | Spectrum Analyzer |
Amplifier Linearity | Triangle Wave Generator (Make Waves) | Waveform Display Window |
Amplitude Measurements | Time Domain Signal (highlighted by user) | Waveform Statistics in Forensics Menu |
Amplitude vs. Frequency | Any signal requiring analysis | Spectrum Analyzer |
Amplitude vs. Time | Any signal requiring analysis | Waveform Display Window |
Analog Tape Authentication | Look for line frequency or multiple line frequency spectral spikes or look for a higher order noise roll-off rate | Spectrum Analyzer operating in high resolution mode |
Analog Tape Recorder Tape Head Azimuth Alignment | Azimuth Reference Tape | XY Display / Vector-scope |
Ballistics Fingerprint | Audio Recording of ballistics events to be compared | Spectrogram
|
Average Phase Angle | Any Binaural Signal | Averaging Selection Box in the XY Display |
Cross-talk | Sine Wave into One Channel from the Make Waves Generator; Terminate the opposite channels input with the proper impedance | Spectrum Analyzer or VU Meters |
DC Offset | Terminate input with proper input impedance | Waveform Display Window |
Dynamic Range | Any combination of signals requiring analysis | VU Meters with Peak Hold |
Fall Time | Any signal requiring analysis | Waveform Display Window and Time Display with Markers |
Frequency | Any signal requiring analysis | Spectrum Analyzer |
Frequency & Amplitude vs. Time | Any signal requiring analysis | Spectrogram |
Frequency Distribution | Any signal requiring analysis | Spectrum Analyzer |
Frequency Ratio | Any signal requiring analysis | XY Display / Vector-scope |
Frequency Response | Swept Sine Wave or Random Noise made by the Make Waves Generator | VU Meter (when using the Swept Sine Wave) or the Spectrum Analyzer (when using the Random Noise Generator) |
Hard Disc Recording Time Available | Any signal being recorded | Recording Function |
Instantaneous Frequency | Any signal requiring analysis | Waveform Display Window and Time Display with Markers. Calculate: F= 1/t |
Inter-modulation Distortion | Dual Sine Wave Tones made with the Make Waves Generator and summed together with “Paste Mix” | Spectrum Analyzer |
Left Channel vs. Right Channel | Any signal(s) requiring analysis | XY Display / Vector scope |
Linearity | Triangle Wave created using the Make Waves Generator | Waveform Display Window |
Noise Floor | Properly Terminated Input | Spectrum Analyzer |
Peak Amplitude | Any signal requiring analysis | VU Meter using the Peak Hold feature |
Phase Angle | Any pair of signals having coherence | XY Display / Vector-scope |
Phase Margin of equipment having a control loop system (1 st& 2nd order) | Stereo Square Wave Generator (Make Waves) | Time display window (dampening factor of ‘ring-out’) |
Power Amplifier Frequency Response vs. Output | Swept Sine Wave (Make Waves) | Proper Loading resistor and True RMS reading Voltmeter |
Real Time of an Event | Any signal requiring analysis | Timer Recording with Time and Date Stamping |
Recording Position | Any signal being recorded | Recording Function |
Relative Amplitude (Scalar) | Any combination of signals requiring analysis | VU Meter |
Relative Loudness | Any combination of signals requiring analysis | VU Meter |
Rise Time | Any signal requiring analysis | Waveform Display Window and Time Display with Markers |
Room Acoustical Balance | Random Noise Generator (Make Waves) | Spectrum Analyzer |
Room Acoustical Propagation Delay & Reflection | Calibrated microphone driving a sound card input & an Impulse source like a handclap or an impulse created with the “Pencil” feature | Waveform Display Window, Markers and Time Display Feature |
Signal to Noise Ratio | Sine Wave @ 0 dB vs. Noise Floor | Spectrum Analyzer |
Slew Rate | Square Wave Generator (Make Waves) | Waveform Display Window and Time Display with Markers |
Sound Card Performance | Please Refer to Application Note 2 (AN-2) | Please Refer to Application Note 2 (AN-2) |
Sound Card Recording Level / Clipping | Audio signal applied to sound Card | Recording Function with recording VU meter and peak indicator |
Stereo Separation | Sine Wave into One Channel from the Make Waves Generator; Terminate the opposite channels input with the proper impedance | Spectrum Analyzer, VU Meters or X-Y Display |
Tape Recording Speed | Any analog tape recorded signal | Spectrum Analyzer |
Time Derivative (dV / dt) | Any signal requiring analysis | Waveform Display Window and Time Display with Markers |
Time Interval between Events | Markers | Time Display Feature |
Total Harmonic Distortion (% THD) | Any Audio Device requiring performance testing using a Sine Wave stimulus (Make Waves) | Spectrum Analyzer with “Show THD” function and “Show Peak” enabled |
Transient Response | Any Active Audio Device with a control loop with a Square Wave applied (Make Waves Generator) | Waveform Display Window |
Turntable RPM | Neon or Fluorescent Lamp connected to a known Frequency Source | Printable Strobe discs found in the your software. |
Voice Print comparison | Audio Signal of Voice(s) to be compared | Spectrogram |
Waveform Statistics | Forensics Recordings | Histogram or Histogram vs Time |
Whisper Amplifier/Enhancer | Forensics Audio Recordings with very Weak “far” parties | Whisper Enhancer (Forensics Version Only) |
Wow and Flutter | Sine Wave (Make Waves) | Spectrum Analyzer |
Attenuation Chart
Here is a table of resistance multipliers for a symmetrical (equal input and output impedance) "T" Pad attenuator:
R1 = Attenuator Input Resistor
R2 = Attenuator Shunt Resistor
R3 = Attenuator Output Resistor
(Note: R1 = R3 & the output impedance of the Input Source and
the input impedance of the Output Load circuit must also be
equal to R1 and R3)
Attenuation (dB) | R1 & R3 (normalized Ohms) | R2 (normalized Ohms) |
0.0 | 0.000000 | infinite |
0.5 | 0.028775 | 17.362 |
1.0 | 0.057501 | 8.6668 |
2.0 | 0.114620 | 4.3048 |
3.0 | 0.171000 | 2.8385 |
4.0 | 0.226270 | 2.0966 |
5.0 | 0.280130 | 1.6448 |
6.0 | 0.332280 | 1.3386 |
7.0 | 0.382480 | 1.1160 |
8.0 | 0.430510 | 0.94617 |
9.0 | 0.476220 | 0.81183 |
10.0 | 0.519490 | 0.70273 |
20.0 | 0.818180 | 0.20202 |
40.0 | 0.980198 | 0.020002 |
60.0 | 0.998000 | 0.0020000 |
80.0 | 0.999800 | 0.00020000 |
100.0 | 1.000000 | 0.000020000 |
To use this table, multiply the input (or output) impedance of your circuit by the numbers associated with the attenuation that you desire. Remember, this table of values requires that the input terminating impedance and the output terminating impedance of the circuits on each side of the attenuator be present and of the same value. To obtain values of attenuation that are not in this table, merely cascade "T" sections adding up to the value (in dB) which you desire. For example, to achieve 23 dB, cascade a 20 dB section with a 3 dB section.
The following table shows the relationship between Voltage, Current, and Power ratios and Decibels:
Numerical Ratio | Voltage or Current Ratio in dB | Power Ratio in dB |
1 : 1 | 0 | 0 |
2 : 1 | 6.0 | 3.0 |
3 : 1 | 9.5 | 4.8 |
4 : 1 | 12.0 | 6.0 |
5 : 1 | 14.0 | 7.0 |
6 : 1 | 15.6 | 7.8 |
7 : 1 | 16.9 | 8.5 |
8 : 1 | 18.1 | 9.0 |
9 : 1 | 19.1 | 9.5 |
10 : 1 | 20 | 10 |
100 : 1 | 40 | 20 |
1,000 : 1 | 60 | 30 |
10,000 : 1 | 80 | 40 |
100,000 : 1 | 100 | 50 |
1,000,000 : 1 | 120 | 60 |
10,000,000 : 1 | 140 | 70 |
100,000,000 : 1 | 160 | 80 |
1,000,000,000 : 1 | 180 | 90 |
10,000,000,000 : 1 | 200 | 100 |
Resistor Color Code
Standard RMA (Radio Manufacturers Association) Color Code:
Color | Significant Figure (Mantissa) | Decimal Multiplier (Exponent) |
Silver | - | 0.01 |
Gold | - | 0.1 |
Black | 0 | 1.0 |
Brown | 1 | 10 |
Red | 2 | 100 |
Orange | 3 | 1,000 (1K) |
Yellow | 4 | 10,000 (10K) |
Green | 5 | 100,000 (100K) |
Blue | 6 | 1,000,000 (1M) |
Violet | 7 | 10,000,000 (10M) |
Gray | 8 | 100,000,000 (100M) |
White | 9 | 1,000,000,000 (1G) |
Note 1: K = Kilo, M = Mega, G = Giga
Note 2: This same color code scheme is sometimes used to identify the values of other electronic components and wires in a system.
Note 3: The tolerance band (next to the Multiplier Band) has the following translation: No Band: +/- 20 %, Silver Band: +/- 10 %, Gold Band: +/- 5%, Red Band: +/- 2%, Brown Band: +/- 1%, Green Band: +/- 0.5 %
Note 4: Some resistors have an additional band denoting the Temperature Co-efficient of the component.
The following is a chart showing some sound sources and their Acoustic Power and Sound Power Levels measured at 10 meters from the source:
Sound Source (measured at 10 meters from source)
| Total Acoustic Power (dB ref. to 10^-12 Watts) (A Weighted) | Power Level in dB (A Weighted) |
Very soft Voice | 1 NanoWatt | 30 |
Conversational Voice | 10 MicroWatts | 70 |
Shouting Voice | 1 MilliWatt | 90 |
Auto on Highway | 10 MilliWatts | 100 |
Blaring Radio | 100 MilliWatts | 110 |
Piano | 1 Watt | 120 |
Small Aircraft Engine | 3 Watts | 125 |
Pipe Organ | 100 Watts | 140 |
75 Piece Orchestra | 100 Watts | 140 |
4 Propeller Airplane | 1,000 Watts | 150 |
Turbojet Engine | 10,000 Watts | 160 |
Ram-Jet Engine | 100,000 Watts | 170 |
Below is a table of common values of audio system resolution and their associated dynamic ranges:
Number of Bits of Resolution | Theoretical Maximum Dynamic Range |
4 bits | 24 dB |
8 bits | 48 dB |
16 bits | 96 dB |
20 bits | 120 dB |
24 bits | 144 dB* |
32 bits | 192 dB* |
*Note: These values are not achievable in practice due to the physics associated with the thermal noise floor of electronic amplification systems at room temperatures.
Audio Frequency Spectrum
The following is a listing of some common audio sources and the portion of the audio spectrum that they typically occupy, including their harmonics:
Audio Source | Fundamentals + Harmonics | Fundamental Only |
Accordion | 130 Hz to 15 kHz | 130 Hz to 1.8 kHz |
Bass Drum | 50 Hz to 5 kHz | ---- |
Bassoon | 65 Hz to 9 kHz | 65 to 650 Hz |
Bass Tuba | 40 Hz to 7 kHz | 40 Hz to 375 Hz |
Bass Viola | 45 Hz to 8 kHz | 45 to 300 Hz |
Cello | 70 Hz to 14 kHz | 70 Hz to 900 Hz |
Clarinet (Soprano) | 150 Hz to 14 kHz | 150 Hz to 1.7 kHz |
Cymbals (14 inch) | 300 Hz to 17 kHz | ---- |
Female Speech* | 165 Hz to 10 kHz | 165 to 255 Hz |
Flute | 250 Hz to 14 kHz | 250 Hz to 2.5 kHz |
Foot Steps | 80 Hz to 15 kHz | ---- |
French Horn | 70 Hz to 6 kHz | 70 to 825 Hz |
Hand Clapping | 100 Hz to 15 kHz | ---- |
Harmonica | 450 Hz to 15 kHz | 450 Hz to 1.3 kHz |
Jingling Keys | 1.5 kHz to 14 kHz | ---- |
Male Speech* | 85 Hz to 8 kHz | 85 to 180 Hz |
Oboe | 250 Hz to 15 kHz | 250 Hz to 1.7 kHz |
Piano | 30 Hz to 6 kHz | 30 Hz to 4.2 kHz |
Piccolo | 500 Hz to 15 kHz | 500 Hz to 3.8 kHz |
Pipe Organ | 16 – 32 Hz to 15 kHz | 16 – 32 Hz to 8 kHz |
Room Noise | 30 Hz to 18 kHz | ---- |
Snare Drum | 80 Hz to 15 kHz | ---- |
Timpani Drums | 50 Hz to 4.5 kHz | ---- |
Trombone | 80 Hz to 8 kHz | 80 Hz to 500 Hz |
Trumpet | 180 Hz to 9 kHz | 180 Hz to 900 Hz |
Violin | 190 Hz to 15 kHz | 190 Hz to 3 kHz |
*Note: Frequency response is specified for mature & healthy adults
Human Hearing Frequency Response vs. Age
(0 dB is referenced to the 20 – 39 year old age group)
(Values are Averages for both Men and Women)
Age | 400 Hz | 1 kHz | 2 kHz | 4 kHz | 10 kHz |
<19 | 0 dB | 0 dB | 0 dB | +1 dB | +3 dB |
20-29 | 0 dB | 0 dB | 0 dB | 0 dB | 0 dB |
30-39 | - 1 dB | - 2 dB | - 2 dB | - 3 dB | - 6 dB |
40-49 | -2 dB | - 3 dB | - 5 dB | -9 dB | -15 dB |
50-59 | - 4 dB | - 7 dB | - 13 dB | - 20 dB | - 30 dB |
60-69 | - 5 dB | - 12 dB | - 21 dB | - 32 dB | - 45 dB |
Musical Scale
The following table provides the frequencies of four octaves of the tempered musical scale (1/2 step between notes) rounded in integers:
Note | Frequency | Note | Frequency |
A | 110 | A (above middle C) | 440 |
A# (B flat) | 117 | A# (B flat) | 466 |
B | 123 | B | 494 |
C (low C) | 131 | C (high C) | 523 |
C# (D flat) | 139 | C# (D flat) | 554 |
D | 147 | D | 587 |
D# (E flat) | 156 | D# (E flat) | 622 |
E | 165 | E | 659 |
F | 175 | F | 698 |
F# (G flat) | 185 | F# (G flat) | 740 |
G | 196 | G | 784 |
G# (A flat) | 208 | G# (A flat) | 831 |
A (below middle C) | 220 | A (above high C) | 880 |
A# (B flat) | 233 | A# (B flat) | 932 |
B | 247 | B | 988 |
C (middle C) | 262 | C | 1,047 |
C# (D flat) | 277 | C# (D flat) | 1,109 |
D | 294 | D | 1,175 |
D# (E flat) | 311 | D# (E flat) | 1,245 |
E | 330 | E | 1,319 |
F | 349 | F | 1,397 |
F# (G flat) | 370 | F# (G flat) | 1,480 |
G | 392 | G | 1,568 |
G# (A flat) | 415 | G# (A flat) | 1,661 |
A (above middle C) | 440 | A | 1,760 |
Note 1: Standard Pitch is based on the tone "A" of 440 Hz. With this standard, the frequency of Middle C should actually be 261.626 Hz.
Note 2: The entire Musical Scale from C0 (16.35 Hz) to D9# (9,956.06 Hz) are available as presets in the “Make Waves” Generator (Edit Menu).
Hard Drive Recording Space Consumption
How much hard drive space will you need for your next recording? This handy chart should get you in the ballpark.
Note 1 - Values are given for one process only (such as recording).
Note 2 - Values are given for 16-bit resolution only.
Note 3 - Multiply the above storage rates X 1.5 for 24-bit recording.
Note 4 - Windows currently operates with a 2 Gigabyte limit on .wav file
size.
Compact Discs
There are a number of standards for data contained on Compact Discs. They are as follows:
Type | Application | Comments |
Red Book | CD Audio / Compact Disc | PCM, 44.1 kHz sampling, 16 bit x 2 channels, 588 bits/frame, 192 bits/frame for the audio stream. |
Yellow Book | Computer Data | Data structure based on ISO 9660 |
White Book | Video CD | MPEG audio/video track encoding |
Blue Book | Enhanced Music CD (Audio + Data) | Structure similar to ISO 9660 |
Orange Book | CD-MO, CD-R & CD-RW | Magneto Optical / CD Write Once / CD Re-Writable |
Photo CD Book | Photographs | Based on CD-I Bridge spec. |
Multi-session CD | Multiple Session not recordable | Data structure based on ISO 9660 |
78 RPM Record Turnover Frequency Chart
Type, Brand, or Process | Turnover Frequency |
Acoustical Recordings | 0 Hz |
Columbia (1925 - 1937) | 200 Hz |
Victor (1925 - 1937) | 200 Hz |
Westrex | 200 Hz |
Decca (1935 - 1949) | 250 Hz |
EMI | 250 Hz |
English Columbia | 250 Hz |
HMV (1931) | 250 Hz |
EMI (1931) | 250 Hz |
London | 250 Hz |
Blumlein | 250 Hz |
Columbia (1938 – End) | 300 Hz |
BSI | 350 Hz |
Capitol | 400 Hz |
Mercury | 400 Hz |
Brunswick | 500 Hz |
Decca (1925 – 1929) | 500 Hz |
Edison Laterals (1929) | 500 Hz |
MGM | 500 Hz |
Parlophone | 500 Hz |
Victor (1938 – 1952) | 500 Hz |
629 | 629 Hz |
|
|
Note: Many of these Turnover Curves can be found as presets in the VPP or the Paragraphic EQ.
LP Equalization Chart for Records by Label (Phonographic)
(Prior to the EQ Standardization in 1955)
Label (Manufacturer) | Turnover Frequency in Hz | Roll-off at 10 kHz in dB |
Angel | 500 | -13.7 |
Audio Fidelity | 500 | -16 |
Arizona | 500 | -13.7 |
Bach Guild | 500 | -16 |
Bartok | 629 | -16 |
Bethlehem | 500 | -13.7 |
Boston | 500 | -16 |
Caedmon | 629 | -16 |
Capitol | 400 | -12 |
Capitol-Cetra | 400 | -12 |
Cetra-Soria | 500 | -16 |
Classic Editions | 500 | -13.7 |
Clef | 500 | -13.7 |
Colosseum | 400 | -12 |
Columbia | 300 | -16 |
Concert Hall | 400 | -12 |
Decca | 400 | -12 |
Decca FFRR (1951) | 300 | -14 |
Decca FFRR (1953) | 450 | -11 |
Ducretet-Thompson | 450 | -11 |
EMS | 375 | -12 |
Epic | 500 | -16 |
Esoteric | 400 | -12 |
Folkways | 500 | -16 |
Haydn Society | 500 | -16 |
HMV | 500 | -16 |
Kapp | 500 | -13.7 |
London | 450 | -11 |
London International | 450 | -11 |
Lyrichord | 500 | -16 |
McIntosh | 500 | -13.7 |
Mercury | 400 | -12 |
MGM | 500 | -13.7 |
Montilla | 500 | -13.7 |
New Jazz | 500 | -13.7 |
Norgran | 500 | -13.7 |
Oceanic | 500 | -16 |
Oiseau-Lyre | 500 | -8.5 |
Overtone | 500 | -16 |
Polymusic | 500 | -16 |
Prestige | 500 | -13.7 |
RCA Victor (until 1953) | 500 | -13.7 |
Remington | 500 | -16 |
Riverside | 500 | -13.7 |
Romany | 500 | -13.7 |
Savoy | 500 | -13.7 |
Urania | 500 | -16 |
Vanguard | 400 | -12 |
Vox | 400 | -16 |
Westminster | 400 | -16 |
Note: Many of these curves can be found as presets within the Virtual Phono Preamp (VPP).
LP Equalization Curves by Curve Name (Phonographic)
The following is a listing of LP turnover frequencies and roll-off attenuation values for the various equalization curves that were used for playback by the phonographic industry (many of which can be found as presets in the Diamond Cut Virtual Phono Preamp {VPP}):
Equalization Curve | Turnover Frequency | Roll-off dB @ 10 kHz |
AES | 400 Hz | - 12 dB |
Columbia LP | 300 Hz | - 16 dB |
EMI LP | 500 Hz | - 10.5 dB |
ffrr (1949) | 250 Hz | - 5 dB |
ffrr (1951) | 300 Hz | - 14 dB |
ffrr (1953) | 450 Hz | - 11 dB |
NAB | 500 Hz | - 16 dB |
NARTB | 500 Hz | - 12 dB |
RCA Early Orthophonic | 500 Hz | - 11 dB |
RCA New Orthophonic | 500 Hz | - 13.7 dB |
RIAA | 500 Hz | -13.7 dB |
RIAA Curve Table of Values
Frequency in Hz | Level in dB referenced to 0 dB @ 1 kHz* | Frequency in Hz | Level in dB referenced to 0 dB @ 1 kHz* |
20 | + 19.3 | 800 | + 0.7 |
30 | + 18.6 | 1,000 | 0.0 * |
40 | + 17.8 | 1,500 | - 1.4 |
50 | + 17.0 | 2,000 | - 2.6 |
60 | + 16.1 | 3,000 | - 4.8 |
80 | + 14.5 | 4,000 | - 6.6 |
100 | + 13.1 | 5,000 | - 8.2 |
150 | + 10.3 | 6,000 | - 9.6 |
200 | + 8.2 | 8,000 | - 11.9 |
300 | + 5.5 | 10,000 | - 13.7 |
400 | + 3.8 | 15,000 | - 17.2 |
500 | + 2.6 | 20,000 | - 19.6 |
Note: The RIAA EQ system operates in Constant Amplitude mode below the 500 Hz Turnover Frequency. It also operates in Constant Amplitude mode above the 2120 Hz Rolloff Frequency. The system operates in Constant Velocity mode between the Turnover and the Rolloff
Frequencies.
Record Type | Stylus Size (mil) | Stylus Type |
16 inch Transcriptions | 2.5 | TE |
16 inch Transcriptions (very late) | 2.0 | E |
33.3 RPM Monophonic LP | 1.0 | E |
33.3 RPM Stereophonic LP | 0.7 | E |
33.3 RPM Badly worn LP | 1.5 | TE |
33.3 RPM Early Mono LPs | 1.5 | TE |
33.3 RPM CD-4 Quadraphonic LPs | 0.2 | Shibata |
45 RPM Monophonic | 1.0 | E |
45 RPM Stereophonic | 0.7 | E |
1931 to 1935 RCA Pre-Grooved Home Recordings | 4.0 – 5.0 | S |
1930’s (late) Lateral 78 RPM Shellac Discs | 2.8 | TE |
Acetate & Aluminum Instantaneous Discs | 6.0 | TE |
Acoustical 78s (very early) | 4.0 | TE |
Acoustical Wide Groove 78 RPM Lateral Discs | 3.8 | TE |
Edison 80 RPM Diamond Discs | 3.0 – 3.7 | S or C |
Edison Blue Amberol Cylinders | 3.0 – 4.2 | S |
Edison Wax Amberol Cylinders | 4.2 | S |
Edison White & Brown Wax, Concert, & Gold Molded Cylinders | 7.4 | S |
Electrical Recordings (Shallow Groove) | 2.0 | TE |
General Purpose 78 RPM | 3.0 | TE |
Metal Stampers* | Depends | BR |
Narrow Groove 78s such as Polydor | 2.4 | TE |
Pathe’ 78s | 3.7 | TC |
Pathé Etched-label up to 14 inches in diameter | 8.0 | S |
Pathe’ Etched-label greater than 14 inches in diameter | 16.0 | S |
Pre-1935 Lateral Cut Electrical 78s | 3.3 | TE |
Standard Groove 78 RPM Discs | 3.0 | TE |
Transcription Recordings | 2.3 | TE |
Transcription. 1930’s and 1940’s 16 inch Acetates | 2.6 | TE |
Wagner-Nichols Records | 0.5 | TE |
Stylus Type Key: BR = Bi-Radial, C = Conical, TC = Truncated Conical, E = Elliptical, TE = Truncated Elliptical, S = Spherical
* Note: When “stampers” are played on a conventional turntable equipped with a bi-radial stylus, you will need to use the Diamond Cut File Reversal feature so that it can be converted to forward play.
Record Type | Speed (RPM) |
45s (Victor and others) | 45 |
Berliner 7 inch Records | 70 |
Berliner (pre-1900) | 57 to 72 |
Berliner, Victor, Zonophone (early) | 71.3 |
Early Microgroove (some) | 16.66 |
Edison Black (wax) Amberols (2 min) | 160 |
Edison Blue Amberols (4 min) | 160 |
Edison Brown Wax Cylinders (early) | 125 to 144 |
Edison Brown Wax Cylinders (1892 – 1899) | 125 |
Edison White Wax Cylinder (1888 – 1892) | 100 |
Edison Brown Wax Cylinders (“New Process” – 1900) | 144 |
Edison Concert Cylinders | 100 |
Edison Gold Molded Cylinders | 160 |
Edison Diamond Discs (Vertical Cut) | 80 |
Electrical Era 78s (Europe) | 77.92 |
Electrical Era 78s (US) | 78.26 |
Electrical Era (Edison Lateral “Thin-Cut” – Needle Type) | 78.8 |
Pathe’ (some) | 90 |
Vertical Cut (Pathe´, Brunswick, Okey, Columbia) | 80 |
Victor Acoustical (1908 to 1925) | 76.6 |
Victor Acoustic (early), Berliner | 71.3 |
Victor Acoustical (most) | 76.59 |
Vinyl LPs (Columbia and others) | 33.33 |
Zonophone | 71.29 |
Fractional Speed Record Transfers
You can use the Diamond Cut Change Speed filter to provide Fractional Speed transfer capability from a 45 RPM turntable. Some important Change Speed ratio's are as follows:
*Note: (Actually it is 78.26086957 which is a 46:1 standard gear reduction from a 60 Hz Line operated Synchronous Motor turning at 3600 RPM.)
Stroboscope Chart (Phonograph)
The following is a chart that you can use to create your own phonograph strobe disc using common line frequencies and RPM values:
RPM | # of Divisions for 50 Hz | # of Divisions for 60 Hz |
16 | 375 | 450 |
33.33 | 180 | 216 |
45 | 133 | 160 |
78.26 | 77 | 92 |
80 | 75 | 90 |
Note 1: Actually, two pulses of light are produced per cycle of the line by the power line. But, for improved visibility, it is better to use every other pulse to light up the strobe as is reflected by the chart above.
Note 2: Printable Stroboscope Disc Metafiles can be found you’re your Diamond Cut software documentation. The 50 Hz strobe disc is called “Strobe50Hz.wmf” and the 60 Hz version is called “Strobe60Hz.wmf”.
<Users Documents>/DCForensics10/Strobe50Hz.wmf
or
<Users Documents>/DCForensics10/Strobe60Hz.wmf
Note 3: The most effective illumination for a phonograph strobe disc is a power line operated fluorescent or neon lamp.
Tape Speeds in Inches Per Second (ips)
The following is a listing of common speeds used by tape recorders:
Speed (IPS) | Pro Reel to Reel | Home Reel to Reel | Compact Cassette | Micro Cassette |
30 | X | - | - | - |
15 | X | - | - | - |
7 1/2 | - | X | - | - |
3 3/4 | - | X | - | - |
1 7/8 | - | - | X | X |
15/16 | - | - | - | X |
15/32* | - | - | - | X |
* This speed is also used by reel-to-reel analog data recorders.
Rotary Head Tape Recorder Speeds
0.321 ips (8.15 mm / sec)
1.31 ips - SP (Standard Play)
0.66 ips - LP (Long Play)
0.44 ips - EP (Extended Play)
1.58 ips (4.0 cm / sec) - Beta I
0.797 ips (2.0 cm / sec) - Beta II
0.524 ips (1.33 cm / sec) - Beta III
3.75 ips
Audio Connection Standards (Connectors)
A. Pin # 1 = Shield
B. Pin # 2 = Signal + (Signal Hot)
C. Pin # 3 = Signal - (Signal Cold)
2. 1/4 inch Stereo Phone Plug (TRS) for Balanced Audio Circuits
A. Tip = Signal + (Signal Hot)
B. Ring = Signal - (Signal Cold)
C. Sleeve = Shield
3. 1/4 inch Mono Phone Plug (TR) for Unbalanced Audio Circuits
A. Tip = Signal + (Hot)
B. Sleeve = Signal - (Shield & Signal Return Path)
5. RCA Phono Plug Color Codes
A. Red = Audio, Right Channel
B. White = Audio, Left Channel
C. Yellow = Composite Video
D. Orange = Digital Audio (S/PDIF {Sony/Philips Digital
Interface Format})
E. Green = Y (Component Video - YPbPr)
F. Blue = Cb or Pb (Component Video - YPbPr)
G. Red = Cr or Pr (Component Video - YPbPr)
6. Amphenol 3 Pin Balanced Microphone Connector
A. Pin #1 = Shield
B. Pin #2 = Signal + (Signal Hot)
C. Pin #3 = Signal - (Signal Cold)
7. Amphenol 4 Pin Microphone Connector (Balanced and Unbalanced)
A. Pin #1 = Shield
B. Pin #2 = + (Hot) Unbalanced (Note: Unbalanced output is
with respect to the Shield)
C. Pin #3 = Signal + (Hot) Balanced
D. Pin #4 = Signal - (Cold) Balanced
8. DIN5 Pin Connector (Tape Deck I / O Connector)
A. Pin #1 = Right Channel Record Input
B. Pin #2 = Shield & Signal Common)
C. Pin #3 = Right Channel Playback Output
D. Pin #4 = Left Channel Record Input
E. Pin #5 = Left Channel Playback Output
9. 1 / 8 inch Mono Phone Plug (TR)
A. Tip = + (Hot)
B. Sleeve = - (Shield & Signal Return Path)
10. 1 / 8 inch Stereo Phone Plug {The type used on most Sound Cards}
A. Tip = Left Channel + (Hot)
B. Ring = Right Channel - (Hot)
C. Sleeve = Shield & Signal Common
11. 1 / 8 inch Microphone Input Plug (TRS) {The type used on most Sound Cards}
A. Tip = Signal + (Hot)
B. Ring = Phantom Power (~3 to 4 Volts @ ~ 0.75 to 1.5 mA)
C. Sleeve = Shield & Circuit Common
12. Modular Telephone Jack Wiring (- 48 Volt, 4 terminal, 2 line system / United States)
A. Red* or Blue or Blue with White Stripe = Line #1 (negative) (Hot)
B. Green* or White or White with Blue Stripe = Line #1 (positive)
(Common)
C. Yellow* or Orange or Orange with White Stripe = Line #2 - (Hot)
D. Black* or White or White with Orange Stripe = Line #2 + (Common)
* Denotes the most standard color code
13. Standard USB (Universal Serial Bus) Pinout and Color Code
A. Pin #1 = Vbus (5 Volts @ 500 mA) (Red Wire)
B. Pin #4 = Vbus Ground Return Conductor (Black Wire)
C. Pin #3 = Data + (Green Wire)
D. Pin #2 = Data – (White Wire)
Note: Data + and Data – Conductors are a Twisted Pair
14. 3.5 mm iPhone style Jack Pinout
A. Pin #1 (Tip) = Left Channel Output
B. Pin #2 (1st Ring) = Right Channel Output
C. Pin #3 (2nd Ring) = Ground/Common
D. Pin #4 (Sleeve) = Microphone Input
15. Stereo Phono Cartridge Wiring Color Standard
A. Red = Right Channel Signal (Hot)
B. Green = Right Channel Signal Return
C. White = Left Channel Signal (Hot)
D. Black = Left Channel Signal Return
Wire Table
The Wire Table below is useful for calculating losses in power amplifier to speaker system cable connections.
(Standard Annealed Copper)
Wire Gauge in AWG | Wire Diameter(in Mils) | Resistance per Foot in Ohms (@ 20 degrees C) |
0 | 324.9 | 0.00009827 |
1 | 289.3 | 0.0001239 |
2 | 257.6 | 0.0001563 |
3 | 229.4 | 0.0001970 |
4 | 204.3 | 0.0002485 |
5 | 181.9 | 0.0003133 |
6 | 162.0 | 0.0003951 |
7 | 144.3 | 0.0004982 |
8 | 128.5 | 0.0006282 |
9 | 114.4 | 0.0007921 |
10 | 101.9 | 0.0009989 |
11 | 90.74 | 0.001260 |
12 | 80.81 | 0.001588 |
13 | 71.96 | 0.002003 |
14 | 64.08 | 0.002525 |
15 | 57.07 | 0.003184 |
16 | 50.82 | 0.004016 |
17 | 45.26 | 0.005064 |
18 | 40.30 | 0.006385 |
19 | 35.89 | 0.008051 |
20 | 31.96 | 0.01015 |
21 | 28.46 | 0.01280 |
22 | 25.35 | 0.016140 |
23 | 22.57 | 0.02036 |
24 | 20.10 | 0.02567 |
Wire Gauge Rule of Thumb:
Conductor resistivity roughly doubles for every 3 AWG increase. (Resistivity = 1 / Conductivity)
Note 1: The temperature coefficient of resistance for copper wire ~ + 0.41% / degree C (4,100 ppm / degree C) referenced to 20 degrees C.
Note 2: The resistance of a 2 conductor cable will be need to be doubled to account for the round trip.
Note 3: Generally, audio power signals are carried with 18 AWG or lower except in some low power 25 or 70 Volt Constant Voltage audio distribution systems (from power amplifiers under 100 Watts).
Note 4: Except in some very unusual circumstances, no wire sizes higher than 16 AWG should be used to carry the output of an audio power amplifier to an audio system’s loudspeakers, especially in permanent building installations.
Telephone Touch Tone Frequency Chart
The Spectrum Analyzer can be used to detect and identify a telephone number dialed when used in conjunction with this chart. Also included are the letters A, B, C, and D, which was used in the US military’s Autovon phone system.
1 | 2 | 3 | A | 697 (687–708) |
4 | 5 | 6 | B | 770 (759–782) |
7 | 8 | 9 | C | 852 (839–865) |
* | 0 | # | D | 941 (927–955) |
1209 (1191–1227) | 1336 (1316-1356) | 1477 (1455-1499) | 1633 (1609-1658) | Frequency (Hz) |
Note 1: The tolerance for these frequencies is +/- 1.5 %, and the range of which is shown in parenthesis. The highest frequency must also be as loud as the lowest frequency, or as much as 4 dB louder (this difference in level is referred to as “twist.”
Note 2: Call waiting tone in the US is 440 Hz.
Note 3: Caller ID on call waiting in the US is 2130 + 2750 Hz.
Worldwide Dial Tone Frequencies
Country | Freq.1 | Freq. 2 | Country | Freq.1 | Freq.2 |
Belgium | 425 Hz | Not Used | Singapore | 270 Hz | 320 Hz |
France | 440 Hz | Not Used | South Korea | 350 Hz | 440 Hz |
Germany | 425 Hz | Not Used | Sweden | 425 Hz | Not Used |
Israel | 400 Hz | Not Used | Switzerland | 425 Hz | Not Used |
Italy | 425 Hz | Not Used | Taiwan | 350 Hz | 440 Hz |
Japan | 400 Hz | Not Used | U.S. | 350 Hz | 440 Hz |
Netherlands | 425 Hz | Not Used | U.K. | 350 Hz | 440 Hz |
Norway | 425 Hz | Not Used | Venezuela | 425 Hz | Not Used |
*Note1: These can be useful as a reference frequency when measuring DTMF signals
Note 2: Further information can be found in an ITU document located at:
http://www.itu.int/ITU-T/inr/forms/files/tones-0203.pdf
Land Line Telephone Interface Circuit (USA System)
Circuit Diagram
This land line analog interface circuit provides a higher quality signal compared to inductive or acoustic coupling methods. Its frequency response and low distortion are important as well as its ground-loop isolation between the phone line and your recording equipment. Hum levels will be quite low using this interface circuit.
It is very important to note that it is universally illegal to tap the phone line of someone else without a court order. However, in some states it is permissible to record your own phone line without second party approval. But, some states require two-party consent (both parties) before recording phone conversations. Please research your specific situation based on local and state regulations pertaining to telephone conversation recording.
Interface Circuit Notes:
1. Phone polarity input connection does not matter with this system.
2. The 5 uF Capacitor must be a Non-Polarized Film Type, 100 VDC or higher.
3. The two protection diodes can be small glass signal types; power diodes are not necessary. Use type 1N914 or equivalent (100 PRV, 200 mA, axial lead)
4. The 600 Ohm, 1:1 ratio audio transformer can be scavenged from an old computer modem board or purchased on the internet from Digikey, Newark Electronics or other similar outlets. You can use Tamura TTC-294 or equivalent.
5. The phase relationship between the primary and secondary sides of the transformer are not important.
6. The 20 KOhm fixed resistor should be +/- 10 % or better (it can be carbon composition, metal film or metal oxide – the type doesn’t matter).
7. The 10 KOhm Potentiometer should also be +/- 10 % and can be of the linear or audio taper variety, but audio taper pots usually give the user easier adjustability. You can use carbon or cermet; both types work well in this application.
8. Adjust the 10 KOhm Potentiometer for the proper input level to the systems sound-card or audio amplifier. Adjust for minimum noise without distortion or overloading.
9. On some systems, you can use the Line Level Input and on others you may have to use the Mic Level Input. It depends on the input Voltage sensitivity of the system to which the Interface Circuit is connected. Experiment to find the best input to use.
10. The input connector preferably should be a modular telephone jack for convenience.
11. The output connector can be a 1/8 inch mini-phone jack.
12. A convenient way to construct this is on a vector style board with 0.1 inch spacing between holes.
13. The circuit can be housed in a metal Altoid, Sucrets, or an old Band-Aid box (or something similar). An insulating spacer should be used to prevent short-circuits between the circuit board and the metal housing.
14. The metal case of the circuit housing can be connected to the point in the diagram designated as the “chassis ground”. This will improve the noise rejection ability of the interface circuit to external influences.
15. Care should be taken to assure that none of the electrical components come in contact with the metal housing.
16. Do not handle the un-enclosed circuit board when it is plugged into the telephone line. The telephone ring Voltage can give you a potentially dangerous shock.
Language Translation – German/Spanish (Deutsch/Español)
DCArt10/DC Forensics10 program terminology translations from English to German and Spanish
English | Deutsch | Español |
About Diamond Cut | Über DC-Art | Acerca del DC-Art |
Accuracy | Genauigkeit | Acuracia |
Add Marker | Marker hinzufügen | Añadir marcador |
Advanced Controls | Controles avanzados | |
Amplitude (dB) | Amplitude (dB) | Amplitud (dB) |
Arrange Icons | Symbole anordnen | Arreglo de Icones |
Attack (mSec) | Anstiegsflanke (mS) | Atacar (mSec) |
Attenuation | Dämpfung | Atenuacion |
Average | Mittelwert | Promedio |
Averaging Filter | Mittelwertfilter | Determinacion del Promedio del Filtro |
Band Pass | Bandpass | Banda de frecuencias alimentadas |
Bandpass Filter | Bandpaßfilter | Filtro de Paso de Banda |
Bandwidth | Bandbreite | Anchura de Banda |
Bright | Hell | Brillante |
Bypass | Bypass | Sobrepasar |
Cancel | Abbrechen | Cancelar |
Cascade | Fenster kaskadieren | Cascada |
CD Preparation | CD Vorbereitung | Preparacion del CD |
Center Frequency | Mittenfrequenz | Centro de Frecuencia |
Change Speed | Geschwindigkeit ändern | Cambio de velocidad |
Chop File into pieces | Datei aufteilen | Recortar el fichero en pedazos |
Clear all Markers | Alle Marker löschen | Despejar todos los marcadores |
Click Filter | Klickfilter | Golpecito seco en el Filtro |
Clicks / Second | Klicks / Sekunde | Golpecitos en seco / Segundo |
Close | Schließen | Fin |
Close Destination | Zieldatei schließen | Cerrar Destinacion |
Close Source | Quelldatei schließen | Cerrar las fuente de datos |
Contents | Inhalt | Contenidos |
Continuous Noise | Dauerrauschen | Sonido Continuo |
Continuous Noise Filter | Rauschfilter | Filtrador Continuo de Sonido |
Copy | Kopieren | Copia |
Crossfade | Crossfade | Interseccion del aumento / disminucion del volumen alto |
Curved | Kurve | Curvado |
Cut | Ausschneiden | Cortar |
Dark | Dunkel | Oscuro |
DC-Art Progress | DC-Art Prozeß | Progreso del DC-Art |
Decay | Ausklingzeit | Decaimiento |
DeEsser | DeEsser | Normalizador de seseos |
Delete | Löschen | Suprimir |
Delete Files | Dateien löschen | Suprimir ficheros / archivos |
Demo | Demo | Demostracion |
Detail | Detail | Detalle |
Device I/O Selection | Device I/O Auswahl | Seleccion del Dispositivo I / O |
Drive | Drive | Impulsar |
Dry | Trockenes Signal | Seco |
Dynamic Noise | Dynamisches Rauschen | Sonido Dinamico |
Dynamic Noise Filter | Dynamisches Rauschfilter | Filtro Dinamico de Sonido |
Dynamics Processor | Dynamikprozessor | Procesor Dinamico |
Early Level | Vorreflexion | Primera reverberacion de Amplificacion |
Edit | Bearbeiten | Editar |
Effects | Effekte | Efectos |
Ending Pitch | Endtonhöhe | Terminando el Grado de Inclinacion |
Even Only | Nur geradzahlige | Paridad Par |
Exciter | Exciter | Excitador |
Exit | Beenden | Salida |
Expander/Gate | Expander/Gate | Ensanche / Puerta |
Fade In | Einblenden | Aumento de Volumen |
Fade Out | Ausblenden | Disminucion de Volumen |
Fast Forward | Schneller Vorlauf | Advanzar / adelantar |
File | Datei | Fichero / Archivo |
File Conversions | Dateikonvertierungen | Traducciones del fichero |
File Information | Dateiinformation | Informacion de Archivo |
File Name | Dateiname | Nombre del fichero / archivo |
File Toolbar | Datei Werkzeugleiste | Archivo de paneles |
Files of Type | Dateityp | Modelos de ficheros |
Filter | Filter | Filtro |
Filter Freq. | Filterfrequenz | Filtro de frecuencia |
Filter Harmonics | Oberwellen filtern | Filtro Armonicos |
Filter Slope | Filterkurve | Filtro Inclinado |
Filter Toolbar | Filter Werkzeugleiste | Filtro de instrumentos |
Find and Mark Silent Passages | Stille Passagen finden und markieren | Encontrar y marcar los pasages silenciosos |
Frequency | Frequenz | Frecuencia |
Frequency Response | Frequenzgang | Frecuencia de respuesta |
Frequency Spectrum | Frequenzspektrum | Frecuencia de espectros |
From Mono to | Von Mono nach | Desde el Mono al |
From Stereo to | Von Stereo nach | Desde el Stereo al |
Full Range | Volle Bandbreite | Margen Entero |
Gain | Verstärkung | Amplificacion |
Gain Change | Verstärkungsänderung | Cambio de Volumen |
Gain Normalize | Pegel normalisieren | Regularizar el sonido |
Graphic Equalizer | Graphischer Equalizer | Equalizador Grafico |
Harmonic Reject | Harmonische ausfiltern | Reyeccion Armonica |
Harmonic Reject Filter | Oberwellen Unterdrückungsfilter | Filtro Armonico de Reyeccion |
Help | Hilfe | Ayuda |
High Frequency | hohe Frequenz | Frecuencia Alta |
High Pass | Hochpass | Paso Alto |
Highlight Marked Area | Markierten Bereich anwählen | Destacar las Areas Marcadas |
Impulse Filter Parameters | Impulsfilter | Filtrar Parametros de Impulso |
Impulse Noise | Impulsrauschen | Sonido de Impulso |
Keep Residue | Rest behalten | Guardar residuo (resto) |
Large | Groß | Grande |
Left | Links | Mando izquierdo |
Look In | Hineinsehen | Mirar En |
Low Frequency | niedrige Frequenz | Frecuencia baja |
Low Pass | Tiefpass | Avance de alimentacion de frecuencia baja |
Lowpass Filter | Tiefpaßfilter | Filtro de pasaje bajo |
Make Destination the Source | Ziel zur Quelle machen | Convertir los datos salidos del Fichero en datos nuevos de entrada de Fichero |
Make Waves | Wellenformdarstellung | Hacer ondas |
Marker | Marker | Marcador |
Maximum Harmonic | Maximale Oberwelle | Armonia Maxima |
Median | Zentralwert | Media |
Median Filter | Mittelungsfilter | Filtro Medio |
Medium | Mittel | Mediano |
Mix | Mischung | Mixto |
Mono | Mono | Mono |
Mute | Stummschalten | Mudo |
No | Nein | No |
Noise Threshold | Rauschschwelle | Umbral de Sonido |
Notch | Notchfilter | Hindumieno |
Octave | Oktave | Octavo |
Odd Only | Nur ungeradzahlige | Paridad impar |
Open | Öffnen | Abrir |
Open as Read Only | Schreibgeschützt öffnen | Abrir tal como se lee - Solo |
Open Destination | Zieldatei öffnen | Salida abierta de archivo |
Open Playlist | Spielliste öffnen | Lista de titulos |
Open Source | Quelldatei öffnen | Abrir la fuente de datos |
Operating Point (Quiescent Point) | Arbeitspunkt | Punto de Ininiazion |
Optimization | Optimierung | Optimizacion |
Output | Ausgang | Salida |
Output Mix | Ausgangsmix | Mezcla de salidas |
Overload | Übersteuerung | Sobrecarga |
Paragraphic Equalizer | Parametrischer Equalizier | Equalizador Paragrafico |
Paste | Einfügen | Pegar |
Pause | Pause | Pausa |
Pause File | Datei anhalten | Pausa del fichero / archivo |
Pentode | Pentode | 5 Elementos |
Percent Done | Prozent erledigt | Porcentage acabado |
Pitch Range | Tonhöhenbereich | Margen del Grado de Inclinacion |
Play Controls | Transportkontrolle | Uso de los Controles |
Play File | Datei spielen | Activar el fichero |
Play Looped | Endlosschleife | Ejecutar el registro y repetir |
Preferences | Voreinstellungen | Preferencias |
Preview | Vorschau | Vostazo/Chequeo |
Quantize for CD Audio | Für CD Audio quantisieren | Cuantificar para el audio CD |
Ratio | Verhältnis | Proporcion |
Record | Aufnahme | Registro |
Record File | Datei aufnehmen | Registro del fichero / archivo |
Reflections | Reflexionen | Reflejos |
Release (mSec) | Abfallzeit (mS) | Librar (mSec) |
Reset | Zurücksetzen (Reset) | Reajustar |
Reset Levels | Pegel zurücksetzen | Reajustar los Niveles |
Restoring a Recording | Aufnahme restaurieren | Restaurando el Registro |
Restoring the Demo | Demo restaurieren | Restauracion del muestreo |
Reverb | Hall | Reverberacion / Eco |
Reverse | Rückwärts | Inverso |
Reverse File | Datei rückwärts abspielen | Invertir fichero / archivo |
Rewind | Zurückspulen | Rebobinar |
Rewind File | Datei zurückspulen | Rebobinar el fichero / archivo |
Right | Rechts | Mando derecho |
Room Size | Raumgröße | Tamaño de espacio |
Run Effect | Effekt abspielen | Comenzar el funcionamiento de Efecto |
Run Filter | Filter anwenden | Comenzamiento del filtro |
Save Source as | Gleiche Quelldatei wie | El mismo dato que el |
Sample Noise | Quantisierungsrauschen | Ejemplo de Sonido |
Samples | Samples | Ejemplos |
Save | Speichern | Guardar |
Save as Type | Speichern als | Guardar tal como se ha mecanografiado |
Save Destination as | Zieldatei spiechern als | Guardar destinacion como |
Save In | Speichern in | Guardar En |
Search for Help on | Suche Hilfe über | Busqueda de ayuda en |
Select all | Alles auswählen | Seleccionar todo |
Shape | Form | Form / Forma |
Shift Threshold | Schwellwert verschieben | Cambio del Margen |
Small | Klein | Pequeño |
Source | Quelle | Fuente de Datos |
Spectrum | Spektrum | Spektrum / Espectros |
Spectrum Analyzer | Spektrumanalysator | Analizador de espectros |
Speed | Geschwindigkeit | Velocidad |
Starting Pitch | Anfangstonhöhe | Comienzo de Frecuencia |
Status Bar | Zustandsleiste | Condicion de los paneles |
Status Toolbar | Zustandsleiste | Compartimiento / Tablero de los paneles |
Stereo | Stereo | Stereo |
Stereo Reverse | Invertir el Stereo / retroceder atras Stereo | |
Stop File | Datei stoppen | Parar el fichero / archivo |
Straight Line | Gerade | Linea Recta |
Sweet | Süß | Agradable |
Sync Files | Dateien synchronisieren | Sincronizacion de archivos |
Threshold | Schwellwert | Margen |
Tile | Fenster anordnen | Diseño de Azulejos |
Time Offset | Zeitversatz | Cambio de tiempo |
Tip of the Day | Tip des Tages | Consejo del dia |
Total Clicks Processed | Anzahl der bearbeiteten Klicks | Total de golpecitos secos (pinchazos/clicks) procesados |
Total Samples to Process | Anzahl der zu bearbeiteten Samples | Total de ejemplos para procesar |
Tracking | Gleichlauf | Rastreando |
Transformer Coupled Class AB | Transformator gekopplete Class AB | Transformador Acoplado de Clase AB |
Triode | Triode | Triodo |
Tube Type/Configuration | Röhrentyp/Konfiguration | Clase de tubo / configuracion |
Undo | Rückgängig | Deshacer |
Very Large | Sehr groß | Muy Grande |
View | Anzeigen | Vista |
Vinyl LP | Vinyl LP | Vinilo LP |
Virtual Valve Amplifier | Virtueller Röhrenverstärker | Amplificador de valvula virtual |
Warm | Warm | Calido |
Wet | Effektsignal | Mojado |
Window | Fenster | Ventana |
Yes | Ja | Si |
Zoom to Markers | Zoom zwischen den Markern | Enforcar rapidamente |
Zoom In | Zoom In | Enforcar |
Zoom Out | Zoom Out | Desenfocar |
# of Filters | Filteranzahl | Numero de filtro |
% Change | % Veränderung | Porcentage de Cambio |
% Selected Time | % Zeit | Porcentage del Tiempo seleccionado |
2 Stage Class A | Zweistufige Class A | 2 Procesos - Clase A |
2 Stage Class AB | Zweistufige Class AB | 2 Procesos - Clase AB |
German Translation: Courtesy of Konstantin Themelidis
Spanish Translation: Courtesy of Monica Sanz Aznar (Monica Hash)
Preset Listings
10 Band Graphic EQ (see Graphic Equalizer – 10 Band)
20 Band Graphic EQ
30 Band Graphic EQ
Adaptive Filter
Adaptive Filter (Legacy Adaptive Filter)
Auto Voice Filter
1. Default
2. Heavy Attenuation
3. Maximum Attenuation
4. Minimum Attenuation
5. Moderate Attenuation
6. Nominal Attenuation
Averaging Filter
Band-pass Filter
Big Click Filter
1. Insensitive
2. Insensitive with De-Thumper
3. Most Insensitive
4. Most Insensitive with De-Thumper
5. Most Sensitive
6. Most Sensitive with De-Thumper
7. Nominal Sensitivity
8. Nominal Sensitivity with De-Thumper
9. Sensitive
10. Sensitive with De-Thumper
Brick Wall Filter
Cell Phone Noise Filter
1. Default
2. GSM – Aggressive Setting
3. GSM – Light Setting
4. GSM – Nominal Setting
5. GSM – Typical Starting Point
6. GSM – Very Aggressive Setting
7. GSM – Very Light Setting
8., Nextel – Aggressive
9. Nextel – Least Aggressive
10. Nextel – Typical Starting Point
11. Nextel – Very Aggressive
Change Speed Filter
Channel Blender
Continuous Noise Filter
De-Clipper
Dynamic Noise Filter
Dynamics Processor
Echo Effect Presets
EZ-Clean Filter
EZ-Enhancer
1. Audiophile Quality
2. Automatic Level Control 1
3. Automatic Level Control 2
4. Automatic Level Control 3
5. Automatic Level Control 4
6. Default
7. Effects Bypass
8. Exciter – Evens Compressor
9. Exciter – Evens Expander
10. Exciter – Odds & Evens Compressor
11. Exciter – Odds & Evens Expander
12. Fat Bottom Evens, Balanced Compression
13. Fat Bottom Evens Balanced Expansion
14. Fat Bottom Evens, Compression
15. Fat Bottom Evens Expansion
16. Fat Bottom Evens Tubes
17. Fat Bottom Odds, Balanced Compression
18. Fat Bottom Odds Compression
19. Fat Bottom Odds Expansion
20. Fat Bottom Odds Tubes
21. Final Cleanup 33 RPM
22. Final Cleanup 45 RPM
23. Final Cleanup 78 RPM
24. Final Cleanup Tape
25. Full Spectrum Evens Tubes
26. Full Spectrum Odds Tubes
27. Multiband Limiter
28. Multiband Noise Gate
29. Slow Response Compressor
30. Slow Response Expander
31. Spoken Word Filter
32. Sweet Balanced Exciter
33. Sweet Evens Compression
34. Sweet Evens Exciter
35. Sweet Evens Expansion
36. Sweet Evens Tubes
37. Sweet Odds & Evens Exciter
38. Sweet Odds, Balanced Compression
39. Sweet Odds, Balanced Expansion
40. Sweet Odds Compression
41. Sweet Odds Expansion
42. Sweet Odds Tubes
43. Warm Balanced Exciter
44. Warm Evens, Balanced Compression
45. Warm Evens Balanced Expansion
46. Warm Evens Compression
47. Warm Evens Exciter
48. Warm Evens Expansion
49. Warm Evens Tubes
50. Warm Odds & Evens Exciter
51. Warm Odds, Balanced Compression
52. Warm Odds, Balanced Expansion
53. Warm Odds Compression
54. Warm Odds Expansion
55. Warm Odds Tubes
EZ-Impulse Noise Filter
EZ-Forensics Filter
1. (170 Filter Factory Presets which are available via a Wizard Driven System)
File Conversions
Filter Sweeper
Forensics AFDF
1. Fast & Heavy
2. Fast & Light
3. Fast & Medium
4. Fast & Very Light
5. Slow & Heavy
6. Slow & Light
7. Slow & Very Heavy
8. Slow & Very Light
9. Very Fast & Very Heavy
10. Very Slow & Heavy
11. Very Slow & Very Heavy
Gain Change
Graphic Equalizer (10 Band)
Harmonic Reject Filter
High-pass Filter
Impulse Noise Filter
Low-pass Filter
Make Waves Generator
1. All Musical Notes running from C0 to D9#
2. 15 General Purpose Test Signals
Median Filter
Multi-Filter
Narrow Crackle Filter
1. Default
2. Gentle Touch Narrow Crackle
3. Large Sized Narrow Crackle
4. Medium Sized Narrow Crackle
5. Nominal Setting
6. Small Sized but Tall Narrow Crackle
7. Small Sized Narrow Crackle
8. Very Aggressive Narrow Crackle
9. Very Large Sized Narrow Crackle
10. Very Small Sized and Tall Narrow Crackle
11. Very Small Sized Narrow Crackle
Notch Filter
Overtone Synthesizer
1. Amplified Orchestral Effect
2. Balanced Orchestral Effect
3. Brilliant
4. Brilliant (very)
5. Default
6. Exaggerated Second Harmonic Overtones
7. Forensics Pseudo Sibilant (Clarifier)
8. Gentle Tough of Overtones
9. Near – Ultrasonic
10. Sparkling
11. Strong Second Harmonic Overtones
12. Subtle Second Harmonic Overtones
13. Top Octave Overtones Only
14. Top Octave Overtones Only (Strong)
15. Touch of Brilliance
16. Very Strong Second Harmonic Overtones
17. Wide Spectrum Second Harmonic Overtones
18. Wide Spectrum Second Harmonic Overtones
(subtle)
19. Wide Spectrum Second Harmonic Overtones
(very subtle)
Paragraphic Equalizer
Reverb
Polynomial Filter
Punch and Crunch
Remove Silence Tool
1. Type 20-10-5
2. Type 20-25-5
3. Type 20-5-5
4. Type 25-25-5
5. Type 25-5-5
6. Type 25-10-5
7. Type 30-10-5
8. Type 30-25-5
9. Type 30-5-5
10. Type 35-10-5
11. Type 35-25-5
12. Type 35-5-5
13. Type 40-10-5
13. Type 40-25-5
15. Type 40-5-5
16. Type 45-10-5
17. Type 45-25-5
19. Type 45-5-5
Spectral Filter
Stretch & Squish Filter
Sub-harmonic Synthesizer
1. Balanced Spectrum, Bump and Thump
2. Balanced Spectrum, Maximus Bump and Thump
3. Balanced Spectrum, Minimus
4. Balanced Spectrum, Nominal Level
5. Balanced Spectrum, Slight Bump and Thump
6. Deep Bass Balanced
7. Deep Bass Light
8. Deep Bass Maximus Thumpus
9. Deep Bass Minimus
10. Deep Bass Moderato
11. Default
12. Disco Bass
13. Terra Bass Balanced Level
14. Terra Bass Dance Club Atmosphere
15. Terra Bass Maximus Thumpus
16. Terra Bass Minimus
Virtual Phono Preamp (VPP)
1. Approximate AES LP EQ Curve
2. Approximate FFRR LP EQ Curve
3. Approximate NAB LP EQ Curve
4. Approximate Atlantic LP Label
5. Approximate Bartok LP Label
6. Approximate Blue Note Jazz LP Label
7. Approximate Canyon LP Label
8. Approximate Capitol – Cetra LP Label
9. Approximate Capitol LP Label
10. Approximate Concert Hall LP Label
11. Approximate Contemporary LP Label
12. Approximate Cook LP Label
13. Approximate Elektra LP Label
14. Approximate EMS LP Label
15. Approximate Folkways LP Label
16. Approximate Good – Time Jazz LP Label
17. Approximate L’Olseau-Lyre LP Label
18. Approximate London LP Label
19. Approximate Lyricord LP Label
20. Approximate Mercury LP Label
21. Approximate Oceanic LP Label
22. Approximate Philharmonic LP Label
23. Approximate Polymusic LP Label
24. Approximate RCA Victor LP Label (Early)
25. Approximate Remington LP Label
26. Approximate Urania LP Label
27. Approximate Westminster LP Label
28. Exact Allied LP Label
29. Exact American Record Society LP Label
30. Exact Angel LP Label
31. Exact Bach Guild LP Label
32. Exact Bethlehem Label
33. Exact Boston LP Label
34. Exact Caedmon LP Label
35. Exact Camden LP Label
36. Exact Cetra – Soria LP Label
37. Exact Classic Editions Label
38. Exact Clef Label
39. Exact Collosseum LP Label
40. Exact Columbia LP Label
41. Exact Decca LP Label
42. Exact Epic LP Label
43. Exact Esoteric LP Label
44. Exact Haydn Society LP Label
45. Exact Kapp Label
46. Exact McIntosh Label
47. Exact MGM Label
48. Exact Montilla Label
49. Exact New Jazz Label
50. Exact Pacific Jazz LP Label
51. Exact Prestige Label
52. Exact RCA Victor Label
53. Exact Riverside LP Label
54. Exact Romany LP Label
55. Exact Savoy LP Label
56. Exact Tempo LP Label
57. Exact Vanguard LP Label
58. Exact Vox LP Label
59. Exact Walden LP Label
60. Default
61. Flat Preamp Hardware playing Acoustical
Records
62. Flat Preamp Hardware playing American
78s
63. Flat Preamp Hardware playing Columbia
Vinyl LPs
64. Flat Preamp Hardware playing European
78s
65. Flat Preamp Hardware playing RIAA Vinyl
LPs
66. Line Input – Phono Preamp Bypass
67. RIAA Preamp Hardware Playing Acoustical
Records
78s
Vinyl LPs
70. RIAA Preamp Hardware Playing European
78s
Vinyl LPs
72. Approximate RIAA EQ with DIN Comp (Flat Preamp)
73. Approximate RIAA EQ with DIN Comp (RIAA Preamp)
Virtual Valve Amplifier (VVA)
Voice Garbler
1. Default
2. Female Child Downshift 1
3. Female Child Downshift 2
4. Female Voice Downshift 1
5. Female Voice Downshift 2
6. Female Voice Downshift 3
7. Female Voice Upshift 1
8. Female Voice Upshift 2
9. Male Child Downshift 1
10 Male Child Downshift 2
11. Male Child Upshift 1
12. Male Child Upshift 2
13. Male Voice Downshift 1
14. Male Voice Downshift 2
15. Male Voice Upshift 1
16. Male Voice Upshift 2
17. Silly Girl
VVA Presets (Relating to the Fat Bass Feature)
Whisper Enhancer (Forensics)
1. ~Starting Point
2. Default
3. Low Sensitivity – Moderate Response 1
4. Low Sensitivity – Moderate Response 2
5. Max Sensitivity – Fast Response
6. Max Sensitivity – Moderate Response
7. Max Sensitivity – Slowest Response
8. Max Sensitivity – Very Fast Response 1
9. Max Sensitivity – Very Fast Response 2
10. Moderate Sensitivity – Moderate Response 1
11. Moderate Sensitivity – Moderate Response 2
12. Moderate Sensitivity – Very Slow Response
13. Very Low Sensitivity – Moderate Response 1
14. Very Low Sensitivity – Moderate Response 2
15. Xtreme Settings
Wind Noise Filter
1. Category 1 Hurricane
2. Category 3 Hurricane
3. Category 4 Hurricane
4. Default – DCArt10
5. Default
6. Light Breeze
7. Strong Breeze
8. Tropical Storm
9. Very Light Breeze
A Brief History of Diamond Cut Productions
In the spring of 1986, an R&D engineer/scientist by the name of Craig Maier read an article in The Star Ledger, a local newspaper, entitled "Budget Cuts Cast Shadow on Edison National Historic Site." The article, written by science editor Kitta McPherson, described the deteriorating condition of the Edison National Historic Site and its archives located in West Orange, New Jersey. Among the many artifacts which were not receiving the proper curatorial attention due to poor funding was a collection of test-press recordings which were made by the Edison Company between the years of 1927 through 1929, which was their last few years in the record business. Craig told a friend and fellow engineer named Rick Carlson about the article in hopes that it might stir up in him some interest in the Edison site as well. Craig and Rick, after some considerable discussion, decided to offer to volunteer some of their spare time and technical expertise in the area of audio hardware and software engineering in order that the Edison Lateral collection of test pressing recordings could be transferred to digital tape so that the "sound artifacts" would be eternally preserved and archived in the digital domain at the site.
Contact was made with then Supervisor Museum Curator, Dr. Edward Pershey, Ph.D. During their first meeting at the site, Dr. Pershey showed the two engineers thousands of one-of-a-kind test pressing recordings that were piled in stacks on a long row of tables on the second floor of the Edison main laboratory building. This initial introduction to the collection was an earnest attempt to sober up these two individuals as to the magnitude of the undertaking for which they were volunteering. The total number of songs which were recorded numbered over 1200 in anywhere from two to five takes each. This only further increased their interest in the project since the possibility of finding some truly important music that had previously been unheard since the late 1920's would be quite high in such a large collection of test pressings. After several additional meetings with Dr. Pershey, an informal agreement was made such that the two engineers could proceed to seek out funding from private sources to set up an audio restoration laboratory in one of their own homes for the project. They contacted around 30 companies in the New Jersey area seeking funds to help build their laboratories. After about seven months of effort, they succeeded in raising enough money to fund their project. In addition to fund raising, they also designed and constructed several pieces of custom equipment that was needed for the project (equipment which was not readily available on the market at the time).
The next step was to become educated in the proper technique of archival audio transferring. To that end, they hired Mr. Tom Owens of the Rogers and Hammerstein musical library in New York City as an engineering consultant. Tom spent time with the two engineers at the New York City Public Library sound lab (Rogers and Hammerstein) teaching them some of the "tricks of the trade." Tom also visited the first sound lab which the two engineers set up for the restoration project located at Craig's home in Verona, NJ. He provided constructive criticism regarding the sound lab which the two engineers had set up, allowing them to improve upon their initial system. One significant problem which Tom highlighted for the two engineers was that of establishing the correct turnover frequency for the transfer of these lateral test pressings. Documentation could not be found at the Edison site regarding the specifics of this important parameter. So Rick and Craig devised some experiments which were conducted on a "high-end" vacuum tube based Edison phonograph designed around the same time period as the test pressings in order to deduce the correct turnover frequency. After their experiments, modifications were made to their magnetic phonograph pre-amplifier to provide the most likely proper turnover frequency for the transfers.
A seven year pro-bono contract was drawn up between the Edison National Historic Site / U.S. Department of the Interior, and Rick Carlson and Craig Maier for the purposes of executing the project outlined above. Finally, the two engineers were ready to begin the project. Nearly one full year had lapsed before the first record was transferred to digital tape at Craig's home in Verona, N.J. Shortly thereafter, the sound lab was rebuilt in the Maier's new home in Rockaway Township, NJ. That is the location in which the lion’s share of the transfer project took place over the next seven years.
After transferring around 900 of the songs (times 2 - 5 takes per song, about 2,200 transfers in total) Craig and Rick decided that the music was not doing much good sitting in the underground vault of a museum. Since they were the only two people alive who had heard almost the entire collection, they decided that it would be a good idea to try to release some of this previously unreleased material (only around 200 of the songs had ever been released in the Edison lateral format). So they approached the Edison site in order to try to accomplish this. After about one year of frustration in dealing with the bureaucracy, they decided it would be a lot easier to form their own company and release these songs under their own record label. Thus was formed Diamond Cut Productions in 1992 with Craig and Rick providing their own seed capital for the venture. Their first release entitled "Unreleased Edison Laterals 1 - - - an anthology of Edison Needle type records" was such a success in the market that they were able to start another project in 1994 entitled "The California Ramblers, Edison Laterals 2." For this project, they decided to improve on the audio restoration process, which they had used on their previous release. Instead of analog signal processing, they migrated to digital signal processing utilizing their own algorithms to remove crackle, ticks, pops and hiss from the original material. They named their process (which ran on an inexpensive pc) "Diamond Cut Audio restoration tools" or DC-Art for short. Their technique proved successful to the extent that the Smithsonian Institution Press employed Diamond Cut Productions to perform audio restoration for some of their American Songwriter Series of CD releases using this process. Diamond Cut's third CD release entitled "Hot Dance of the Roaring 20's, Edison Laterals 3" was processed utilizing exclusively their own audio restoration program; all analog processing equipment had been abandoned by this point in time. In the meantime and in parallel with the efforts to bring "Hot Dance . . . " to the market, Craig worked with County records to produce and release an Edison olde time group on CD called "Ernest Stoneman and his Dixie Mountaineers" using their audio restoration process. In the spring of 1996, their program was first formally introduced into the commercial marketplace at a meeting of "Record Research" which was held at the Maier residence in Rockaway Township, NJ. Since then it has been sold throughout the world for not only musical audio restoration applications, but for others such as 911 call restoration, clarification of police surveillance recordings, cleanup of radio broadcasts for release on CD, restoration of historic spoken word recordings, cockpit voice recording restoration, plus many others.
Diamond Cut Productions, Inc. has now become one of the predominant international players in the audio restoration and enhancement software market. Their Forensics Audio Software product line has gained wide acceptance on an international scale. New features and improved performance will be added into their legacy audio restoration software products on a continuous process basis.
In the future, Diamond Cut Productions expects to continue releasing more CDs and digital downloads in their Edison Lateral Cut series. However, they have also branched out into other musical venues from the 1920s and 1930s time period.
Diamond Cut Audio Restoration Tools Development Timeline
Mid 1993 -
While frustratingly removing clicks from an Edison record using just a computer and a mouse whilst drinking too much wine and beer, Rick Carlson and Craig Maier wrote the first few lines of code in an attempt to perform this process automatically. Although very crude at the beginning, this particular algorithm (the Impulse Filter) eventually developed into its present level of sophistication occupying about 500 K of compiled code. Several of those original lines and thinking are still in the present day code. Rick had stored those original lines of code under the filename of dcart.exe ultimately giving rise to the name "Diamond Cut audio restoration tools."
Late 1993 -
Having heard about Diamond Cut through the grapevine, Bruce Talbot, executive producer for the Smithsonian Collection of Recordings contacted us and inquired if they would be willing to apply their "de-clicking" process to a particularly bad recording of "Darn That Dream." This restoration was released on the American Songbook Series on a CD entitled "James Van Heusen." which was copyrighted in 1994 as release number RD 048-18 / A 23955.
Early 1994 -
Having been satisfied with their work on the "James Van Heusen" CD, Bruce Talbot again contacted Diamond Cut to do some work on a release in the American Songbook Series, which was to be called "Richard Whiting." On it, they restored a "basket case" copy of a Rudy Vallée rendition of "Honey." In the liner notes for the CD it says "The only source available for "Honey" was a 78-rpm disc in very poor condition. The sound quality has been greatly improved by Craig Maier and Rick Carlson of Diamond Cut Productions, using their DC-Art system of sound restoration." This CD is also copyrighted in 1994 but under the release number of RD048-22 / A 24571.
Mid 1994 -
While recuperating from surgery and being extremely bored, Craig decided to restore an entire artist's output of Edison Lateral Cut records which Rick and Craig had earlier transferred to digital audiotape as part of the Edison Lateral Cut Disc archival project. The artist was Ernest V. Stoneman (and his Dixie Mountaineers). He used their DC-Art program to remove all extraneous clicks, pops, and hiss from the originals. Ultimately, Diamond Cut Productions sold the Master digital tape to County Records which released and copyrighted the CD in 1996 on County release number CD-3510.
Late 1994 -
Diamond Cut Productions decided that it was time to release another in its series of mostly Unreleased Edison Lateral Cut recordings. They choose "The California Ramblers" as the subject of the release. They also decided to use no additional analog processing equipment other than their DC-Art program to restore the recording. De-clicking, de-popping, de-hissing, de-rumbling and minor equalization were all performed via their computer algorithms. Thus was their first release which included only two analog steps, that of the mastering back in the late 1920's and that of the transfer to digital tape in the late 1980's and early 1990's. This CD is entitled "The California Ramblers - - - Edison Laterals 2" and was released under number DCP-301D and copyrighted in late 1994. This CD is still available from Diamond Cut Productions, Inc. and other venues throughout the world.
Early 1995 -
Diamond Cut Productions decided to expand their business from the production of CD's to the manufacture of audio restoration software products. They decided that since the program had been quite useful to in their CD business, it might also be useful to many other people with audio collections in need of restoration. The first public release took about 7 months to smooth out the bumps in the program that we had learned to work around. Making a commercial software product is much different than writing one for yourself as they were soon to find out!
April 21st 1995 -
Diamond Cut Productions sent out the initial Beta version of DC-Art to some potential customers identified as QA 1.1. They worked on de-bugging this software for the next few months. If you have an original copy of QA 1.1, it may be an antique! (Antique software - - - what's this world coming to??)
July 1996 -
Version 1.0 was officially released at a meeting of "Record Research" held at the Maier Rockaway Township residence. The first copies were sold at the end of the meeting during which the program had been demonstrated to a small group of about 15 people.
September 4th, 1997 -
A distributorship agreement is signed between Diamond Cut Productions, Inc. and Tracer Technologies, Inc. in order to help facilitate the marketing and distribution of the DC-Art product line.
December 1997 -
Version 2.0 of DC-Art featuring, among other things, real time Preview was introduced into the market.
September 1998 -
Version 3.0 of DC-Art, otherwise known as Diamond Cut 32 was introduced into the market with novel features such as the Virtual Valve Amplifier.
August 1999 -
Version 4.0 otherwise known as Live and Millennium was introduced. This brought with it a new level of performance and features in the audio restoration and enhancement software market. Features like Live feed through mode, and 24-bit/96 kHz support have changed the landscape in this area of endeavor.
December 1999 -
Established German distributorship for the Live and Millennium programs through Digital Broadcast Systems GmbH (dBS). The products can be seen and purchased in the German language at www.diamondcut.de
August 2001 -
Updated Live and Millennium to version 4.8 with bug fixes and the addition of a high resolution VU Meter. Also, the frequency resolution of the spectrum analyzer was greatly enhanced.
February 2001 -
Released the code for Enhance/MP3, a low cost product used for improving the sound quality of MP3 audio files. Diamond Cut Productions Inc. and Tracer Technologies form a new Partnership called Enhanced Audio Inc., whose sole purpose is to market, and distribute the world’s best audio enhancement, restoration, and analysis tools.
June 2002 -
Released Live/Five to Beta
September 2002 -
Released Live/Five to Production
May 2004 -
Released Live/Six to Beta
August 2004 -
Released Live/Six to Production
July 2007 -
Released Version 7 to Beta
October 2007 -
Released Version 7 to Production
November 2008 -
Released Live/Forensics Audio Laboratory, Version 7.5 to Beta
January 2009 -
Released Live/Forensics Version Audio Laboratory, Version 7.5 to Production
November 2009 -
Released DC8, Version 8.0 to Beta
March 2010 -
Released DC8, Version 8.0 to Production
November 2010 –
Released DC Forensics8 Audio Laboratory, Version 8.0 to Beta Test
April 2011 –
Released DC Forensics8 Audio Laboratory, Version 8.0 to Production
December 2011 –
Released DC Forensics8 Audio Laboratory, Version 8.1 to Production
April 2012 –
Released DC8, Version 8.1 to Production
October 2015 –
Released DCForensics10 to Beta Test
March 2016 -
Released DCForensics10.0 to Production
March 2017 –
Released DCForensics10.03 to Production
March 2017 –
Released DCArt10 to Beta Test
June 2017 –
Released DCArt10 to Production
Diamond Cut Productions Edison Lateral Series CD and Cassette Music Releases
Diamond Cut Productions is proud to offer releases of Edison Lateral Cut Test Pressing recordings available in the CD format, with one available in both CD and Cassette. Also, we have an assortment of non-Edison recordings available. These albums are also available in the .mp3 downloadable format located at the following link:
http://www.diamondcut.com/st3/product-category/music/
The following is our current product offering:
*Visit Our Online music store at www.diamondcut.com to audition and/or purchase these tunes (via download).
For all other items, please include $2.30 per item to cover Shipping and Handling in the U.S. Europe, please include $4.20 per item.
N.J residents add 7% Sales Tax.
All of the Diamond Cut Music Albums can now be downloaded from our online store in .mp3 format at www.diamondcut.com where they can be auditioned and/or purchased (via download).
To order, please visit our on-line store located at www.diamondcut.com, or
please send your order including your check or money order payable in U.S funds to:
Diamond Cut Productions, Inc.
P.O. Box 305
Hibernia, NJ 07842-0305
Alternatively, you can fax your order to 973-316-5098
Visa, MasterCard, Discover, or Paypal Accepted
Or, call in your order at 973-316-9111
Contact us via our website or make your purchase at our online store located at:
http://www.diamondcut.com/st3/shop/
Note: Dealers, Retailers, and Record Distributors are invited to request a copy of our Product Discount Schedule.
DCAT-3 is a comprehensive set of 147 audio signals contained on a 3 CD set, which is very useful for room acoustical response balancing and audio equipment testing and evaluation. Room acoustical response balancing can be performed with nothing more than a calibrated low cost sound pressure meter in conjunction with the DCAT-3’s set of 31 narrowband random 1/3rd octave weighted noise signals.
All DCAT-3 signals are announced on a separate track allowing any signal to be repeated using the loop-play feature on your CD player. DCAT-3’s signals are all tightly calibrated in frequency, amplitude and spectral distribution since they are all mathematically synthesized without the use of A/D converters. Sine waves are very low in harmonic distortion content while square waves exhibit excellent rise times while triangle waves display exceptional linearity. Also, none of the signals contain any annoying transients since each signal is smoothly faded-in and faded-out. DCAT-3 offers the user a great value at a very reasonable price. DCAT-3 contains the following signal types:
DCAT-3 Performance Specifications
Signal Type | Frequency Accuracy | Amplitude Accuracy | Distortion (% THD) |
Sine | + / - 0.005 % | + / - 0.5 dB | 0.0033 % @ 1 kHz |
Square | + / - 0.005 % | + / - 0.5 dB | 44 % @ 1 kHz |
Triangle | + / - 0.008 % | + / - 0.5 dB | 12 % @ 1 kHz |
White | N/A | + / - 0.7 dB | 100 % |
Pink | N/A | + / - 1.5 dB | 100 % |
Narrowband Random (1/3 rd Octave Steps) | + / - 0.2 % | + / - 1.5 dB | 100 % |
Swept Sine | + / - 0.005 % | + / - 0.5 dB | 0.0033 % @ 1 kHz |
Swept Square | + / - 0.005 % | + / - 0.5 dB | 44 % @ 1 kHz |
Swept Triangle | + / - 0.5 % | + / - 1.5 dB | 12 % @ 1 kHz |
Dual Tone | + / - 0.005 % | + / - 0.5 dB | 0.008 % (high tone) |
*The quality of your CD player’s performance may degrade these numbers to varying degrees
To Order, just go to www.diamondcut.com and follow the signs to the online store.
Diamond Cut Software Product Model Number Nomenclature (English Versions)
DCArt10, v. 10.x – Full Version: DCP-1010F
DCArt10, v. 10.x – Upgraded Version: DCP-1010UP
DCForensics10 Audio Laboratory, v. 10.x – Full Version: DCP-2110F
DCForensics10 Audio Laboratory, v. 10.x – Upgraded Version: DCP-2110UP
License Agreement
This is a legal agreement between you, the end user, and Diamond Cut Productions, Inc. (Diamond Cut Productions). This Diamond Cut Productions software program (the SOFTWARE) is licensed by Diamond Cut Productions for use only on the terms set forth herein. Please read this license agreement. Installing this software indicates that you accept these terms. If you do not agree to these terms, please contact Diamond Cut Productions or its representatives within 15 days of purchase.
GRANT OF LICENSE. Diamond Cut Productions grants to you the right to install a copy of the DCArt10/DC Forensics10 SOFTWARE on no more than two terminals or computers. These two installations of the SOFTWARE are for the sole use of the single purchaser/licensee of the SOFTWARE. If two installations are created, they are for the sole use of the licensee and are only to be used by one person at any given time. If you install the SOFTWARE on a network server, you must purchase a separate copy of the SOFTWARE for each computer terminal that will be used to operate the SOFTWARE.
GRANT OF NETWORK LICENSE. If you are acquiring a special version of the SOFTWARE specifically intended for network use, Diamond Cut Productions grants you the right to use the SOFTWARE on a LICENSED COMPUTER NETWORK as provided below. A computer network is any combination of two or more terminals that are electronically linked and capable of sharing the use of a single software program. A LICENSED COMPUTER NETWORK is a computer network for which you have acquired and dedicated at least one (1) Diamond Cut Productions standard version of the SOFTWARE (which can run stand-alone or as a network server). For additional users to use the SOFTWARE on the network you must acquire a WRITTEN LICENSING AGREEMENT from Diamond Cut Productions indicating the number of users expected to be able to use the SOFTWARE. You may have as many copies of the SOFTWARE in simultaneous use on the network as is specifically authorized in the WRITTEN LICENSING AGREEMENT with Diamond Cut Productions, Inc.
COPYRIGHT. The SOFTWARE is owned by Diamond Cut Productions, Inc. and is protected by United States copyright, trade secret and trademark laws and international treaty provisions. You may either (a) make one copy of the SOFTWARE solely for backup or archival purposes provided that you reproduce all copyright and other proprietary notices that are on the original copy of the SOFTWARE provided to you, or (b) transfer the SOFTWARE to a single hard disk provided you keep the original solely for backup or archival purposes.
OTHER RESTRICTIONS. You may not rent or lease the SOFTWARE. You may not reverse engineer, decompile, disassemble, or create derivative works from the SOFTWARE. You may not embed or bundle the SOFTWARE in non-Diamond Cut Productions, Inc. products without a written contractual agreement providing for such usage.
GOVERNMENT LICENSEE. If you are acquiring the SOFTWARE on behalf of any unit or agency of the United States Government, the following provisions apply:
The Government acknowledges Diamond Cut Productions representation that the SOFTWARE and its documentation were developed at private expense and no part of them is in the public domain.
The Government acknowledges Diamond Cut Production's representation that the SOFTWARE is "Restricted Computer Software" as that term is defined in Clause 52.227-19 of the Federal Acquisition Regulations (FAR) and is "Commercial Computer Software" as that term is defined in Subpart 227.471 of the Department of Defense Federal Acquisition Regulation Supplement (DFARS). The Government agrees that:
(i) If the SOFTWARE is supplied to the Department of Defense (DoD), the SOFTWARE is classified as "Commercial Computer Software" and the Government is acquiring only "restricted rights" in the SOFTWARE and its documentation as that term is defined in Clause 252.227-7013 (c) (1) of the DFARS, and
(ii) If the SOFTWARE is supplied to any unit or agency of the United States Government other than DoD, the Government's rights in the SOFTWARE and its documentation will be as defined in Clause 52.227-19 (c) (2) of the FAR.
RESTRICTED RIGHTS LEGEND. Use, duplication or disclosure by the Government is subject to restrictions as set forth in subparagraph (c) (1) (ii) of the Rights in Technical Data and Computer Software clause at DFARS 252.227-7013. Diamond Cut Productions, P.O. Box 305, Hibernia, NJ 07842-0305.
EXPORT LAW ASSURANCES. You acknowledge and agree that the SOFTWARE is subject to restrictions and controls imposed by the United States Export Administration (the "Act") and the regulations thereunder. You agree and certify that neither the SOFTWARE nor any direct product thereof is being or will be acquired, shipped, transferred or re-exported, directly or indirectly, into any country prohibited by the Act and the regulations thereunder or will be used for any purposes prohibited by the same.
GENERAL. This Agreement will be governed by the laws of the State of New Jersey, except for that body of law dealing with conflicts of law. Should you have any questions concerning this Agreement, or if you desire to contact Diamond Cut Productions for any reason, please write: Diamond Cut Productions Customer Sales and Service, P.O. Box 305, Hibernia, NJ 07842-0305.
NUMBER OF USERS LICENSED. If you have not purchased a site license that authorizes use of the Software on multiple computers (or servers) and by multiple individuals, then you are authorized to use ONLY a single copy of the Software at a given time and installed on no more than two computers by a single licensee at that time. Only ONE additional copy of the Software may be created for archival or backup purposes on one external media system. All copies of the Software MUST include the Diamond Cut Productions, Inc. Copyright notice and other legal notices.
TERM. This license is effective from your date of purchase and shall remain in force until terminated. You may terminate the license and this License Agreement at any time by destroying the Software, including all back-up copies thereof, and the accompanying documentation, together with all other copies in any form. End-user resale of this software product is prohibited.
ARCHIVE: The product serial number, user name, registration code and e-mail address are not kept on the Diamond Cut Productions servers indefinitely. It is the customer’s responsibility to preserve that information in their own archive.
LIMITED WARRANTY. Diamond Cut Productions, Inc. warrants that the SOFTWARE will perform substantially in accordance with the accompanying written materials for a period of ninety (90) days from the date of receipt. Any implied warranties on the SOFTWARE are limited to ninety (90) days. Some states do not allow limitations on duration of an implied warranty, so the above limitation may not apply to you.
PRODUCT APPLICATION LIMITATION(s): Diamond Cut Productions, Inc. does not recommend the use of any of its products in emergency communications or real time intelligence gathering environments where the failure or malfunction of the product can reasonably be expected to cause compromise of the communications system, or to significantly affect its safety or effectiveness. Products are not authorized for use in such applications unless Diamond Cut Productions, Inc. receives written assurances, to its satisfaction, that: (a) the risk of injury, or damage has been minimized; (b) the user assumes all such risks; and (c) potential liability of Diamond Cut Productions Inc. is adequately protected under the circumstances.
CUSTOMER REMEDIES. Diamond Cut Productions, Inc. entire liability and your exclusive remedy shall be, at Diamond Cut Productions option repair or replacement of the SOFTWARE that does not meet Diamond Cut Productions Limited Warranty. This Limited Warranty is void if failure of the SOFTWARE has resulted from accident, abuse, or misapplication. Any replacement SOFTWARE will be warranted for the remainder of the original warranty period or thirty (30) days, whichever is longer. These remedies are not available outside of the United States of America. Fully functional demo versions of Diamond Cut Software products are provided and should be evaluated before purchase. Refunds are not provided on software products after purchase.
NO OTHER WARRANTIES. Diamond Cut Productions, Inc. disclaims all other warranties, either express or implied, including but not limited to implied warranties of merchantability and fitness for a particular purpose, with respect to the SOFTWARE and any accompanying written or electronic materials. This limited warranty gives you specific legal rights. You may have others, which vary from state to state.
NO LIABILITY FOR CONSEQUENTIAL DAMAGES. In no event shall Diamond Cut Productions, Inc. or its suppliers be liable for any damages whatsoever (including, without limitation, damages for loss of business profits, business interruption, loss of business information, or other pecuniary loss) arising out of the use of or inability to use this Diamond Cut Productions, Inc. product, even if Diamond Cut Productions, Inc. has been advised of the possibility of such damages. Because some states do not allow the exclusion or limitation of liability for consequential or incidental damages the above limitation may not apply to you. You are solely responsible for all work-product created through the use of this software.
PRODUCT CHANGES. Product features and specifications are subject to change without notice.
NOTIFICATIONS: The availability of product updates and upgrades are announced as they become available via email and also posted on the Diamond Cut website and its User’s Forum. You have the ability to opt-out of future email notifications upon receipt your initial notification following the purchase of your Diamond Cut software product.
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